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General

How to Use this Manual

About this book
This manual is both a tutorial and a reference manual for the Leica TCS SP2. We intend this manual
for the novice and the experienced user. If you are a new user, you should start with the chapter
"Running the LCS Software," use the software for a while, and then read through the rest of the
manual. Experienced users can search through the chapters, table of contents, and index to find
special topics explained.
This book also covers the way your Leica Confocal Software and the Leica Microscope interact.
How to use this manual
We urge you to use this book, not just read it. To learn about the Leica Confocal Software, use the
book as a tutorial. We show how to accomplish a variety of tasks. Work through the instructions to
learn. The manual usually introduces a set of steps to accomplish a particular task with a distinctive
heading.
Performing a task
Following the heading that introduces a task are either sequential steps or optional steps, each with
its distinctive style:
1. Numbered paragraphs, like this one, designate step-by-step instructions. Follow them to learn how
the tools work.
2. If several menu commands must be selected in sequence, an arrow separates the individual menu
commands: for example, File →→→→ Save indicates that you click on File and select Save in the displayed
pull-down menu.

Usually there is a sequence. Perform one or more of the steps to cause the designated action or
actions.
We recommend reviewing this manual again after you have used the Leica TCS SP2 for a while. You
will come across useful functions during the second reading that may have been overlooked during
the first reading.
Online Help
Leica TCS SP2 comes with a context-sensitive online help system that explains the different functions
of the instrument.
To retrieve the contents of the online help system:
Select Help →→→→ Contents. The online help system opens with an activated CONTENTS window. It
shows a collapsible table of contents. Double-click an entry of the table of contents to view the
corresponding information.
To retrieve information using a keyword:
Select Help →→→→Index. The online help system opens with an activated INDEX window. Enter the word
you want to look up. The online help shows the key word that represents the closest match to the
word you entered.
To perform a full-text-search:
Select Help →→→→ Search. The online help system opens with an activated SEARCH window. Enter the
term or definition you want to look up and click on the LIST TOPICS button. A hierarchically structured
list of topics is returned. On the right side of the field where you enter the word is a menu to perform a
full-text search using logical operators.
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Documentation Conventions

Button
The buttons provided on the user interface of the Leica Confocal Software. Buttons are marked with
icons and/or have an (often abbreviated) English label. They either trigger actions directly or open
dialog windows.

Menu
The menus are divided into the categories of File, View, Macro, Tools, Window and Help and are
displayed in the menu bar located at the upper edge of the user interface.

Option
Options refer to the selectable items that are hierarchically listed below the menus. Options either
trigger actions directly or open dialog windows.

Dialog Window
Both buttons and options open dialog windows. Dialog windows are used to set various parameters
and select functions.

Tab
Tabs are found in dialog windows. Tabs thematically combine the parameters and functions that can
be configured in dialog windows. Some registers are divided into fields.

Viewer window
The Leica Confocal Software offers two types of viewer windows: The Viewer window is called up
using the New button and shows the recorded images. The Experiment Overview viewer window
displays the recorded images in a directory tree. This viewer window is called up from the View menu
and appears as a separate window at the left side of the user interface.

Legend
The Leica Confocal Software provides two legends, which display the parameters and settings of an
image recording. The Experiment legend can be placed at the right edge of the Viewer window. The
Hardware legend is called up from the View menu and appears as a separate window at the left side
of the user interface.

Context Menu
Context menus appear when you click the right mouse button while holding the mouse pointer over
certain areas of the user interface. Context menus contain various, context-sensitive commands.
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New in this version of the manual

• Adjusting intensity, contrast and gamma correction
(chapter on Data Processing, page 214)

• Leveling and filtering of surface recordings (optional)
(chapter on Data Processing, page 219)

• Identifying and separating superimposed fluorescence signals
(chapter on Data Processing, page 219)

• Segmentation of image structures (optional)
(chapter on Data Processing, page 284)

• Operating modules of the microscope stand via software
(chapter on Data Recording Functions, page 135)

• Importing and exporting dye spectrums
(chapter on Data Recording Functions, page 151)

• Selecting Z actuator type
(chapter on Data Recording Functions, page 170)

• Graphical display of measured values of an online measurement
(chapter on Data Display Functions, page 178)

• Updated descriptions of work processes and exercises
(chapter on Procedures and Exercises for Selected Processes, page 62)
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Confocal imaging

What is confocal imaging?
Conceptualized in 1953, the Confocal Laser Scanning Microscopy has only in the past 10 years
become a practical technique. Today it is the technique of choice for biological research, chemical
analysis, and materials testing. The results of many years of research and development in many
different areas are combined in such an instrument: microscopy, laser technology and optics for
coherent light, video technology, electronics and computer technology.
Confocal microscopy detects structures by collecting light from a single focal plane of the sample,
excluding light that is out of focus.
In a point scanning confocal system, the microscope lenses focus the laser light on one point in the
specimen at a time (the focal point). The laser moves rapidly from point to point to produce the
scanned image. Both fluorescent and reflected light from the specimen pass back through the
objective.
The microscope and the optics of the scanner module focus the light emitted from the focal point to a
second point, called the confocal point. The pinhole aperture, located at the confocal point, allows
light from the focal point to pass through the detector. Light emitted from outside the focal point is
rejected by the aperture.
The confocal principle is illustrated schematically for the epi-illumination imaging mode.
As in conventional epifluorescent microscopes, one lens is used as both condenser and objective.
The advantage is eliminating the need for exact matching and co-orientation of two lenses. A
collimated, polarized laser beam from an aperture is reflected by a beam splitter (dichroic mirror) into
the rear of the objective lens and is focused on the specimen. The reflected light returning from the
specimen passes back through the same lens. The light beam is focused into a small pinhole (i.e., the
confocal aperture) to eliminate all the out-of-focus light, i.e., all light coming from regions of the
specimen above or below the plane of focus. The achieved optical section thickness depends on
several parameters such as the variable pinhole diameter and the wavelength. The in-focus
information of each specimen point is recorded by a light-sensitive detector (e.g., a photodiode)
positioned behind the confocal aperture. The analog output signal is digitized and fed into a computer.
The detector is a point detector and only receives light from one point in the specimen. Thus, the
microscope sees only one point of the specimen at a time as opposed to the conventional microscope
where an extended field of the specimen is visible at one moment. Therefore, to obtain an image it is
necessary either to move the illuminated point or to move the specimen. These two possibilities have
given rise to two different types of confocal microscopes:
Microscopes with movable objective stage (stage scanning): The objective stage with the specimen is
moved forward after every finished recording, while the optical system remains stationary with this
type of scanning.
Microscopes with beam or mirror technology: The illuminated point is scanned over the fixed
specimen using small, fast, galvanometer-driven mirrors as used by LEICA.
The LEICA TCS SP2 system allows you to image a single focal plane as well as a series of planes—
horizontal or vertical. A single vertical section or xz-scan allows for a side view of the specimen.
If a sequence of optical sections of the specimen is combined to form an image stack and then
digitally processed, it offers the advantage of using this multidimensional data set to create either a
calculated two-dimensional image (projection) or a reduced scale 3D representation of the specimen
using a suitable computer.
Optical resolution
The term resolution refers to the capability of distinguishing finest details in a structure. In a perfect
microscope, the optical system would be free of any type of aberration. In such a hypothetical
instrument, the resolution would be limited only through diffraction. One could express this as the
smallest distance between two points of a specimen at which they are still visible as two separate
points (Rayleigh criterion). Beyond this limit, the two points merge (i.e., their diffraction discs overlap
completely or partially) and can no longer be recognized as two different points. This distance can be
calculated using the size of the diffraction image of an infinitely small point of the specimen. It
corresponds to the radius of the first minimum in this diffraction image. This, in turn, is related to the
numeric apertures of the objective and the condenser. The numeric aperture is defined by the
diffraction index of the lens and the size of the luminous cone that may enter.
Analogous to the argumentation above, the axial resolution can be defined as the radius of the first
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minimum along the microscope axis of the diffraction image of a point object. According to the theory
for such 3D diffraction images, the optical resolution along the z-axis is smaller than the lateral optical
resolution by a factor of 2. Thus, the optical resolution along the z-axis amounts to approximately one
half of the resolution within the focal plane.
The LEICA TCS SP2 microscope is a no-compromise true point-scanning system with extremely high
sensitivity and theoretical maximum x-, y- and z-resolution.
Scan resolution refers to image clarity as determined by the number of pixels and pixel size. The
larger the number of pixels and the larger the scanning format, the more easily two close objects can
be distinguished. The scan resolution is restricted to the maximum optical resolution power.
Detection
Confocal imaging, or to be more precise, the measurement of the optical properties of tiny sub-
volumes of a specimen, is limited not only by the optical quality of the microscope. Other limitations
are:
- The measurement of continuous specimen only in discrete sub-volumes (because of sampling and
digitalization).
- The accuracy with which the sub-volumes are defined, determined by the scanning mechanism.
- The brightness of the light source in relation to the reflectivity of the specimen.
- The sensitivity and noise produced by the detector.
Another central component of the confocal microscope is the detector. Due to its very high signal-to-
noise ratio, LEICA Microsystems Heidelberg uses photomultipliers as detectors.
Image processing
In the first confocal microscopes, the detector was connected to an oscilloscope with long-persistence
phosphor which would display an image as it was being scanned. In the instruments of today, the
signal is digitized and recorded in a computer. This makes it possible to manipulate the image in a
multitude of ways. The following options are available:
- Contrast enhancement by thresholds, linear contrast stretching and gamma correction (curvature of
the image intensity value versus source intensity graph).
- Superimposition of images in experiments.
- Digital filtering for edge enhancement, smoothing, noise suppression, etc.
- Reconstruction of three-dimensional views from stacks of images of optical sections. This allows, for
instance, an image of an xz plane to be reconstructed from a stack of images of xy planes. Complete
3D models of the specimen can also be rendered and examined from any direction.
- Assembly of digital movies from time-sequences of microscope images.
- Quantification and Measurements.
Although this type of image manipulation does not improve the quality of the collected data, it serves
the purpose of improving the visibility and facilitating the qualitative interpretation of the data.
Light source
Lasers are extremely well suited as light sources for confocal microscopy because they emit a very
bright light and small divergence of the beam. In addition, they are easy to focus and stable in
intensity. The stability is especially important for quantitative measurements.
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Integration
The Leica TCS SP2 was designed as an integrated system. Optical and mechanical elements work
seamlessly with computer hardware and software. The integrated Leica Confocal Software package
supports the complete imaging process, from optical sectioning, through image processing and
analysis (which is the main application), to hardcopy output.

Help via the Internet

First contact your local Leica subsidiary or the local dealer.
You can also find information on Leica Microsystems Heidelberg GmbH and confocal microscopy on
our web site at
http://www.confocal-microscopy.com.
Or send an e-mail to llt.support@leica-microsystems.com.
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Legal Notes

Version 2.3, October 31, 2002. Made in Germany.
© Copyright 2001/2002, Leica Microsystems Heidelberg GmbH. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or by any means, electronic
or mechanical, including photocopying, recording, or storing in a retrieval system, or translating into
any language in any form without the express written permission of Leica Microsystems Heidelberg
GmbH.

DISCLOSURE
This document contains Leica Microsystems Heidelberg GmbH proprietary data and is provided solely
to its customers for their express benefit of safe, efficient operation and maintenance of the product
described herein. Use or disclosure of Leica Microsystems Heidelberg GmbH proprietary data for the
purpose of manufacture or reproduction of the item described herein, or any similar item, is prohibited,
and delivery of this document shall not constitute any license or implied authorization to do so.

REVISIONS AND CHANGES
Leica Microsystems Heidelberg GmbH reserves the right to revise this document and/or improve
products described herein at any time without notice or obligation. Information and specifications in
this manual are subject to change without notice.

WARRANTY
Leica Microsystems Heidelberg GmbH provides this publication "as is" without warranty of any kind,
either expressed or implied, including but not limited to the implied warranties of merchantability or
fitness for a particular purpose. All reasonable precautions have been taken in the preparation of this
document, including both technical and non-technical proofing. Leica Microsystems Heidelberg GmbH
assumes no responsibility for any errors or omissions. Leica Microsystems Heidelberg GmbH shall
not be responsible for any direct, incidental or consequential damages arising from the use of any
material contained in this document.

TRADEMARKS
Throughout this manual, trademarked names may be used. Rather than including a trademark (™)
symbol at every occurrence of a trademarked name, we state that we are using the names only in an
editorial fashion, and to the benefit of the trademark owner, with no intention of infringement.

SAFETY

The terms used of the laser safety class refer to the standard EN 60825-1. Within the

scope of the CDRH, the laser class 4 should be replaced by IV in the text, the laser

class 3B by IIIb, the laser class 3A by IIIA, the laser class 2 by II and the laser class 1

by I.

This instrument is designed and manufactured to comply with applicable performance standards for
Class 3B laser products as defined by USHHS, CDRH/FDA, OSHA and EN standards and regulations
known to be effective at the date of manufacture.
Every hazardous situation cannot be anticipated, therefore, the user must exercise care, common
sense, and observe all appropriate safety precautions applicable to Class 3B lasers and high-voltage
electrical equipment during installation, operation and maintenance.
Deviating from published operating or maintenance procedures is not recommended. Operation and
maintenance procedure changes are performed entirely at the user's risk.

SOFTWARE LICENSE
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The software described in this document is furnished under a License Agreement which is included
with the product. This agreement specifies the permitted and prohibited uses of the product.



Leica Microsystems Heidelberg GmbH
Safety Notes

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 13 of 307

Safety Notes

This section introduces the standard safety precautions, warnings and safety cautions.

General Safety Directions
Your safety is extremely important. Read and observe all warnings and safety cautions listed in this
manual and attached to the instrument before operating any Leica instruments. Serious injuries can
occur, and equipment and data can be damaged if the safety warnings and safety cautions are not
followed.

Risk of Operation
The risk for the performance of the device is assumed by the operator or the owner of the product.
The owner or operator will be fully liable for all consequences which may result, if the device is
opened by persons other than authorized Leica service staff, if it is not serviced or maintained
properly or if it is used for purposes other than those described in the accompanying documentation
and the online help facility. Leica Microsystems Heidelberg GmbH will not be liable for damages
resulting from non-observance of the above information. The above information does not, in any way,
implicitly or explicitly, modify the warranty and liability clauses contained in the general terms and
conditions of Leica Microsystems Heidelberg GmbH.

Warnings, Safety Cautions, and Notes
The warnings, safety cautions, and notes in this manual use the following format.

Such a warning alerts you of an operating procedure, practice, condition, or statement

that must be strictly observed to avoid death or serious injury to the persons working on

the equipment.

Such a safety caution alerts you to an operating procedure, practice, condition, or

statement that must be strictly observed to prevent equipment damage or destruction,

or corruption or loss of data.

Notes are statements that either provide extra information about a topic or contain

special instructions for handling a particular condition or set of circumstances.

Special Conditions of the Installation Site
Even though the system was tested and complies with the permissible limits of electromagnetic
radiation (EMC), a residual risk of effecting other devices cannot be ruled out.

This system must not be mounted next to medical life-saving equipment.
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Before moving the confocal system, it should be thoroughly cleaned. The same also

applies to the removal of components. This applies in particular to systems that are

located in biomedical research labs.

This is necessary to remove a possible contamination and, thereby, avoid carry-over of

dangerous substances and pathogens and its accompanying risk of persons. Pay not

only attention to surfaces, but especially to fans and cooling devices since dust can

frequently accumulate at these locations.

The use of the instrument for unintended purposes as well as unauthorized opening of

the instrument can create the risk of electrical voltage as well as laser radiation.

The terms used of the laser safety class refer to the standard EN 60825-1. Within the

scope of the CDRH, the laser class 4 should be replaced by IV in the text, the laser

class 3B by IIIb, the laser class 3A by IIIA, the laser class 2 by II and the laser class 1

by I.

Laser Class
This instrument is designed and manufactured to comply with applicable performance standards for
Class 3B laser devices as defined by USHHS, CDRH/FDA, OSHA and EN 60825-1 standards and
VBG 93 regulation for prevention of accidents known to be effective at the date of manufacture.
Every hazardous situation cannot be anticipated by the manufacturer, therefore, the user must
exercise care and common sense, and observe all appropriate safety precautions applicable to Class
3B lasers and high-voltage electrical equipment during installation, operation and maintenance.
Operation and maintenance procedure changes are performed entirely at the user's risk.
The Leica TCS SP2 used in accordance with the instructions is harmless.

The user is responsible for compliance with current safety regulations. For safety

reasons, only trained Leica service personnel is permitted in the laser area.

Technical Safety Measures
In accordance with the laser safety directives EN 60825 (European standard) and CDRH (US-
American standard) Leica Microsystems Heidelberg GmbH employs various safety measures.
Warning labels have been affixed near all apertures or removable parts where exposure to laser light
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is possible.
Furthermore, several laser interlock-switches were installed.

Observe the specification of the standard EN 60825-1: "Safety of laser products, Part 1. Equipment
classification, requirements and user's guide", which requires that a laser safety officer or a laser
protection advisor must be named for installations using instruments of class 3B. It is the user's
responsibility to review and designate appropriate controls for the use of the equipment.

Never look directly into a laser beam or a reflection of the laser beam. Exposure to the

laser beam can cause irreversible damage to your vision. A reflected laser beam is just

as intensive as a direct beam.

The user is responsible for the safe operation and maintenance of this instrument at all

times. Class 3B laser product and electrical safety compliance is assured only when all

safety devices, interlocks, and laser containment systems are in serviceable condition

and operating. Disabled or damaged safety devices or systems will expose personnel to

Class 3B laser radiation of sufficient power to cause severe eye injury, burns or

property damage.

Every interference with or any deactivation of one of the safety systems and/or one of

the safety locks results in the loss of warranty claims.

Power cord set
The power cord set supplied with your instrument meets the requirements of the country where you
purchased the instrument. If you use the instrument in another country, you must use a power cord
set that meets the requirements of that country.

The following wiring is specified by the manufacturer:
The power cord of the microscope must be plugged into the supplied connector strip. If a high-
pressure mercury lamp is used, it should be connected to a separate power supply. This prevents it
from continuously being switched on and off together with the control computer and the scan
electronics and, therefore, increases the service life of the source of illumination.

This equipment is designed for connection to a grounded (earthed) outlet. The

grounding type plug is an important safety feature. To reduce the risk of electrical shock

or damage to the instrument, do not disable this feature.

To reduce the risk of fire hazard and electrical shock, do not expose the unit to rain or

humidity. Do not open the cabinet. All maintenance is to be performed by an authorized
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Leica technician.

Do not allow any liquid to enter the instrument cabinet, or come into contact with any

electrical components. The instrument must be thoroughly dry before you connect

power, or turn the instrument on.

General Safety Notes
In accordance with general safety regulations as well as laser device safety regulations comply with
the following stipulations:

Observe the operating instructions!
Use the product only according to the information given in this documentation and in the online help
facility of the Leica Confocal Software. Carefully read the complete operating instructions before you
start the system. As a preparation for your single work steps always read the relevant description of
function in the online help and in particular observe the safety regulations indicated for handling the
system. You can get an overview of the single functions in the contents file of the online help.

Use the product only for purposes described in this documentation and in the online help facility of the
Leica Confocal Software.
The system is designed for making confocal laser scan images and quantitative measurements in the
discipline of material science. Using the Leica TCS SP2 for any other purposes or applications is
inexpert and inadmissible handling. The user assumes the entire risk for all experiments with this
system and for the consequences resulting from such experiments. This is particularly true if the
device has been opened or modified by the user.

Observe the maintenance instructions.
Please read the chapter 'Maintenance and Cleaning' in this manual.

Do not perform any adjustments on the equipment that are not described in this manual or in any
subsequent addendum to the manual.
Only service technicians authorized by Leica Microsystems Heidelberg GmbH are allowed to carry out
repair and service work.

Electrically connect only those electrical devices to the product that are mentioned in this
accompanying documentation. Never electrically connect devices that are not mentioned in this
documentation.
Before connecting any such devices to the product, consult the local Leica Service Agency or Leica
Microsystems Heidelberg GmbH directly.

Do not use an S70 microscope condenser.
In the worst-case scenario, the large working distance and the low numeric aperture of the S70
condenser could result in impermissible high laser radiation loads if the safety notes are not observed
(see "Special Safety Notes for Users"). Therefore, only S1 and S23 Leica condensers should be used.

Special Safety Remarks for Users
Leica Microsystems Heidelberg GmbH has done everything possible to maximize user safety and
minimize health risks applying special safety measures in accordance with several safety directives.
The user must operate the TCS SP2 in accordance with the instructions in order to ensure safety.
Several important points are listed below:

Do not change objectives during scanning operations
How to change objectives:
Ensure that the Scan mode is switched off. Be sure that there is no laser light in the focal plane.
Turn the objective nosepiece so that the objective lens to be exchanged appears outside of the optical
axis and points outwards. Do not apply any force to the objective nosepiece, as this may permanently
reduce the resolution of the turret scan.
Screw in the new objective lens and turn the objective nosepiece back into the optical axis.
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All unused positions on the objective nosepiece must be capped!

Do not insert objects into the beam path during scanning operations!

Insert the specimen correctly into the specimen holder!

Do not change specimen during scanning operations!
How to exchange a specimen:
Ensure that the Scan mode is switched off. Be sure that there is no laser light in the focal plane. Close
the safety shutter at the tube.
Exchange the specimen.

Laser Safety
The word 'LASER' is an acronym for Light Amplification by Stimulated Emission of Radiation. The first
laser was demonstrated in 1960 and used a ruby as the lasing medium. Lasers have been used in
many applications from surgery to bar code readers at supermarket checkouts, laser pointers, laser
printers to CD players.
Lasers can produce a very intense and very narrow (collimated) beam of electromagnetic radiation in
the wave range of 150 nm to 1 mm. This radiation is generally in the form of intense visible light.
Because laser light is not an ionizing type of radiation, interaction with matter is generally at the
surface. The eye and the skin are very sensitive organs for laser radiation exposure. The resultant
effects vary depending on the type of laser (wavelength of the radiation) and beam energy output.
Laser energy of the proper wavelength and power may be focused by the lens of the eye onto the
retina causing irreversible damage. If laser radiation energy is high enough, skin burns may also
result if extremities or other body parts are placed in the laser beam. The following table summarizes
the various regions of the electromagnetic spectrum produced by lasers and the organs that are at
risk if exposure occurs.

Spectrum Region Wavelength Range Organ Effected
UV-C 100 nm to 280 nm All absorbed in cornea and conjunctiva

Ultraviolet UV-B 280 nm to 320 nm Almost all absorbed in cornea and conjunctiva
UV-A 320 nm to 380 nm Lens (lens cloudiness)

Visible 380 nm to 760 nm Retina
IR-A 760 nm to 1400 nm Retina, lens, skin

Infrared IR-B 1400 nm to 3000 nm Cornea and skin
IR-C 3000 nm to 106 nm Cornea and skin

Lasers are frequently identified based on the type of laser medium. The Laser Hazard Classification is
determined by the wavelength(s), maximum duration of exposure, and the average power output of
the laser.

Laser hazard classification

Never look directly into a laser beam regardless of the type of laser and the power

used.

Class 1
Harmless laser (usually embedded).
Class 2
Low power visible laser which, due to the reflex response, does not normally present a hazard unless
viewed directly.
Class 3A
Lasers that are generally harmless if inadvertently viewed directly, including intrabeam viewing;
however, these lasers may represent a danger if collector optics are used.
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Class 3B
Lasers that can produce an eye injury if viewed directly, including intrabeam viewing of specular
reflections.
Class 4
Laser that can produce an eye injury or skin burns from direct, specular or diffuse reflections. Danger
of burns may develop.

Embedded systems
Class 2, 3A, 3B or 4 lasers or laser systems contained in a protective housing and operated in a lower
classification mode may be classified at a lower classification. Specific control measures may be
required to maintain the lower classification.

Laser Hazards
The danger from lasers can be divided into the following major categories:
1. Eye injuries such as burns of the retina or cornea.

RETINAL INJURY IS IRREVERSIBLE

2. Skin hazards such as burns.
3 Electrical hazards from high voltage equipment.
4. Fire and explosion hazard.

Specification of laser radiation in use

Laser
type

Wavelength
[nm]

Maximum luminous power at
laser output [mW]

Maximum luminous power in
focal plane [mW]

Pulse duration

Ar-UV 351, 364 < 50 < 2.5 continuous wave
(non-pulsed)

Diode 405 < 25 < 4 continuous wave
(non-pulsed)

Diode 430 < 10 < 4 continuous wave
(non-pulsed)

HeCd 442 < 30 < 3 continuous wave
(non-pulsed)

ArKr 488, 568, 647 < 125 < 10 continuous wave
(non-pulsed)

Ar 458, 476, 488,
514

< 200 < 50 continuous wave
(non-pulsed)

HeNe 543 < 1.5 < 0.5 continuous wave
(non-pulsed)

Kr 568 < 25 < 5 continuous wave
(non-pulsed)

HeNe 594 < 3 < 1 continuous wave
(non-pulsed)

HeNe 633 < 15 < 4 continuous wave
(non-pulsed)

The following laser safety labels are used

1. at all openings where light can be emitted

For laser emission in the visible spectral region
(Ar/ ArKr/ Kr/ HeNe/ HeCd/ diode)

For laser emission in the ultraviolet spectral region
(Ar-UV)

LASER RADIATION

IS EMITTED

FROM THIS APERTURE

AVOID EXPOSURE

VISIBLE AND INVISIBLE

LASER RADIATION

IS EMITTED

FROM THIS APERTURE

AVOID EXPOSURE
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LASER RADIATION

IS EMITTED

FROM THIS APERTURE

AVOID EXPOSURE

VISIBLE AND INVISIBLE
LASER RADIATION

IS EMITTED

FROM THIS APERTURE

AVOID EXPOSURE

2. on all housing parts that can be opened with tools and emit laser radiation

For laser emission in the visible spectral region
(Ar/ ArKr/ Kr/ HeNe/ HeCd/ diode)

For laser emission in the ultraviolet spectral region
(Ar-UV)

LASER RADIATION WHEN OPEN
AVOID EXPOSURE TO BEAM

DANGER
VISIBLE AND INVISIBLE

LASER RADIATION WHEN OPEN
AVOID EXPOSURE TO BEAM

DANGER

3. on the cover of the supply unit

For laser emission in the visible spectral region
(Ar/ ArKr/ Kr/ HeNe/ HeCd/ diode)

For laser emission in the ultraviolet spectral region
(Ar-UV)

AVOID DIRECT EXPOSURE TO BEAM
< 15 mW HeNe 633 nm

CLASS IIIb LASER PRODUCT

LASER RADIATION

AVOID DIRECT EXPOSURE TO BEAM
< 400 mW ArKr 457-675 nm

CLASS IIIb LASER PRODUCT

LASER RADIATION

AVOID DIRECT EXPOSURE TO BEAM
< 400 mW ARGON 457-514 nm
CLASS IIIb LASER PRODUCT

LASER RADIATION

AVOID DIRECT EXPOSURE TO BEAM
< 400 mW KRYPTON 568 nm
CLASS IIIb LASER PRODUCT

LASER RADIATION
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AVOID DIRECT EXPOSURE TO BEAM
< 500 mW Ar-Kr-HeNe 457-633 nm

CLASS IIIb LASER PRODUCT

LASER RADIATION

AVOID DIRECT EXPOSURE TO BEAM
< 500 mW Ar-Kr-HeNe-HeCd 442-633 nm

CLASS IIIb LASER PRODUCT

LASER RADIATION

At an external 405 nm diode laser (optional / UV substitute):

LASER RADIATION

AVOID EXPOSURE TO BEAM
CLASS IIIb CDRH LASER PRODUCT
CLASS 3B PER EN60825-1 1994+A11

2303 LINDBERGH ST.
AUBURN, CA 95602-9295
USA (530) 888 - 5062

WAVELENGTH / POWER

SERIAL NUMBER

PART NUMBER / REVISION

405 nm 25 mW

THIS PRODUCT DOES NOT CONFORM TO
THE APPLICAPLE STANDARDS OF
21CFR1040

PLEASE READ INSTRUCTIONS
BEFORE USING

Installation on the laser itself:

While the radiation of the 405-nm laser is still part of the spectral range, it is treated as

a UV laser. Confocal systems operated with a UV laser or a 405-nm laser feature a

special microscope optics. For this reason, retrofitting a confocal system designed for

the visible spectral range with a UV laser or a 405-nm laser cannot be done easily.
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On a UV laser (optional):

VISIBLE AND INVISIBLE
LASER RADIATION IS EMITTED

FROM THIS APERTURE
AVOID EXPOSURE

INVISIBLE AND VISIBLE

LASER RADIATION. AVOID

EYE OR SHIN EXPOSURE

TO DIRECT OR SCATTERED

RADIATION. CLASS 4

LASER PRODUCT PER

EN60825-1 (1994)

ARGON ION LASER
2 WATTS MAX CW

THIS PRODUCT COMPLIES WITH DHHS RADIATION PERFORMANCE STANDARDS
21 CFR SUBCHAPTER J EXCEPT WITH RESPECT TO THOSE CHARACTERISTICS
AUTHORIZED BY VARIANCE NUMBER 89V-0201 EFFECTIVE JULY 1998.
MODIFICATION OR USE AS A COMPONENT OF ANOTHER PRODUCT MAY
RESULT IN IT NOT COMPLYING WITH THE ABOVE REGULATIONS.

5100 PATRICK HENRY DRIVE SANTACLARA CA 95054 MADE IN U.S.A.

Installation on the laser itself:

Confocal systems operated with a UV laser feature a special microscope optics. For

this reason, retrofitting a confocal system designed for the visible spectral range with a

UV laser cannot be done easily.
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Position of laser safety labels

1. Inverted microscope
Location 1 and Location 2 mark
the mounting locations of the
laser safety labels on the
inverse microscope stand.

Location 1 for systems WITHOUT UV laser

LASER RADIATION
IS EMITTED

FROM THIS APERTURE

AVOID EXPOSURE

for systems WITH UV laser

VISIBLE AND INVISIBLE

LASER RADIATION

IS EMITTED
FROM THIS APERTURE

AVOID EXPOSURE

Location 2 for systems WITHOUT UV laser

LASER RADIATION

IS EMITTED
FROM THIS APERTURE

AVOID EXPOSURE

for systems WITH UV laser

VISIBLE AND INVISIBLE
LASER RADIATION

IS EMITTED
FROM THIS APERTURE

AVOID EXPOSURE
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2. Upright microscope
Location 1 and Location 2 mark
the mounting locations of the
laser safety labels on the
upright microscope stand.

Location 1 for systems WITHOUT UV laser

LASER RADIATION

IS EMITTED
FROM THIS APERTURE

AVOID EXPOSURE

for systems WITH UV laser

VISIBLE AND INVISIBLE
LASER RADIATION

IS EMITTED
FROM THIS APERTURE

AVOID EXPOSURE

Location 2 for systems WITHOUT UV laser

LASER RADIATION
IS EMITTED

FROM THIS APERTURE

AVOID EXPOSURE

for systems WITH UV laser

VISIBLE AND INVISIBLE
LASER RADIATION

IS EMITTED
FROM THIS APERTURE

AVOID EXPOSURE
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3. Scan head
Location 1 and Location 2
mark the mounting
locations of the laser safety
labels on the scan head.

Location 1 and 2 for systems WITHOUT UV laser

LASER RADIATION WHEN OPEN
AVOID EXPOSURE TO BEAM

DANGER

Location 1 and 2 for systems WITH UV laser

VISIBLE AND INVISIBLE
LASER RADIATION WHEN OPEN
AVOID EXPOSURE TO BEAM

DANGER

4. Supply unit (cover)

Location 1 for systems with HeNe laser

LASER RADIATIONWHEN OPEN
AVOID EXPOSURE TO BEAM

DANGER

for systems with ArKr laser

AVOID DIRECT EXPOSURE TO BEAM
< 15 mW HeNe 633 nm

CLASS IIIb LASER PRODUCT

LASER RADIATION
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for systems with Ar laser

AVOID DIRECT EXPOSURE TO BEAM
< 400 mW ArKr 457-675 nm

CLASS IIIb LASER PRODUCT

LASER RADIATION

for systems with Kr laser

AVOID DIRECT EXPOSURE TO BEAM
< 400 mW ARGON 457-514 nm
CLASS IIIb LASER PRODUCT

LASER RADIATION

For systems with HeNe laser, Ar laser
and Kr laser

AVOID DIRECT EXPOSURE TO BEAM
< 400 mW KRYPTON 568 nm
CLASS IIIb LASER PRODUCT

LASER RADIATION

For systems with HeNe laser, HeCd
laser, Ar laser and Kr laser

AVOID DIRECT EXPOSURE TO BEAM
< 500 mW Ar-Kr-HeNe 457-633 nm

CLASS IIIb LASER PRODUCT

LASER RADIATION

AVOID DIRECT EXPOSURE TO BEAM
< 500 mW Ar-Kr-HeNe-HeCd 442-633 nm

CLASS IIIb LASER PRODUCT

LASER RADIATION
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System overview

Upright microscope

SP2_FDA.fh10

ArKr Laser
476...647 nm,
125 mW

Kr Laser
568 nm, 25 mW

HeNe Laser
543 nm, 1.5 mW

HeNe Laser
633 nm, 15 mW

Ar Laser
488/514 nm, 150 mW

HeCd Laser
442 nm, 30 mW

Diode Laser
430 nm, 10 mW

HeNe Laser
594 nm, 3 mW

MP Laser < 2000 mW
Ti:Sapphire

IR
port

8

7

5

7

7

7

7

7

7

7

12

12

12

option

option

option

option

option

10
11

13

1

2

3

4

9
7

option

UV Laser, 50 mW
Ar-Ion

7

9

6
VIS Laser, 25 mW
405 nm , Diode

7
6

1: Upright microscope stand, 2: Objectives, 3: Microscope specimen stage, 4: Condenser, 5:
Transmitted light detector (non-descanned), 6: UV modulator (for UV systems only), 7: Laser safety
shutter, 9: embedded optical fibers (all optical fibers leading to the scan head), 10: Beam collection,
VIS modulator, 11: Scan head, 12: Supply unit, 13: Eyepieces
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Inverted microscope

FDAinverted.FH5

1

5

3
4

2

6

1: Inverse microscope stand, 2: Objectives, 3: Microscope specimen stage, 4: Condenser, 5:
Aluminum disc as beam collector, protective sleeve between condenser and transmitted light
detector, 6: Connection for scan head (scan head identical to that used with upright microscope
stand)
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Starting the Operating System

You do not have to start the operating system—it starts automatically when you turn on your PC. You
will first see a splash screen.
Next you have to log on to your computer. As you can see from the instructions in the box, pressing
the Ctrl, Alt and Delete keys at the same time will log you on.
After pressing the Ctrl, Alt, and Delete keys, the Logon information dialog box appears.
Typing your password identifies you as a valid user for this computer.
The default user name for the Leica TCS SP2 system is "TCS_User."
A standard password was not set. It is recommended setting up a separate user ID for each user
(system administrator). This will create individual directories that can be viewed only by the respective
user. Since the LCS software is based on the user administration of the operating system, separate
files are created for managing user-specific profiles of the LCS software. For information about setting
up users, please refer to the chapter "Setting Up Users" in this manual.
After logging on with your user ID, you may change your password by pressing the keys Ctrl, Alt, and
Delete at the same time.
Then click on Change Password. The Change Password dialog box displays.
Type your current password in the Old Password field (passwords are case sensitive, so be sure you
use the right case). Then press the Tab key. Pressing the Tab key moves the cursor to the next field.
Type your new password, then press the Tab key again. Confirm your new password by re-entering it.
This will eliminate any typing errors. This is especially important since the characters you type appear
as asterisks on the screen.

If you miss-type the confirmation password, you will see a warning dialog. Try again!

Then click the OK button. Your new password will be in effect the next time you log on.

Caution: Do not forget your password if you set one! Without the right password you

cannot access your computer anymore.

The Welcome dialog box is now displayed. Take a moment to read the "Did you know..." tip and then
click the Close button to begin using the operating system.
Using a Mouse
You need a mouse to work most efficiently with the operating system. Here are the mouse actions you
need to know:
Point means to move the mouse pointer onto the specified item by moving the mouse. The tip of the
mouse pointer must touch the item.
Click on an item means to move the pointer onto the specified item and press and release the
mouse button once. Unless specified otherwise (i.e. right-click), use the left mouse button. Clicking
usually selects an item.
Double-click on an item means to move the pointer to the specified item and press and release the
left mouse button twice quickly. Double-clicking usually activates an item.
Drag means to move the mouse pointer onto the item, hold down the mouse button, and move the
mouse while holding down the button. Unless specified otherwise (i.e. right-drag), use the left mouse
button.
The user interface of the operating system
The basic user interface of the operating system is referred to as Desktop. It provides a background
for the items it contains.
The initial icons on the Desktop allow the user to view and interact with the system in a logical way.
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The background on which all the pictures and boxes rest is the desktop.
The taskbar shows the windows and programs that are open. You can switch between open windows
and programs by clicking the name on the taskbar.
The Start button opens a menu system from which you can start programs. Click on the Start button,
then click on your selection from each menu that appears. Click on the desired option.
Some icons appear on your desktop. You can activate one by double-clicking on it.
We now take a brief tour of the items you see on the screen.
A standard desktop item is the My Computer icon. Double-clicking this icon opens the ‘My
Computer’ window.
The 'My Computer' window gives you easy access to the major components like hard and floppy disk
drives of your computer system or workstation. For example, by double-clicking the Hard disk [C:]
icon you can see the contents of your PC's hard drive. This allows the user to view local resources as
objects. In addition, the 'My Computer' window gives you access to the control panel (Control Panel
symbol) and the printer of the control computer, if a printer is installed. If you installed one of the
additional applications such as 'Dial-Up Networking' at installation time, it will also appear in the 'My
Computer' window.
You can use the Control Panel icon in the 'My Computer' window to view and change any system
component. The Control Panel contains numerous icons that allow you to control your system. The
particular icons that you see on your PC may be slightly different from those illustrated, due to that
fact that you may have different hardware installed, and may or may not be connected to a network or
modem. Yet another reason could be that you have installed other operating system options.
Double-clicking the Network Neighborhood icon displays the Network Neighborhood dialog box
which gives you information about who and what is connected to your workstation. It provides an easy
mechanism for browsing any network systems and resources that you may be able to connect to in a
way that is independent of the actual type of network vendor. Traditionally, if a system needed to be
simultaneously connected to different types of network, the way in which each could be connected
and viewed would be vendor-specific. The operating system is capable of displaying a common view
of your entire network even though it may actually comprise resources from Windows NT, Novell
NetWare, Banyan Vines, or others!
The Inbox icon is used if Microsoft Exchange is active on your system. The operating system has
built-in electronic mail services based on Microsoft Mail (MS Mail) and Microsoft Exchange. If there is
already an MS Mail post office on the same network that the system is connected to, the operating
system mail client can connect directly to it. The Inbox lets you access your messages.
The Recycle Bin icon represents the holding place for deleted items. As long as files are in the
Recycle Bin they can easily be recovered if they have been accidentally deleted. The operating
system will preserve files until the system runs out of free disk space. When this happens, the
operating system will prune the contents of the Recycle Bin on a first-in first-out basis.

Files that are overwritten due to an application using a duplicate filename will not be

saved to the Recycle Bin.

Double-clicking the Bin displays its contents. The empty window confirms that there are no items in
the Recycle Bin.
The Start menu
A single click with the left mouse button on the Start button opens the start menu and presents the
seven major option categories for starting work on the system.
A single click of the right mouse button opens a small but powerful control menu containing the
options Open, Explore and Find.
Their functionality is described below.
Starting a Program
The Start menu contains the various categories where your applications and work are stored. You can
move further into the various subcategories by positioning the mouse over the category that you are
interested in to automatically open the next subcategory. You do not have to click the mouse!
The Programs command displays the Programs menu. This menu lists all of the applications installed
and available to you. Some options are marked by an arrow. This arrow indicates that a submenu
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follows. Drag the mouse cursor over the Accessories command to see its submenu. The Accessories
submenu lists the set of program built into the operating system.
TIP: If you drag an object either from the Desktop or Windows Explorer and drop it directly onto the
Start button, a link to that object will automatically appear in the Start menu. This object immediately
appears in the start menu and can now be called up via this menu.
There are many ways to start a program. The following method is the simplest one:
1. Click on the Start button.
2. Click on Programs.
3. Click on the group that contains the program you want to start (for instance, LCS).
4. Click on the program you want to start (for instance, Leica LCS).
Another way to start a program is to open a document that you created in that program. The program
automatically opens when the document opens. Double-click on a document file in My Computer or
Windows Explorer to open it. Or click on the Start button and select a recently used document from
the Documents menu.
You can also start a program by double-clicking on its shortcut icon on the desktop. Shortcut icons are
links to other files. When you use a shortcut, Windows simply follows the link back to the original file.
Whenever you use a document or program frequently, you might consider creating a shortcut for it on
the desktop. To do so, just use the right mouse button to drag an object out of Windows Explorer or
My Computer. After releasing the mouse button, a menu appears. Select the option Create
Shortcut(s) Here. Some programs automatically create a shortcut during their installation procedure.

The operating system does not actively track a link between an original and a shortcut.

For instance, if you create a shortcut of a program, and subsequently move (rather than

copy) the original to a different folder, then the shortcut may no longer function.

The Startup folder has a special function: All programs located in this folder are automatically started
whenever the operating system is started.
The Documents menu shows the names of the 15 files you created most recently. You can open any
of these files and its related application at the same time by clicking the file's name in this menu.

Document files that are opened within an application (typically by selecting the

File/Open command within the application) will not be displayed here. Only documents

opened directly from the Desktop will be displayed here.

The Settings menu offers three commands for changing your system's settings. You can directly
access the Control Panel and Printing folders. Also accessible is the Task Properties window.
Being able to access the core system configuration utilities in this way is particularly useful when an
application is already in the foreground and you want to make a quick change.
The Find command features an easy way to locate all system resources. Within the Find category you
can perform searches for three distinct types of search as described below:
The Taskbar
The taskbar—positioned at the bottom of the screen—provides a constant view of which applications
are running on the system and an easy way of switching between them. As you add to the number of
concurrently running applications, the taskbar automatically resizes its iconized view of the
applications to ensure that they can always be seen. To switch from one running program to another,
simply click on the second program as displayed in the taskbar.
The taskbar also provides constant additional information such as the system time and volume control
if a sound card is installed. All of these functions can be adjusted by the user.
Setting the Time and Date
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The current Date, Time and Time Zone information can be set from the Date/Time icon within the
Control Panel. This setting is important since the operating system stamps the date and time on all of
your files as you create and modify them. The two options can be selected by clicking on the
appropriate tab.
To change the Date and Time
Click on the appropriate date or use the controls to change the month or year. The time can also be
changed by first selecting the digital display and then using the up and down arrows.
To change the Time Zone
Select the appropriate Time Zone from the drop down list at the top of the screen. Notice that the
option to automatically adjust the clock for daylight savings time is selected. On some systems you
can also drag the highlighted area on the world map and drop it on the correct location.
Changing the date and time information within operating system will update the battery backup CMOS
clock in your system.

Depending on the shell configuration, systems connected to a network may get a time

and date update from a network server every time they log on. If the server's time is

incorrect, your workstation's time will be wrong, too. Please inform your network

administrator.

Getting Help
The operating system includes a powerful help system. In addition to Help menus in every window,
there is a standalone Help feature available from the Start menu. To access it, click your mouse on
the Start button, and click on Help.
There are three tabs in this box: Contents, Index and Find. The Contents tab appears on top. To
move to a tab, click on it.
Contents
The Contents tab displays individual Help topics. The topics are organized into categories and are
represented by small book icons. Double-click on any book to open it. Sub-books and documents
appear. Double-click on sub-books and documents to open them.
Index
The Index tab displays an index of all available topics. Type the word you want to look up. The Index
list scrolls to that part of the alphabetical listing. When you see the topic on the list that you want to
read, double-click on it.
Find
Rather than searching for information by category, the Find tab offers a full text search. Enter the
word(s) or phrase to be searched for under Help in the text entry box. The text entry box is linked to a
list of words in your Help files, and any words or phrases that match will be displayed, and any words
or phrases that match will be displayed. You can specify more than one word by separating words
with a space. If you wish to change a search option, select Options. The first time you click on this tab,
Windows tells you it needs to create a list. Click Next and then Finish to allow this. The main Find tab
appears next. Type the word(s) you want to find in the top text box. Then click a word in the middle
box to narrow the search. Finally, review the list of help topics at the bottom, and double-click the one
you want to read.
When you are done reading about a document, click Help Topics to return to the main Help screen, or
click Back to return to the previous Help topic. Click on the window's Close button to exit Help.
Exiting the operating system (Shutdown)
Always use the Shut Down command before you turn off your PC. The Shut Down option allows the
user to close the operating system and ensure all running processes can halt cleanly and are given
the chance to flush any data out to the disk that may be in cache memory. Several options are
available when shutting the system down.
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Powering down your computer without prior shutting it down may result in severe data

loss.

Setting Up Users

1. Logging on as Administrator
To log on as administrator use the ID: "Administrator" and the password: "Admin"
2. Open the User Manager
Select Start→→→→Programs→→→→Administrative Tools→→→→User Manager
3. Defining a new user
Enter the following information in the dialog window being displayed:
1. User name
2. Password (must be re-entered in the next line for confirmation purposes)
From the check boxes displayed, select the following two:
a.) "User must change password at next logon" (this allows the new user to define his or her own
password at logon)
b.) "Password never expires" (this allows a defined password to be valid either until it is changed in
the User Manager or the user is deleted)
Select the "Profiles" option in the bottom section of the dialog. In the "Local path" field enter the
following path for storing user-specific files:
d:\users\username ("username" is an open parameter which must be replaced by the currently
defined user name).

Factory-installed hard disks are set up with two partitions (C:\ and D:\). The user

directory should be set up on partition D:\.
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Starting the Confocal System

1. Check whether the hardware dongle is plugged into the parallel port of the computer.
The LCS software can NOT be started without the provided dongle.

2. Switch on the microscope(s) and the light sources.
All manual Leica microscope stands (DM-LM, DM-IRB, DM-R, DM-LFSE) can be switched on and off
using the switch located at the side of the stand.
All automatic Leica microscope stands (DM- LFSA, DM-RXA, DM-RXA2, DM-RE, DM-IRBE) can be
switched on and off using the switch located at the side of the stand.
The Leica microscope stands DM-LFSA, DM-IRE2 and DM-RXA2 can be switched on and off using
the separate electronics unit (LEICA CTR MIC Electronics box).

All fluorescent lamps are equipped with individual power supplies. For this reason, they

can only be switched on and off at the power supply.

3. Activate the switches on the control panel for the workstation (PC), confocal scanner
(Scanner) and lasers (Lasers).

4. Log on to the computer.
Use your personal user ID if one has been set up. This ensures that the user-specific settings are
saved and maintained for this user only. If the system administrator has not yet assigned a personal
user ID, log on as "TCS_User". A password is not required.

5. Start the LCS program.
To do so, click on the program icon on the desktop of the computer.
L C
S

6. Next, select a software profile.
A separate profile can be created for each user containing the structure of the graphic user interface
as well as the definition of user-specific settings of the confocal system.
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Do not perform the next step until the initialization of the hardware components is

complete.

7. Affix a specimen and adjust the specimen using the conventional microscopy mode.
First, focus on a position of your specimen to be observed. Next, set the Koehler illumination (see the
chapter on "Koehler Illumination" page 41).

a.) Adjusting to conventional observation for upright microscopes of series DM-Rxxx, DM-LFxx

DM_Rxx microscope series: DM-LFSx microscope series:
Set the switch rod to "VIS" and turn the fluorescence filter wheel to the corresponding filter cube
Pos.: 1 DAPI (optional), Pos2: TRITC, Pos3: FITC, Pos4: open position (scan)

b.) Adjusting to conventional observation for inverted microscopes of series DM-IRxx

DM_IRxx microscopes:
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Pull out the switch rod on the left side completely (removed) and turn the fluorescence filter wheel to
the corresponding filter cube
Pos.: 1 DAPI (optional), Pos2: TRITC, Pos3: FITC, Pos4: open position (scan) Push in the switch rod
on the right side completely
In the case of a UV system: Turn the objective tube lens to the "Scan" position.

DM_IRxx microscopes:
Turn tube lens wheel on the right side to "Scan."

8. Changing to confocal operation.

a.) Switching to confocal observation for upright microscopes of the DM-Rxxx, DM-LFxx series

DM_Rxx microscope series: DM-LFSx microscope series:
Set the witch rod and fluorescence filter wheel to "Scan"



Leica Microsystems Heidelberg GmbH
Starting

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 36 of 307

9. Selecting a specific set of acquisition parameters (application).

Press the "Beam" button in the "Acquisition" section

Select a method in the open "Beam Path Setting" dialog window (top right window)

A method is a set of hardware settings (IPS: Instrument Parameter Setting) specifically

identifying a certain acquisition technique and a special type of sample preparation. For

example, the FITC/TRITC designation refers to the settings for a two-channel recording

(simultaneous) for the two fluorescent dyes FITC and TRITC). It is always possible to

define and store your own methods in addition to the factory-set methods. For details,

refer to the chapter on "Software User Configurations".

10. Selecting the microscope objective.

Press the "Obj." button in the "Acquisition" section

Select the objective lens to be used in the opened dialog window.
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With automatic microscope stands, the selected microscope objective is automatically

moved into the beam path.

Other stands require a manual operation.

11. Selecting the scan mode.

Press the "Mode" button to select the scan mode.

The scan mode is used to select the type of data stack to be recorded. The following

options are available:

a.) spatial scan mode (xyz, xzy)

b.) time scan mode (xt, xyt, xzt, xyzt)

c.) spectral scan mode (xyλ, xzλ)
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12. Selecting the scan format

Press the "Format" button to select the scan format.

The scan format determines the number of grid points used by the scanner to scan the

scan area.

13. Optimizing the acquisition parameters in continuous scan.

Press the "Continuous" button to start the continuous scan.

As soon as the continuous scan runs, you can use the control panel and its defined acquisition
parameters to optimize image quality.
The optimization parameters include:
a.) the exact z-position within the specimen
b.) the amplification factor of the selected detector
c.) the diameter of the detection grid mask
d.) the zoom factor
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14. Acquisition of a three-dimensional spatial data set (3D series)

14.1. Define the upper limit of the data set to be acquired.
Use the corresponding knob for adjusting the z-position of the control panel.

The default setting of the z-position is position 7 of the control panel.

Standard layout of the control panel (bottom part of the image)

14.2. Press the "Begin" button to define the starting position of the 3D series.

14.3. Define the lower limit of the data set to be acquired.
Use the corresponding knob for adjusting the z-position of the control panel.

14.4. Press the "End" button to define the end position of the 3D series.

14.5. Stop the continuous scan by pressing the "Cont." button again.

14.6. Press the "Sect." button to define the number of optical sections.

Additional details concerning this function can be found in the online help.

14.7. Press the "Aver." button to define the number of sampling times (frame average).

This method averages the recordings of individual optical sections.

14.8. Next, press the "Series" button to record the 3D series.
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15. Saving image data.

Select File→→→→Save as from the menu to save the data record.

For additional details on saving data records and on saving formats, see the chapter

"Opening and Saving Data Sets“ on page 47.
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Setting the Köhler Illumination

What is the Köhler illumination?

In a microscopic image, only a certain area of a specimen can be displayed (image field). Köhler
illumination allows for illuminating only this particular area. The technical background for the
illumination of the image field is described as follows:
If the illuminated area is smaller than the image field, the luminous cone detected by the objective
lens as well as the numeric aperture becomes smaller. Since the optic resolution is directly dependent
upon the numeric aperture, a lower illumination also reduces the optic resolution—which is not
desired in most cases.
If the illuminated area is larger than the image field, it leads to increased scattered light. This, in turn,
leads to a reduction of the image contrast, possibly resulting in the situation where optically dissolved
structures of the microscopic image can no longer be observed.
Köhler illumination represents a compromise between maximum contrast and maximum resolution.
The most efficient microscope objectives frequently reach their optimum optic performance only with
exactly adjusted Köhler illumination.

Setting the Köhler Illumination

1. Focussing
Focus an area of the object. Neglect the quality of the illumination for the time being.

2. Opening the aperture diaphragm
Fully open the aperture diaphragm. It will be closed at a later point in time until the desired contrast is
adjusted.

A

F

F

A
DM-Rxx DM-Irxx

DM-LSFxx

A: aperture diaphragm, F: field diaphragm
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3. Closing the field diaphragm
The image field darkens in most areas. You will see an unfocused light spot. If the spot disappears
upon closing the field diaphragm, the field diaphragm must be centered. In this case, open the field
diaphragm until you can just see the light spot at the border of the image field.

If no light spot is visible, the condenser could be set to the wrong height. You should,

therefore, adjust the height of the condenser until the field diaphragm is visible.

4. Focussing
Focus the border of the light spot by adjusting the height of the condenser.

5. Centering
Turn the centering screws of the condenser until the light spot is centered in the middle of the image
field. The centering is easier if you slightly open the field diaphragm to enlarge the light spot.

6. Opening the field diaphragm
Open the field diaphragm until the light spot just disappears at the border of the image field.

7. Closing the aperture diaphragm
Close the aperture diaphragm until you have set the desired image contrast (open to approximately
70% of the maximum diameter).

8. If you change the objective
It may become necessary to readjust the Köhler illumination after you have changed the objective.
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Maintenance and Cleaning

Please refer to the corresponding manuals for information on how to maintain the Leica research
microscope.
The instructions and additional information relating to the components of the TCS SP2 confocal
system are summarized below.
Selecting an installation site
Do not expose the system to draft. Ensure that the TCS SP2 is not installed next to elevators, air
conditioners or other inlets and outlets. For this reason, the installation site should be carefully
planned.
Protecting the microscope from dust and grease
When not in use, the system should be covered with a plastic foil (part of delivery) or a piece of cotton
cloth. The system should be operated in a room which is kept as dust and grease-free as possible.
Dust caps should always be placed over the objective nosepiece positions when no objective is in
place.
Exercising care in the use of aggressive chemicals
You must be particularly careful if your work involves the usage of acids, lyes or other aggressive
chemicals. Make sure to keep such substances away from optical or mechanical components.
Cleaning the optical system of the microscope
The optical system of the microscope must be kept clean. Under no circumstances should users
touch the optical components with their fingers or anything which may bear dust or grease.
Remove dust by using an air puffer (not solvent-based) or a fine, dry hair pencil. If this method fails,
use a piece of cloth, moistened with distilled water. Persistent dirt can be removed from glass
surfaces by means of pure alcohol, chloroform or naphtha.
If an objective lens is accidentally contaminated by unsuitable immersion oil or by the specimen,
please contact your local Leica representative for advice on the use of certain solvents for cleaning
purposes. Take this seriously, because some solvents may dissolve the glue which holds the lens in
place.

Do not open objectives for cleaning!

Oil should be removed from oil immersion lenses after use. First, remove the immersion oil using a
clean cloth. Once most of the oil has been removed with a clean tissue, a piece of lens tissue should
be placed over the immersion end of the lens. A drop of recommended solvent should be applied, and
the tissue gently drawn across the lens surface. This should be repeated as often as necessary to
attain total cleanliness. Use a clean piece of lens tissue each time.
Cleaning the microscope surface
Use a linen or leather cloth (moistened with naphtha or alcohol) to clean the surfaces of the
microscope housing or the scanner (varnished parts).

Never use acetone, xylene or nitro thinners as they attack the varnish!
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All LEICA components and systems are carefully manufactured using the latest production methods.
If you encounter problems in spite of our efforts, do not try to fix the devices or the accessories
yourself, but contact your Leica representative.

Before moving the confocal system, it should be thoroughly cleaned. This applies in

particular to systems that are located in biomedical research labs.

This is necessary to remove any existing contamination and to prevent any carry-over

and endangering of others. Pay not only attention to surfaces, but especially to fans and

cooling devices since dust can frequently accumulate at these locations.
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The Leica Confocal Software: Overview

Starting the Software
Requirements for starting the software
The LCS software is copy-protected to prevent it from being used on two computers at the same time.
This protection system allows all additional application packages to be used. The protection system
consists of a dongle that must be inserted into the parallel port of the workstation. The functionality of
the parallel port (e.g., for printing, etc.) is not affected. To use the software on a second computer, the
dongle must be attached to its parallel port.

If you remove the dongle from the workstation of the confocal system, the software

cannot be started, thereby preventing operation of the confocal system.

The LCS software can be started in two operating modes: hardware mode and simulation mode. In
hardware mode, all hardware components are accessed and initialized by the software. For this
reason, you should switch on the hardware first and then wait about 20 seconds before starting the
software.
In simulation mode, the software runs independently of the hardware. This mode is intended for
secondary installations on another computer, for example for training or offline analysis of existing
data.
Starting the software
Select Start→→→→Programs→→→→Leica Confocal Software. The initial screen of the Leica Confocal
Software appears. This window allows you to select from three profiles.
Company
This option starts the Leica Confocal Software using the default factory settings. This means that the
configuration and the position of the Toolbars is preset. These settings cannot be changed.
Personal
This option lets you use a user-defined configuration profile. The user name is dependent upon the
account used to log on to the operating system. If the custom profile does not yet exist at the first
initialization, the default factory settings are applied to the personal profile.
Last Exit
This option loads the configuration profile that was last active.
For advanced users:
If you have more than one configuration profile, you can load them at startup by clicking the button
with the three black dots, which is located at the right lower edge of the profile options. You may also
use this option to reset your custom configuration profile to the standard factory profile.
Clicking the Start button starts the Leica Confocal Software using the corresponding configuration
profile.

After a delay, the software starts automatically and loads the currently selected

configuration profile.

The Experiment Software Concept
The Leica Confocal Software allows you to join image data or edited images into groups. Each group
is called an "experiment" and is stored in a special data format (*.lei). This makes it possible to store
both the original experimental image data and the image viewing data together. Additional information
can be found in the chapter "Organizing Data by Grouping Experiments".

The Basic Structure of the User Interface
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The appearance of the Graphical User Interface—henceforth referred to as GUI—depends strongly
on the configuration profile being used. A number of elements of the GUI, however, are standard.
The GUI provides the following standard elements:
The Menu
The menu contains the submenus File, View, Macro, Tools, Window and Help. The submenus contain
commands and information for general display, settings and user customization. They do not provide
any of the functions for directly controlling the scan functions. These functions are located in the TCS
menu (View →→→→ Menu →→→→ TCS Menu). The menu line cannot be customized.
The Viewer Window (TCS_Viewer)
The Viewer window displays the image data, experimental conditions and user data. The image
window can be configured (see the chapter on "Modifying the User Interface and Defining User-
Specific Settings"). The image window shows not only the confocal image data records, but also the
experiment data and system settings. You can open a new experiment image window by selecting
File →→→→ New.
The TCS Menu (TCS_Menu)
The TCS menu contains buttons for the individual device functions. It is subdivided into individual
work steps. The number of work steps available depends on the installed software. The standard set
of work steps consists of data recording (Acquire), image viewing (View), surface reconstruction (3 D),
measurement functions (Quantify), image processing and analysis functions (Process), and
documentation functions (Annotate). If the TCS menu is not displayed using the current configuration
profile, you can activate it by selecting View→→→→ Menu →→→→ TCS Menu.
The Toolbars
This area allows you to insert and customize individual (function) buttons. The advantage of the
container is that it can be switched on or off with its entire contents of buttons. For this purpose,
proceed as follows: View →→→→ Menu →→→→ Container.
The Document Viewer Window (Experiment Overview)
The Document Overview window displays the recorded experiments and their contents in a directory
tree. Open this viewer window by selecting View →→→→ Experiment Overview.
The Status bar
The Status bar is found at the bottom edge of the Leica Confocal Software user interface. It displays:
- the progress while loading image data (progress bar)
- the version number of the software
- the name of the system configuration (system type)
For details about these functions, refer to the chapter on "The LCS Software Functions."
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Opening and Saving Data Sets
Readable File Formats
The following file formats can be opened and viewed in the Leica Confocal Software:
Experiment (*.lei):
The format of this type of file is Leica-specific and binary. This format is provided for the data of entire
experiments.
TIFF files (*.tif):
These are Leica image files in single and multiple TIF format. Both image files in the previously used
TCS formats and external files in RGB TIF format can be read.
Annotation (*.ano):
The format of this type of file is also Leica-specific and binary. It is used for saving annotation sheets.
The elements on the annotation sheet, such as images, texts and graphic images, are each available
as individual objects.
When these files are loaded, both the image data and the experiment settings are loaded.
Automatically Applying the Study Parameters of an Experiment
With the Leica Confocal Software, hardware settings that have been saved for previous experiments
or single images can be applied to new experiments. This allows you to carry out different
experiments using constant settings. To carry over settings from a previous experiment, open the
viewer window for the data record that contains the settings you want to apply. There, click the
"Apply" button, which, in the factory default configuration profile, is located in the toolbar.

If you do not find the "Apply" button in one of the open windows, you can load it into any

of the windows by selecting Tools →→→→ Customize. In the dialog window that appears,

select the "Commands" tab under the file category. With the left mouse button, click the

"Apply" button and drag it while holding the mouse button pressed to the desired

window. Release the left mouse button to insert the button at the current location.

Saving Images.
As described above under "Readable File Formats", individual images and experiments can be saved
using the same data formats.
Select File →→→→ Save to save your images and experiments. The first time an experiment is saved, the
"Save as" dialog opens automatically, allowing you to specify a file name. In addition to defining a
suitable file name, you can also select a file format here. Experiments can only be saved in the Leica-
specific *.lei format. When you are saving experiments, you may be able to save existing individual
images in *.tif or *.raw format.

If you are saving an experiment or image that has already been saved before, the old

data will be overwritten. If you do not want to do this, select File →→→→ Save as to save the

new or changed data to a new file with a new name.
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Data Organization by Grouping Experiments
The concept of the Leica Confocal Software allows you to group individual images, image series and
the results of edited images into single groups, or experiments. The Experiment Overview window
provides a general overview of the open experiment. To open the Experiment Overview window,
select View →→→→ Experiment Overview. Create a new experiment by selecting File →→→→ New or File →→→→
New (Template). Files that were previously saved are handled as separate experiments when
opened.
Compiling Experiments
After you have defined a new experiment by selecting File →→→→New or File →→→→ New (Template), you
can start filling it with data.

Images that have been recorded in continuous scan mode are overwritten automatically

when the next scan is started. If you want to keep a single recording as a permanent

part of an experiment, you should use the single scan function.

An experiment contains data acquired with the "single scan" or "series scan" function. If you carry out
image processing functions on a data record, you can save the results as additional components of
the experiment. To do this, double-click the desired image or series in the experiment overview
window. Carry out the desired image processing functions (such as maximum projection or topological
image or others). Mark the region within the viewer window that you want to keep as part of the
experiment. Click the right mouse button (to open the context menu) and select Send to →→→→
Experiment. The Selection (raw) option stores a copy of the raw data of the selected object as a
new, separate component of the experiment. The Selection (snapshot) option stores an RGB image
(no 3D data, just a pure snapshot) of the selected object as a new, separate component of the
experiment.

Keyboard Shortcuts
In order to accelerate recurring software functions, special key combinations have been defined:

Button
Combination

Function

F1 Opens online help.
ALT + F8 Opens the Macros dialog window for launching, editing, and deleting macros.
ALT + F9 Opens a dialog window containing predefined macros that can be started from

this dialog window.
ALT + F10 Starts the online help for the LCS macro language.
ALT + F11
(optional)

Launches the VBA developmental environment (optional).

CTRL + I This option allows you to install subsequently purchased software licenses.
CTRL + J Opens the Objective dialog window in order to define and select the microscope

objectives.
CTRL + L Opens the Legend Info dialog window in order to enter user-specific data that

can be stored and displayed when documenting image recordings.
CTRL + M This option allows you to select the Leica microscope being used.
CTRL + N Opens a new experiment.
CTRL + O Starts the Open dialog window to open an existing file.
CTRL + P Opens the Printer Selection dialog window.
CTRL + S Saves the active experiment.
CTRL + T

Menu Functions
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The following functions can be carried out from the menu bar:

File Menu
New:
This option opens a new experiment in a new window. The display properties of the new window are
determined by the active defaults (see the chapter on "Default Settings and Templates").
New (Template):
This option opens a new experiment in a new window. The way in which the viewer window is
displayed can be selected from a set of templates.
Open:
This option opens a previously saved experiment or a single data block (image data or annotation).
The display properties of the new window are determined by the active defaults (see the chapter on
"Default Settings and Templates").
Open (Template):
This option opens a previously saved experiment, a single data block or documentation files. The way
in which the viewer window is displayed can be selected from a set of templates.
Close:
This option closes the current experiment. It does not save the experiment automatically before
closing it.

You are not asked whether you want to save the experiment before it is closed.

Close all:
This option closes all open experiments. It does not save the experiment automatically before closing
it.

You are not asked whether you want to save the experiment before it is closed.

Save:
Saves the current experiment.
Save as:
Saves the current experiment under a different name.
Save all:
Saves all experiments and the annotation sheets.
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If one or several experiments or annotation sheets were not saved previously using the

"Save“ command, it is necessary to enter a file name and a savings location for the

corresponding experiment using a dialog window.

Recent files:
Opens one of the recently opened files.
Print:
Opens a dialog for printing the content of the currently active window.
Exit:
Terminates the program.

The View Menu
Menus:
Use this option to switch TCS menu and the toolbar on and off.
Status bar:
This option switches the display of the status bar on and off at the bottom edge of the user interface of
the LCS software.
Experiment Overview:
This option opens a window displaying the individual experiments and their components (data
records, graphs, etc.) in the form of a tree. Double-click an experiment component within the
Experiment Overview window to bring the corresponding viewer window to the foreground.
Hardware Legend:
This option toggles the display of the hardware legend on and off.

The Macro Menu
Macros:
Depending on the software installed, either use this option to edit macros directly or just list and run
them.

You can edit and modify macros only if the complete, integrated VBA development

environment (IDE) is installed.

Run Macros:
Opens a dialog window containing predefined macros that can be started from this dialog window.
Macro Interface Help:
Starts the online help for the LCS macro language.
Record a New Macro:
This starts the automatic macro recorder.
For more information, refer to the documentation provided with the optional macro development
environment.
Pause Recording:
This pauses the macro recorder.
Stop Recording:
This stops the macro recorder.
Visual Basic Editor (optional):
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This option launches the software for developing macros and programs based on Visual Basic for
Applications (VBA). Here you can edit and modify macros and even develop entire programs.

The Tools Menu
Legend Info:
This option opens the dialog window for entering user-specific data. This data (e.g., name of institute,
name of specimen, etc.) is saved with each data record and can be displayed next to the acquired
images in the legend.
Objective:
This option opens the dialog window for defining applied objectives. The objectives you use can be
made known to the software by copying them using "drag and drop" from the list provided in this
dialog window.

The correct information of the objective is important since some calculated values

depend on it (e.g. scan field dimensions), automatic adaptation of the detection pinhole.

Microscope:
Use this option to select the Leica microscope you are using. This setting influences the way in which
the microscope is controlled (for example, the motorized objective nosepiece).
Stains:
This option allows for manually entering values for dye characteristics.
Settings:
Use this option to select the hardware settings that you want to be applied when opening a previously
saved data record.
License:
This option allows you to install subsequently purchased licenses. A subsequent license usually is
installed if a software package offered as an option is purchased.

The Window Menu
New Window:
This option opens a new viewer window within the same experiment. For example, you can use this
function to view the same data record using different views (such as topographical and overlay views).

The Help Menu
Contents:
Opens the table of contents of the online help.
Search:
Starts the search function for the online help.
Index:
Opens the index of the online help.
Tutorials:
Opens a tutorial in which the user is guided through selected processes step by step.
Set Language:
Allows for selecting the language of the online help.
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LCS File Formats

Formats of user-specific and device-dependent data
The LCS software provides the following file formats for user-specific data:

Directory: Leica Directory: User
Instrument data (Instrument Parameter Settings) *.IPS *.IPS
Macros Company.mac User.mac
Templates for operator console *.pbo *.pbo
User profiles CompanyProfile.pro PersonalProfile.pro

LastExitProfile.pro
LastRecent.lst

Templates *.prt *.prt
Calibration data Machine.lhw
Color Look-Up Tables *.lut
User-specific profile as it was defined the last time in use *.lst

In detail, the different file formats contain:

*.IPS
Instrument parameters are saved in this format. This includes hardware-based settings such as
intensity of the individual laser lines, number of channels used simultaneously, type of main beam
splitter used, position and bandwidth of individual spectrophotometer diaphragms and sensitivity of
detectors. In addition to the default unchangeable instrument parameter sets that allow a quick
adjustment of the hardware, any user can save custom instrument parameter sets in his personal user
directory. This allows you to save the instrument parameters typical for your planned use so that they
can be reproduced and made available for other experiments.
*.mac
Macros are saved in this format. Macros contain VBA (Visual Basic for Application) program code.
Leica provides the individual program objects for controlling the confocal system in an object model.
Additional information about the development of macros for controlling the confocal system can be
found in the chapter on "The LCS Macro Language".
The software includes factory-predefined macros that can be used without modifications or modified
according to your particular needs. The self-designed or modified macros are stored in the respective
user-defined directory.
*.pbo
Templates for the assignment of the control panel are saved in this format. These templates define
which scan parameter is controlled by which rotary knob. This format also includes factory presets
that have proven useful for most standard applications. Self-defined templates are saved in the user-
specific directory.
*.pro
Specific profiles of the user interface are saved in this format. This includes which button is located in
which position on which toolbar. In addition, new toolbars can be defined or existing toolbars can be
displayed or hidden. The position of the toolbars—whether embedded or freely movable—is also
stored in a profile. This allows every user to save an individual user interface. For example, system
administrators can use this tool to create a separate user interface for each knowledge level of the
user (beginner, advanced, expert).
*.lst
Besides the individual user-specific profiles, the user directory also contains the profile of the last
session as well as a list of the last four data records applied by the user.
*.prt
Templates for the "Viewer" window are saved in this format. This allows for specifically saving the
appearance and type of displayed information. An explanation of the individual configuration options
can be found in the chapter on "Viewer window".
*.lhw
Calibration data and hardware settings of the confocal system are saved in this format. This file may



Leica Microsystems Heidelberg GmbH
LCS software functions: General overview

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 53 of 307

be edited only by service personnel certified by Leica Microsystems Heidelberg.

Changes to this file may result in serious, possibly irreparable damages to the confocal

system. Damages demonstrably resulting from changes to this file by the user will result

in a loss of warranty for the complete system.

*.lut
Color look-up tables are saved in this format. They are used to assign the intensity values measured
by the detectors to each color. This allows to bring out not only the true color display, but also certain
intensity areas. More details can be found in the chapter on "Selecting Color Look-Up Tables."

Fixed Leica-specific file formats

The following file formats can be opened and viewed in the Leica Confocal Software:
Raw data (*.raw)
The RAW format saves data as a linear two-dimensional array in the INTEL format. The column index
of the array corresponds to the fastest scan dimension (in general the x-axis), while the line index
corresponds to the slower scan dimension (in general the y-axis). In an 8-bit image, each measured
variable is saved as a single byte. A 12-bit recording uses 2 bytes, whereby the first byte contains the
more significant bits according to the INTEL format (little endian). Each optical section is saved for
each channel in a separate file with the file extension .raw using the following naming convention:
name of experiment_name of data record_channel number_z-dimension_number of optical
section.raw
Experiments (*.lei)
The format of this type of file is Leica-specific and binary. This format is provided for the data of entire
experiments.
A file description is saved in this file format, referencing a series of image files in TIF format or RAW
format.
Tiff files (*.tif)
These are Leica image files in single and multiple TIF format. Both image files in the previously used
TCS formats and external files in RGB TIF format can be read.
Annotation (*.ano)
The format of this type of file is also Leica-specific and binary. It is used for saving annotation sheets.
The elements on the annotation sheet, such as images, texts and graphic images, are each available
as individual objects.
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Information on whether the stored measured variable is an intensity value or a height

value is saved in the corresponding LEI file.

27 26 25 24 23 22 21 20 215 214 213 212 211 210 29 28

Least significant byte according to INTEL format Most significant byte according to INTEL format
Displaying a 12-bit number in the INTEL format

Specification of the "Lei" File Format (Version beta 2.000)

When a file is saved in the LCS software, a subdirectory is first created under the current directory.
The following files are saved in this subdirectory:
1. A description file whose structure is described below. This file is used for interpreting the data of an
experiment through the LCS software.
2. The individual image files; naming image files is based on the following naming convention:

NAME_channel number_dimensionIndex. Thus, Chloroplast_C1_Z1 means that "Chloroplast"
is the name of the data record assigned by the user, that the image corresponds to the first optical
section of a three-dimensional data stack (Z1), and that the data was acquired in the first detection
channel (C1).

Example for saving an experiment in "Lei" format

Structure of description file

The description file can be read only by the LCS software.
It consists of a collection of various tables and contains the following structure:

Header table
Byte Meaning Possible values
0 ... 3 Byte arrangement 0x49494949 Intel LSB

0x4D4D4D4D Motorola MSB
4 ... 7 Identification for Leica "Lei"

format
0x016033F0

8 ... 11 Version number current: =x20000000
12 ...
15

Address of directory tableA any possible address within the complete length of the
file
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Directory table A
Address Meaning Entry data

type
Address of

A = A

Number of entries in this table DWORD

A+4 Index of the first entry (represents a logical memory block, e.g.,
acquisition parameter ("hardware settings") or image parameter
("dimensions")

DWORD

A+8 AddressA1 of the 1st entry DWORD

A+12 Index of the first entry (represents a logical memory block, e.g.,
acquisition parameter ("hardware settings") or image parameter
("dimensions")

DWORD

A+14 AddressA2 of the 2nd entry DWORD

… ... ...
The length of the directory table depends upon the number of images and image data to be saved in
an experiment (acquisition parameters, number of channels, number of optical sections, etc.).
Each entry in the directory table corresponds to a logical memory block.

Block table Xn
Address Meaning Data type
A1 or A2 or
A3.....Ai

Check digit DWORD

Ai+ 4 Bytes Description of the contents of the block table
(currently not used)

DWORD

Ai+ 8 bytes Version of entry DWORD
Ai+ 12 bytes Size of entry DWORD
Ai+ 16 bytes Begin of entry The data type depends upon

the entry type

The following logical memory blocks are available:
const DWORD ID_SERIES = 10;
const DWORD ID_IMAGES = 15;
const DWORD ID_DIMDESCR = 20;
const DWORD ID_FILTERSET = 30;
const DWORD ID_TIMEINFO = 40;
const DWORD ID_SCANNERSET = 50;
const DWORD ID_EXPERIMENT = 60;
const DWORD ID_LUTDESC = 70;

A memory space of 32 bits is defined for the DWORD data type.

ID_SERIES memory block
This data block contains information about the size of the complete data series combined in an
experiment. It always occurs only once per experiment The data block is structured as follows:

Size [byte] Data type Symbol Description
4 int Internal version number
4 int nSE Number of image series
4 int nIm Length of a file name in wchar
4 int nExt Length of the file extension of the image file in bytes
nExt wchar File extension of image file
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ID_IMAGES memory block
This block contains all file names of all image files that are part of a series. The data block is
structured as follows:

4 int nFiles Number of single images of the series
4 int Width of a single image
4 int Length of a single image
4 int Bits / data points (image resolution)
4 int Data points / pixels (display resolution)

For the next n image files
nIm * 2 wchar Name of the next image

ID_DIMDESCR memory block
This block provides a description of an image in an n-dimensional space.

Size
[byte]

Data type Symbol Description

4 int Internal version number of the VOXEL description
4 int Voxel type, e.g., RGB or GRAY (see the following VOXEL

TYPES table)
4 DWORD Byte size of a pixel

Typical: (1 or 2) or (3 or 6 for RGB)
4 DWORD Resolution of scan data (8, 12 or 16 bit)
4 int nTC Length of the following string in wchar (wchar = wide

character; character format that uses a 2-byte coding of
characters unlike the ASCII format (1 byte)

nTC * 2 wchar Maximum value of measured variable (intensity value or length
value of a distance) for a voxel

4 int nTC Length of the following string in wchar
nTC * 2 wchar Minimum value of measured variable (intensity value or length

value of a distance) for a voxel
4 int nTC Length of the following string in wchar
nTC * 2 wchar Designation of measured variable ("I" for intensity, "z" for

length value)

4 int Internal version number
4 int nDims Dimension of the image, e.g., x_y_ch_z = 4

For the next n
dimensions

4 DWORD Identification number (ID) of the dimension (see the following
list "Identification numbers (ID) for image dimensions")

4 DWORD Size of dimension (e.g., 512 pixel)
4 DWORD Distance between sub-dimensions (e.g., byte distance between

the image series of two consecutive channel numbers)
4 int nTC Length of the following string in wchar
nTC * 2 wchar Physical length with unit of length, e.g., 10 µm
4 int nTC Length of the following string in wchar
nTC * 2 wchar Physical start position with unit of length, e.g., 10 µm
4 int nTC Length of the following string in bytes
nTC wchar Name of the image series
4 int nTC Length of the following string in bytes
nTC wchar Description of the image series
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Identification numbers (ID) for image dimensions
The following identification numbers are possible:

ID (decimal) Meaning
0 undefined
120 x
121 y
122 z
116 t for time dimension
6815843 channel number
6357100 wavelength Range
7602290 rotation
7798904 x-wide for motorized xy-stage
7798905 y-wide for motorized xy-stage
7798906 z-wide for z-stage
4259957 user1 (not specified)
4325493 user2 (not specified)
4391029 user3 (not specified)

6357095 gray-scale, e.g., of histogram
6422631 gray-scale1, e.g., of histogram
6488167 gray-scale2, e.g., of histogram
6553703 gray-scale3, e.g., of histogram

7864398 logical x (not physical, but logical position value)
7929934 logical y (not physical, but logical position value)
7995470 logical z (not physical, but logical position value)
7602254 logical t (not physical, but logical position value)
7077966 logical wavelength value (not physical, but logical value)
7471182 logical rotation value (not physical, but logical value)
5767246 logical x-wide value (not physical, but logical value)
5832782 logical y-wide value (not physical, but logical value)
5898318 logical z-wide value (not physical, but logical value)

ID_FILTERSET memory block
This memory block describes the hardware settings such as pinhole diameter or selected filters. The
memory block starts with a SAFEARRAY header that describes the number and size of the entries. A
complete description of the SAFEARRAY structure can be found in Appendix 1.
Presently, only three entries of the SAFEARRAY structure are used:

1. sa.cDims:
should be = 1. Presently, only one-dimensional data fields (arrays) are used.
2. sa.cbElements:
size of elements in byte
3. sa. rgsabound[0].cElements:
indicates the number of elements contained in the structure

Size [byte] Data type Symbol Description
24 SAFEARRAY sa Microsoft type, see Appendix 1

for all elements that contain the structure = sa.rgsabound[0].cElements
128 wchar Identifier for the contents of the entry
64 wchar Name of a short description, e.g., a TIFF

description tag
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64 wchar String (contains the contents of the string)
16 VARIANT Contains the data type and data value (except for

the "string" data value which is described in the
field above)

4 DWORD Separate memory space for data values
4 DWORD Not in use
4 DWORD Identifier (ID) of the memory block (for internal

use only)
4 DWORD Test value

ID_TIMEINFO memory block
This memory block contains the time taggers for image series that were acquired with a time-
dependent scan mode.

Size
[byte]

Data
type

Symbol Description

4 int nDims Indicates the number of dimensions that the description of the
time tagger includes

4 int Indicates which dimension was provided with a time tagger
For the next n dimensions

4 DWORD Identifier (ID) of the dimension (see the description of the
D_DIMDESCR memory block)

4 DWORD Size of the dimension (number of elements, e.g., 512 pixel)
4 DWORD Distance between the individual dimension entries
4 int nTS Number of time taggers

For the next ntime taggers = nTS
64 wchar Time tagger as string ("string" data type)
4 int nTM Number of time tags per time tagger

For the next m time tags = nTM
4 int nC Number of dimensions of

the time tagger
description

loop nC
4 int Coordinate in this

dimension
64 wchar Time tag as string

(wchar data type)

Example:

Image with the following dimensions and dimension sizes:
x y ch z
512 512 3 10

For example, the description of a time tag is 512_512_3_10. This description matches the description
of the image. The time tagger description 1024_1024_3_10 for the above sample image means that
the original image featured an xy-dimension of 1024*1024 and was reduced by the software
(downsampling). In such cases, the time tag must be recalculated accordingly.
A time tag can be defined at any time during an n-dimensional data acquisition process (scan). The
coordinate of the time tag 0_0_2_7 indicates that the time tag was set at the start of a data record
(0_0_c_#) on the second channel (0_0_2_#) for the 7th optical section (0_0_2_7).

ID_SCANNERSET memory block
This memory block contains device parameters that are set at the time of the image acquisition.
Further details about the SAFEARRAY structure can be found in the description of the
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ID_FILTERSET memory block.

Size
[byte]

Data type Symbol Description

24 SAFEARRAY sa Microsoft type, see Appendix
for all elements that contain the structure = sa.rgsabound[0].cElements

128 wchar Identifier for the contents of this entry
64 wchar Name of a shorthand notation, e.g., a TIFF description

tag
64 wchar String (contains the contents of the string)
20 VARIANT Contains the data type and data value (except for the

"string" data value which is described in the field above)
4 DWORD Separate memory space for data values
4 DWORD Not in use
4 DWORD Identifier (ID) of the memory block (for internal use only)
4 DWORD Test value

ID_EXPERIMENT memory block
Description of the used save format (e.g., “*.lei file with PC-Tiff images”)

Size [byte] Data type Symbol Description
4 int Internal version number
4 int Number of images in the data collection of the experiment
4 int nTC Length of the following string in wchar
nTC * 2 wchar Short description of the format
4 int nTC Length of the following string in wchar
nTC * 2 wchar File extension of the main file
4 int nTC Length of the following string in wchar
nTC * 2 wchar Identifier of the single image format (e.g., PC-TIFF)
4 int nTC Length of the following string in wchar
nTC * 2 wchar File extension for the single image format (e.g., tif / raw)

ID_LUTDESC memory block
Description of the color look-up tables (LUTs)

Size [byte] Data type Symbol Description
4 int nLU Number of channels
4 DWORD Identifier (ID) of the dimension whose display is being colored.

For the next channels until = nLU
4 int Internal version number
1 bool bool IsInverted
4 int nTC Length of the following string in bytes
nTC wchar Description of the color look-up table (LUT)
4 int nTC Length of the following string in bytes
nTC wchar File name of the color look-up table (if available)
4 int nTC Length of the following string in bytes
nTC wchar Name of the color look-up table
4 int Field for internal use
4 int Dimension of the color look-up table

SAFEARRAY Data Type
typedef struct FARSTRUCT tagSAFEARRAY {
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unsigned short cDims; // Count of dimensions in this array
unsigned short fFeatures; // DON’T CARE
unsigned long cbElements; // Size of an element of the array.

// Does not include size of
// pointed-to data.

unsigned long cLocks; // DON’T CARE
void HUGEP* pvData; // Pointer to the data.
SAFEARRAYBOUND rgsabound[1]; // One bound for each dimension.

} SAFEARRAY;

The Leica-specific file format "LEI" uses only one-dimensional data fields (arrays).

SAFEARRAYBOUND Structure
Represents the bounds of one dimension of the array. The lower bound of the dimension is
represented by lLbound, and cElements represents the number of elements in the dimension. The
structure is defined as follows:
typedef struct tagSAFEARRAYBOUND {

unsigned long cElements; // num of elements
long lLbound; // DON’T CARE

} SAFEARRAYBOUND;

VARIANT and VARIANTARG
typedef struct FARSTRUCT tagVARIANT VARIANT;

typedef struct tagVARIANT {
VARTYPE vt;
unsigned short wReserved1;
unsigned short wReserved2;
unsigned short wReserved3;
union {

unsigned char bVal; // VT_UI1.
short iVal; // VT_I2 .
long lVal; // VT_I4 .
float fltVal; // VT_R4 .
double dblVal; // VT_R8 .
VARIANT_BOOL boolVal; // VT_BOOL.
SCODE scode // VT_ERROR.
CY cyVal; // VT_CY .
DATE date; // VT_DATE.
BSTR bstrVal; // VT_BSTR.
IUnknown FAR* punkVal; // VT_UNKNOWN.
IDispatch FAR* pdispVal; // VT_DISPATCH.
SAFEARRAY FAR* parray; // VT_ARRAY|*.
unsigned char FAR* pbVal; // VT_BYREF|VT_UI1.
short FAR* piVal; // VT_BYREF|VT_I2.
long FAR* plVal; // VT_BYREF|VT_I4.
float FAR* pfltVal; // VT_BYREF|VT_R4.
double FAR* pdblVal; // VT_BYREF|VT_R8.
VARIANT_BOOL FAR* pboolVal; // VT_BYREF|VT_BOOL.
SCODE FAR* pscode; // VT_BYREF|VT_ERROR.
CY FAR* pcyVal; // VT_BYREF|VT_CY.
DATE FAR* pdate; // VT_BYREF|VT_DATE.
BSTR FAR* pbstrVal; // VT_BYREF|VT_BSTR.
IUnknown FAR* FAR* ppunkVal; // VT_BYREF|VT_UNKNOWN.
IDispatch FAR* FAR* ppdispVal; // VT_BYREF|VT_DISPATCH.
SAFEARRAY FAR* FAR* pparray; // VT_ARRAY|*.
VARIANT FAR* pvarVal; // VT_BYREF|VT_VARIANT.
void FAR* byref; // Generic ByRef.

};
};
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Files with the "LEI" format never use pointers as parameters.

VARTYPE
typedef unsigned short VARTYPE;
enum VARENUM{

VT_EMPTY = 0, // Not specified.
VT_NULL = 1, // Null.
VT_I2 = 2, // 2-byte signed int.
VT_I4 = 3, // 4-byte signed int.
VT_R4 = 4, // 4-byte real.
VT_R8 = 5, // 8-byte real.
VT_CY = 6, // Currency.
VT_DATE = 7, // Date.
VT_BSTR = 8, // Binary string.
VT_DISPATCH = 9, // IDispatch
VT_ERROR = 10, // Scodes.
VT_BOOL = 11, // Boolean; True=-1, False=0.
VT_VARIANT = 12, // VARIANT FAR*.
VT_UNKNOWN = 13, // IUnknown FAR*.
VT_UI1 = 17, // Unsigned char.

// Other constants that are not valid in VARIANTs omitted here.

};
VT_RESERVED = (int) 0x8000
// By reference, a pointer to the data is passed.
VT_BYREF = (int) 0x4000
VT_ARRAY = (int) 0x2000 // A safe array of the data is passed.

The vt value determines the interpretation of the data of the experiment as follows:

Value Description
VT_EMPTY No value was entered
VT_UI1 An unnamed 1-byte character was saved in bVal.
VT_I2 A 2-byte integer value was saved in iVal.
VT_I4 A 4-byte integer value was saved in lVal.
VT_R4 An IEEE 4-byte real value was saved in fltVal.
VT_R8 An IEEE 8-byte real value was saved in dblVal.

VT_CY A fixed point value is indicated. It consists of 15 digits before the point and 4 digits after
the point. The value was saved in cyVal.

VT_BSTR Exceptions for files in LEI format:
A string was saved in the variable TCHAR

VT_NULL A floating zero value was indicated. Here, the floating zero is not a NULL pointer. This
value is required for a 3-state logic, for example, in the SQL database query language.

VT_ERROR An SCODE error was indicated. The error type is specified scodee.

VT_BOOL A Boolean value (true / false) was indicated.
The value 0xFFFF (all bits=1) means "true," the value 0 (all bits=0) means "false."

VT_DATE

A value corresponding to a date was indicated.
A date is saved as a number in double-precision format. All data is saved as differential
dates in reference to January 1, 1900.
For example, the entry "25" corresponds to 01-25-1900.
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Procedures and Exercises for Selected Processes

Setting Instrument Parameters for the First Image Recording
Step 1

Click on the «Acquire» arrow symbol and then on the «Beam» button to open the
«Beam Path Setting» dialog window.

Step 2
Double-click on one of the Instrument Parameter Settings (IPS), in the list box in the
upper right corner of the dialog window to load important hardware settings.

What is an instrument parameter setting?
An instrument parameter setting (IPS) consists of a file, in which all hardware settings
are stored which are specific to a certain recording method. The designation «FITC-
TRITC», for example, refers to the settings for a two-channel recording with the two
fluorescent dyes FITC and TRITC. An instrument parameter setting enables the user to
store optimum hardware settings in a file and to load them again with a simple double-
click. Instrument parameter settings labeled with the letter «L» are predefined by Leica
and cannot be changed. User-defined, modifiable instrument parameter settings are
stored below «U» in the list box.
& see the chapter "Creating user-defined instrument parameter settings (IPS)“ (page
69)

Step 3
Assign the «Glow (O&U)» color look-up table to every active «PMT» detection channel.

����Click on the symbol for the color look-up table.
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����Select «Glow (OU)».

Note on image quality
The «Glow (O&U)» color look-up table visualizes maximum values in blue and minimum
values in green. Thus, it is best suited for optimizing image quality. In step 12 you will
find a description of how you can use this color look-up table to optimize the intensity
value range of a recording for display on the monitor.

Step 4
Before you start to optimize image quality, check the default setting of the instrument
parameters listed in the following steps 5 through 9, which cannot be changed during
image recording.

Step 5
Click on the «Objective» button and select a microscope objective in the list.

If no entries appear in the list, the microscope objectives have to be assigned to the slots
of the objective nosepiece.
�To learn how to do this, read the help description of the «Objective» button. To open
this description, first click on the «Help» button and then on the «Objective» button.
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Note on image quality
The numerical aperture of the microscope objective determines the resolution of the
image, i.e. the minimum distance between two points in the object, which can still be
displayed as distinct points in the image. Objectives with greater magnification also have
a higher resolving power.

Using the beam expander lens («Beam Expander» button), an optimum adaptation of
the diameter of the laser beam and the objective lens can be achieved.

In most cases the standard setting «Beam Exp 6» is best. However, in experiments in
which weak lasers and high-resolution objectives are used, setting the beam expander to
a smaller value can improve the illumination of the objective lens.

Step 6
Click on the «Mode» button and select a scan mode.

Using the scan mode, you define the dimensionality of the image recording. You can
select the spatial image series «xyz, xzy», the time image series «xt, xyt, xzt, xyzt» and
the spectral image series «xyλ , xzλ».

Step 7
Click on the «Format» button and select the scan format.
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Note on image quality
The scan format determines the number of points that the scanner uses to sample the
specimen and thus the number of pixels of the image. The higher the scan format at a
given scan field size, the smaller is the distance between the sampling points and the
better the resolution of the image.

Step 8
Click on the «Speed» button and select the scan speed.

Using the scan speed, you determine how many image lines per second are sampled by
the scanner.

Note on image quality
Changing the scan speed also has an impact on image quality. The lower the scan
speed at a given scan format, the better the signal-to-noise ratio of the image.

You can double the scan speed, if you activate bidirectional scanning by clicking the
«Scan» button.

When bidirectional scanning is active, not only the forward sweep but also the reverse
sweep of the scanner is used for sampling.

Step 9
Click on the «Bit» button and select the bit depth.

With a bit depth of 8 bit it is possible to resolve 256 different intensity values, with a bit
depth of 12 bit the number is 4096.

Step 10
Next, start the continuous scanning mode with the «Continuous» button to optimize
image quality during image recording.
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Step 11
Click on the «Series» button and select a suitable focal plane (z-position) for image
recording; in general this would be the brightest image plane in the specimen.

����Drag the yellow square to the desired z-position or

����Double-click on «Absolute Position» and enter a numerical value.

Note on finding the focal plane
If you have difficulty finding the focal plane, this can be due to a wrong setting of the
signal amplification of the detectors.

�Click on the «Signal» button and set the «Gain» value of all active detection channels
to the maximum voltage.

You can adjust many instrument parameters more quickly and conveniently by using the
control panel instead of the software buttons.
& see the chapter "Setting instrument parameters using the control panel“ (page 74)
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Step 12
Click on the «Signal» button and adjust the signal amplification (Gain) and set a
threshold value (Offset) for each of the active detector (PMT) separately.

�Move the slider or double-click on the number and enter a value.
�Adjust the «Gain» value so that the brightest points in the image (structure) are
displayed in blue.
�Adjust the «Offset» value so that the dark points in the image (background) are
displayed in green. As a rule of thumb, approximately half of the background should be
displayed in green.

Note on image quality
Adapting the detection parameters to the specimen ensures that the intensity value
range of the image data set is optimally assigned to the digital value range and thus best
visualized.

You can adjust many instrument parameters more quickly and conveniently by using the
control panel instead of the software buttons.
& see the chapter "Setting instrument parameters using the control panel“ (page 74)

Step 13
Click on the «Pinhole» button and set the detection pinhole to one Airy unit.



Leica Microsystems Heidelberg GmbH
LCS software functions:

Description of individual functions

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 68 of 307

Note on image quality
The detection pinhole is essential for the resolution of the image. Setting the diameter of
the detection pinhole to one Airy unit ensures that the thickness of an optical section is
minimum and thus maximum resolution is attained in the z-dimension of the image.

You can adjust many instrument parameters more quickly and conveniently by using the
control panel instead of the software buttons.
& see the chapter "Setting instrument parameters using the control panel“ (page 74)

Step 14
Click on the «Electronic Zoom» button and zoom into the area of the image that you
want to record.

Note on image quality
Using the electronic zoom, you can improve the resolution of the image. If for example
the zoom factor 2.00 is selected, only one fourth of the maximum scan field size is
sampled. Consequently, at a given scan format, the distance between the sampling
points is reduced and resolution is improved.

You can adjust many instrument parameters more quickly and conveniently by using the
control panel instead of the software buttons.
& see the chapter "Setting instrument parameters using the control panel“ (page 74)

Step 15
Click on the «Continuous» button to stop the continuous scanning mode.
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llll
Now that all essential instrument parameters are set, you can continue recording
individual images or image series.
{tc "Creating user-defined instrument parameter settings (IPS)"}

Creating User-Defined Instrument Parameter Settings (IPS)
Step 1

Click on the «Acquire» arrow symbol and then on the «Beam» button to open the
«Beam Path Setting» dialog window.

Step 2
The instrument parameter settings are displayed in the list box in the upper right
corner in this dialog window.

What is an instrument parameter setting?
An instrument parameter setting (IPS) consists of a file, in which all hardware settings
are stored which are specific to a certain recording method. The designation «FITC-
TRITC», for example, refers to the settings for a two-channel recording with the two
fluorescent dyes FITC and TRITC. An instrument parameter setting enables the user to
store optimum hardware settings in a file and to automatically load them again with a
simple double-click. Instrument parameter settings labeled with the letter «L» are
predefined by Leica and cannot be changed. User-defined, modifiable instrument
parameter settings are stored below «U» in the list box.

Step 3
Select «Tools → Settings → Instr. Parameter Settings» and specify the parameters,
which are to be retrieved when an instrument parameter setting is loaded.

����Select «Tools → Settings → Instr. Parameter Settings».
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����Several standard parameters are preselected in the list field and should only be
changed purposefully. Select the «IPS-DoubleClick» option and click on the check boxes
of the additional instrument parameters to be included.

Step 4
To adapt instrument parameters to the currently used specimen during image recording,
click on the «Continuous» button and start the continuous scanning mode.

& see the chapter "Setting instrument parameters for the first image recording“ (page
62)

Step 5
In the «Beam Path Setting» dialog window, click on the «Save» button to save the
modified parameters as an instrument parameter setting.

����Give the new instrument parameter setting a name and click on OK.

The new instrument parameter setting appears in the list box below «U». Whenever you
double-click on «My Gorgeous IPS», all hardware settings saved with this instrument
parameter setting are loaded.

Where are instrument parameter settings stored?
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User-defined instrument parameter settings are stored in the user directory of the user
who is currently logged onto Windows NT. As default setting the directory of users is
located at: D:\users\... Consequently, access to a specific instrument parameter setting
is only given to the user who produced it. If several users should have access to a user-
defined parameter setting, the user who produced it or the administrator has to unblock it
for other users.

Step 6
You can give other users access to your instrument parameter setting.
�Open the Windows Explorer and select the directory where the instrument parameter
settings are stored. As default setting you will find this directory, for example of a user
logged onto the system as administrator, at: D:\ users\ Administrator\ Lcs\ Instrument
Parameter Settings\...
�Highlight the instrument parameter setting, click the right mouse button to open the
context menu and select «Properties».
�In this dialog window, click on the «Security» tab and then on «Permissions».

�Click on the «Add» button in the «File Permissions» dialog window to select the users
who will receive permission to use the file.
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�Select the users in the «Names» field (e.g. «Everyone») and click on «Add».
�Assign the «Full Access» permission status to the new user in the «Type of Access»
list box and close the dialog window with «OK».
�In Windows Explorer, copy the file of the instrument parameter setting to the directory:
C:\Program files\ Leica\ Lcs\ Instrument Parameter Settings\...

Important: Use the «Copy »and not the «Cut»command to do this!

The next time you open the «Beam Path Setting» dialog window, the instrument
parameter setting will appear in the list labeled with «L» and can be used by all users.

Step 7
When you highlight the newly defined instrument parameter setting and open the
context menu with the right mouse button, you can select one of the following optional
commands:

�Select «Set as default setting», if you want the parameter setting to be loaded
automatically when the software is started.
�Select «Remove default setting», if you want to undo the definition of an instrument
parameter setting as default setting.
�Select «Load» to activate the highlighted parameter setting.
�Select «Rename» to give the parameter setting a new name.
�Select «Delete» to remove the parameter setting from the list.

Step 8
If the loading speed of an instrument parameter setting is too slow, you can activate a
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fast mode.

����Select «Tools → Settings → Scan Options».

����Click on the «Fast IPS Execution» check box to activate the fast mode.

Note
If you open instrument parameter settings which have not been created with the version
of the Leica Confocal Software that you have currently in use, it is possible that the fast
mode cannot be carried out. In this case, an error message will be displayed which
prompts you to restart the system.

Step 9
If you want to reuse the instrument parameter settings of an existing experiment for a
new image recording, open the experiment and click on the «Apply» button.

�Select «Tools → Settings → Instr. Parameter Settings» and specify the instrument
parameters to be loaded when the «Apply» button is clicked.

����Select «Tools → Settings → Instr. Parameter Settings».
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����Several standard parameters are preselected in the list field and should only be
changed purposefully. Select the «IPS-Apply» option and click on the check boxes of the
additional instrument parameters to be included.

Setting Instrument Parameters Using the Control Panel
Step 1

You can set many instrument parameters more quickly and conveniently when you use
the control panel instead of the software buttons.

The seven rotary knobs of the control panel can be assigned to different instrument
parameters, which can then be controlled by means of the control panel.

Note
The status bar of the control panel is displayed at the bottom margin of the user
interface. If this is not the case, select «View → Status Bars → Control Panel Status
Bar».

Step 2
Load a predefined function template for the rotary knobs of the control panel.

�You find the three small buttons used to configure the control panel in the right corner
of the control panel status bar.

�Click on the button in the middle.
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�Select one of the predefined function templates, e.g. «Standard».
�The instrument parameters assigned to the control panel are displayed in seven fields
in the status bar. The order of these fields corresponds to the order of the rotary knobs
on the control panel.

Step 3
You can change the assignment of the rotary knobs of the control panel according to
your needs.

�In the control panel status bar click on the field (rotary knob) that you want to assign to
another instrument parameter.
�In the list box, select the new instrument parameter which you want to assign to the
corresponding rotary knob of the control panel.

�Select «Gain PMT 1..» or «Offset PMT 1...» if you want to adjust the signal
amplification and the threshold value for the corresponding detector. It corresponds to
this button in the software:

�Select «Phase» to correct a possible phase shift when using the bidirectional scanning
mode. It corresponds to this button in the software:
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�Select «Pinhole» if you want to set the diameter of the detection pinhole. It
corresponds to this button in the software:

�Select «Scan Field Rotation» if you want to adjust the degree of rotation of the scan
field. It corresponds to this button in the software:

�Select «Z Position» and «Z Wide Position» if you want to set the focal plane (z-
position). It corresponds to these buttons in the software:

�Select «Zoom» if you want to set the zoom factor of the electronic zoom. It
corresponds to this button in the software:

�Use «Smart Gain» and «Smart Offset» to set the signal amplification and threshold
value of the detection channel, which you previously selected in the Viewer window.
�Select «Macro» to save the currently executed command as a macro.

Step 4
You can vary the response sensitivity of the rotary knobs. For this purpose, click with
the right mouse button on an instrument parameter that is displayed in the status bar of
the control panel.

�You can select from three sensitivity steps when you click on the instrument
parameters «Phase», «Pinhole», «Scan Field Rotation» or «Zoom».

�For the recording parameters «Gain», «Offset», «Smart Gain» and «Smart Offset»,
the number of volts can be adjusted by rotating the radio button.
�Select «others...» to enter a user-defined value.

�For the recording parameters «Z Position» and «Z Wide Position», the number of
micrometers can be adjusted by rotating the radio button.
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�Select «others...» to enter a user-defined value.
�When you click on the «Z Wide Position» instrument parameter, you will find the
additional default setting «Automatic».

Default setting «Automatic» with «Z Wide Position»
With the default setting «Automatic», the response sensitivity of the rotary knob is set
automatically depending on the magnification factor of the objective currently in use.
�For objectives with a magnification of m < 10, the response sensitivity is set to: SC =

150 µm per turn.
�For objectives with a magnification of 10 < m < 20, the response sensitivity is set to:

S3 = 15 µm per turn.
�For objectives with a magnification of 20 < m < 30, the response sensitivity is set to:

S2 = 7 µm per turn.
�For objectives with a magnification of 30 < m < 60, the response sensitivity is set to:
S1 = 1  µm per turn.
�For objectives with a magnification of m > 60, the response sensitivity is set to: S0 =
0.5 µm per turn.

Step 5
Save the new assignment as a user-defined function template.

����Click on the left button.

�Give the new function template a name and click on OK.

Step 6
When you highlight the newly defined function template and open the context menu
with the right mouse button, you can select one of the following optional commands:

����Click on the right button.

The new function template of the control panel appears in the list box below «U».
Whenever you double-click on «My Lovely Template», the corresponding function
template is loaded.
�Select «Set as default setting», if you want the template to be loaded automatically
when the software is started.
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�Select «Remove default setting», if you want to undo the definition of a template as
default setting.
�Select «Load» to activate the highlighted template.
�Select «Rename» to give the template a new name.
�Select «Delete» to remove the template from the list.
{tc "Recording Spatial Image Series"}

Recording Spatial Image Series
Step 1

Click on the «Acquire» arrow symbol and then on the «Mode» button to select the «xyz»
or «xzy»  scan mode.

�Select the «xyz» scan mode if you want to record a stack of horizontal images
(orthogonal to the optical axis).
�Select the «xzy» scan mode if you want to record a stack of vertical images (parallel to
the optical axis).

Which scan modes are available?
The number of available scan modes depends on the selected z-actuator type. Click on
the «z-Scan» button to choose the z-actuator.

All scan modes are available when you use the galvanometer-driven z-specimen stage.
For this stage select the «z-Galvo» option in the list.
There are only the scan modes «xyz, xt, xyt, xyzt, xyλ , xyλ t and xyλz» available when
you use the electromotor-driven z-specimen stage (or the motorized objective nosepiece
with inverted microscopes). For this stage select the «z-Wide» option in the list.

Step 2
Click on the «Beam» button and open the «Beam Path Setting» dialog window to
choose the excitation wavelength and set the laser intensity.
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�Move the slider or double-click on the number and enter a value for the laser intensity.

Note
Using a predefined instrument parameter setting allows you to activate optimized
acquisition parameters with a single click.
& see the chapter "Creating user-defined instrument parameter settings (IPS)“ (page
69)

Step 3
Select a suitable excitation beam splitter:

If your system is equipped with an acousto-optical beam splitter (AOBS), the beam path
is optimized automatically for the wavelength you selected.
Otherwise double-click on the green line and select a beam splitter:
�Select the dichroic RSP 500 for image recordings of FITC and GFP with an excitation
wavelength of 488 nm and a detection bandwidth of 500 to 600 nm.
�Select the dichroic RSP 465 for image recordings of CFP with an excitation
wavelength of 458 nm and a detection bandwidth of 465 to 525 nm.
�Select the double dichroic DD 488 / 543 for image recordings of FITC and TRITC or
GFP and DsRED with an excitation wavelength of 488 and 543 nm and a detection
bandwidth of 500 to 530 nm and 555 to 700 nm, respectively.
�Select the triple dichroic TD 488 / 543 / 633 for image recordings of FITC, TRITC and
CY5 with an excitation wavelength of 488, 543 and 633 nm and a detection bandwidth of
500 to 535 nm, 555 to 620 nm and 650 to 750 nm, respectively.
�Select the neutral filter RT 30/70 for recordings of reflected light.

Step 4
Select one or several «PMT» detection channels and set the fluorescence dye and
detection bandwidth.
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�Click on the list box of a detection channel and select the fluorescence dye you want
to use. The emission curve of the fluorescence dye is displayed in the spectrum.
�Position the slider below the emission curve.

Note on positioning the detection band
When recording fluorescence light, take care that you do not position the detection band
directly below the laser line, since thus reflected light will also be recorded. The distance
between laser line and detection band should be at least 5 nm in the blue spectral range
(excitation line 488 nm), 10 nm in the green spectral range (excitation line 543 nm) and
15 nm in the red spectral range (excitation line 633 nm). If the AOBS is used, the
distance to the laser line can be reduced further because this excitation beam splitter
suppresses reflected light much better than conventional beam splitters. However, this
requires that the refraction index of the specimen and the medium between coverslip
and objective is perfect.

�Double-click on the slider of the selected detection channel.
�In the «Range Properties» dialog window enter a wavelength for the beginning and
the end of the detection band.
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�Click on the symbol for the color look-up table.

�Click on a color look-up table. For the first image recording it is recommendable to use
the «Glow (OU)» color look-up table.
& see the chapter "Setting instrument parameters for the first image recording“ (page
62)

Step 5
Click on the «Series» button and open the «Series Scan Overview» dialog window to
define begin point and end point of the spatial image series.
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Scan mode: xyz
(Hold the mouse pointer over the image)

Scan mode: xzy
�To set the begin point, move the yellow square to the desired z-position (xyz scan
mode) or y-position (xzy scan mode) and click the «Begin» check box.
�To set the end point, move the yellow square to the desired z-position (xyz scan
mode) or y-position (xzy scan mode) and click the «End» check box.
or

�Double-click on «Absolute Position», enter a position value and click the «Begin»
check box.
�Double-click on «Absolute Position», enter a position value and click the «End» check
box.
You can adjust many instrument parameters more quickly and conveniently by using the
control panel instead of the software buttons.
& see the chapter "Setting instrument parameters using the control panel“ (page 74)
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Relative z-positioning
If you use the electromotor-driven z-actuator and you have selected the «z-Wide» option
with the «z-Scan» button, you can set a relative z-position. The relative z-position is
calculated in reference to an «Upper Threshold» which has to be set in the software of
the microscope stand. Relative z-positioning is only available with microscope stands of
the following types: DM RXA, DM RXA2, DM IRE2 and DM LFSA (as well as with older
IRBE stands with EPROM version 2.40). The «Upper Threshold» and «Lower
Threshold» values are displayed in the «Series Overview» dialog window.

Step 6
Click on the «Sections» button and determine the number of recordings between begin
point and end point.

����Select one of the values in the list or «Others».

When you select «Others», the «Z/Y-Configuration» dialog window appears where you
can calculate the number of recordings «#» or the distance between the recordings
«Step size» depending on the total height of the image stack «Image dim.z».

�When you change the number of recordings and click on «Calculate» next to «#», the
step size is calculated with the priority of leaving the height of the image stack
unchanged.
�When you change the number of recordings and click on «Calculate» next to «Step
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size», the step size is calculated with the priority of leaving the number of recordings
unchanged.
�When you change the step size and click on «Calculate» next to «Step size», the
number of recordings is calculated with the priority of leaving the height of the image
stack unchanged.
�When you change the step size and click on «Calculate» next to «#», the number of
recordings is calculated with the priority of leaving the step size unchanged.

Step 7
Start the continuous scanning mode with the «Continuous» button to optimize image
quality during image recording.

�Set the focal plane (z-position), the detector parameters and the detection pinhole. For
more details, read steps 7 through 15 in the tutorial «Setting instrument parameters for
the first image recording» (page 62).
& see the chapter "Setting instrument parameters for the first image recording“ (page
62)

Step 8
Click on the «Series» button to start recording the spatial image series.

�To improve the signal-to-noise ratio click on the «Average» button. Define how often
the recording of an image is to be repeated. The average value is displayed in the result
image.

�To improve the signal-to-noise ratio click on the «Line Average» button. Define how
often the recording of a line is to be repeated. The average value is displayed in the
result image.

�Click on the «Gallery» button to display the single images in the Viewer window
already during image recording.

Note
It has a negative impact on the system performance when you record large image data
sets and use the «Gallery» function.

Step 9
For a statistical evaluation of the spatial image series click on the «Quantify» arrow
symbol and then, for example, on the «Profile» button.
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Clicking this button opens the «Profile» dialog window and displays a measurement
section on the image.

����The measurement section can be positioned anywhere on the image.
Step 10

In the «Profile» dialog window where an evaluation graph and various statistical data
are displayed, you have access to the following additional commands:

�Hold the mouse pointer over the diagram and click the right mouse button to open the
context menu.
�Select «Export» to save the evaluation data in an ASCII text file.
�Select «Send to» and «Document» to save a snapshot of the evaluation graph as a
new file in the currently active experiment.
�Select «Print» to print out the evaluation graph.
�Click on the «View» arrow symbol and the «Play» button to run the spatial image
series as a movie. Simultaneously, the evaluation graph and evaluation data of each
single image are displayed.

Step 11
An image of a detection channel or an overlay image can be created separately as a
new data block in the active experiment from several detection channels.
�Click on the image of the desired detection channel or on the overlay image.
�Hold the mouse pointer over the Viewer window and click the right mouse button to
open the context menu.
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�Choose «Selection (raw)» to save the image data of the selected image in a new file.
�Choose «Selection (snapshot)» to save a snapshot of the selected image in a new file.
�Choose «All (snapshot)» to save a snapshot of all images in the Viewer window in a
new file.

The new files are displayed in the «Experiment Overview» window where you have
access to the following commands in the context menu:

�Highlight a file of your choice and click the right mouse button to open the context
menu.
�Select «Activate» to display the image data of the file in the Viewer window.
�Select «New Window» to open the currently displayed recording in a second Viewer
window. This is useful, for example, when you want to visualize the same image data
with another color look-up table.
�Select «Delete» to remove the file from the list.
�Select «Rename» to give the file a new name.
�Select «Export» to save a recording in the *.avi file format.
�Select «Browse Images» to display all images of an experiment as thumbnails images
on the user interface.
�Select «Properties» to document important properties of the recording in a dialog
window.
�To move single files from one experiment to the other (drag and drop) click on the file,
keep the left mouse button pressed and drag the file to the target folder.
{tc "Recording Time Image Series"}

Recording Time Image Series
Step 1

Click on the «Acquire» arrow symbol and then on the «Mode» button to select the «xt»,
«xyt», «xzt» or «xyzt» scan mode.
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�Select the «xt» scan mode if you want to record a line at regular time intervals.
�Select the «xyt» scan mode if you want to record horizontal images (orthogonal to the
optical axis) at regular time intervals.
�Select the «xzt» scan mode if you want to record vertical images (parallel to the
optical axis) at regular time intervals.
�Select the «xyzt» scan mode if you want to record a stack of horizontal images
(orthogonal to the optical axis) at regular time intervals.

The selection of one of these scan modes automatically activates the «Time» button
which is required for configuring a time series.

Which scan modes are available?
The number of available scan modes depends on the selected z-actuator type. Click on
the «z-Scan» button to choose the z-actuator.

All scan modes are available when you use the galvanometer-driven z-specimen stage.
For this stage select the «z-Galvo» option in the list.
There are only the scan modes «xyz, xt, xyt, xyzt, xyλ , xyλ t and xyλz» available when
you use the electromotor-driven z-specimen stage (or the motorized objective nosepiece
with inverted microscopes). For this stage select the «z-Wide» option in the list.

Step 2
Click on the «Beam» button and open the «Beam Path Setting» dialog window to
choose the excitation wavelength and set the laser intensity.
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�Move the slider or double-click on the number and enter a value for the laser intensity.

Note
Using a predefined instrument parameter setting allows you to activate optimized
acquisition parameters with a single click. For details, see «Creating user-defined
instrument parameter settings (IPS)».
& see the chapter "Creating user-defined instrument parameter settings (IPS)“ (page
69)

Step 3
Select a suitable excitation beam splitter.

If your system is equipped with an acousto-optical beam splitter (AOBS), the beam path
is optimized automatically for the wavelength you selected.
Otherwise double-click on the green line and select a beam splitter:
�Select the dichroic RSP 500 for image recordings of FITC and GFP with an excitation
wavelength of 488 nm and a detection bandwidth of 500 to 600 nm.
�Select the dichroic RSP 465 for image recordings of CFP with an excitation
wavelength of 458 nm and a detection bandwidth of 465 to 525 nm.
�Select the double dichroic DD 488 / 543 for image recordings of FITC and TRITC or
GFP and DsRED with an excitation wavelength of 488 and 543 nm and a detection
bandwidth of 500 to 530 nm and 555 to 700 nm, respectively.
�Select the triple dichroic TD 488 / 543 / 633 for image recordings of FITC, TRITC and
CY5 with an excitation wavelength of 488, 543 and 633 nm and a detection bandwidth of
500 to 535 nm, 555 to 620 nm and 650 to 750 nm, respectively.
�Select the neutral filter RT 30/70 for recordings of reflected light.

Step 4
Select one or several «PMT» detection channels and set the fluorescence dye and
detection bandwidth.
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�Click on the list box of a detection channel and select the fluorescence dye you want
to use. The emission curve of the fluorescence dye is displayed in the spectrum.
�Position the slider below the emission curve.

Note on positioning the detection band
When recording fluorescence light, take care that you do not position the detection band
directly below the laser line, since thus reflected light will also be recorded. The distance
between laser line and detection band should be at least 5 nm in the blue spectral range
(excitation line 488 nm), 10 nm in the green spectral range (excitation line 543 nm) and
15 nm in the red spectral range (excitation line 633 nm). If the AOBS is used, the
distance to the laser line can be reduced further because this excitation beam splitter
suppresses reflected light much better than conventional beam splitters. However, this
requires that the refraction index of the specimen and the medium between coverslip
and objective is perfect.

�Double-click on the slider of the selected detection channel.
�In the «Range Properties» dialog window enter a wavelength for the beginning and
the end of the detection band.
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�Click on the symbol for the color look-up table.

�Click on a color look-up table. For the first image recording it is recommendable to use
the «Glow (OU)» color look-up table.
& see the chapter "Setting instrument parameters for the first image recording“ (page
62)

Step 5
Click on the «Time» button and set all parameters required for the time image series.

The different scan modes for a time image series also have different parameters that
have to be set.

Functioning of the «Time Configuration» dialog window
Each parameter can be calculated in reference to the other parameters. Click on the
parameter to be calculated. The corresponding entry field is grayed out. Now enter the
values for the other parameter. Click on «Apply» to calculate the parameter. Click on
«Reset» to display the most recently saved values.

When you choose the «xt» scan mode, the following parameters have to be set:
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�In the «Lines» field, enter the number of recordings of the line.

�Deselect the «Maximize» check box. In the «Lines per page» field, you can now enter
the number of lines to be recorded before the data is transferred to the computer. As
default setting a recording is carried out continuously until the memory of the scan head
can store no additional data.
�In the «Complete Time» field, enter the total time that you want the recording to take.

When you choose the «xyt» or «xzt» scan mode, the following parameters have to be
set:

�In the «Frames» field, enter the number of recordings of the image.
�In the «∆T» field, you define the time interval between the recording of two single
images. When you select the «Minimize» check box, the minimum interval is set, i.e. the
time needed for recording one single image (which depends on scan parameters such
as scan format or scan speed) plus a pause interval required for positioning the scan
mirror.
�In the «Complete Time» field, enter the total time that you want the recording to take.

When you choose the «xyzt» scan mode, the following parameters have to be set:
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�In the «Stacks» field, enter the number of recordings of the image stack.

�In the «∆T» field, you define the time interval between the recording of two image
stacks. When you select the «Minimize» check box, the minimum interval is set, i.e. the
time needed for recording one image stack (which depends on scan parameters such as
scan format or scan speed) plus a pause interval required for positioning the scan mirror.
�In the «Complete Time» field, enter the total time that you want the recording to take.

Step 6
Start the continuous scanning mode with the «Continuous» button to optimize image
quality during image recording.

�Set the focal plane (z-position), the detector parameters and the detection pinhole. For
more details, read steps 7 through 15 in the tutorial «Setting instrument parameters for
the first image recording».
& see the chapter "Setting instrument parameters for the first image recording“ (page
62)

Step 7
Click on the «Series» button to start recording the time image series.

�To improve the signal-to-noise ratio click on the «Average» button. Define how often
the recording of an image is to be repeated. The average value is displayed in the result
image.

�To improve the signal-to-noise ratio click on the «Line Average» button. Define how
often the recording of a line is to be repeated. The average value is displayed in the
result image.

Step 8
For a statistical evaluation of the time image series, click on the «Quantify» arrow
symbol and then, for example, on the «Histogram» button.
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When you click on this button, the «Histogram» dialog window opens and the ROI
buttons needed for the next steps are activated automatically.

Step 9
To draw a region of interest (ROI) on the image click, for example, on the «Wizard»
button and then on the «Polygon» button.

�In the image double-click on the structure which you want to evaluate. The structure is
automatically defined as a region of interest.
�Select other geometrical shapes with the «Ellipse» button or «Rectangle» button and
mark further regions of interest in the image.

�Deactivate the «Wizard» button, when you want to draw the regions of interest without
the aid of the wizard function.
�Using the «Select» button and the «Rotate» button, you can move, rotate and change
the size of the regions of interest. With the «Clear» button you remove all regions of
interest.

Step 10
In the «Histogram» dialog window where an evaluation graph and various statistical
data are displayed you have access to the following additional commands:
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�Hold the mouse pointer over the diagram and click the right mouse button to open the
context menu.
�Select «Export» to save the evaluation data in an ASCII text file.
�Select «Send to» and «Document» to save a snapshot of the evaluation graph as a
new file in the currently active experiment.
�Select «Print» to print out the evaluation graph.
�Click on the «View» arrow symbol and the «Play» button to run the time image series
as a movie. Simultaneously, the evaluation graph and evaluation data of each single
image are displayed.

Step 11
An image of a detection channel or an overlay image can be created separately as a
new data block in the active experiment from several detection channels.
�Click on the image of the desired detection channel or on the overlay image.
�Hold the mouse pointer over the Viewer window and click the right mouse button to
open the context menu.

�Choose «Selection (raw)» to save the image data of the selected image in a new file.
�Choose «Selection (snapshot)» to save a snapshot of the selected image in a new file.
�Choose «All (snapshot)» to save a snapshot of all images in the Viewer window in a
new file.

The new files are displayed in the «Experiment Overview» window where you have
access to the following commands in the context menu:
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�Highlight a file of your choice and click the right mouse button to open the context
menu.
�Select «Activate» to display the image data of the file in the Viewer window.
�Select «New Window» to open the currently displayed recording in a second Viewer
window. This is useful, for example, when you want to visualize the same image data
with another color look-up table.
�Select «Delete» to remove the file from the list.
�Select «Rename» to give the file a new name.
�Select «Export» to save a recording in the *.avi file format.
�Select «Browse Images» to display all images of an experiment as thumbnails images
on the user interface.
�Select «Properties» to document important properties of the recording in a dialog
window.
�To move single files from one experiment to the other (drag and drop) click on the file,
keep the left mouse button pressed and drag the file to the target folder.
{tc "Recording Lambda Series (Spectral Image Series)"}

Recording Lambda Series (Spectral Image Series)
Step 1

Click on the «Acquire» arrow symbol and on the «Mode» button to select the «xyλ»,
«xzλ» «xyλ t» or «xyλz» scan mode.
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�Select the «xyλ» scan mode if you want to record horizontal images (orthogonal to the
optical axis), each at a specific wavelength.
�Select the «xzλ» scan mode if you want to record vertical images (parallel to the
optical axis), each at a specific wavelength.
�Select the «xyλ t» scan mode to repeatedly record spectral time image series, i.e.
horizontal single images (orthogonal to the optic axis) at a certain wavelength and in
definable time intervals.
�Select the «xyλz» scan mode to record spatial image series, i.e. a stack of horizontal
single images (orthogonal to the optic axis) at a certain wavelength.

The selection of one of these scan modes automatically activates the buttons required
for configuring a lambda series:

Which scan modes are available?
The number of available scan modes depends on the selected z-actuator type. Click on
the «z-Scan» button to choose the z-actuator.

All scan modes are available when you use the galvanometer-driven z-specimen stage.
For this stage select the «z-Galvo» option in the list.
There are only the scan modes «xyz, xt, xyt, xyzt, xyλ , xyλ t and xyλz» available when
you use the electromotor-driven z-specimen stage (or the motorized objective nosepiece
with inverted microscopes). For this stage select the «z-Wide» option in the list.
Furthermore, the scan modes for recording a lambda series are only available if
only one detection channel is active.

Step 2
Click on the «Beam» button and open the «Beam Path Setting» dialog window to
choose the excitation wavelength and set the laser intensity.

�Move the slider or double-click on the number and enter a value for the laser intensity.

Note
Using a predefined instrument parameter setting allows you to activate optimized
acquisition parameters with a single click. For details, see «Creating user-defined
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instrument parameter settings (IPS)».
& see the chapter "Creating user-defined instrument parameter settings (IPS)“ (page
69)

Step 3
Select a suitable excitation beam splitter:

If your system is equipped with an acousto-optical beam splitter (AOBS), the beam path
is optimized automatically for the wavelength you selected.
Otherwise double-click on the green line and select the neutral filter «RT 30/70», which
is best suitable for lambda series.

Step 4
Select only one «PMT» detection channel and assign a color look-up table to it.

�Click on the symbol for the color look-up table.
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�Click on a color look-up table. For the first image recording it is recommendable to use
the «Glow (OU)» color look-up table.
& see the chapter "Setting instrument parameters for the first image recording“ (page
62)

Step 5
Define the detection bandwidth for the selected detection channel.

�Double-click on the slider of the selected detection channel.
�In the «Range Properties» dialog window enter a wavelength for the beginning and
the end of the detection band. The minimum possible detection bandwidth is 5 nm.

Step 6
Define the begin point and end point of the lambda series.
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and
�Move the slider to the desired position in the spectrum and click on the «Lambda
Begin» button to save the position as begin point.

and
�Move the slider to the desired position in the spectrum and click on the «Lambda End»
button to save the position as end point.

Step 7
Click on the «Lambda Steps» button and define the number of recordings.

The selected number of recordings will be carried out at uniform step widths within the
range delimited by the begin point and end point of the lambda series.

Step 8
Start the continuous scanning mode with the «Continuous» button to optimize image
quality during image recording.
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�Set the focal plane (z-position), the detector parameters and the detection pinhole. For
more details, read steps 7 through 15 in the tutorial «Setting instrument parameters for
the first image recording».
& see the chapter "Setting instrument parameters for the first image recording“ (page
62)

�If the «xyλ t» or «xyλz» scan mode is selected, additional parameters must be set for
the time image series or for the spatial image series. For more details, read the chapters
«Recording spatial image series» and «Recording time image series».�

& see the chapter "Recording spatial image series“ (page 78) and the chapter
"Recording time image series“ (page 86)

Step 9
Click on the «Series» button to start recording the lambda series.

�To improve the signal-to-noise ratio click on the «Average» button. Define how often
the recording of an image is to be repeated. The average value is displayed in the result
image.

�To improve the signal-to-noise ratio click on the «Line Average» button. Define how
often the recording of a line is to be repeated. The average value is displayed in the
result image.

�Click on the «Gallery» button to display the single images in the Viewer window
already during image recording.

Note
It has a negative impact on the system performance when you record large image data
sets and use the «Gallery» function.

Step 10
For a statistical evaluation of the lambda series, click on the «Quantify» arrow symbol
and then, for example, on the «Pr.(z)» button.

When you click on this button, the «Profile through Stack» dialog window opens and the
ROI buttons needed for the next steps are activated automatically.
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Step 11
To draw a region of interest (ROI) on the image click, for example, on the «Wizard»
button and then on the «Polygon» button.

�In the image double-click on the structure which you want to evaluate. The structure is
automatically defined as a region of interest.
�Select other geometrical shapes with the «Ellipse» button or «Rectangle» button and
mark further regions of interest in the image.

�Deactivate the «Wizard» button, when you want to draw the regions of interest without
the aid of the wizard function.
�Using the «Select» button and the «Rotate» button, you can move, rotate and change
the size of the regions of interest. With the «Clear» button you remove all regions of
interest.

Step 12
In the «Profile through Stack» dialog window where an evaluation graph and various
statistical data are displayed, you have access to the following additional commands:

�Hold the mouse pointer over the diagram and click the right mouse button to open the
context menu.
�Select «Export» to save the evaluation data in an ASCII text file.
�Select «Send to» and «Document» to save a snapshot of the evaluation graph as a
new file in the currently active experiment.
�Select «Print» to print out the evaluation graph.
�Click on the View arrow symbol and the «Play» button to run the lambda image series
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as a movie. Using a vertical subsidiary line, the evaluation graph and the corresponding
evaluation data of each single image are displayed at the same time.

Step 13
An image of a detection channel or an overlay image can be created separately as a
new data block in the active experiment from several detection channels.
�Click on the image of the desired detection channel or on the overlay image.
�Hold the mouse pointer over the Viewer window and click the right mouse button to
open the context menu.

�Choose «Selection (raw)» to save the image data of the selected image in a new file.
�Choose «Selection (snapshot)» to save a snapshot of the selected image in a new file.
�Choose «All (snapshot)» to save a snapshot of all images in the Viewer window in a
new file.

The new files are displayed in the «Experiment Overview» window where you have
access to the following commands in the context menu:

�Highlight a file of your choice and click the right mouse button to open the context
menu.
�Select «Activate» to display the image data of the file in the Viewer window.
�Select «New Window» to open the currently displayed recording in a second Viewer
window. This is useful, for example, when you want to visualize the same image data
with another color look-up table.
�Select «Delete» to remove the file from the list.
�Select «Rename» to give the file a new name.
�Select «Export» to save a recording in the *.avi file format.
�Select «Browse Images» to display all images of an experiment as thumbnails images
on the user interface.
�Select «Properties» to document important properties of the recording in a dialog
window.
�To move single files from one experiment to the other (drag and drop) click on the file,
keep the left mouse button pressed and drag the file to the target folder.
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{tc "Recording Sequential Image Series"}

Recording Sequential Image Series
Step 1

First, you have to set all parameters for the first recording method and save the settings
as an instrument parameter setting. For this purpose, click on the «Acquire» arrow
symbol and on the «Beam» button to open the «Beam Path Setting» dialog window.

Step 2
Choose the excitation wavelength and set the laser intensity.

�Move the slider or double-click on the number and enter a value for the laser intensity.

Step 3
Select a suitable excitation beam splitter.

If your system is equipped with an acousto-optical beam splitter (AOBS), the beam path
is optimized automatically for the wavelength you selected.
Otherwise double-click on the green line and select a beam splitter:
�Select the dichroic RSP 500 for image recordings of FITC and GFP with an excitation
wavelength of 488 nm and a detection bandwidth of 500 to 600 nm.
�Select the dichroic RSP 465 for image recordings of CFP with an excitation
wavelength of 458 nm and a detection bandwidth of 465 to 525 nm.
�Select the double dichroic DD 488 / 543 for image recordings of FITC and TRITC or
GFP and DsRED with an excitation wavelength of 488 and 543 nm and a detection
bandwidth of 500 to 530 nm and 555 to 700 nm, respectively.
�Select the triple dichroic TD 488 / 543 / 633 for image recordings of FITC, TRITC and
CY5 with an excitation wavelength of 488, 543 and 633 nm and a detection bandwidth of
500 to 535 nm, 555 to 620 nm and 650 to 750 nm, respectively.
�Select the neutral filter RT 30/70 for recordings of reflected light.

Step 4
Select a «PMT» detection channel and set fluorescence dye and detection bandwidth.
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�Click on the list box of a detection channel, for example «PMT2», and select the
fluorescence dye to be used, for example «TRITC». The emission curve of the
fluorescence dye is displayed in the spectrum.
�Position the slider below the emission curve.

Note on positioning the detection band
When recording fluorescence light, take care that you do not position the detection band
directly below the laser line, since thus reflected light will also be recorded. The distance
between laser line and detection band should be at least 5 nm in the blue spectral range
(excitation line 488 nm), 10 nm in the green spectral range (excitation line 543 nm) and
15 nm in the red spectral range (excitation line 633 nm). If the AOBS is used, the
distance to the laser line can be reduced further because this excitation beam splitter
suppresses reflected light much better than conventional beam splitters. However, this
requires that the refraction index of the specimen and the medium between coverslip
and objective is perfect.

�Double-click on the slider of the selected detection channel.
�In the «Range Properties» dialog window enter a wavelength for the beginning and
the end of the detection band.
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�Click on the symbol for the color look-up table.

�Click on a color look-up table. For the first image recording it is recommendable to use
the «Glow (OU)» color look-up table.
& see the chapter "Setting instrument parameters for the first image recording“ (page
62)

Step 5
Start the continuous scanning mode with the «Continuous» button to optimize image
quality during image recording.

�Set the focal plane (z-position), the detector parameters and the detection pinhole. For
more details, read steps 7 through 15 in the tutorial «Setting instrument parameters for
the first image recording».
& see the chapter "Setting instrument parameters for the first image recording“ (page
62)

Step 6
In the «Beam Path Setting» dialog window, click on the «Save» button to save the
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settings of the first recording method as an instrument parameter setting.

�Give the instrument parameter setting a name and click on OK.

The new instrument parameter setting appears in the list box below «U».
& see the chapter "Creating user-defined instrument parameter settings (IPS)“ (page
69)

Step 7
Next, all instrument parameters for the second recording method are set and saved as
an instrument parameter setting. Choose the excitation wavelength and set the laser
intensity.

�Move the slider or double-click on the number and enter a value for the laser intensity.

Step 8
Select a suitable excitation beam splitter.

�For a detailed description of the available beam splitters see step 3 in this tutorial.

Step 9
Select a «PMT» detection channel and set fluorescence dye and detection bandwidth.
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�Click on the list boxes of the detection channels, for example «PMT1» and «PMT3»,
and select the fluorescence dye to be used in each channel, for example «FITC» and
«CY5». The emission curves of the fluorescence dyes are displayed in the spectrum.
�Position the sliders below the respective emission curves.

�Double-click on the slider of the selected detection channel.
�In the «Range Properties» dialog window, enter a value for the beginning and the end
of the detection band.

����Click on the symbol for the color look-up table.
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����Click on the color look-up table you want to use and on «OK».
For the first image recording it is recommendable to use the «Glow (O&U)» color look-up
table.

Step 10
Start the continuous scanning mode with the «Continuous» button to optimize image
quality during image recording.

�Set the focal plane (z-position), the detector parameters and the detection pinhole. For
more details, read steps 7 through 15 in the tutorial «Setting instrument parameters for
the first image recording».
& see the chapter "Setting instrument parameters for the first image recording“ (page
62)

Step 11
In the «Beam Path Setting» dialog window, click on the «Save» button to save the
settings for the second recording method as an instrument parameter setting.

����Give the instrument parameter setting a name and click on OK.
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The new instrument parameter setting appears in the list box below «U».

Step 12
In the «Beam Path Setting» dialog window, click on the check box labeled «Sequential
Scan» in the bottom left corner.

The dialog elements needed for configuring a sequential image recording appear.

Step 13
In the «Beam Path Setting» dialog window, copy the instrument parameter settings into
the «Sequential scan settings» list box.

�Highlight the instrument parameter setting in the list box in the upper right corner of
the dialog window.

�Click on the «Add» button in the «Sequential scan settings» field in the lower left
corner of the dialog window.
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or
�Click on the instrument parameter setting, keep the left mouse button pressed and
move the IPS to the «Sequential scan settings» list box (drag and drop).
�Click on the «Remove» button to remove the instrument parameter setting from the
list.
�Click on the «Save» button to save the instrument parameter settings together as a
sequential recording method.

�Use the «Load» button to load this sequential recording method again.

Step 14
In the «Mode» list box, select one of the three sequential scan modes. This selection
defines when the sequential recording methods are changed.

�Select «between lines» if you want to change the sequential recording method after a
line has been recorded.
�Select «between frames» if you want to change the sequential recording method after
an image has been recorded.
�Select «between stacks» if you want to change the sequential recording method after
an image stack has been recorded.

Step 15
In the «Parameter» list box, check the parameters which will be used for the recording
of all sequential recording methods.
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�Click on the check box of the desired parameters.

Step 16
Next, adjust all other instrument parameters which differ depending on the type of
recording: spatial image series, time image series or spectral image series.

Step 17
Click on the «Series» button or on the «Single Scan» button to start the sequential
image recording.

�If you have selected the sequential mode «between lines», you can also use the
«Continuous» button to start the sequential recording. The advantage of the continuous
scanning mode is that you can modify many parameters during image recording.

�Click on the «Gallery» button to display the single images in the Viewer window
already during image recording.

Step 18
An image of a detection channel or an overlay image can be created separately as a
new data block in the active experiment from several detection channels.
�Click on the image of the desired detection channel or on the overlay image.
�Hold the mouse pointer over the Viewer window and click the right mouse button to
open the context menu.

�Choose «Selection (raw)» to save the image data of the selected image in a new file.
�Choose «Selection (snapshot)» to save a snapshot of the selected image in a new file.
�Choose «All (snapshot)» to save a snapshot of all images in the Viewer window in a
new file.

The new files are displayed in the «Experiment Overview» window where you have
access to the following commands in the context menu:
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�Highlight a file of your choice and click the right mouse button to open the context
menu.
�Select «Activate» to display the image data of the file in the Viewer window.
�Select «New Window» to open the currently displayed recording in a second Viewer
window. This is useful, for example, when you want to visualize the same image data
with another color look-up table.
�Select «Delete» to remove the file from the list.
�Select «Rename» to give the file a new name.
�Select «Export» to save a recording in the *.avi file format.
�Select «Browse Images» to display all images of an experiment as thumbnails images
on the user interface.
�Select «Properties» to document important properties of the recording in a dialog
window.
�To move single files from one experiment to the other (drag and drop) click on the file,
keep the left mouse button pressed and drag the file to the target folder.

{tc "Recording Images of Regions of Interest (ROI Scanning)"}

Recording Images of Regions of Interest (ROI Scanning)
Step 1

The first step is to optimize the instrument parameters for the recording of the overall
image. To do this during image recording, click on the «Continuous» button to start the
continuous scanning mode.

�Set the focal plane (z-position), the detector parameters and the detection pinhole. For
more details, read steps 7 through 15 in the tutorial «Setting instrument parameters for
the first image recording».
& see the chapter "Setting instrument parameters for the first image recording“ (page
62)

Step 2
Click on the «Acquire» arrow symbol and then on the «Beam» button to open the
«Beam Path Setting» dialog window.

�Select the excitation wavelength and set the laser intensity for the image background
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(overall image).

�Move the slider or double-click on the number and enter a value for the laser intensity.
To obtain a black background, set all excitation wavelengths to 0 %.

Step 3
Click on the «ROI» button to save the laser setting for the image background.

When you click on this button, the ROI buttons needed for the next steps are activated
automatically.

�If you do not find the «ROI» button in the «Acquire» button bar of the user interface,
select Tools -> Customize -> Commands -> Category Basic Scan.

�Click on the «ROI» button, keep the left mouse button pressed and drag it onto the
user interface.
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Step 4
Choose the excitation wavelength and set the laser intensity for the region of interest
(ROI) which will be defined in the next step.

�Move the slider or double-click on the number and enter a value for the laser intensity.

Note
Several laser lines can be used for excitation of a region of interest (ROI). However, only
one intensity value can be set for each laser line, which is used for all region of interests.

Step 5
To draw the first region of interest on the overall image, click on the «Quantify» arrow
symbol and then, for example, on the «Wizard» button and the «Polygon» button.

�In the image double-click on a structure of your choice to be defined as region of
interest. The structure is automatically defined as a region of interest.
�Using the «Select» button and the «Rotate» button, you can move, rotate and change
the size of the regions of interest. With the «Clear» button you remove all regions of
interest.

Step 6
Choose the excitation wavelength and set the laser intensity for a second region of
interest.

����Move the slider or double-click on the number and enter a value for the laser intensity.

Note
Several laser lines can be used for excitation of a region of interest (ROI). However, only
one intensity value can be set for each laser line, which is used for all region of interests.

Step 7
To draw the second region of interest onto the image, click on the «Quantify» arrow
symbol and then, for example, on the «Ellipse» button.
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�Deactivate the «Wizard» button, when you want to draw the regions of interest without
the aid of the wizard function.
�Using the «Select» button and the «Rotate» button, you can move, rotate and change
the size of the regions of interest. With the «Clear» button you remove all regions of
interest.

Step 8
Repeat the procedure described in steps 4 through 7 of this tutorial for any additional
region of interest to be defined in the image.

Step 9
Then click on the «Configuration» button to get an overview of the defined regions of
interest and the laser lines assigned to them.

�Here you can modify the assignment of laser line and region of interest, if required.

Step 10
Click on the «Series» button to start the image recording.

�To improve the signal-to-noise ratio click on the «Average» button. Define how often
the recording of an image is to be repeated. The average value is displayed in the result
image.

�To improve the signal-to-noise ratio click on the «Line Average» button. Define how
often the recording of a line is to be repeated. The average value is displayed in the
result image.

�Click on the «Gallery» button to display the single images in the Viewer window
already during image recording.

Step 11
An image of a detection channel or an overlay image can be created separately as a
new data block in the active experiment from several detection channels.
�Click on the image of the desired detection channel or on the overlay image.
�Hold the mouse pointer over the Viewer window and click the right mouse button to
open the context menu.
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�Choose «Selection (raw)» to save the image data of the selected image in a new file.
�Choose «Selection (snapshot)» to save a snapshot of the selected image in a new file.
�Choose «All (snapshot)» to save a snapshot of all images in the Viewer window in a
new file.

The new files are displayed in the «Experiment Overview» window where you have
access to the following commands in the context menu:

�Highlight a file of your choice and click the right mouse button to open the context
menu.
�Select «Activate» to display the image data of the file in the Viewer window.
�Select «New Window» to open the currently displayed recording in a second Viewer
window. This is useful, for example, when you want to visualize the same image data
with another color look-up table.
�Select «Delete» to remove the file from the list.
�Select «Rename» to give the file a new name.
�Select «Export» to save a recording in the *.avi file format.
�Select «Browse Images» to display all images of an experiment as thumbnails images
on the user interface.
�Select «Properties» to document important properties of the recording in a dialog
window.
�To move single files from one experiment to the other (drag and drop) click on the file,
keep the left mouse button pressed and drag the file to the target folder.
{tc "Linking Single Images or Image Series"}

Linking Single Images or Image Series
Step 1

Click on the «Process» arrow symbol and then on the «Editing» tile and the «Merging»
tile.
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or

�At the bottom left of the user interface in the navigation window, select «Image

Processing → Editing → Merging».

Step 2
In the «Experiment Overview» display window, select the first image data set by
double-clicking it:

�The active image data set is marked by a red check mark

Step 3
In the «Second Source Image» list field, select the second image data set.

����If the «Use Selected Image» button is clicked, the image data set selected in the
«Experiment Overview» display window is used.

Step 4
Check the bit depth of both image data sets to be linked on the «Amplitude» tab.

Black resulting images during linking
If image data sets are linked that feature different bit depths (8 bit or 12 bit), the reported
different resolutions can lead to dark or black images. This dynamic loss can be avoided
by standardizing the bit resolution to a common level.
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�Select the bit depth in the «Result» field for the new image data set: either «8 Bit» or
«12 Bit».
�To overlay images, select «Maximum Value» or «Average Value» in the «Result» field
to determine whether the maximum value or the average value of both image data sets
is displayed in the resulting image. If the images are only linked together using the
«Append» function (see the description below), this selection is irrelevant.

�In addition, manually correct the bit information of the image data set, which should be
adapted to the bit depth of the other image data set, in the input field.

Linking detection channels of two image data sets
Step 1

To link together the detection channels of two image data sets in a new image data set,
simply select the «Append» check box on the «ch» tab.
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�The detection channels of the second image data set («Image 2») are inserted behind
the detection channel of the first image data set («Image 1»):

Image data set 1 («Image 1»)

+

Image data set 2 («Image 2»)

=

New image data set

Step 2
To overlay the detection channels of two image data sets in a new image data set,
define the position that each respective image data set should occupy in the resulting
image in the «Start» input field on the «ch» tab.

�The detection channels of the first image data set («Image 1») are inserted in the new
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image data set beginning with the second position, while the detection channels of the
second image data set («Image 2») are inserted beginning with the first position:

Image data set 1 («Image 1»)

+

Image data set 2 («Image 2»)

=

New image data set

Linking two single images or image series
Step 1

To horizontally link together two single images or image series, simply select the
«Append» check box on the «x» tab.

+ =

Step 2
To vertically link together two single images or image series, simply select the «Append»
check box on the «y» tab.
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+ =

Step 3
To link together two single images or image series to one series, simply select the
«Append» check box on the «z» tab.

+ =

Reducing images and integrating them in a second image series
Step 1

Correct the dimensions of the image data set to be reduced on the «x» tab and the «y»
tab.
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����

����In the Size field, enter the new value for the image width.

����In the Size field, enter the new value for the image length.

Step 2
On the «x» tab and the «y» tab, define the position that the reduced image should have
in the resulting image.

����
The upper left corner of the image is the reference point.
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����In the Shift field, enter the new x-coordinate of the reference point.

����In the Shift field, enter the new y-coordinate of the reference point.

+ =
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Separating Single Images or Image Series
Step 1

Click on the «Process» arrow symbol and then on the «Editing» tile and the
«Separation» tile.

or

�At the bottom left of the user interface in the navigation window, select «Image
Processing →→→→ Editing →→→→ Separation».

Step 2
In the «Experiment Overview» display window, select the desired image data set by
double-clicking it:

�The active image data set is marked by a red check mark.

Step 3
To cut out all images of a detection channel from an image data set, activate the check
box of the respective channel in the «ch» field and deactivate the others.
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Step 4
To cut out individual images of an image series, select the respective images in the
«Start z» and «End z» input fields.

����Image 2 through image 4 are cut out in all detection channels.



Leica Microsystems Heidelberg GmbH
LCS software functions:

Description of individual functions

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 126 of 307

����Image 2 through image 4 are cut out in detection channel 1 only.

Step 5
For example, if every second image should be cut in all detection channels of an image
data set, enter the value «2» in the «Step z» input field.

Step 6
To reduce the Format of an image enter, for example, the value «2» in the «Step x» and
«Step y» input fields.
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����Every second pixel of the images is cut. The image format of the resulting image is
reduced to 256 x 256.

Step 7
To cut a section of an image, define length and width of the section in the «Start x» and
«End x» as well as «Start y» and «End y» input fields.
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General

Introduction to the Leica Confocal Software Help

Three different help levels are available:

Quick Help
When you let the mouse pointer hover over a Leica Confocal Software button, a brief explanation of
the function of this button is displayed. This so-called Help Banner automatically disappears when the
mouse pointer is moved.

Context-sensitive Help
If you want to use the context-sensitive help function, click on the Help button:

The entire user interface is then frozen and a question mark appears beside the mouse pointer. Then,
instead of triggering the button function, clicking a button opens an explanation of the button's
function. If the Help button is not present on the user interface:

� Select the Customize option from the Tools menu. Here you will find all buttons arranged by
categories.

� The Help button can be found in the File category.
� Click on it using the left mouse button and drag it to the desired window.

Contents of the Online Help
Select the Contents option from the Help menu to view the online help table of contents. which allows
you to select any function in order to view information on it.

Keyword Search (Index)
Select the Index option from the Help menu to view an index of key words. Select a key word. View
the corresponding content pages by double-clicking the key word or selecting it and then clicking the
Display button.

Full-text Boolean Search
Select the Search option from the Help menu to launch the full-text search engine. Enter your search
word in the input field. Click on the triangle to the right of the input field to view the available logical
operators. Select the desired operator. Enter the second search word you would like to associate with
the first search word behind the operator:

Examples Result
Pinhole AND
Sections

This phrase finds help topics containing both the word "pinhole" and the word
"sections".

Pinhole OR
Sections

This phrase finds help topics containing either the word "pinhole" or the word
"sections" or both.

Pinhole NEAR
Sections

This phrase finds help topics containing the word "pinhole" and the word "sections"
if they are located within a specific search radius. This method also looks for words
that are similar in spelling to the words specified in the phrase.

Pinhole NOT
Sections

This phrase finds help topics containing the word "pinhole" and not containing the
word "sections".

Favorites
If you select Favorites in the dialog window of the online help tab, you can include the current help
topic in a list, making them easily available for future use.



Leica Microsystems Heidelberg GmbH
LCS software functions:

Description of individual functions

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 129 of 307

Opening the Context-Sensitive Help

Function
Click Help to open the context-sensitive online help function, which provides you with short
explanations for the various buttons and functions of the Leica Confocal Software.

� Click on the Help button.
� A question mark appears next to the mouse pointer. This temporarily disables the functions of all

buttons.
� Use the mouse pointer to click the button that you want an explanation of.
� Online help opens directly to the description for the corresponding button.

Online help also provides you with an index of key words and a search function so that you can
search for specific topics and buttons. Furthermore, you can print the individual descriptions.

You can also open the online help by selecting Contents, Search or Index option under the Help
menu.



Leica Microsystems Heidelberg GmbH
LCS software functions:

Description of individual functions

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 130 of 307

Data Recording Functions

Setting the Beam Path

Function
Open the Beam Path Setting dialog window using the Beam button, and set up the beam path and the
detectors with the corresponding color look-up tables used to record the image.

Selecting the excitation wavelength
Above the spectrum in the dialog window you will find boxes to set the excitation wavelength using an
AOTF:

� Click on the check box next to the laser name to activate the laser.
� Set the output for the laser line by moving the slider on the corresponding scale to the desired

value, or
� Double click the percentage value for the laser output. This opens a second dialog window

where you can enter an exact value.
� The active laser line is shown as a line in the spectrum.

Loading and saving parameter settings
Also above the spectrum is a list box for loading and saving parameter settings. The manufacturer
has predefined parameter settings for the most important fluorescent dyes. They are labeled with the
letter L (for Leica) and can be loaded only, not modified.

You can also save the settings made for a specific image recording as user-defined parameter
configuration so that you can load them any time with a single click:

� Click on the Save button.
� This opens a dialog window for entering a name for the parameter configuration.
� The parameter configuration is stored in the list box under User and is labeled with the letter U

(for User).

Furthermore, you can individually select the parameters that you want to save using the Save
command:

� Select the Settings option from the Tools menu.
� In the Settings dialog window, click the Instrument Parameters tab.
� Select individual parameters by clicking the corresponding check boxes. The Select all and

Deselect all buttons allow you to select all or no parameters quickly.

Click one of the user-defined or preset parameter configurations and then press the right mouse
button to open a context menu which contains the following commands:

Command Function
Set as default setting The standard setting for the parameters is loaded when you start the

software.
Remove default
setting

This removes the default setting property from the selected configuration.

Load Loads the parameter configuration.
Rename (only for U) Use this to change the name of the parameter configuration.
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Delete (only for U) Deletes the parameter configuration.

Selecting the excitation beam splitter
The excitation beam splitter directs the excitation light of the laser to the specimen and separates the
fluorescence light and reflected excitation light returned from the specimen.

If the confocal system is equipped with an AOBS (Acousto-Optical Beam Splitter), the AOBS is
automatically adjusted after selecting one or several laser lines so that fluorescence light is
transmitted at its maximum and the reflection light is suppressed at its maximum.

& see Adjusting the Acousto-Optical Beam Splitter (AOBS) (page 131)

If the confocal system is equipped with conventional excitation beam splitters, a suitable filter must be
selected for the corresponding application. The symbol (green, tilted line) for the excitation beam
splitter is located to the left of the spectrum. Click on the symbol and select the desired beam splitter:

� Neutral filters, such as the RT 30/70 filter, are used in reflection applications to lead the
excitation light to the sample and the reflected light to the detection pin hole.

� Dichroic filters, such as the reflection short pass filter RSP 510, are used in fluorescence
applications to split and detect fluorescent light of a particular wavelength range from the
excitation light.

� Double dichroic filters are used for image recording, where the preparation is marked with two
fluorescent dyes and two excitation wavelengths. The DD 488 / 568 double dichroic, for
instance, is used to split excitation light with a 488 nm and 568 nm wavelength from the
detection light. Depending on the system configuration, you can also select DD 488 / 543 and
DD 458 / 514 type double dichroites.

� Triple dichroic filters are used for image recording, if the preparation is marked with three
fluorescent dyes and three excitation wavelengths. The TD 488 / 568 / 633 triple dichroic, for
instance, is used to split excitation light with a 488 nm, 568 nm, and 633 nm wavelength from the
detection light. Depending on the system configuration, you can also select TD 488 / 568 / 647
and TD 488 / 543 / 633 type triple dichroites.

Setting detectors and color look-up tables (LUT)
Below the spectrum in the dialog window the boxes for the four detectors, PMT 1 to 4, as well as for
the PMT Trans transmitted light detector are shown. Adjust the settings as follows:

� Activate each of the desired detectors by clicking on its corresponding Active check box below
the color look-up table icon. A cast shadow now links the activated detector to the corresponding
slide bar on the scale of the spectrum.

� Specify the wavelength range for the detection by dragging the two ends of the slider to the
desired positions on the scale, or

� Double-click the slider bar to open an additional dialog window in which you can enter a precise
value for the begin point and the end point of the wavelength range.

� For fluorescence applications, list fields with common fluorescence dyes have been set up for
each detector. Select the desired fluorescence dye to display its emission curve in the spectrum.

� Select a color look-up table by clicking on the corresponding icon.

& see Selecting Color Look-Up Tables (page 185)

Adjusting the Acousto-Optical Beam Splitter (AOBS) (optional)

This page contains the following topics
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� Function of the acousto-optical beam splitter
� Use of the AOBS with fluorescence recordings
� Use of the AOBS for mixed reflection / fluorescence recordings

Function
The Acousto-Optical Beam Splitter (AOBS) directs the excitation light of the laser onto the specimen
and separates the fluorescence light returned from the specimen and the reflected excitation light. In
Leica confocal microscopes, the AOBS replaces and optimizes conventional excitation filters, such as
double dichroite or triple dichroite.

The AOBS is a transparent optical crystal to which an ultrasonic field is applied. Light, which
penetrates the optical crystal, is deflected depending on its wavelength and the wavelength of the
ultrasonic field. By modulating the ultrasonic amplitude, the AOBS can be used not only to select a
laser line, but also to control the amount of light as well as the beam splitter ratio of excitation and
detection light for the selected laser line. The AOBS allows the simultaneous use of up to 8 excitation
wavelengths.

Use of the AOBS with fluorescence recordings

� The standard setting is specified to fluorescence recordings with up to 4 excitation wavelengths.
As soon as you activate a laser line with the slider in the Beam Path Setting dialog, the AOBS is
automatically set so that the excitation light is optimally deflected to the specimen. For
fluorescence light, the AOBS is transparent, independent of the slider. The slider in the AOBS
dialog is set to 100%.
& see Setting the Beam Path (page 130)

� The two check boxes Enhanced Dynamics and Ultra-High Dynamics are activated as standard
setting. This double dynamic setting ensures that reflection light, which returns through the beam
path in reverse direction, is removed from the optical axis and, therefore, not detected.
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� If more than 4 excitation wavelengths are used, the double dynamic setting is no longer
applicable for all laser lines. In this case, the improved dynamic (Enhanced Dynamics check
box) for the laser line with the shortest wavelength is automatically switched off. With each
additional excitation wavelength, the improved dynamic is deactivated for an additional laser
line.

Use of the AOBS for mixed fluorescence / reflection recordings

� If reflection light is to be recorded, too, it is usually sufficient to vary the portion of the reflection
light by using the slider.

� If this is not sufficient, click the Maximum detection of reflected light button. The corresponding
slider is automatically set to 50% and the improved dynamic (Enhanced Dynamics check box) is
switched off.

� For true reflection light recordings, additionally deactivating the Ultra High Dynamics check box
allows for increasing the reflection light for all laser lines to the maximum value.
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Selecting an Objective

Function
Click on the Objective button to open a list of objectives and make an appropriate selection. This list
contains only the objectives that were previously assigned to one of the maximum of seven threaded
ports on the objective nosepiece. You can assign objectives as follows:

� Select the Objectives option from the Tools menu. A dialog window opens containing an
extensive list of objectives and the symbolic representation of the slots on the objective
nosepiece.

� Find in the list the objective that you are using and select it with the mouse. Click and hold the
left mouse button and drag the objective onto the symbol representing the slot in which the
objective is installed.

� The assignment is saved in the software and the objective appears in the selection list, which
you can open by pressing the Objective button.

� Repeat this procedure for every objective that you have installed in the objective revolver.

You can use the Add, Remove and Edit buttons in this dialog window to add new objectives, remove
objectives or edit existing objective labels.

The microscope models DM RXA, DM RXE, DM IRBE, and DM IRBE2 use a software

program to control the objective nosepiece. The program automatically rotates the

selected objective into the beam path whenever you select an objective by using the

button or Objective dialog window. All other microscope models require not only

software adjustment of the objective, but also manual rotation of the objective into the

beam path.

Additional information
When selecting the correct objective for a specific application, the objective's correction class
(achromatic, apochromatic, fluorite objectives and plane objectives) and especially the magnification
factor and the numerical aperture are of great significance. The numerical aperture determines the
resolution capacity of an objective and is deduced from the flare angle of the light cone recorded by
the objective and the refraction index of the medium between objective and specimen: NA = n*sin α

Objectives with greater magnification generally have larger numerical apertures but smaller entrance
pupils and therefore can record light only from a relatively small scan field. Objectives with larger
apertures permit higher resolutions but allow less free working distance. The following table illustrates
this relationship:

Objective Resolution
(xy)

Resolution
Air (z)

Resolution
Water (z)

Resolution
Oil (z)

Scan field size (xy)

HC PL FLUOTAR 5x 0.15 1301 19410 25879 29559 3000
HC PL FLUOTAR 10x 0.30 651 4768 6407 7335 1500
N PLAN 20x 0.40 488 2630 3566 4093 750
N PLAN 50x 0.75 260 649 948 1108 300
PL APO 100x 1.40 139 319 209 236 150

Values in nm at wavelength λ 488 nm Values in µm

Typical Applications
Material scientists commonly use dry objectives to study surface structures. Immersion Objectives are
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the best choice for producing images of layered structures in which material layers with varying
refraction indexes come into contact with each other. When working with biological specimens, the
choice between an oil immersion objective and water immersion objective depends on the specimen
itself and its embedding medium. You will achieve the best resolution when the refraction indexes of
the embedding medium and/or the specimen are matched to the refraction index of the objective
medium.

Operating Modules of the Microscope Stand Via Software

This page contains the following topics
� Function of the Microscope Control button
� Adjusting modules of the DM IRE2 microscope stand
� Adjusting modules of the DM RXA2 microscope stand

Function of the Microscope Control button
This function is available only with automatic microscope stands DM RXA2 and DM IRE2.
It offers the possibility to adjust several modules of the microscope stands DM RXA2 or DM IRE2 via
Leica Confocal Software by clicking on the visual mode or the scan mode. In the visual mode, the
specimen is viewed through the eyepieces; in the scan mode, the specimen is recorded using the
laser scanning method. The modules, which are simultaneously controlled by the software, are the
tube with the photo exits, the fluorescence filter block and the tube optics.

Adjusting modules of the DM IRE2 microscope stand
� To adjust the microscope stand to view the specimen through the eyepieces, click on the

Microscope Control button and select the Visual option.
� To adjust the microscope stand for image recording using the laser scanning method, click on

the Microscope Control button and select the Scan option.
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Front operating panel of the DM IRE2 microscope stand Front operating panel of the DM IRE2 microscope stand
� The light is directed to the front exit (the eyepieces).

The VIS diode illuminates.
� The light is directed to the lateral photo exit. The SIDE

diode illuminates.
� The shutter opens: The Shutter Closed diode

extinguishes.
� The shutter closes: The Shutter Closed diode

illuminates.
� The filter cube of the fluorescence module last saved

is selected here. The settings of the fluorescence
module are saved while changing from the visual
mode to the scan mode.

� Position 4 (Scan) of the fluorescence module is set,
and the display shows: — —.

� Tube optics 1x is selected, and the MAG 1x diode
illuminates.

� Tube optics 1x is selected, and the MAG 1x diode
illuminates.
With UV microscope systems, the UV optics is
selected, and the MAG UV diode illuminates.

When the microscope stand is switched on, neither the visual mode nor the scan mode

is set.The light path is directed to the front exit, while the shutter is closed at the same

time for safety reasons.You can leave this «undefined status», for example, by

selecting the visual mode using the Visual option.

Adjusting modules of the DM RXA2 microscope stand
� To adjust the microscope stand to view the specimen through the eyepieces, click on the

Microscope Control button and select the Visual option.
� To adjust the microscope stand for image recording using the laser scanning method, click on the

Microscope Control button and select the Scan option.
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� The light is directed to the front exit (the eyepieces). The VIS
diode illuminates.

� The light is directed to the rear photo exit. The
REAR diode illuminates.

� The shutter opens: The Shutter Closed diode extinguishes. � The shutter closes: The Shutter Closed diode
illuminates.

� The filter cube of the fluorescence module last selected is
selected here. The settings of the fluorescence module are
saved while changing from the visual mode to the scan
mode.

� Position 8 (Scan) of the fluorescence module is set,
and the display shows: — —.

� Tube optics 1x is selected, and the MAG 1x diode
illuminates.

� Tube optics 1x is selected, and the MAG 1x diode
illuminates.
With UV microscope systems, the UV optics is
selected, and the MAG UV diode illuminates.
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When the microscope stand is switched on, neither the visual mode nor the scan mode

is set.The light path is directed to the front exit, while the shutter is closed at the same

time for safety reasons. You can leave this «undefined status», for example, by

selecting the visual mode using the Visual option.

Setting the Detectors

Function
Use the Signal button to open a dialog window for adjusting the detectors so that the entire range of
intensities of a color look-up table is assigned and displayed in the image. For this purpose, a Gain
value and an Offset value can be set for each detector. The gain value modifies the amplification of
the detected signal, thus changing the brightness and contrast of the image. The offset value defines
a threshold value. Only those signals that lie above the threshold value are detected and displayed in
the image.

There are two methods for setting the gain and offset values:

� Use the mouse to move the slide on the scale. The corresponding value is shown below the
corresponding scale.

� Double-click the numerical value that is displayed below the scale. This opens a second dialog
window where you can enter an exact value.

Best suited to optimization of gain value and offset value are the color look-up tables Glow Over, Glow
Under and Glow Over and Under.

& see Selecting Color Look-Up Tables (page 185)

You can also set the gain value and offset value of the detectors using the corresponding radio
buttons of the control panel.

& see Controlling Functions using the Control Panel (page 245)

A detector is not enabled unless its corresponding Active check box is checked in the

Signal or Beam Path Setting dialog windows.
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The Electronic Zoom

Function
In confocal microscopy, the magnification of an image is determined both by the objective and the
electronic zoom. The objective generates a first image whose magnification is based on the
objective's magnification factor. Additional magnification is provided by the electronic zoom. A zoom
factor of 1 scans the maximum scan field size with a specific number of dots. If the zoom factor is set
to 2, the same number of dots is used to scan a scan field with half the page length of the maximum
scan field (1/4 the original scan field). This achieves stronger magnification and thus better image
resolution too, because a smaller scan field is scanned with the same frequency, which results in a
higher density of data.

In the dialog window that was opened by pressing the Zoom button, you can select one of the preset
zoom factors. If you click on the Others button, you can set a different zoom factor in two ways:

� Use the mouse to move the slide of the scale. The corresponding value is shown in the middle of
the dialog window.

� Double-click the boldface numerical value located in the middle of the dialog window. This opens
a second dialog window where you can enter an exact value.

You can also set the zoom factor using the corresponding rotary knob on the control panel.

& see Controlling Functions using the Control Panel (page 245)

Additional information
While zoom factors from 1 to 32 can be set, the useful magnification of the electronic zoom can not be
increased infinitely. The limit is achieved using the smallest optically resolvable distance, which is
determined by the resolution capacity of the objective. According to the Nyquist theorem, this smallest
optically resolvable distance can only be mapped without information loss if it is scanned with about 2
to 3 raster points. If the scan frequency is exceeded at a relatively high zoom factor and the specified
scan format, further magnification is no longer useful because no more optical details can be resolved
(zero-order magnification).

& see Selecting a Scan Format (page 142)
& see Selecting an Objective (page 134)

With bleach-sensitive specimens it is advisable to restrict the use of the electronic zoom

to short time intervals. Since you are recording a segment of the specimen with a

relatively higher scan frequency in the case of high zoom factors, the specimen is

exposed to a stronger impact of light. This can lead to photomechanical destruction of

the specimen (optical bleaching).

Optimal Zoom Factors
The following table shows which zoom factors (marked red)—depending on the scan field size and
scan format specified by the objective—can be used to scan the specimen without loss of data:

Scan Zoom Scan field Scan Resolution/ Scan
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Objective format factors size (µµµµm) Frequency
(nm)

Frequency

Magnification Numerical
Aperture

Resolution
at λλλλ 488
nm

20 0.6 325 1024 x
1024

1
2
4
6

750
375
187
125

732
366
183
122

0.4
0.8
1.8
2.7

512 x 512 1
2
4
8
10

750
375
187
94
75

1465
732
365
183
146

0.2
0.4
0.9
1.8
2.2

200 x 200 1
2
4
8
16
32

750
375
187
94
47
23

3750
1875
935
470
235
115

0.1
0.2
0.3
0.7
1.4
2.8

40 1.25 156 1024 x
1024

1
2
4
6

375
187
94
62

366
183
92
60

0.4
0.8
1.7
2.6

512 x 512 1
2
4
8
10

375
187
94
47
37

732
365
183
92
72

0.2
0.4
0.8
1.7
2.2

200 x 200 1
2
4
8
16
32

375
187
94
47
23
12

1875
935
470
235
115
60

0.1
0.2
0.3
0.7
1.3
2.6

100 1.4 139 1024 x
1024

1
2
3

150
75
50

146
73
49

0.9
1.9
2.8

512 x 512 1
2
4
6

150
75
37
25

293
146
72
49

0.5
0.9
1.9
2.8

200 x 200 1
2
4
8
12

150
75
37
18
12

750
375
185
90
60

0.2
0.4
0.7
1.5
2.3

The specified scan field sizes apply only to the DM Rxx and DM IRxx microscope

stands. The values of the scan field sizes must be multiplied by 0.8 for the DM LFxx

microscope series. The Leica Confocal Software features three distinguishing zoom

functions: electronic zoom, 3D zoom and graphic zoom.

& see Zooming the 3D View (page 202)
& see Viewer Options Dialog Window, Display Icon (page 176)

Enlarged Recording of a Frame
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Function
The Zoom In function enables an enlarged recording of a freely selectable square frame of a
specimen.

� Click on the Zoom In button. At the same time, the Rectangle button is automatically activated.
 
& see Defining the Region of Interest (ROI) as a Rectangle (page 234)

� Specify the frame to be enlarged by drawing a rectangular evaluation area (region of interest or
ROI) into the image using the Rectangle button.
 
& see Selecting and Moving the Region of Interest (page 236)

� Use the Select button to move the frame on the image.
� To start the image recording, press the Continuous Scan, Series Scan or Single Scan button.

The software automatically adapts the freely selected rectangular frame to the actual

square form that can be implemented by the scanner. The dashed line shows the actual

frame.

Additional information
The enlarging recording of a frame will only provide additional detailed information as long as the
distance of the grid points remains larger than half the optical resolution. On the other hand, the
resolution depends on the objective used, the adjusted scanning format, and the light wavelength
used (empty magnification).

Typical Applications
All applications that deal with the optical resolution of very small structures and that can do without an
overview image. While recording such specimens, care should be taken that an objective with a
corresponding high optical resolution is used for image recording.

Setting the Detection Pinhole

Function
Clicking the Pinhole button opens a dialog window that you can use to set the diameter of the
detection pinhole. In the upper right list field in the dialog window, select the units for displaying the
diameter. You can select from µm, Airy units and digital values. There are two ways of specifying a
value for the diameter:

� Use the mouse to move the slide on the scale that is displayed on the left in the dialog window.
The corresponding value is shown in the middle of the dialog window.

� Double-click the boldface numerical value located in the middle of the dialog window. This opens
a second dialog window where you can enter an exact value.

The diameter of the detection pinhole must be set to the currently used objective at all times. If you
click the Airy 1 button, the detection pinhole is set automatically to the optimum value of 1 Airy unit
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depending on the objective in use.

In addition to the numerical aperture of the objective and the wavelength of the light, the detection
pinhole also determines the thickness of the optical sections.

Additional information
The diameter of the pinhole has the optimum if it matches the diameter of the Airy disc. The Airy disc
refers to the inner, light circle of the diffraction pattern of a point light source. The diameter of the Airy
disc, in turn, is also dependent on several optical parameters and can be described for the Leica
Confocal System as follows:

To calculate the diameter of the Airy disc, you need the excitation wavelength λ (in the case of several
wavelengths, a mean value should be used), the numerical aperture NA and the magnifying factor M
of the objective. The factor of 3.6 refers to the magnification of other optical components belonging to
the Leica Confocal microscope.

If the pinhole is set to the Airy disc, light from outside the focal plane is suppressed and the signal-to-
noise ratio is high. These conditions allow the recording of optical sections of minimum thickness. The
wider the diameter of the pinhole, the more light reaches the detector. The image becomes brighter
but blurring from structures outside the focal plane will also appear in the image, making it
increasingly unfocused.

Increasing the diameter of the pinhole above 1 Airy unit is recommended only for detecting very weak
signals.

Generally when recording material scientific specimens, enough light is reflected into the detectors so
that the detection pinhole can be closed completely (i.e. set to the minimum diameter).

Selecting a Scan Format

Function
Clicking the Format button opens a dialog window containing a selection list of scan formats.
Selecting the scan format selects the image raster that will be used for recording the images. An
image raster is the amount of points scanning the specimen in the three directions in space. Besides
the numerical aperture of the objective and the excitation wavelength, the scan format, together with
the electronic zoom, determines in large part the spatial resolution of the recorded data.

Additional information
When selecting the scan format, observe the influences between the image raster and the resolution
of the generated image. According to the Nyquist theorem (or sampling theorem), a structure can only
be scanned without information loss if the smallest optically resolvable distance is scanned with about
2 to 3 raster points. This optically resolvable distance, called lateral resolution, depends on the
numerical aperture of the objective and the wavelength of the applied excitation light:

The following example illustrates this correlation: For example, you selected the PL APO 100x
objective with numeric diaphragm ND = 1.4 and a wavelength of λ = 488 nm. Based on these factors,
the smallest optically resolvable distance is determined as follows:
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Based on this rough formula, the distance of the raster points required to avoid information loss while
recording is:

If however you select a scan format of 1024x1024, a PL APO 100x objective, which has a maximum
scan field size of 150 µm, would result in the following raster point distance:

To achieve the required 47 nm raster distance, you can either raise the scan format (to 2048x2048 for
instance) or you can decrease the scan field size using the Electronic Zoom (Zoom=2).

The current raster distance is displayed in the Hardware legend. This value is referred to as Voxel
Size and recalculated as soon as you change the scan format, the Electronic Zoom or the objective.

& see Electronic Zoom (page 139)
& see Selecting an Objective (page 134)

When the sampling rate of 2 to 3 points is exceeded, it is referred to as oversampling.

In the case of oversampling, the structure is fully mapped but no additional information

is gained. The disadvantage of oversampling is the long scanning time and the danger

of destroying bleach-sensitive specimens. When the sampling rate is less than 2 to 3

points, it is referred to as undersampling. In this case, there is the danger that not all

necessary information is sampled. The image might illustrate structures that are not

actually present in the specimens. This effect is called aliasing.

Selecting a Scan Mode

Function
Clicking the Mode button opens a dialog window containing a list of available scan modes. The scan
mode determines which optical levels of the specimen are to be scanned. In general, horizontal xy-
sections or vertical xz-sections can be recorded. To generate a three-dimensional image of the
specimen, the optical sections are continued in the corresponding third direction in space, thus
recording a stack of individual images. In addition to this, it is possible to add the factor of time or
wavelength while recording the images:

Mode Function
xyz An image stack is recorded from the xy-sections in the z direction.
xzy An image stack is recorded from the xz-sections in the y direction.
xt A line is recorded several times in succession.
xyt A xy-section is recorded several times in succession.
xzt A xz-section is recorded several times in succession.
xyzt An image stack is recorded several times in succession from xy-sections in z-direction.
xyλ An xy section is recorded at different wavelengths.
xzλ An xz section is recorded at different wavelengths.

All scan modes (with the exception of xt) are composed of at least three dimensions. The third as well
as other dimensions will be ignored by the device if you record images only from one optical plane (xy
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or xz) using the Continuous Scan function of the Single Scan function.

The xzy and xzt scan modes are only displayed in the list if you previously selected the

selection point Galvo using the Z-Scan button. Likewise, the scan modes for an xyλ and

xzλ lambda series will only be displayed if only one detector is activated in the Beam

Path Setting dialog window.

 
& see Setting the Beam Path (page 130)

Selecting a Scan Speed

Function
Clicking the Speed button opens a dialog window that you can use to select from four scan speeds.

Speed
200 Image lines per second
400 Image lines per second
800 Image lines per second
1000 Image lines per second

The data recording speed can be further increased in combination with the bidirectional scan.

& see Unidirectional or Bidirectional Scan (page 160)

Additional information
The higher the set scan speed, the shorter the dwell time of the laser point. Furthermore, the scan
format, i.e. the number of sampling points in a row, needs to be taken into account. The higher the
scan format at a constant speed is, the shorter the dwell time of the laser point over a sampling point.

The longer the light point of the laser beam dwells over the individual sampling points of the
specimen, the more light is detected by the detector. So using a lower scan speed results in a better
signal-to-noise ratio. The disadvantage of a lower scan speed is that the relatively long impact of the
light on the specimen can bleach the specimen photochemically, making it unusable. This is
especially important with fluorescence applications.

If the speed levels 800 or 1000 are set, technical limitations prevent the maximum scan

field from being scanned. The system automatically switches to zoom factor 2 or zoom

factor 4.

Starting a Single Scan
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Function
Use the Single Scan button to record a single image from a single optical level in the specimen.

Before recording an image using the single scan function, configure all required scan parameters
using the Continuous Scan function to ensure optimal image quality.

& see Starting a Continuous Scan (page 145)

Typical Applications
The Single Scan function is designed for recording bleach-sensitive specimens. Use this function in
the case of bleach-sensitive specimens not only for image recording, but also as an alternative to the
continuous scan function for setting the scan parameters. The Single Scan function can also be used
to check the image section by zooming in on the scan field.

Starting a Continuous Scan

Function
Use the Continuous Scan button to permanently record images from a single optical level in the
specimen. This does not generate image series, since the image being generated always replaces the
previously generated image.

Press the button a second time to stop the continuous scan.

Additional information
The unit applies the last used scan parameters automatically. You can modify some of the parameters
while the image is being recorded. Others have to be configured before you start the recording:

Before recording While Recording
Selecting an objective
Selecting a Scan format
Selecting a scan mode
Selecting a scan speed
Selecting a unidirectional or bidirectional scan

Setting the beam path
Setting the detection pinhole
Adjusting the electronic zoom
Setting the detectors
Adjusting the phase

The buttons of the functions that can not be changed during continuous scanning are disabled and
appear gray.

Typical Applications
The continuous scan function is best used to optimize the image quality for the first scan of a
specimen. While the specimen is being scanned continuously, you can modify the scan parameters
listed above and check the results directly in the image.
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With bleach-sensitive specimens it is advisable to restrict the use of the Continuous

Scan function to short time intervals. Subjecting the specimen to the continuous light of

the laser can destroy the specimen photochemically (optical bleaching), thus making it

unusable.

Series Scan Overview Dialog Window

Function
This dialog window lets you define the begin and end points of an image series and trace the
recording of the individual sections. The three-dimensional scan area is represented graphically as a
cube. Within this cube, a yellow square represents the current z-position or y-position, a green one
represents the begin point and a red one the end point. The corresponding position values are
displayed to the right of the cube. Set the begin and end point as follows.

� Use the mouse pointer to drag the yellow square to the level in which the image series is to
begin.

� Click in the white box for the begin point. The corresponding position value appears and is
saved.

� Use the mouse pointer to drag the yellow square to the level in which the image series is to end.
� Click in the white box for the end point. The corresponding position value appears and is saved.
� The entire height of the image stack between the begin and end points is calculated and

displayed (total).

Now click the Series Scan button. The dialog window stays open and you can follow the process of
the image series being recorded.

The begin point and end point can also be defined using the control panel and the

separate keys Begin and End.

& see Defining the Begin Point for a Spatial Series (page 147)
& see Defining the End Point for a Spatial Series (page 148)

Additional information
The following additional parameters, which have to be set before recording an image series, are
specified in the Series Scan Overview dialog window:

� Scan mode (top line to the right of the graphic image)
� Scan format (red digits at the upper edge of the cube)
� Number of optical sections (division between begin and end points)

The red number on the vertical edge of the cube represents maximum travel of the z-actuator that can
not be changed.

& see Selecting a Scan Mode (page 143)
& see Selecting a Scan Format (page 142)
& see Defining the Number of Spatial Sections (page 149)



Leica Microsystems Heidelberg GmbH
LCS software functions:

Description of individual functions

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 147 of 307

Defining the Begin Point for a Spatial Series

Function
Use the Begin button to define the begin point of a spatial image series. First, set the exact z-position
or y-position in the Series Scan Overview dialog window or on the control panel using the
corresponding radio button. Then click Begin. This saves the position value for the begin point. The
end point is set in the same manner.

& see Series Scan Overview Dialog Window (page 146)
& see Controlling Functions using the Control Panel (page 245)

Defining the Begin Point for a Lambda Series

Function
For a lambda series, this function records a stack of individual images, each of which are detected at
a specific wavelength, from a single, optical level. Use the Lambda Scan Begin button to define the
wavelength at which recording should begin:
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The Lambda Scan Begin button is only active if you used the Mode button to select a

scanning mode with the wavelength dimension.

& see Selecting a Scan Mode (page 143)

� Press Beam to open the Beam Path Setting dialog window.
� Activate a detector by clicking its corresponding check box. A cast shadow now links the

activated detector to the corresponding slide bar on the scale of the spectrum.
� Double-click this slide bar to open the Range Properties dialog window, where you can specify

the end point of the series.
� Drag the slide bar on the scale of the spectrum to the desired start position. The left edge of the

slide bar represents the wavelength at which the recording is to begin.
� Click Lambda Scan Begin to save the value.

The end point of a lambda series is set in the same manner. In addition, you also have to set the
number of wavelength steps.

& see Defining the End Point for a Lambda Series (page 149)
& see Setting the Number of Wavelength Steps (page 150)

Typical Applications
A lambda series can be applied to determine the maximum emission of a fluorochrome. This is useful
because the Stokes shift of the emission curve of a fluorochrome is dependent on each specimen that
is applied. This then allows you to set the detection range precisely for a specific application.

Defining the End Point for a Spatial Series

Function
Use the End button to define the end point of a spatial image series. First, set the exact z-position or
y-position in the Series Scan Overview dialog window or on the control panel using the corresponding
radio button. Then click End. This saves the position value for the end point. The begin point is set in
the same manner.

& see Series Scan Overview Dialog Window (page 131)
& see Controlling Functions using the Control Panel (page 245)
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Defining the End Point for a Lambda Series

Function
For a lambda series, this function records a stack of individual images, each of which are detected at
a specific wavelength, from a single, optical level. Use the Lambda Scan End button to define the
wavelength at which recording should end.

The Lambda Scan End button is only active if you used the Mode button to select a

scanning mode with the wavelength dimension.

& see Selecting a Scan Mode (page 143)

� Press Beam to open the Beam Path Setting dialog window.
� Activate a detector by clicking its corresponding check box. A cast shadow now links the

activated detector to the corresponding slide bar on the scale of the spectrum.
� Double-click this slide bar to open the Range Properties dialog window, where you can specify

the end point of the series.
� Drag the slide bar on the scale of the spectrum to the desired end position. The right edge of the

slide bar represents the wavelength at which the recording is to end.
� Click Lambda Scan End to save the value.

The begin point of a lambda series is set in the same manner. In addition, you also have to set the
number of wavelength steps.

& see Defining the Begin Point for a Lambda Series (page 147)
& see Setting the Number of Wavelength Steps (page 150)

Typical Applications
A lambda series can be applied to determine the maximum emission of a fluorochrome. This is useful
because the Stokes shift of the emission curve of a fluorochrome is dependent on each specimen that
is applied. This then allows you to set the detection range precisely for a specific application.

Defining the Number of Spatial Sections

Function
Clicking the Sections button opens a dialog window that you can use to select the number of
horizontal xy-sections and vertical xz-sections for recording an image series. If you want to specify a
number of sections that is not listed, click the Others option. This opens the Z/Y Configuration dialog
window, which contains the following data:

Parameter Description
Image Dim. z/y
(µm)

The height of the entire image stack between the begin and end points of the
image series

# Sections The number of configured sections
Step Size (µm) The step size, i.e. the distance between two sections
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In this dialog window, you can enter any value for the number of sections and the section width. The
height of the image stack can not be changed, as this parameter is determined by the start and end
point of the image series. As the section width always has to be a multiple of the minimum section
width of the z-setting drive, certain combinations of values are only possible if either the height of the
image stack or the number of sections is adapted. Depending on which of the two Calculate buttons
you click, one of the two parameters is not changed.

If you want to calculate the number of sections with the priority of leaving the height of the image
stack unchanged where possible:

� Enter the desired step size in the Step Size field.
� Then click the Calculate button next to the Step Size field.

If you want to calculate the number of sections with the priority of leaving the number of sections
unchanged where possible:

� Enter the desired step size in the Step Size field.
� Then click the Calculate button next to the # Sections field.

If you want to calculate the step width with the priority of leaving the height of the image stack
unchanged where possible:

� Enter the number of desired sections (whole numbers only) in the # Sections field.
� Then click the Calculate button next to the # Sections field.

If you want to calculate the step width with the priority of leaving the number of sections unchanged
where possible:

� Enter the number of desired sections (whole numbers only) in the # Sections field.
� Then click the Calculate button next to the Step Size field.

If you click the Reset button, the last shown values are displayed.

& see Starting a Series Scan (page 154)
& see Series Scan Overview Dialog Window (page 146)

Setting the Number of Wavelength Steps

Function
For a lambda series, this function records a stack of individual images, each of which are detected at
a specific wavelength, from a single, optical level. The images are recorded within a wavelength
range, which is limited by the begin and end points. Use the Lambda Steps button to define the
number of recordings that are to take place within this range.

The Lambda Steps button is only active if you used the Mode button to select a

scanning mode with the wavelength dimension.
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& see Selecting a Scan Mode (page 142)
& see Defining the Begin Point for a Lambda Series (page 147)
& see Defining the End Point for a Lambda Series (page 149)

Typical Applications
A lambda series can be applied to determine the maximum emission of a fluorochrome. This is useful
because the Stokes shift of the emission curve of a fluorochrome is dependent on each specimen that
is applied. This then allows you to set the detection range precisely for a specific application.

Importing Dye Spectrums

This page contains the following topics
� Importing dye spectrums from a text file
� Determining dye spectrums with LCS and importing them with Excel

The emission spectrums of the most common fluorescent dyes are available in the Leica Confocal
Software (LCS). However, they can only be read by the user and not edited. The dye editor can be
used to import the data of any fluorescent dye spectrum from an external text file, e.g. an ASCII file or
an Excel file, save them and edit them at any time.



Leica Microsystems Heidelberg GmbH
LCS software functions:

Description of individual functions

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 152 of 307

Importing dye spectrums from a text file

(1) Wavelength (possible units are nm
or m)
(2) Level of fluorescence signal
(3) Tab stops as separators
Data of the emission spectrum of
calcium crimson

Stain Editor dialog window

� Create the data of the dye spectrum to be imported using any text editor.
� Ensure that the values of the wavelengths in the left column (1) are separated from the emission

values in the right column (2) by means of tab stops (3).
� Highlight both columns and copy them to the clipboard using the keyboard keys Ctrl and C.
� In the Leica Confocal Software, open the Stain Editor dialog window by selecting Tools/ Stains.
� Click on the Add button, enter the name of the fluorescent dye, and click on OK.
� In the Stain Editor dialog window, click in the first cell of the column with the heading Wavelength.
� Insert the copied data from the clipboard into the stain editor by pressing Ctrl and V.

In the stain editor, the data of the emission spectrum are standardized to a value range of 0 to 1 and
displayed in increments of 10 nm. The emission curves are needed for setting the detection
bandwidth in the Beam Path Setting dialog window. The next time you open the Beam Path Setting
dialog window, the emission curve of the new fluorescent dye can be selected and displayed in the
spectrum. In addition, the data of the emission curves is needed to correct crosstalk data between
detection channels.

& see Setting the Beam Path (page 130)
& see Process Operating Step / Dye Finder Folder (page Fehler! Textmarke nicht definiert.)

The data will only be imported correctly into the stain editor if the period was selected

as decimal separator.This setting must be performed under Windows → Control Panel

→ Regional Settings.

Determining dye spectrums with LCS and importing them with Excel
The Leica Confocal Software provides the possibility of independently determining the emission
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spectrum of a fluorescent dye by recording a lambda series of a specimen, which was dyed using the
corresponding fluorescent dye. The Online help (Help -> Tutorials -> Recording lambda series)
contains a detailed description of how to create a lambda series. After creating the lambda series,
proceed as follows:

� Click on the Quantify arrow symbol and then on the Z Profiles button. The Profile through Stack
dialog window opens.

� Click on one of the ROI buttons, e.g. the Rectangle button, and draw a region of interest on the
image in the Viewer window. The dialog window shows a diagram with the graph of the
fluorescence spectrum.

� Hold the mouse pointer over the diagram and click the right mouse button to open the context
menu.

� Select Export from the pop-up menu to export the evaluation data as ASCII text file.

The data of the emission spectrum can be entered into the required column format in Microsoft Excel.

� Open the text file (ASCII or ANSI) with the data of the emission spectrum in Microsoft Excel. The
Text Import wizard opens automatically.

� In the Original Data Type field, click on the option Delimited and then click on Next.
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� In the field, select the separator to be used for separating the data; in this case, Space is used as
the separator.

� Use the preview window to check the data for correctness.
� Next, click on Finish to open the data in Excel.
� Select the two columns and copy them as described above into the stain editor of the Leica

Confocal Software.

Starting a Series Scan

Function
Use the Series Scan button to create an image series. This creates a multidimensional image data
block of the specimen. The available dimensions for recording an image series are the three
directions in space (x, y, z) as well as the dimensions of time (t) and wavelength (λ). This allows you
to record a three-dimensional, spatial image stack consisting of xy or xz-sections with the additional
factor of time or wavelength.

Before recording an image series, configure all required scan parameters using the

Continuous Scan function to ensure optimal image quality.

& see Starting a Continuous Scan (page 145)

Before recording a spatial image series, configure the following settings:
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� Select the scan mode using the Mode button.
& see Selecting a Scan Mode (page 143)

� Select the scan format using the Size button.
& see Selecting a Scan Format (page 142)

� Set the desired z-position or y-position in the Series Scan Overview dialog window or by means
of the corresponding radio button on the control panel.
& see Series Scan Overview Dialog Window (page 146)
& see Controlling Functions using the Control Panel (page 245)

� Set and store the begin point for an image series using the Begin button or in the Series Scan
Overview dialog window.
& see Defining the Begin Point for a Spatial Series (page 147)

� Set the desired z-position or y-position in the Series Scan Overview dialog window or by means
of the corresponding radio button on the control panel.
& see Series Scan Overview Dialog Window (page 146)
& see Controlling Functions using the Control Panel (page 245)

� Set and store the end point for an image series using the End button or in the Series Scan
Overview dialog window.
& see Defining the End Point for a Spatial Series (page 148)

� Select the number of spatial sections using the Sections button.
& see Defining the Number of Spatial Sections (page 149)

When you have finished configuring these settings, press the Series Scan button.
You can track the recording process of the image stack in the Series Scan Overview dialog window.

Before recording a time series, configure the following settings:

� Select a scan mode with time dimension using the Mode button.
& see Selecting a Scan Mode (page 143)

� Select the scan format using the Size button.
& see Selecting a Scan Format (page 142)

� Set the desired z-position or y-position in the Series Scan Overview dialog window or by means
of the corresponding radio button on the control panel.
& see Series Scan Overview Dialog Window (page 146)
& see Controlling Functions using the Control Panel (page 245)

� Set the number of recordings, the pause interval between the recordings, and the complete
editing time.
& see Setting a Time Series (page 170)

Before recording a lambda series, configure the following settings:

� Select a scan mode with wavelength dimension using the Mode button.
& see Selecting a Scan Mode (page 143)

� Select the scan format using the Size button.
& see Selecting a Scan Format (page 142)

� Define the wavelength at which you want the lambda series to begin.
& see Defining the Begin Point for a Lambda Series (page 147)

� Define the wavelength at which you want the lambda series to end.
& see Defining the End Point for a Lambda Series (page 149)

� Select the desired number of recordings between the begin and end points of the lambda series.
& see Setting the Number of Wavelength Steps (page 150)

When you have finished configuring these settings, press the Series Scan button.

Configuring Recording Sequences
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Function
This function is used to combine up to six recording intervals with different hardware settings and their
sequence into a recording sequence. Clicking on the Time Lapse button opens the following dialog
window:

Configuration of Recording Sequence

� Using the Beam Path Setting dialog window and the buttons in the Acquire operating step (e.g.
Pinhole, Series Scan Overview), adjust all required hardware parameters for the first recording
interval (Lapse 1).
& see Setting the Beam Path (page 130)

� Click on the Define (1) button to save these hardware settings for the recording interval. The
settings of all scan functions are automatically saved.

Which hardware parameters are saved using Define, can be changed using the Setting dialog

window. For this purpose, select the Tools menu, Settings option and Instrument Parameter

Settings tab. In the Choose Settings field, click on IPS Time Lapse.

� Repeat this process with different settings for each additional recording interval (Lapse 2...8).
Reset (2) is used to undo the settings.

� Clicking Apply (3) transfers the settings defined for the recording interval to the current hardware
settings. This button does not have to be used since the settings are automatically transferred at
the start of the recording sequence. This function allows you to recheck the respective settings.
& see Applying the Parameter Setting of an Experiment (page 163)

� If the specimen must be bleached prior to the start of a recording interval, activate the Bleach (4)
check box. The bleaching pattern defined in the Bleach dialog window is used. This bleaching
pattern is used for all recording intervals. Activate the Bleach Dialog (5) check box to open the
Bleach dialog window and redefine the bleaching pattern.
& see Definition of a Bleach Experiment (page 158)

� In the first list box under Continue (6), set a pause interval between the processing of the current
and the subsequent recording interval.

� In the second list box under Continue (7), select the recording interval (Lapse 1...8) that is to be
executed after processing the current interval. If you select Finished, the recording sequence
ends with the current interval.

� Click on the Start (8) button to start the recording sequence. Click on Stop (9) to stop the
recording sequence.
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Triggering image recordings through external signals (requires special hardware equipment)

���� If the recording interval is to be started through an external signal, click on the Trigger (10)
button. The following settings for the trigger signals can be performed in the expanded dialog
window:

List
box

Function

Input The channel for incoming trigger signals is selected here. If a trigger channel is selected,
the recording interval is started upon receipt of a TTL trigger via the selected channel:
& see Signal Connector of Trigger Electronics (page 159)

Input 1: Pin 4 of the trigger electronics connector
Input 2: Pin 12 of the trigger electronics connector
Input 3: Pin 5 of the trigger electronics connector
Input 4: Pin 13 of the trigger electronics connector
Input –: An incoming trigger signal is not required to start the recording interval.

To use the trigger input, ground (0V) must be applied to Pin 8 of the trigger electronics

connector.

Output The channel for outgoing trigger signals is selected here. If a trigger channel is selected, a
TTL trigger is transmitted via the selected channel when the recording interval is started:
& see Signal Connector Assignment of Trigger Electronics (page 159)

Output 1
Pin 7 of the trigger electronics connector. It is a line signal that is set to logical «1»
for the duration of the actual data recording.

The line signal doubles its frequency when switching from unidirectional to bidirectional

data acquisition.

Output 2
Pin 15 of the connector of the trigger electronics. This is a free signal that can be used to
trigger external devices in accordance with predefined events.

Output –: No trigger signal is issued.

To use the trigger output, a voltage of +5 V DC must be applied to Pin 11 and ground (0V)

to Pin 8 of the trigger electronics connector.
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All inputs are decoupled through optocoupler. The maximum current that may be

applied to the optocoupler is 2 mA. The minimum pulse duration for incoming trigger

signals is 100 ms.

If a recording interval is started via incoming trigger signal, the processing of an already

running recording is interrupted. A recording interval is only started by a trigger signal if

the Activate (11) button or Start is pressed.

Definition of a Bleach Experiment

Function
Bleach points and a specific bleaching period can be defined and saved for each bleach point using
this dialog window. This function can be used only in connection with an imaging sequence.

& see Configuring Recording Sequences (page 155)

� Hold the mouse pointer over the image in the Viewer display window when the Bleach dialog
window is opened. The mouse pointer symbol changes to a cross.

� Select the bleach points in the image by clicking the corresponding positions in the image. The
bleach points are entered in the Bleach Points list field with the designation POS 1..n. Use the
Remove button to remove the bleach points.

� To set the bleaching duration for a single bleach point, mark the corresponding entry in the
dialog window and select a time interval in the Duration field. To set the same bleaching duration
for all bleach points, click the Select All button and then set the bleaching duration.

� Click on the Define button. Besides the bleaching duration, this also automatically stores the
laser intensity and the z-height of the selected bleach point. The laser intensity can be modified
in the Beam Path Setting dialog window.
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& see Setting the Beam Path (page 130)
� Clicking Apply transfers the settings defined for the bleaching pattern to the current hardware

settings.
� Click OK or Continue (if the dialog was opened via the Time Lapse dialog window).

The signal connector of the trigger electronics is located on the back of the supply unit

Signal connector assignment of the trigger electronics

Signal Signal connector
Input 1 Pin 4 of the trigger electronics connector.
Input 2 Pin 12 of the trigger electronics connector.
Input 3 Pin 5 of the trigger electronics connector.
Input 4 Pin 13 of the trigger electronics connector.
Output
1

Pin 7 of the trigger electronics connector.
This is a line signal. In contrast to the Output 3 (Pin 6) signal, it remains on a logical «1»
for the duration of the actual data recording only.
This signal is also available if the Time Lapse function is not used.
& see Configuring Recording Sequences (page 155)

Output
2

Pin 15 of the connector of the trigger electronics.
This is a free signal that can be used within the Time Lapse function to trigger external
devices in accordance with predefined events.
& see Configuring Recording Sequences (page 155)

Output
3

Pin 6 of the connector of the trigger electronics.
This is a line signal (line-clock). At each start of a new line, the signal features a rising
edge. The signal remains on a logical «1» for the complete time in which the scanning
beam is located on one line.
This signal is also available if the Time Lapse function is not used.

Output
4

Pin 14 of the connector of the trigger electronics.
This is a frame signal (frame-clock). At each start of a new frame, the signal features a
rising edge. The signal remains on a «1» for the complete time that is required for
recording a frame.
This signal is also available if the Time Lapse function is not used.

GND Pin 8 of the trigger electronics connector for the use of outgoing and incoming trigger
signals (ground)

+ 5 V
DC

Pin 11 of the trigger electronics connector for the use of outgoing trigger signals
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The line signal doubles its frequency when switching from unidirectional to bidirectional

data acquisition.

To facilitate the use of trigger functions, an optional trigger control panel is available, which is
described in more detail in the appendix (see page ).

Selecting a Unidirectional or Bidirectional Scan

Function
If you click the Unidirectional/ Bidirectional Scan button, bidirectional scan mode is enabled. If this
button is not clicked, unidirectional scan mode is automatically set.

In unidirectional scan mode, each line is scanned from left to right. No data is recorded while the laser
beam is being guided to the starting point of the next line. In bidirectional scan mode, the first line is
scanned from left to right and the second from right to left. In other words, the return run, or flyback, of
the laser beam is implemented for recording data too, thus increasing the scan speed when using
bidirectional scan mode.

If bidirectional scan mode is active, you can double the scan speed using the Speed button:

Unidirectional Bidirectional
200 Currently not available Image lines per second
400 800 Image lines per second
800 1600 Image lines per second
1000 2000 Image lines per second

& see Selecting a Scan Speed (page 144)

In order to accurately align the pixels of the forward sweep and flyback, the phase between the
forward sweep and the flyback can be adjusted. Use the Phase button for this purpose.

& see Setting the Phase (page 160)

If the speed levels 800 or 1000 are set, technical limitations prevent the maximum scan

field from being scanned. The system automatically switches to zoom factor 2 or zoom

factor 4.

& see Electronic Zoom (page 139)

Adjusting the Phase
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Function
During bi-directional image recording, there may be a phase displacement between the scanning
beams moving forward and backwards. Click on the Phase button to open a dialog window that allows
you to correct the displacement:

� Use the mouse pointer to move the slider on the scale until the pixel displacement disappears
from the image.

It is also possible to adjust the phase with the respective knob on the control panel.

& see Controlling Functions using the Control Panel (page 245)

Additional information
Before delivery of the instrument, the factory performs a phase adjustment for each zoom value and
enters the corresponding values. Due to the temperature dependency of the mechanics and
electronics, there may be a slight deviation from these default values during operation. Use this
function to readjust these values.

Rotating the Scanning Field

Function
Use the Scan Field Rotation function to rotate the scan field. This neither rotates the specimen nor the
direction of the scanner, but rather the intermediate microscopic image.

� Select a rotating angle between 0 and 90 degrees in the Scan Field Rotation dialog window. The
original position (0 degrees) is based on a predefined reference position in the scanning head.
When the unit is switched on, it automatically relocates to this reference position.

� Click on the Apply button to apply the specified rotation angle to the current image. Use Reset to
return to the previously set value. If Auto Apply is selected, new settings are automatically
applied to the image.

� Click the Visualize check box to display the rotation angle in the image. The rotation angle can
be changed directly in the image by repositioning the white line using the mouse pointer.

Y-positioning
If the xzy, xzt or xzλ scan mode is specified, activating the Visualize check box will also display the y-
level as a red line in the image. The y-position can now be modified in the Series Scan Overview
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dialog window and the positioning can be checked using the red line in the image.

& see Selecting a Scan Mode (page 143)
& see Series Scan Overview Dialog Window (page 146)

Typical Applications
This function is used to align textures on surfaces or long stretched-out biological structures relative to
the viewer.
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Applying the Parameter Setting of an Experiment

Function
Click on the Apply button to use the hardware settings of a previous experiment for recording a new
experiment. This lets you configure the settings for new image recordings with a single click with the
scan parameters that have been optimally configured for a previous application.

� Activate the image data block that is configured with the settings you want to apply to the new
experiment.

� Click on the Apply button.

Recording an Image of a Line Using the Averaging Method

Function
The Line Average function launches an averaging method for the image recording. In this case, each
single line is scanned several times. For every sampling point, the arithmetical average is calculated
from the repeatedly measured intensity values in one line and represented in the result image. The
next line of the specimen will not be scanned until after the set number of averaging steps has
completed. The method used here determines a consecutive average. This means that every line
recorded after the first line is averaged with the previously displayed line and is displayed in the result
image (dynamic average).

Clicking the Line Average button opens a dialog window that you can use to set how often a line is to
be scanned. You can select from 1 to 8 scan repeats.

Using a parallel function, it is possible to record complete images using the averaging method.

& see Recording an Image Using the Averaging Method (page 164)

Typical Applications
This function is used predominantly for recording live specimens.

Recording an image using the averaging method is not recommended for bleach-

sensitive specimens. Repeated recordings and the resulting length of subjection to light

can lead to the destruction of the specimen.
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Recording an Image Using Burst Mode

Function
If the workstation must process large amounts of data during the recording of images, it may lead to a
delay of the scanning process. This is because the recorded image is first displayed on the monitor
before additional images can be scanned by the scanner. The Burst function allows for decoupling the
scan process of the laser and the refreshing of image data on the screen. For this purpose, the
transmission of image data from the program memory to the monitor is delayed, but the scanning
process is not. By clicking on the Burst button, you can select operating modes with different delay
times:

Mode Description
No Burst Image data are recorded and simultaneously continuously displayed on the

monitor.
Frame Burst Image data are not displayed on the monitor until a single image has been

recorded.
Complete Burst Image data are not displayed on the monitor until an image series has been

recorded.
Automatic The software automatically sets the optimum operating mode for a specific

application.
Free Ratio
Burst

Only every x-th recorded image is displayed on the screen

Adjusting the Free Ratio Burst mode
� In the Tools menu, select the Settings option and then the Scan Options tab.
� Enter a number in the Update Ratio field. For example, entering the number 3 displays only every

third image on the screen.

The following parameters can increase the amount of data to be processed to the

extent that it results in a delay of the data display on the screen: scan format, scan

speed, bidirectional scan, number of active detection channels, calculation of an overlay

image and size of the Viewer window.

Recording an Image Using the Averaging Method

Function
The Average function launches an averaging method for the image recording. In this case, every
individual image, i.e. every xy-section or xz-section, is scanned several times. For every sampling
point, the arithmetical average is calculated from the repeatedly measured intensity values and
represented in the result image. The method used here determines a consecutive average. This
means every image recorded after the first image is calculated with the results of the previously
displayed image and is displayed in the result image (dynamic average).
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Clicking the Average button opens a dialog window that you can use to set how often a section is to
be scanned. You can select from 1 to 64 scan repeats.

Typical Applications
Recording an image using the averaging method is primarily useful for suppressing noise. In
fluorescence microscopy, weak fluorescent specimens result in little light reaching the detector. The
resulting low photon count leads to noisy images. In such cases, you can improve the signal-to-noise
ratio by carrying out multiple recordings and determining averages of the image.

Recording an image using the averaging method is not recommended for bleach-

sensitive specimens. Repeated recordings and the resulting length of subjection to light

can lead to the destruction of the specimen.

Image Recording with Accumulation Method

Function
The Accumulation button is used to apply an accumulation method for the image recording. In this
case, every individual image, i.e. every xy-section or xz-section, is scanned several times. The
repeatedly measured intensity values are added for each scanning point and the sum is displayed in
the resulting image.

Clicking the Accumulation button opens a dialog window that you can use to set how often a section is
to be scanned. You can select from 1 to 16 scan repeats.

Typical Applications
The accumulation method is intended to improve the image quality during image recordings when
only weak fluorescence signals can be detected.

Image Recording With a Digital Resolution of 8 Bits or 12 Bits

Function
This function reads in the analog intensity values measured by the detector by means of an A/D
converter, either as 8 bit signal or 12 bit signal.

Additional information
While digitizing the analog intensity signal with a digital resolution of 8 bit, 256 different intensity
values can be displayed. Taking the natural statistical variations of the typical intensity value range of
fluorescence specimen into account, a digitization with 8 bit is completely sufficient in most cases for
an image recording without loss of information. For specimens with a higher intensity dynamics (e.g.,
for specimen with very intensity-weak and intensity-strong areas), an image recording with 12 bit
digitization is recommended. In a 12 bit digitization, 4096 different intensity values can be resolved.
However, the data capacity to be saved doubles.

Typical Applications
For image recording with very high intensity dynamics (mostly material specimens with high reflectivity
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of the surface and occurrences of very dark areas at the same time).

Setting the UV Lens Wheel (Option)

Function
For each objective, this function reduces the focus offset between visible and UV excitation light to a
value below the optical resolving capacity. In order to achieve this, a suitable correction lens is
brought into the beam path for each objective suitable for use with UV excitation light. To use this
corrective feature, proceed as follows:

� Click on the Objective button (standard procedure in Acquire step).
& see Selecting an Objective (page 134)

� Select a UV-capable objective from the list (see indication on list).

In this case, the corrective lens for the selected objective is automatically moved into the beam path.

The possible occurrence of a focus offset between visible light and UV light has

physical reasons and is not a malfunction of the device.

Other Requirements
In order to achieve an automatic correction of the physically based color length fault between visible
and UV light, it is not sufficient to manually rotate the objective into the beam path.

Selecting the Laser Line for the Image Background (ROI Scan)

Function
This function is required for the recording of regions of interest (ROI Scan). In this recording process,
the image background is recorded with a different excitation wavelength than the selected regions of
interest. The ROI button saves the laser settings for the image background before you separately
specify the excitation wavelength for each region of interest with the Configuration button.

Additional information about this topic can be found in the chapter on „Procedures and

Exercises for Selected Processes

" ,page 62
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Selecting Laser Lines for Individual Regions of Interest (ROI Scan)

Function
This function is required for the recording of regions of interest (ROI Scan). In this recording process,
the image background is recorded with a different excitation wavelength than the selected regions of
interest. The Configuration button opens a dialog window which allows you to assign different laser
lines to the individual regions of interest.

Additional information about this topic can be found in the chapter on „Procedures and

Exercises for Selected Processes

" ,page 62

Controlling the X/Y Specimen Stage

Function of dialog elements
The XY-Stage Control dialog window features the following dialog elements to control the
«Märzhäuser» X/Y specimen stage:

The symbol of the scan field (1) in the dialog window changes its size in relation to the parameters
that are also physically determining the size of the scan field. These parameters are: objective



Leica Microsystems Heidelberg GmbH
LCS software functions:

Description of individual functions

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 168 of 307

magnification, beam divergence, scan format and electronic zoom. The intersection of the guide lines
(2) at the top left corner of the scan field serves as reference point for positioning the specimen stage.
The coordinates of this reference point are displayed in the Current Position field.

Positioning the X/Y specimen stage
The X/Y specimen stage can be positioned using the Set Position button (5), the mouse pointer, the
arrow keys in the dialog window (4), the arrow keys of the keyboard or the joystick.

Positioning via button
� Click on the Set Position button (5). A dialog window displays in which you can enter the x- and

y-coordinate of the reference point with a precision of several decimal points.

Positioning via mouse pointer
� Click the scan field in the dialog window, hold the left mouse button pressed and drag the scan

field to the desired position. The stage will not be moved until the mouse button is released.
� To ensure that the specimen stage is not moved until the desired position is reached, you can

specify a delay time between releasing the mouse button and moving the specimen stage. Click
on the Settings button (8) and set the delay time on the Delay tab.

Positioning via arrow keys
� Operate the four arrow keys in the dialog window (4) or the arrow keys of the keyboard.

Positioning the specimen stage with the arrow keys on the keyboard moves the scan field

exactly by the length of the side of the scan field so that a specimen, which is larger than the

scan field, can seamlessly be scanned.

� To ensure that the specimen stage is not moved until the desired position is reached, you can
specify a delay time between pressing the keys and moving the specimen stage. Click on the
Settings button (8) and set the delay time on the Delay tab.

Positioning via joystick
� If you position the specimen stage using the joystick, the coordinates in the Current Position

field are not updated. Click on the Update Position button (6) to display the current position.

Adjusting the positioning speed
You can adjust the speed at which the specimen stage is moved, and the time available for this
action.

� Click on the Settings button (8) and define the minimum and maximum positioning speed on the
Speed tab by dragging the slider or entering the corresponding values in the entry fields.

� The positioning time is defined in the Positioning Time entry field, i.e. the time in which the
specimen stage must reach its position. Please note that a high speed requires a short
positioning time and a low speed requires a long positioning time.

Setting the zero position
� Click on the Set Zero Position button (7) to define the current position of the specimen stage

(intersection of guide lines in the dialog window) as the zero position. This value is also changed
in the Hardware legend.

Changing the unit of measure of the positioning range
The measurements at the sides of the positioning range of the specimen stage (3) change according
to the selected unit of measure. This unit can be set to nanometer (nm), micrometer (µm), millimeter
(mm), centimeter (cm) or meter (m).
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� Click on the Settings button (8) and select the unit of measure on the Unit tab.

Enlarging the display of the positioning range
To be able to exactly position the specimen stage in the micrometer range, the display of the scan
field and the positioning range can be enlarged in the dialog window.

� Click on the + and – buttons (9) and enlarge or reduce the display of the positioning range.

The position of the X/Y specimen stage can also be saved with recording parameter

set. This allows the use of the X/Y specimen stage for recording sequences.

& see Configuring Recording Sequences (page 155)
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Selecting the z-Actuator Type

Function
Use the z-Scan button to select the actuator type for moving the specimen in the z-direction.

� Select z-Galvo if you intend to use the galvanometer-driven fine-focusing stage for z-positioning.
This z-objective stage can be used to create image recordings from horizontal xy-sections as well
as vertical xz-sections. It is used with upright as well as inverse microscope stands.

� Select z-Wide to use the electromotor-driven z-objective stage (with upright microscope stands) or
the objective nosepiece (with inverse microscope stands) for z-positioning. This selection allows
only image recordings of horizontal xy-sections (see the table below).

Available scan modes depending on the z-actuator type
If the z-Wide option is selected, it is no longer possible to select all scan modes. If you click on the
Scan Mode button, the corresponding entries can no longer be found in the list.

& see Selecting a Scan Mode (page 143)

Actuator type Scan modes
Z-Galvo xyz xzy xt xyt xzt xyzt xyλ xzλ xyλt xyλz
Z-Wide xyz — xt xyt — xyzt xyλ — xyλt xyλz

Configuring a Time Series

Function
Click on the Time button to open the Time Configuration dialog window for setting up a time series
recording. The settings that can be changed in this dialog window depend on the selected scan mode.
You can record a line (xt), a horizontal section (xyt), a vertical section (xzt), or a stack of horizontal
sections (xyzt), interrupted by a particular time interval, many times in a row.

The Time button is not enabled unless you have selected a scan mode with time

dimension using the Mode button.

& see Selecting a Scan Mode (page 143)

Use the following parameters in the dialog window to configure a time series using the xt scan mode.

∆∆∆∆T The recording time for a line (cannot be modified by the user)
Lines Number of line recordings
Lines per page Number of lines per stored page
Pages Number of stored pages (calculated automatically)
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Maximize Recording of the maximum possible number of lines per stored page
Complete Time Total recording time, i.e. the product of ∆∆∆∆T and number of recordings

Using the Calculate button, you can calculate how many stored pages are needed for a particular
number of lines per page.

Use the following parameters in the dialog window to configure a time series using the xyt or xzt scan
mode.

∆∆∆∆T Recording time for an xy-section or xz-section plus pause interval
Minimize The smallest possible interval (∆T) is used.
Frames Number of recordings of the xy-section or xz-section
Complete Time Total recording time, i.e. the product of ∆∆∆∆T and number of recordings

Use the following parameters in the dialog window to configure a time series using the xyzt scan
mode:

∆∆∆∆T Recording time for a stack of xy-sections plus pause interval
Minimize The smallest possible interval (∆T) is used.
Stacks Number of recordings of the image stack
Complete Time Total recording time, i.e. the product of ∆∆∆∆T and number of recordings

Each parameter can be calculated in relation to the other parameters. When entering the values, note
how the dialog window operates. The entry field you click on will be activated:

� Click on the parameter to be calculated. The corresponding entry field is grayed out.
� Now enter the values for the other parameter.
� Click on Apply to calculate the parameter. By clicking on Reset, the last saved values are

displayed.

When you have finished configuring these settings, press the Series Scan button.
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Data Viewing Functions

The Viewer Window

In the default setting, the Viewer window consists of three important areas. The image window (4), in
which the recorded images are displayed, is located in the middle. Button pads (1) and (2) can be
arranged to the left and below the image window and the Experiment legend (3) to the right of it. It is
possible to select other default settings of the Viewer window and to save user-defined configurations
as a template.

& see Saving Viewer Window Viewer as a Template (page 246)

Button pads (1) and (2)
By default, the button pad to the left of the image window contains the buttons for image viewing
functions and the button pad below the image window contains the buttons used for scrolling through
the individual images of an image series. Both button pads can be moved within the Viewer window or
removed from it as separate windows. To do so, click on the double-lined edge of the button pad and
drag it while keeping the mouse button depressed to the desired position.

Image window (4)
If you place the mouse pointer at any position within the image window and then press the right
mouse button, a context menu containing the following commands opens:

Command Function
Send to �Experiment �Selection

(raw)
This copies the raw data of a selected area in the
image window as a new image in the current
experiment. The new image can be processed.

�Selection
(snapshot)

This creates a new image in the current experiment
from the snapshot of a selected area in the image
window. The new image can no longer be
processed.

�All
(snapshot)

This creates a new image in the current experiment
from the snapshot of the entire, current image
window. The new image can no longer be
processed.

�Printer �Selection This prints the area selected in the image window.
�All This prints the entire, current image window.

Left buttons This shows or hides the button pad to the left of the image window.
Bottom
buttons

This shows or hides the button pad located below the image window.

LUT This shows or hides the color look-up tables of the current image.
Legend This shows or hides the Experiment legend.
Full screen This enlarges the Viewer window to full screen.
Viewer This opens the Viewer Options dialog window.
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Options

The color look-up tables (5) are displayed as color bars to the right of the image window. If you hold
the mouse pointer over a color bar, grab points appear at the top and bottom of the color bar. You can
use these grab points to limit the current color look-up table to a specific intensity range and to load a
second color look-up table. This allows you to increase the contrast of the image graphically.

� Drag the top grab point down or the bottom grab point up.
� Double-click the area above or below the corresponding grab point.
� The Select LUT's dialog window opens so that you can select a second color look-up table.
� The upper and lower intensity ranges are represented in the colors of the second color look-up

table.

& see Selecting Color Look-Up Tables (LUT) (page 185)

The Experiment Legend (3)
Various image parameters of an image recording are registered in the Experiment legend. To select
the parameters that you want displayed, click any area of the legend. This opens a list of all available
entries. Then select the desired entry. If you hold the mouse pointer over any area within the
Experiment legend and press the right mouse button, a context menu containing the following
commands opens:

Command Function
Experiment �Edit This opens the Edit Legend dialog window, where you can specify a

Title for the legend, specify the Number of legend entries or Clear all
entries.

�Activate This displays the Experiment legend in the Viewer window.
�Remove This deletes the current Experiment legend.

Add
Experiment
tab

This creates a new Experiment legend in the Viewer window.

The Hardware Legend
The hardware settings for image recording are registered in the Hardware legend. To open the
legend, select the Hardware Legend option from the View menu. To select the entries that you want
displayed in the legend, click the Edit button. This opens the Edit Legend Entries dialog window:

� The Available Entries list box shows all available entries. Select the entries that you want
displayed in the legend. Then click Add to carry the selected entries over into the Show entries
list box.

� The Show entries list box contains the entries that are to be displayed in the legend. Use the
Remove button to remove entries from being displayed in the legend.

� Use the Move up and Move down buttons to shift one or more than one entry up or down in the
list.

� You can use the Edit grid color and Edit background color buttons to modify the color of the
frame and background of the legend.

The Hardware legend is aligned automatically along the right edge of the user interface. You can
change however the size and position of the legend as desired:

� To change the width of the legend, use the mouse pointer to drag the edge to the position you
desire.

� To change the position of the legend, double-click on the double-lined edge of the legend or click
the icon once. This releases the legend from the user interface, turning it into a window. Now
you can drag the legend to any position by pressing and holding the left mouse button.
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If the legend has been enlarged to cover the entire width of the user interface, you first

have to shrink the height of it in order to drag it back to the edge of the user interface.

Option New Window
You can open a second Viewer window containing the same image as the currently open Viewer
window by clicking the New Window option in the Window menu. This command does not create a
new experiment, but rather opens a second view of the current image data. This feature is useful for
viewing different representations of the same image data at the same time. Sequential numbers are
added behind the file extension to distinguish between the resulting copies of the current Viewer
window.

Displaying Recordings as Thumbnails in the Experiment Browser

Function
The Experiment Browser enables you to display all recordings of an experiment as thumbnails. This
gives you an overview of the current image collection and quick access to individual recordings.

� Select an experiment in the Experiment Overview display window.
� Click on the Browse button to open the Experiment Browser. All recordings of the experiment

are displayed as thumbnails. Image series are displayed as maximum projection.
� Click a thumbnail to open the complete image data set in the Viewer window.
� Click on the Browse button again to close the Experiment Browser.

Viewer Options Dialog Window

Viewer Options Dialog Window, 3D Icon
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Function
To open the Viewer Options dialog window, select the Experiment Overview option in the View menu.
The Experiment Overview display window appears on the left side of the user interface. The top part
of this window displays the recorded images in a directory tree. The bottom part displays the Viewer
Options dialog window. This dialog window is used to perform basic settings for different software
functions. The left side shows the icons corresponding to the functions and the right side shows the
related tabs. When you open the dialog window, it contains the icons of the functions that you are
currently using. Click Show all to view all icons.

The tabs of the 3D icon can be used to perform optional settings for the following functions:

& see Rotating the 3D View (page 201)
& see Moving the 3D View (page 201)
& see Zooming the 3D View (page 202)

The Navigation tab displays the numerical values of the actions that are carried out using the Rotate,
Move and Zoom buttons (and the mouse pointer).

Use the Rotation field to tilt a 3D view in all three spatial directions by modifying the angular degrees
of the three axes. The 3D view is rotated around a fixed point, which is located in the center of the
image. To best understand the rotation function, modify the angle of one axis at a time, while leaving
the other two axes set to 0.

Rotation Function
X from 0° to 45° The 3D view is rotated 45° around the fixed point in the direction of the negative

z-axis.
Y from 0° to 45° The 3D view is rotated 45° around the fixed point in the direction of the negative

y-axis.
Z from 0° to 45° The 3D view is rotated 45° around the fixed point in the direction of the negative

y-axis.

Use the Translation field to shift a 3D view to the right or left, up or down and enlarge or shrink it by
modifying the coordinate values. (Users of all regional versions should be sure to use the dot as the
decimal placeholder.)

Translation Function
X Positive values shift the 3D view to the right, negative to the left.
Y Positive values enlarge the 3D view, negative shrink it.
Z Positive values shift the 3D view up, negative down.

Use the Predefined field to change the viewing perspective of the image to Top view or Side view by
clicking these buttons respectively.

In the Display tab click on one of the listed commands to show or hide the corresponding graphic
element of the 3D view in the Viewer window:

Graphic Elements Function
Show LUT Show the selected color look-up table on the z-axis.
Show scale Show the scale.
Show bounding box Show the bounding box, which limits the measurement volume.
Show axes Show the coordinate axes.
Show data during 3D
motion

Show the image data while the 3D view is being rotated, shifted,
enlarged or shrunken.
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Viewer Options Dialog Window, Display Icon

Function
To open the Viewer Options dialog window, select the Experiment Overview option in the View menu.
The Experiment Overview display window appears on the left side of the user interface. The top part
of this window displays the recorded images in a directory tree. The bottom part displays the Viewer
Options dialog window. This dialog window is used to perform basic settings for different software
functions. The left side shows the icons corresponding to the functions and the right side shows the
related tabs. When you open the dialog window, it contains the icons of the functions that you are
currently using. Click Show all to view all icons.

The tabs of the Display icon can be used to perform optional settings for the following functions:

& see Starting and Ending a Film (page 191)

On the Settings tab, use the graphic zoom to enlarge or reduce the image displayed in the Viewer
window:

n-1 The image is reduced by displaying n pixel as 1 pixel in the resulting image.
Automatic The image is displayed in the original image format.
1-n The image is enlarged by displaying 1 pixel as n pixel in the resulting image.
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The Leica Confocal Software features three distinguishing zoom functions: graphic

zoom, 3D zoom and electronic zoom.

& see Zooming the 3D View (page 202)
& see Electronic Zoom (page 139)

Click on one of the selection points on the same tab to hide or display the respective graphic element
in the Viewer window:

Coordinates The z position of the current image is displayed.
Scale A measurement bar with length indicators is displayed.
Grid A grid is placed over the current image.

The length of the measurement bar and the grid width are calculated dependent on the objective, the
electronic zoom and the beam divergence.

You can use the Movie tab to set the speed for running the film sequence of an image series. You
can choose speeds from 6 images per minute to 25 images per second.

� Use the mouse to drag the slide on the scale to the desired value.
� Select the Ping-Pong mode if the film sequence is to run from the first to the last image and then

in reverse order back to the first image. If this mode is not selected, the film sequence always
starts with the first image again.

Viewer Options Dialog Window, Charts Icon

Function
To open the Viewer Options dialog window, select the Experiment Overview option in the View menu.
The Experiment Overview display window appears on the left side of the user interface. The top part
of this window displays the recorded images in a directory tree. The bottom part displays the Viewer
Options dialog window. This dialog window is used to perform basic settings for different software
functions. The left side shows the icons corresponding to the functions and the right side shows the
related tabs. When you open the dialog window, it contains the icons of the functions that you are
currently using. Click Show all to view all icons.

The tab of the Charts icon can be used to perform optional settings for the following functions:

& see Measuring a Profile Along a Line Segment (page 229)

& see Measuring a Profile Within a Region of Interest (ROI) (page 228)

& see Measuring Surfaces and Volumes (page 258)

& see Measuring Roughness Along a Line Segment (page 247)
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The options in Charts tab can only be selected if one of these buttons was used earlier to activate a
quantification function.

Activating the two-point measurement

� Clink on 2 Point in the Measurement field to activate the two-point measurement.

Each of the buttons listed above opens a window that displays a measuring curve and statistical
values.
If the two-point measurement is selected, the window shows a measurement slider (2) with two
measurement points (3) below the measurement curve (1). The position of the two measurement
points in the profile curve is symbolized by small black squares (4). This allows for very precise
settings of the range to be evaluated within the measurement. In addition, the statistics that is
displayed below the measurement curve is expanded by the following measurement values: position
of measurement points, distance of measurement points, measurement values at the measurement
points, difference of measured values between the measurement points.

Changing the position and length of the measurement slider

� To change the position, move the mouse over the slider, click and hold the left mouse button
and drag it to the desired position.

� To change the length of the slider, grasp it at one end with the mouse and enlarge or reduce it
while pressing the left mouse button.

Changing the scaling of the measurement curve
By default, the scaling of measurement curves is automatically adapted by the software to the
intensity value range that is present in an image recording. However, the scaling can also be changed
manually:

� Deselect the Auto check box to deactivate automatic scaling.
� You can now redefine the upper and lower limit value of the value range separately for each

measurement curve (each detection channel).
� Check the results of the changed scaling directly in the window.

Viewer Options Dialog Window, Multicolor Icon
 
& see the chapter "Optional Software Packages / Multicolor“ on page 267

Viewer Options Dialog Window, Online Measure Icon

Structure of the Experiment Overview window
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To open the Viewer Options dialog window, select the Experiment Overview option in the View menu.
The Experiment Overview display window appears on the left side of the user interface. The top part
of this window displays the recorded images in a directory tree. The bottom part displays the Viewer
Options dialog window. This dialog window is used to perform basic settings for different software
functions. The left side shows the icons corresponding to the functions and the right side shows the
related tabs. When you open the dialog window, it contains the icons of the functions that you are
currently using. Click Show all to view all icons.

In the tab of the Online Measure icon, you can make optional settings for the following functions:

The slider on this function can be used to set the number of optical sections for which the measured
values of an online measurement are displayed graphically. The developing trend in an experiment
can be seen from the online measurement graph.

The trend data only exists in temporary form and it can not be saved.The temporarily

saved data can however be exported via the context-sensitive menu (right mouse

button) or copied into an annotation sheet.

& see Exporting Quantification Data (page 233)
& see Copying Quantification Graphs to the Annotation Sheet (page 232)

Typical Applications
Quantitative evaluation of data sets

Viewer Options Dialog Window, Projections Icon

Function
To open the Viewer Options dialog window, select the Experiment Overview option in the View menu.
The Experiment Overview display window appears on the left side of the user interface. The top part
of this window displays the recorded images in a directory tree. The bottom part displays the Viewer
Options dialog window. This dialog window is used to perform basic settings for different software
functions. The left side shows the icons corresponding to the functions and the right side shows the
related tabs. When you open the dialog window, it contains the icons of the functions that you are
currently using. Click Show all to view all icons.

In the tabs of the Projections icon, you can make optional settings for the following functions:

& see Maximum Projection of an Image Stack with Invariable Projection Axis (page 196)
& see Average Projection of an Image Stack with Invariable Projection Axis (page 197)
& see Transparent Projection of an Image Stack with Invariable Projection Axis (page 198)
& see Creating an SFP Projection of an Image Stack (page 199)

The Projections tab contains various options for generating a projection image. Select whether the
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intensity maximums, the arithmetical average or a weighted average of the intensities are to be
displayed in the projection image. Vary the weight factor for the transparent projection. Set a threshold
value or scaling factor for the displayed intensities.

Type Function
Maximum
projection

From each of the examined columns of sampling points, the sampling point with
the highest intensity is displayed in the projection image as the representative of
all values within the column.

Average
projection

From each of the examined columns of sampling points, the arithmetical average
of the intensities measured in the column is displayed in the projection image.

Transparent
projection

From each of the examined columns of sampling points, a weighted average of
the intensities measured in the column is displayed in the projection image.

Transparent
factor

Function (enabled only for transparent projection)

Drag the slide
on the scale.

The higher the transparent factor α (0 < α < 1) setting, the stronger the intensity
values flow from the lower levels in the image stack into the projection image.

Threshold Function (enabled only for average and transparent projection)
Drag the slide
on the scale.

Intensities that are below the specified threshold value are ignored in the
calculation of the projection image.

Scaling Function (enabled only for average and transparent projection)
Rescale to
maximum

The measured intensity values are scaled to the maximum possible intensity
values.

The SFP tab contains various options for generating an SFP projection image.

& see Principles and Types of Projections (page 193)

Field Function
Light
Direction

Here, enter a coordinate for x and y for the projection angle of the SFP projection.
This angle symbolizes the angle of incidence of the laser beam onto the specimen.
Click on the Apply button to create the projection with the new angle.

Absorption The slider is used to vary the absorption coefficient. The higher it is set, the smaller
are the values calculated in the projection image. If the coefficient is set low, many of
the pixels in the projection image reach the maximum value, making it increasingly
difficult to distinguish between the structures.

Threshold Use the slider to define a threshold value. The intensity values below this value are
not taken into account for the creation of the projection image.

Rescale to
maximum

The intensity values of the image are scaled to the maximum possible intensity
values. This ensures that the calculated gray values of the projection image remain
within the value range of, for example, 0 to 255 at 8 bits. This allows for brightening
dark images.

Viewer Options Dialog Window, Overlay Icon

Structure of the Experiment Overview window
To open the Viewer Options dialog window, select the Experiment Overview option in the View menu.
The Experiment Overview display window appears on the left side of the user interface. The top part
of this window displays the recorded images in a directory tree. The bottom part displays the Viewer
Options dialog window. This dialog window is used to perform basic settings for different software
functions. The left side shows the icons corresponding to the functions and the right side shows the
related tabs. When you open the dialog window, it contains the icons of the functions that you are
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currently using. Click Show all to view all icons.

The tab of the Overlay icon can be used to perform optional settings for the following functions:

& see Viewing an Overlay Image (page 188)

On the Overlay tab you can select among three types of creating an overlay image from raw data and
the corresponding color look-up tables:

Color Merging Function
True Color (add RGBs) The color values of the pixels in the original images are averaged and

displayed in the overlay image.
True Color (add RGBs)
with dynamic adjustment

The color values of the pixels in the original images are averaged,
scaled to the maximum possible color values and displayed in the
overlay image.

Fast (bitwise "OR" RGB) The color values of the pixels in the original images are mixed using a
fast bit-by-bit calculation process and displayed in the overlay image.
& see Boolean Operations (page 291)

Coloring Function
Only Red/
Green/ Blue

The color look-up tables Red, Green and Blue are always used to create the
overlay image, independent of the current color look-up tables of the original
images.

Viewer Options Dialog Window, Scan Progress Icon

Function
To open the Viewer Options dialog window, select the Experiment Overview option in the View menu.
The Experiment Overview display window appears on the left side of the user interface. The top part
of this window displays the recorded images in a directory tree. The bottom part displays the Viewer
Options dialog window. This dialog window is used to perform basic settings for different software
functions. The left side shows the icons corresponding to the functions and the right side shows the
related tabs. When you open the dialog window, it contains the icons of the functions that you are
currently using. Click Show all to view all icons.

In the tab of the Scan Progress icon, you can make optional settings for the following functions:

& see Selecting a Scan Mode (page 143)

The currently set scan mode is shown in the Scan Progress tab. The status of an image recording
can also be checked on the basis of the progress display.

Viewer Options Dialog Window, Surface View Icon

Function
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To open the Viewer Options dialog window, select the Experiment Overview option in the View menu.
The Experiment Overview display window appears on the left side of the user interface. The top part
of this window displays the recorded images in a directory tree. The bottom part displays the Viewer
Options dialog window. This dialog window is used to perform basic settings for different software
functions. The left side shows the icons corresponding to the functions and the right side shows the
related tabs. When you open the dialog window, it contains the icons of the functions that you are
currently using. Click Show all to view all icons.

In the tab of the Surface View icon, you can make optional settings for the following functions:

& see Creating the 3D View (page 200)

In the Visualization tab, you can select whether the 3D view is to be generated as Surface,
Wireframe or Isolines and specify the perspective in which the 3D view is displayed:

Render Mode Function
Surface The blank spaces between the pixels are filled in with surface.
Wireframe All pixels are linked with lines, while the blank spaces remain free.
Isolines Pixels that correspond to values of the same intensity are enclosed in a curve.

Projection Type Function
Perspective The 3D view is displayed in central perspective.
Parallel The 3D view is displayed in parallel perspective.

The Stretch height (factor) field offers the ability to vary the scaling factor in the z-direction, thus
stretching or shrinking the height of the 3D view.

Use the Downsample rate field to reduce the density of data of the 3D view to increase the speed of
image processing. At a pixel density of 1:1, all measured intensity values are displayed in the image.
At a pixel density of 1:2, only every second measured intensity value is used in the surface image.

Use the Isoline interval field to define a distance for separating the individual isolines in µm. This
allows you to limit the number of isolines in the 3D view.

Use the Isoline detail level field to enter a limiting value, specifying that only isolines of a particular
length are to be displayed in the 3D view. This limits the displayed isolines to those which correspond
to an intensity value that has a a specific frequency of occurrence.

Viewer Options Dialog Window, Surface Measure Icon

Function
To open the Viewer Options dialog window, select the Experiment Overview option in the View menu.
The Experiment Overview display window appears on the left side of the user interface. The top part
of this window displays the recorded images in a directory tree. The bottom part displays the Viewer
Options dialog window. This dialog window is used to perform basic settings for different software
functions. The left side shows the icons corresponding to the functions and the right side shows the
related tabs. When you open the dialog window, it contains the icons of the functions that you are
currently using. Click Show all to view all icons.

In the tab of the Surface Measure icon, you can make optional settings for the following functions:
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& see Measuring Roughness Along a Line Segment (page 247)

In the Leveling field, there are options for an adaptation function to bring measurement curves of a
roughness profile that show a trend into a horizontal position. For this purpose, a linear interpolation
function (polynom) is fitted to the measurement curve.

& see Process Operating Step / Materials Folder (page )
& see Adaptation Function for Correcting Trend Curves

None No adaptation function is applied to the measurement curve.
Automatic
linear

The measurement curve is brought into a horizontal position using a linear adaptation
function.

Interactive
level

The position of the measurement curve is corrected using the linear adaptation
function in such a way that the line segment between the two measurement points is
on the horizontal plane.

Freeze The newly positioned measurement curve is locked so that the item of the
measurement points can be changed again without interactively modifying the
measurement curve.

The Multipoint Measurement field provides the possibility of saving the two measurement points as
well as the difference in height between the measurement points.

� Click on the Remember button to save the values. The Clear button deletes them again.

Viewer Options Dialog Window, Surface Calculation Icon

Function
To open the Viewer Options dialog window, select the Experiment Overview option in the View menu.
The Experiment Overview display window appears on the left side of the user interface. The top part
of this window displays the recorded images in a directory tree. The bottom part displays the Viewer
Options dialog window. This dialog window is used to perform basic settings for different software
functions. The left side shows the icons corresponding to the functions and the right side shows the
related tabs. When you open the dialog window, it contains the icons of the functions that you are
currently using. Click Show all to view all icons.

On the tab of the Surface Calculation icon, you can perform optional settings for the following
functions:

& see Creating a Topographical Image

The Topography tab contains various options for generating a topographical image. Select whether
the intensity maximums or centers of mass of the intensities are to be interpreted as height in the
topographical image. Specify the type of visualization for height in the topographical image and set a
threshold value for the displayed intensities.

Surface
Reconstruction

Function
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Search maximum
intensity

From each of the examined columns of sampling points, the sampling
point with the highest intensity is displayed in the topographical image as
the representative of all values within the column.

Calculate center of
mass of intensities

From each of the examined columns of sampling points, the center of
mass of the surface, which is restricted by the curve of the measured
intensity values, is displayed in the topographical image.

Topography
Processing

Function

Invert height The column of sampling points is examined in reversed direction. This reverses
the height information. A negative of the topographical image is displayed.

Level The horizontal position of a recording is corrected using a linear interpolation
function (polynom).
& see Process Operating Step / Materials Folder (page 255)

Threshold Function
Drag the slider on the scale or
enter a numerical value.

Intensities that are below the specified threshold value are
ignored in the calculation of the topographical image.

Viewing the Detection Channels

Viewing detection channels 1-8

Function
Clicking the Channel 1-8 button displays the image data that has been recorded in detection channel
1-8 in the Viewer window. You can assign any of several other color look-up tables to the detection
channel. This setting can be changed both in the result image and while the image is being recorded.
To do so, open the Select Look-up Tables dialog window. There are two ways of opening the dialog
window.

� Click on the Select Look-up Tables button.
� Hold the mouse pointer over any position in the Viewer window.

Click the right mouse button. Click on the LUT item in the context menu that appears.
The color bars for the active detection channels appear in the Viewer window.
Double-click the corresponding color bar.

& see Selecting Color Look-Up Tables (LUT) (page 185)

This method of assigning color look-up tables only influences the currently displayed

image. As soon as you start a new scan, the color look-up tables configured in the

Beam Path Setting dialog window are applied again.

& see Setting the Beam Path (page 130)
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Zooming Image(s) in the Viewer Window

Function
Clicking the Display button opens a drop-down list that you can use to set the graphical zoom. This
enlarges or reduces the image displayed in the Viewer window:

n-1 The image is reduced by displaying n pixel as 1 pixel in the resulting image.
Automatic The image is displayed in the original image format.
1-n The image is enlarged by displaying 1 pixel as n pixel in the resulting image.

The Leica Confocal Software features three distinguishing zoom functions: graphic

zoom, 3D zoom and electronic zoom.

& see Zooming the 3D View (page 202)
& see Electronic Zoom (page 139)

Selecting Color Maps (LUT)

Function
Use the Look-up Tables button to open a dialog window, which you can use to assign color look-up
tables to the detection channels. The color look-up tables can be configured both in the result image
and while the image is being recorded:

� Click on the detection channel to which you want to assign a new color look-up table in the
Select Channel field.

� Select the desired color look-up table in the Select LUT field.
� Click Apply to check the results in the Viewer window.

It is also possible to open the Select LUT's dialog window from the Viewer window.

� Hold the mouse pointer over any position in the Viewer window. Then push the right mouse
button. Click on the LUT item in the context menu that appears.

� The color bars for the active detection channels appear in the Viewer window to the right of the
image window. Double-click one of the color bars.

Loading a second color look-up table
If you hold the mouse pointer over a color bar, grab points appear at the top and bottom of the color
bar. You can use these grab points to limit the current color look-up table to a specific intensity range
and to load a second color look-up table:

� Drag the top grab point down or the bottom grab point up.
� Double-click the area above or below the corresponding grab point.
� The Select LUT's dialog window opens so that you can select a second color look-up table.
� The upper and lower intensity ranges are represented in the colors of the second color look-up
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table.

This method of assigning color look-up tables only influences the currently displayed

image. As soon as you start a new scan, the color look-up tables configured in the

Beam Path Setting dialog window are applied again.

& see Setting the Beam Path (page 130)

Typical Applications
Generally the selection of a suitable color look-up table for a specific use depends on the user's own
judgment and needs. Experience shows however that certain color look-up tables are particularly
useful for specific uses.

Color Map Application
Green This is commonly used for recording specimens that have been marked with FITC,

Cy2, DTAF or other similar fluorochromes, which emit within the green spectral range.
Red This is commonly used for recording specimens that have been marked with TRITC,

Texas Red, Cy3, Rodamin or other similar fluorochromes, which emit within the red
spectral range.

Blue This is commonly used for recording specimens that have been marked with UV
fluorochromes such as DAPI or Hoechst or other similar fluorochromes, which emit
within the blue spectral range.

Gray This is commonly used for displaying transmission recordings.
P. Color 1 This is especially suited for displaying 12 bit images.
P. Color 2,
3, 4, 5, 6

This is commonly used for recording specimens that have been marked with pH-
sensitive or ion-sensitive fluorochromes and for displaying time series.

Geo (Land),
Geo (Sea)
Geo (Land
& Sea)
R & B

These are recommended for generating topographical images, i.e. for mapping
surface structures. Geo Land & Sea is especially useful for visualizing depths and
graduations.

Glow,
Glow
(Over),
Glow
(Under),
Glow (Over
& Under)

These are recommended for optimizing image contrast (the offset and gain of the
detectors). Glow Over highlights in blue intensities at the upper end of the table while
Glow Under represents in green intensities at the lower end of the table. Glow Over
and Under is a combination of these two color tables.

Cyan,
Magenta,
Yellow

These are recommended for printing images. The CMY(K) colors are generally used
for the printer system color output. RGB colors such as the other color look-up tables
used here are applied generally for color representation on monitors. Because these
two color systems vary greatly, the colors in the CMY(K) representation can differ
strongly from those used in the monitor representation.

All color look-up tables are also available with inverse color flow, meaning high intensities are
represented as dark and low intensities as light.

Viewing the Single Image
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Function
Click on the Single button to view only one detection channel or several detection channels in only
one image in the Viewer window. The following display modes are available depending on the other
options you enable simultaneously.

Button Combination Display
Single + Channel
1 / 2 / 3 / 4 / 5

Only the selected detection channel is displayed; for an image
series, the first image of the selected detection channel is displayed.

Single + Gallery + Channel
1 / 2 / 3 / 4 / 5

All individual images in an image series are displayed for the
selected detection channel only.

Single + Overlay + Channel
1 / 2 / 3 / 4 / 5

A single overlay image is generated from all selected detection
channels; for an image series, the first image of each selected
detection channel is used.

Single + Gallery + Overlay +
Channel 1 / 2 / 3 / 4 / 5

Based on the number of individual images in an image series,
overlay images are generated from all selected detection channels.

The Single and Tiled buttons can not be enabled simultaneously because they carry out

opposing functions.

Viewing a Multiple Image

Function
If you click the Tiled button, the detection channels are displayed separately in the Viewer window.
The following display modes are available depending on the other options you enable simultaneously.

Button Combination Display
Tiled + Channel
1 / 2 / 3 / 4 / 5

All selected detection channels are displayed separately; in the case
of image series, the first image in each is applied.

Tiled + Gallery + Channel
1 / 2 / 3 / 4 / 5

All individual images in an image series are displayed for all selected
detection channels.

Tiled + Overlay + Channel
1 / 2 / 3 / 4 / 5

All selected detection channels are displayed both separately and, in
an overlay image, together. In the case of image series, the first
image in each is applied.

Tiled + Gallery + Overlay +
Channel 1 / 2 / 3 / 4 / 5

All individual images of an image series are displayed both separately
for all selected detection channels and, in overlay images, together.

The Tiled and Single buttons can not be enabled simultaneously because they carry out

opposing functions.
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Viewing the Series Image

Function
If you click the Gallery button, all of the individual images in an image series are displayed in the
Viewer window. The following display modes are available depending on the other options you enable
simultaneously.

Button Combination Display
Gallery + Single + Channel
1 / 2 / 3 / 4 / 5

All individual images in an image series are displayed for the
selected detection channel only.

Gallery + Single + Overlay +
Channel 1 / 2 / 3 / 4 / 5

Based on the number of individual images in an image series,
overlay images are generated from all selected detection channels.

Gallery + Tiled + Channel
1 / 2 / 3 / 4 / 5

All individual images in an image series are displayed for all selected
detection channels.

Gallery + Tiled + Overlay +
Channel 1 / 2 / 3 / 4 / 5

All individual images of an image series are displayed both
separately for all selected detection channels and, in overlay images,
together.

Viewing an Overlay Image in RGB

Function
Clicking the Overlay button displays all selected detection channels together in an overlay image in
the Viewer window. In contrast to the Overlay RGB button, the detection channels are always
displayed with currently specified color look-up tables. For this purpose, the color values of the pixels
are averaged. The following display modes are available depending on the other options you enable
simultaneously.

Button Combination Display
Single + Overlay + Channel
1 / 2 / 3 / 4 / 5

A single overlay image is generated from all selected detection
channels; for an image series, the first image of each selected
detection channel is used.

Gallery + Single + Overlay +
Channel 1 / 2 / 3 / 4 / 5

Based on the number of individual images in an image series,
overlay images are generated from all selected detection channels.

Tiled + Overlay + Channel
1 / 2 / 3 / 4 / 5

All selected detection channels are shown separately as well as
together in an overlay image. In an image series, the first image is
used.

Tiled + Gallery + Overlay +
Channel 1 / 2 / 3 / 4 / 5

All individual images of an image series are displayed both
separately for all selected detection channels and, in overlay
images, together.

Use the Viewer Options dialog window to select from three different methods of color mixing for
generating an overlay image:

� From the View menu, select Viewer Options.
� Click on the Overlay icon.

& see Viewer Options Dialog Window, Overlay Icon (page 180)
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Viewing an Overlay Image in RGB

Function
Clicking the Overlay rgb button displays all selected detection channels together in an overlay image
in the Viewer window. In contrast to the Overlay button, the detection channels are always displayed
with red, green and blue (RGB) color look-up tables. The following display modes are available
depending on the other options you enable simultaneously.

& see Viewing an Overlay Image (page 188)

Button Combination Display
Overlay rgb + Single +
Channel 1 / 2 / 3 / 4 / 5

A single overlay image is generated from all selected detection
channels; for an image series, the first image of each selected
detection channel is used.

Overlay rgb + Single + Gallery
+ Channel 1 / 2 / 3 / 4 / 5

Based on the number of individual images in an image series,
overlay images are generated from all selected detection channels.

Overlay rgb + Tiled + Channel
1 / 2 / 3 / 4 / 5

All selected detection channels are shown separately as well as
together in an overlay image. In an image series, the first image is
used.

Overlay rgb + Tiled + Gallery +
Channel 1 / 2 / 3 / 4 / 5

All individual images of an image series are displayed both
separately for all selected detection channels and, in overlay images,
together.

Use the Viewer Options dialog window to select from three different methods of color mixing for
generating an overlay image:

� From the View menu, select Viewer Options.

� Click on the Overlay icon.

& see Viewer Options Dialog Window, Overlay Icon (page 180)
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Viewing of Image Series

Viewing the First Image of a Series

Function
You can view the individual images of an image series as a film sequence. Click First to jump to the
first image in the series.

If the Gallery button is enabled, the First and Last, Next and Previous and Play/Stop

buttons are disabled and displayed in gray. The Gallery button is used to show all of the

individual images of an image series and does not allow film sequence mode.

Display the Next Image in a Series

Function
You can view the individual images of an image series as a film sequence. Click Next to jump to the
next image in the series.

If the Gallery button is enabled, the Next and Previous, First and Last and Play/Stop

buttons are disabled and displayed in gray. The Gallery button is used to show all of the

individual images of an image series and does not allow film sequence mode.

Displaying the Previous Image in a Series

Function
You can view the individual images of an image series as a film sequence. Click Previous to jump to
the previous image in the series.

If the Gallery button is enabled, the Next and Previous, First and Last and Play/Stop

buttons are disabled and displayed in gray. The Gallery button is used to show all of the

individual images of an image series and does not allow film sequence mode.
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Viewing the Last Image of a Series

Function
You can view the individual images of an image series as a film sequence. Click on the Last button to
jump to the last image in the series.

If the Gallery button is enabled, the First and Last, Next and Previous and Play/Stop

buttons are disabled and displayed in gray. The Gallery button is used to show all of the

individual images of an image series and does not allow film sequence mode.

Displaying any Image from a Series

Function
When you click on the Selection button, a dialog window opens which lets you select any image of a
series and display it in the Viewer window. The number of individual images for the series is displayed
from 1 to n, as well as in an entry field the number of the currently displayed image.

� Use the mouse to move the slide of the scale. The corresponding image is displayed
immediately.

� Enter the number of the desired image into the entry field, and click on Apply.

Starting and Ending a Film

Function
You can view the individual, recorded images of an image series as a film sequence. Use the
Play/Stop button to start and stop the film. The film speed, that is the number of single images per
time unit, is variable and can be set in the Viewer Options dialog window:

� From the View menu, select Viewer Options.
� Click on the Display icon and then on the Movie tab.

& see Viewer Options Dialog Window, Display Icon (page 176)

If the Gallery button is enabled, the Play/Stop, First and Last, Next and Previous

buttons are disabled and displayed in gray. The Gallery button is used to show all of the

individual images of an image series and does not allow film sequence mode.
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Viewing the Series image

Function
If you click the Gallery button, all of the individual images in an image series are displayed in the
Viewer window. The following display modes are available depending on the other options you enable
simultaneously.

Button Combination Display
Gallery + Single + Channel
1 / 2 / 3 / 4 / 5

All individual images in an image series are displayed for the
selected detection channel only.

Gallery + Single + Overlay +
Channel 1 / 2 / 3 / 4 / 5

Based on the number of individual images in an image series,
overlay images are generated from all selected detection channels.

Gallery + Tiled + Channel
1 / 2 / 3 / 4 / 5

All individual images in an image series are displayed for all
selected detection channels.

Gallery + Tiled + Overlay +
Channel 1 / 2 / 3 / 4 / 5

All individual images of an image series are displayed both
separately for all selected detection channels and, in overlay
images, together.
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Projections

Principles and Types of Projections

Biological specimens are recorded with a series of images. Each image is taken from a particular level
in the specimen. The result is a three dimensional recording that contains the entire volume of a
specimen. Each optical section (each individual image) depicts only the information from a single level
in the specimen. Therefore, structures that extend throughout the entire specimen will be partially
represented in several images. Projections are necessary to view these structures in their entirety.
Using projection algorithms, it becomes possible to select the relevant information from many images
and to depict this information in a single two dimensional image. This method can be used to
reconstruct connected structures.

Accordingly, a series of images is the foundation of any projection. The series may consist of
horizontal xy-sections or vertical xz-sections. In order to best understand the functionality of a
projection, it is practical to think of an image series as a stack of individual images. In turn, each
individual image consists of individual laser sampling points. Furthermore, the individual sampling
points or Voxels (1), (the intensity values measured in each individual image) lie on top of each other.
During creation of a projection, the sampling points of the individual images, which lie on top of each
other along the projection axis (2a, 2b), are scanned through all of the optical sections. Then, either
the intensity value that fulfills the selection criteria or another calculated value is depicted in a two-
dimensional image (4a, 4b) as a representative of all intensity values within the column. This is
repeated for each column of sampling points (3a, 3b).

(2a) Projection with an invariable projection axis
(2b) Projection with a variable projection axis

Projections with invariable or variable projection axes
There are two main groups of projection types available in the Leica Confocal Software. These are
distinguished by the type of projection axis. There are projections with invariable axes as well as
projections with variable axes. The first type is orthogonal projections. The projection axis is always
the optical axis that runs vertical to the stack of images (the z-axis with horizontal xy-cuts and the y-
axis with vertical xz-cuts). In contrast, the projection axis for the second type may be freely selected.
With the exception of the SFP projection, the same three projection types are available in both of the
two main groups.

The Projection Types
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Projection Type Invariable Projection Axis Variable Projection Axis
Maximum Projection

Average Projection

Transparent Projection

SFP Projection __________

Activate the projection type either with the corresponding button or in the Image Tool dialog window. If
you activate the function using the button, the projection image will just be a temporary display on the
monitor. When activated through the dialog window, the projection image will be stored as a new file
in the current experiment:

� The projections with invariable projection axes are located in the Image Tool dialog window / 3D button / Orthogonal
Projection icon.

� The projections with variable projection axes are located in the Image Tool dialog window / 3D button / Projections and
Animations icon.

� The SFP projection is located in the Image Tool dialog window / 3D button / SFP icon.

Maximum Projection
During maximum projection, we assume that the maximum intensity values are the relevant
information for the reconstruction of a structure. For this reason, the maximum value is found in each
column of sampling points and is displayed in the two dimensional projection image as representative
of the entire column:

Ip = Max(Vn)
whereby Ip is the pixel in the projection image and Vn is the investigated Voxel

Average Projection
During average projection, every intensity value with equal weighting flows into the projection image.
For this reason, during average projection the arithmetic average of all intensity values is calculated in
each column of sampling points. This value is displayed in the two dimensional projection image as
representative of the entire column:
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whereby IP is the pixel in the projection image, Vn is the investigated Voxel, and N is the total number
of Voxel.

Transparent Projection
During transparent projection, all intensity values should be included in the projection image as well.
In contrast to average projection, the intensity values from the various individual images are weighted
differently. The intensity values from the lower images in the image stack are weighted less than the
intensity values from the upper images. For this reason, during transparent projection the weighted
mean of all intensity values is calculated in each column of sampling points. This value is displayed in
the two dimensional projection image as representative of the entire column:
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whereby In is the pixel in the projection image, Tn = 1 - (Vn / Vmax) is the standardization, α is the
variable transparent factor, In-1 is the value of the previously calculated Voxels, and Vn is the
currently investigated Voxel.

Calculation of the projection image begins with the lowest and ends with the highest individual image
in the image stack. Weighting of the intensity values is based on two factors.
The first factor, Tn, is calculated from the relationship of the respective intensity value to the maximum
possible intensity (standardization). This factor ensures that an image's gray value range from 0 to
255 at 8 bit, for example, will not be exceeded.
The second (user adjustable) transparent factor α (0 < α < 1) determines the weighting of the
previously measured intensity value. The higher the transparent factor is adjusted, the more the
intensity values from the lower levels in the image stack will be included in the projection image.

SFP Projection (Simulated Fluorescence Process), Mathematical Simulation of a Fluorescence
Process
This projection type uses arithmetic operations to simulate in a specimen the process of absorbing
laser light and emitting fluorescent light. This procedure is common in fluorescence microscopy. It
consists of two arithmetic steps.

The first step simulates the laser beam (1), which penetrates the sample and is thereby weakened.
We assume a lateral light source striking the Voxel of the image stack. The weakening of the
incoming beam while traversing the image stack is represented by the following expression:
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whereby In+1 is the remaining intensity of the incoming light after absorption in the nth Voxel, In is the
intensity of the incoming light in the nth Voxel, is the absorption coefficient of the laser light in the
sample, Vn is the intensity in the Voxel, and Vmax is the maximum Voxel intensity. The quotient Vn /
Vmax corresponds to the standardization.

For each Voxel, the illumination strength VIn = In x Vn is calculated using the calculated intensities
(In). This information is temporarily saved in a table (In = intensity of the incoming light in Voxel n, Vn
= intensity of the Voxel n). This calculation is completed in one step for the entire image stack (for all
Voxel in the direction of the incoming beam). The result is a table of illumination strengths.
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In the second step, the established illumination strengths are used to calculate the emitted
fluorescence (2). The recursive formula is used to calculate the intensity of the pixel in the projection
image as representative of the Voxel in the observer's viewing direction.

In
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In addition, α is the absorption coefficient of the fluorescent light in the sample and VIn is the
illumination strength of the nth Voxel, calculated in the first step.

Maximum Projection of an Image Stack with Invariable Projection Axis

Function
Use the fix. Max. button starts a maximum projection. For this function, the projection axis is always
the orthogonal axis (z-axis for horizontal xy-sections, and y-axis for vertical xz-sections).

The basis for a projection is an image stack, i.e. a series of horizontal xy-sections or vertical xz-
sections. When a projection is generated, the sampling points of the individual images—
superimposed along the projection axis—are examined throughout all optical sections. From each of
these columns of sampling points, the maximum intensity value is displayed in the two-dimensional
projection image as the representative of all intensity values within the column.

& see Principles and Types of Projections (page 193)

� Click on the fix. Max. button. A maximum projection of the current image stack is created and
displayed in the Viewer window.

� You can return to the original image anytime by clicking on the Original button.

In the Viewer Options dialog window, you can also adjust a threshold and scale the intensity value
range present in the image.

& see Viewer Options Dialog Window, Projections Icon (page 178)

A maximum projection can be activated using either the fix. Max. or the Process

operating step / Extended Focus folder. If you activate the function using the button, the

projection image will just be a temporary display on the monitor.

& see Process Operating Step / Materials Folder (page 217)
& see Creating an Experiment (page 244)

Note the difference between a maximum projection and a topographical image, which is

generated from intensity maximums. In a maximum projection, the intensity maximums

are assigned color values directly. In a topographical image based on intensity

maximums, the intensity maximums are assigned real z-positions of the individual
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sampling points first and then are color-coded.

& see Creating a Topographical Image (page 199)

Maximum Projection of an Image Stack with Variable Projection Axis
(optional, see the chapter "Optional Software Packages, 3D" on page 271 ff.)

Average Projection of an Image Stack with Invariable Projection Axis

Function
Use the fix. Avg. button starts an average projection. For this function, the projection axis is always
the orthogonal axis (z-axis for horizontal xy-sections, and y-axis for vertical xz-sections).

The basis for a projection is an image stack, i.e. a series of horizontal xy-sections or vertical xz-
sections. When a projection is generated, the sampling points of the individual images—
superimposed along the projection axis—are examined throughout all optical sections. From each of
these columns of sampling points, the arithmetic average is calculated from all intensity values and
displayed in the two-dimensional projection image as the representative of the complete column.

& see Principles and Types of Projections (page 193)

� Click on the fix. Avg. button. An average projection of the current image stack is created and
displayed in the Viewer window.

� You can return to the original image anytime by clicking on the Original button.

In the Viewer Options dialog window, you can also adjust a threshold and scale the intensity value
range present in the image.

& see Viewer Options Dialog Window, Projections Icon (page 178)
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An average projection can be activated either by using the fix. Avg. button or the

Process operating step / Extended Focus folder. If you activate the function using the

button, the projection image will just be a temporary display on the monitor.

& see Process Operating Step / Extended Focus Folder (page 217)
& see Creating an Experiment (page 244)

Average Projection of an Image Stack with Variable Projection Axis
(optional, see the chapter "Optional Software Packages, 3D" on page 271 ff.)

Transparent Projection of an Image Stack with Invariable Projection Axis

Function
Use the fix. Trans. button to start the transparent projection. For this function, the projection axis is
always the orthogonal axis (z-axis for horizontal xy-sections, and y-axis for vertical xz-sections).

The basis for a projection is an image stack, i.e. a series of horizontal xy-sections or vertical xz-
sections. When a projection is generated, the sampling points of the individual images—
superimposed along the projection axis—are examined throughout all optical sections. From each of
these sampling point columns, a weighted average is calculated from all intensity values, which is
then displayed in the two-dimensional projection image as a representative of the entire column.

& see Principles and Types of Projections (page 193)

The user can vary the weighting of the sampling points to calculate the averages by setting the
corresponding factors (transparent factor) in the Viewer Options dialog window. Furthermore, you can
indicate a threshold and scale the intensity value range for the image.

& see Viewer Options Dialog Window, Projections Icon (page 178)

� Click on the fix. Trans. button. A transparent projection of the current image stack is created and
displayed in the Viewer window.

� You can return to the original image anytime by clicking on the Original button.

You can activate a transparent projection using the fix.Trans. button or the Process

operating step / Extended Focus folder. If you activate the function using the button, the

projection image will just be a temporary display on the monitor.

& see Process Operating Step / Extended Focus Folder (page 217)
& see Creating an Experiment (page 244)



Leica Microsystems Heidelberg GmbH
LCS software functions:

Description of individual functions

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 199 of 307

Transparent Projection of an Image Stack with Variable Projection Axis
(optional, see the chapter "Optional Software Packages, 3D" on page 271 ff.)

Creating an SFP Projection of an Image Stack
(optional, see the chapter "Optional Software Packages, 3D" on page 271 ff.)

Creating a Topographical image

Function
Use the Topography function to select specific intensity data from an image stack, i.e. a series of xy or
xz-sections, and transfer them into a two-dimensional topographical image. This function examines
the sampling points (voxels) that are superimposed along the z-axis throughout all optical sections.
From each of these columns of sampling points, only the intensity value that is met by the selection
criterion is displayed in the two-dimensional topographical image as the representative of all values
within the column.

You can make your selection based on either the maximum intensity or the center of mass of the
measured intensities. If you want to represent the intensity maximums in the topographical image,
only the sampling point at which the maximum intensity was measured is selected. When determining
the center of mass, a mean value is calculated from all superimposed sampling points (the center of
mass of the area that is limited by the curve of the measured intensity values).

The intensity maximum or center of mass is then assigned the real z position of the corresponding
sampling point and then color-coded. Based on this assignment, a topographical image maps the real
surface structure of the specimen. Using the default settings, higher structures appear light and
deeper structures dark.

Use the Viewer Options dialog window to set the selection criterion for the topographical image:

� From the View menu, select Viewer Options.
� Click on the Surface Calculation icon to view the Topography tab.

& see Viewer Options Dialog Window, Surface Calculation Icon (page 183)

By applying a second step, you can display the topographical image as a three-dimensional graphical
image using the 3D View function.

& see Creating the 3D View (page 200)

Typical Applications
Displaying the image data in a topographical image is especially informative in material scientific
research. For the application of quantification functions, the topography function is indispensable.

Viewing the Original image

Function
Click on the Original button to undo a projection image or topographical image. The Viewer window
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then displays the recorded raw data of the image again.

Creating sectional views of an image stack

Function
Clicking on the Sectioning button creates two sectional views of the active image data set and
displays them on the right and lower portion of the image data set. This function can be applied only
to one detection channel at a time.

Sectional views of an image stack Display of sectional views in the Viewer window

Creating 3D Views

Creating the 3D View

Function
Use the 3D View button to display a two-dimensional data record three-dimensionally. When viewing
an image series, the data record of the series that is currently being viewed in the Viewer window is
always the one applied. You can display a single xy-section or xz-section from the raw data or a result
image, such as a topographical image or projection image, in the 3D view. Depending on the
dimension represented or calculated in the output image, either intensity values or height values are
mapped to the z-axis of the 3D view when the 3D view is generated.

The spatial representation of intensity in a 3D view leads easily to the assumption that

the topography of the specimen is being represented. Note however that you can only

display the real surface structure of a specimen if you have generated a

topographical image first.
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& see Creating a Topographical Image (page 199)

The 3D view can be generated in three different modes: surface, wireframe or isolines. Set the display
mode in the Viewer Options dialog window:

� From the View menu, select Viewer Options.
� Click on the Surface View icon and then click the Visualization tab.

& see Viewer Options Dialog Window, Surface View Icon (page 181)

A separate 3D view is created for each detection channel. Therefore it is not possible to

generate a single 3D view from one overlay image (Overlay button).

Rotating the 3D View

Function
Use the Rotate button to rotate a 3D view in all three spatial directions. Note that the 3D view is
rotated around a fixed point, which is located in the center of the image.

� Hold the mouse pointer over any position in the 3D view.
� Press and hold the left mouse button.
� Move the mouse pointer in the direction in which you want to rotate the 3D view.

While the 3D view is being turned, the resolution of the image is decreased in order to

speed up processing. When the left mouse button is released, the image is displayed

with its original resolution.

As an alternative to rotating a 3D view manually, the Viewer Options dialog window also provides the
option of specifying the angles of rotation for the three spatial axes:

� From the View menu, select Viewer Options.
� Click on the 3D icon and then click the Navigation tab.
� You can then specify the angles of rotation for all three axes in the Rotation field.

& see Viewer Options Dialog Window, 3D Icon (page 174)

Moving the 3D View

Function
Use the Move button to shift a 3D view:



Leica Microsystems Heidelberg GmbH
LCS software functions:

Description of individual functions

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 202 of 307

� Hold the mouse pointer over any position in the 3D view.
� Press and hold the left mouse button.
� Move the mouse pointer in the direction in which you want to move the 3D view.

While the 3D view is being moved, the resolution of the image is decreased in order to

speed up processing. When the left mouse button is released, the image is displayed

with its original resolution.

As an alternative to moving a 3D view manually, the Viewer Options dialog window also provides the
option of specifying the coordinate values for the position of the image:

� From the View menu, select Viewer Options.
� Click on the 3D icon and then click the Navigation tab.
� Modify the coordinate values for the x-axis and z-axis in the Translation field.

& see Viewer Options Dialog Window, 3D Icon (page 174)

Zooming the 3D View

Function
Use the Zoom button to magnify and shrink a 3D view steplessly while maintaining the aspect ratio.
This function only adjusts the scale of the generated image. It can not be used to improve its
resolution.

To zoom in on
the 3D view:

Click anywhere inside the image window of the Viewer window and, while
pressing the left mouse button, drag the mouse pointer toward the lower edge.

To zoom out of
the 3D view:

Click anywhere inside the image window of the Viewer window and, while
pressing the left mouse button, drag the mouse pointer toward the upper edge.

While the 3D view is being zoomed, the resolution of the image is decreased in order to

speed up processing. When the left mouse button is released, the image is displayed

with its original resolution.

As an alternative to zooming a 3D view manually, the Viewer Options dialog window also allows you
to change the zoom scale by specifying numerical values:

� From the View menu, select Viewer Options.
� Then click on the 3D icon.
� You can then vary the zoom factor in the Navigation tab by changing the y value in the

Translation field.

& see Viewer Options Dialog Window, 3D Icon (page 174)
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The Leica Confocal Software features three distinguishing zoom functions: 3D zoom,

electronic zoom and graphic zoom.

& see Electronic Zoom (page 139)
& see Viewer Options Dialog Window, Display Icon (page 176)

Visualizing Correlation of Detection Channels

See Optional Software Packages / Multicolor (page 260 ff.)
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Data Processing

3D Projections and Animations of Image Series
(optional, see the chapter "Optional Software Packages, 3D" on page 271 ff.)

Arithmetic and Boolean Operations

This chapter contains the following topics
�Setup and operation of the Process operating step
�Navigation: Arithmetic and Boolean Logic\ Image and Image
�Navigation: Arithmetic and Boolean Logic\ Image and Constant

Setup and operation of the Process operating step

After clicking the Process arrow symbol, the usual setup of the user interface is completely changed.
All function buttons of the other button areas/operating steps are hidden. The Experiment Overview
(1) display window is shown on the left with the opened experiments. The navigation window (2) with
the directory tree of all functions available in this operating step is located underneath it. The middle of
the user interface displays 10 large tiles (3), which comprise the 10 function groups. A help field (4) is
located above these tiles, which can display a brief explanation of a function group by holding the
mouse pointer over the corresponding tile.

� Click on the tile with the desired function group. On every navigational level, you can display an
explanation of the function groups in the top help field by holding the mouse pointer over the
corresponding tile.

� Select one tile each on the following navigational levels until you have reached the desired
function with the corresponding dialog on the lowest level.

� You can directly select a function in the navigation window by clicking the corresponding folder.

The menu bar at the top right offers the following buttons (5):
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� Click Back to return to the previously displayed navigational level.
� Click Forward to display the level which you selected prior to clicking the Back button.
� Click Up to enter the next higher level in the hierarchy.
� Click Reset to return modified variables to their last setting.
� To exit the Process operating step, click the arrow symbol of another operating step (e.g.

Acquire).

The bottom of every dialog displays the following two buttons:

� Click Preview to execute the selected function and to display the resulting image on the right in
the preview window.

� Click Apply to apply the selected function to the current image data set, to display the resulting
image in the Viewer display window and to create a new file in the current experiment.

Navigation: Arithmetic and Boolean Logic\ Image and Image
Arithmetic and logical operations with two image data sets

A requirement for running arithmetical operations is equal dimensions or a 1/n

relationship of the two data sets. Equal dimensions means that two images must have

the same format in x and y, and that two image stacks must have the same number of

single images (z). The 1/n relationship exists when, for example, 1 single image is

offset against each (nth) single image of an image stack.
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Boolean Logic tile

& see Boolean Operations (page 291)

� In the Experiment Overview display window, select the first image data set by double-clicking
the file.

� In the Second Source Image field, select the second image data set for the calculation process.
� Select the AND operator to combine the binary representations of the pixels of the two selected

images with the logical AND operator. That means that pixels in the result image are given the
value 1 when the value 1 is present in both of the pixels; otherwise 0 is entered.
You achieve meaningful results using this Boolean operator when you link an image with a
binary mask. The pixel is displayed in the result image at the point where the pixels of the image
meet the pixels of the mask with the value 1. The areas defined by the mask are cut out of the
image.

� Select the OR operator to combine the binary representations of the pixels of the two selected
images with the logical OR operator. That means that pixels in the resulting image are given the
value 1 when the value 1 is present in at least one of the two pixels; otherwise 0 is entered.
You achieve meaningful results using this Boolean operator:
1. When you link two binary masks. The result image is a combination of the two masks.
2. When you link an image with a binary mask. The result image is an image in which the mask
appears.
3. When you link two images. In contrast to the overlay image, pure intensity values are overlaid
here. An RGB color addition does NOT take place here.
& see Viewing an Overlay Image (page 188)

� Select the XOR operator to combine the binary representations of the pixels of the two selected
images with the logical XOR operator. That means that pixels in the resulting image are given
the value 1 when the two pixels have different values; otherwise 0 is entered.
You achieve meaningful results using this Boolean operator when you create two binary masks
of images and link them. The pixel is displayed in the result image at the point where the two
images differ.

Arithmetic with World Coordinates tile
Arithmetic with Pixel Values tile
If you select Arithmetic with World Coordinates, world coordinates such as the z-position, the time or
the wavelength are used for the arithmetic operations. If you selected Arithmetic with Pixel Values, the
gray values standardized to the interval 0 – 255 for 8 bits or 0 – 4095 for 12 bits are used.

� In the Experiment Overview display window, select the first image data set by double-clicking
the file.

� In the Second Source Image field, select the second image data set for the calculation process.
� Select Addition to add the intensity values of the two selected images according to the formula:

pixel (resulting image) = pixel (first source image) + pixel (second source image).
� Select Subtraction to subtract the intensity values of the two selected images according to the

formula: pixel (resulting image) = pixel (first source image) – pixel (second source image).
� Select Multiplication to multiply the intensity values of the two selected images according to the

formula: pixel (resulting image) = pixel (first source image) x pixel (second source image).
� Select Division to divide the intensity values of the two selected images according to the

formula: pixel (resulting image) = pixel (first source image) / pixel (second source image).
� Select Min to use the minimum value of the two selected images for each pixel in the resulting

image according to the formula: pixel (resulting image) = MIN (pixel (first source image); pixel
(second source image)).

� Select Max to use the maximum value of the two selected images for each pixel in the resulting
image according to the formula: pixel (resulting image) = MAX (pixel (first source image); pixel
(second source image)).

� Select Average to use the average value of the two selected images for each pixel in the
resulting image according to the formula: pixel (resulting image) = 1/2 x (pixel (first source
image) + pixel (second source image)).
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� If you select 12 Bit Output in the Output Option field, each pixel in the result image is coded with
12 bits, i.e. the result values are saved in a value range from [0..4095].

� Click on the Absolute Value check box if the amounts of the result data are to be used. This
turns negative results into positive results.

Only for Arithmetic with Pixel Values
� Click on the Cut at Maximum check box to cut off values that fall outside the value range

following the calculation. Values less than 0 are set to 0. All values greater than 255 for 8-bit
images or 4095 for 12-bit images are set to the value 255 or 4095.

� Click on the Rescale check box to standardize the intensity values of the image to the maximum
possible intensity values. The extreme values are determined. The minimum value is assigned
to the 0. The maximum value for 8-bit images is assigned to the value 255, for 12-bit images to
the value 4095. This ensures that the calculated pixel values of the resulting image remain
within the respective value range.

Navigation: Arithmetic and Boolean Logic\ Image and Constant
Arithmetic and logical operations with one image data set and one constant

A requirement for running arithmetical operations is equal dimensions or a 1/n

relationship of the two data sets. Equal dimensions means that two images must have

the same format in x and y, and that two image stacks must have the same number of

single images (z). The 1/n relationship exists when, for example, 1 single image is

offset against each (nth) single image of an image stack.

Boolean Logic tile

& see Boolean Operations (page 291)

���� Enter a value for the constant in the Constant field. In the Experiment Overview display window,
select the image data set to be processed by double-clicking the file.

���� Select the AND operator to combine the binary representations of the pixels of the constant and
the image with the logical AND operator. That means that pixels in the result image are given
the value 1 when the value 1 is present in both of the pixels; otherwise 0 is entered.

���� Select the OR operator to combine the binary representations of the pixels of the constant and
the image with the logical OR operator. That means that pixels in the resulting image are given
the value 1 when the value 1 is present in at least one of the two pixels; otherwise 0 is entered.

���� Select the XOR operator to combine the binary representations of the pixels of the constant and
the image with the logical XOR operator. That means that pixels in the resulting image are given
the value 1 when the two pixels have different values; otherwise 0 is entered.

Arithmetic with World Coordinates tile
Arithmetic with Pixel Values tile
If you select Arithmetic with World Coordinates, world coordinates such as the z-position, the time or
the wavelength are used for the arithmetic operations. If you selected Arithmetic with Pixel Values, the
gray values standardized to the interval 0 – 255 for 8 bits or 0 – 4095 for 12 bits are used.

���� Enter a value for the constant in the Constant field. In the Experiment Overview display window,
select the image data set to be processed by double-clicking the file.

� Enter a value for the constant in the Constant field. The image data set is automatically the
active image data record in the Viewer window.

� Select Addition to add the constant pixel by pixel to the intensity values of the selected image
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according to the formula: pixel (resulting image) = pixel (source image) + constant.
� Select Subtraction to subtract the constant pixel by pixel from the intensity values of the selected

image according to the formula: pixel (resulting image) = pixel (source image) – constant.
� Select Multiplication to multiply the constant pixel by pixel with the intensity values of the

selected image according to the formula: pixel (resulting image) = pixel (source image) x
constant.

� Select Division to divide the intensity values of the selected image by the constant according to
the formula: pixel (resulting image) = pixel (source image) / constant.

� Select Min to use the minimum value each of the selected image and constant for each pixel in
the resulting image according to the formula: pixel (resulting image) = MIN (pixel (source image);
constant).

� Select Max to use the maximum value each of the selected image and constant for each pixel in
the resulting image according to the formula: pixel (resulting image) = MAX (pixel (source
image); constant).

� Select Average to use the average value each of the selected image and constant for each pixel
in the resulting image according to the formula: pixel (resulting image) = 1/2 x (pixel (source
image) + constant).

� If you select 12 Bit Output in the Output Option field, each pixel in the result image is coded with
12 bits, i.e. the result values are saved in a value range from [0..4095].

� Click on the Absolute Value check box if the amounts of the result data are to be used. This
turns negative results into positive results.

Only for Arithmetic with Pixel Values
� Click on the Cut at Maximum check box to cut off values that fall outside the value range

following the calculation. Values less than 0 are set to 0. All values greater than 255 for 8-bit
images or 4095 for 12-bit images are set to the value 255 or 4095.

� Click on the Rescale check box to standardize the intensity values of the image to the maximum
possible intensity values. The extreme values are determined. The minimum value is assigned
to the 0. The maximum value for 8-bit images is assigned to the value 255, for 12-bit images to
the value 4095. This ensures that the calculated pixel values of the resulting image remain
within the respective value range.
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Conversion of the Bit Resolution of Images

This chapter contains the following topics
� Setup and operation of the Process operating step
� Navigation: Conversion\ Bit Depth Conversion

Setup and operation of the Process operating step

After clicking the Process arrow symbol, the usual setup of the user interface is completely changed.
All function buttons of the other button areas/operating steps are hidden. The Experiment Overview
(1) display window is shown on the left with the opened experiments. The navigation window (2) with
the directory tree of all functions available in this operating step is located underneath it. The middle of
the user interface displays 10 large tiles (3), which comprise the 10 function groups. A help field (4) is
located above these tiles, which can display a brief explanation of a function group by holding the
mouse pointer over the corresponding tile.

� Click on the tile with the desired function group. On every navigational level, you can display an
explanation of the function groups in the top help field by holding the mouse pointer over the
corresponding tile.

� Select one tile each on the following navigational levels until you have reached the desired
function with the corresponding dialog on the lowest level.

� You can directly select a function in the navigation window by clicking the corresponding folder.

The menu bar at the top right offers the following buttons (5):

� Click Back to return to the previously displayed navigational level.
� Click Forward to display the level which you selected prior to clicking the Back button.
� Click Up to enter the next higher level in the hierarchy.
� Click Reset to return modified variables to their last setting.
� To exit the Process operating step, click the arrow symbol of another operating step (e.g.

Acquire).
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The bottom of every dialog displays the following two buttons:

� Click Preview to execute the selected function and to display the resulting image on the right in
the preview window.

� Click Apply to apply the selected function to the current image data set, to display the resulting
image in the Viewer display window and to create a new file in the current experiment.

Navigation: Bit Depth Conversion
Converting images of 8-bit depth to 12-bit depth and vice versa

� In the Experiment Overview display window, select the image data set to be processed by
double-clicking the file.

� The Source field displays the bit depth of the selected image.
� Select the bit depth in the New Resolution field to which the image data set is to be converted.

Merging or Separating of Image Segments, Images and Image
Series

This chapter contains the following topics
� Setup and operation of the Process operating step
� Navigation: Editing\ Merging
� Navigation: Editing\ Separation

Setup and operation of the Process operating step

After clicking the Process arrow symbol, the usual setup of the user interface is completely changed.
All function buttons of the other button areas/operating steps are hidden. The Experiment Overview
(1) display window is shown on the left with the opened experiments. The navigation window (2) with
the directory tree of all functions available in this operating step is located underneath it. The middle of
the user interface displays 10 large tiles (3), which comprise the 10 function groups. A help field (4) is
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located above these tiles, which can display a brief explanation of a function group by holding the
mouse pointer over the corresponding tile.

� Click on the tile with the desired function group. On every navigational level, you can display an
explanation of the function groups in the top help field by holding the mouse pointer over the
corresponding tile.

� Select one tile each on the following navigational levels until you have reached the desired
function with the corresponding dialog on the lowest level.

� You can directly select a function in the navigation window by clicking the corresponding folder.

The menu bar at the top right offers the following buttons (5):

� Click Back to return to the previously displayed navigational level.
� Click Forward to display the level which you selected prior to clicking the Back button.
� Click Up to enter the next higher level in the hierarchy.
� Click Reset to return modified variables to their last setting.
� To exit the Process operating step, click the arrow symbol of another operating step (e.g.

Acquire).

The bottom of every dialog displays the following two buttons:

� Click Preview to execute the selected function and to display the resulting image on the right in
the preview window.

� Click Apply to apply the selected function to the current image data set, to display the resulting
image in the Viewer display window and to create a new file in the current experiment.

Navigation: Editing\ Merging
Combining several images or data sets to a new image or data set

Amplitude tab
Adaptation of different bit resolutions and additional settings for calculating the resulting
image
� In the Experiment Overview display window, select the first image data set by double-clicking

the file.
� In the Second Source Image field, select the second image data set for the calculation process.
� In the Amplitude Image 1/2 Min. field, set the minimum intensity value. This value is «0» for data

sets with gray values. For data sets with world coordinates, this field shows the actual minimum.
The minimum is adjustable so that differently scaled data sets can be adapted to each other.
If a data set with a small interval of intensity values is combined with a data set featuring a large
intensity value range, the first one is shown darker than the second one. Adapting the minimum
values of both data sets scales them in such a way that equal parts of the intensity values of
both data sets are included in the merged image.

� In the Amplitude Image 1/2 Max. field, set the maximum intensity value. For data sets with gray
values, this value is «255» with 8-bit data or «4095» with 12-bit data. For data sets with world
coordinates, this field shows the actual maximum. The maximum is adjustable so that differently
scaled data sets can be adapted to each other.
If a data set with a small interval of intensity values is combined with a data set featuring a large
intensity value range, the first one is shown darker than the second one. Adapting the maximum
values of both data sets scales them in such a way that equal parts of the intensity values of
both data sets are included in the merged image.
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� In the Result field, you define the image resolution of the merged image. An 8-bit resolution can
display 256 different intensity levels. A 12-bit resolution can display 4096 different intensity
levels.

� If the Maximum Value option is selected in the Result field, the brightest pixel from the two
images to be merged is used to calculate the corresponding pixel of the merged image.

� If the Average Value option is selected in the Result field, the arithmetical mean from the two
images to be merged is used to calculate the corresponding pixel of the merged image.

If two strongly different images are calculated to a merged image by using the average method,

the black image background causes a reduction of the image intensity!

x, y, z, t, la tab
Definition of the stereoscopic arrangement of the output images in the resulting image before
combining
� In the Image 1 and Image 2 field, enter the position ( x / y / z / t / λ) of the output image in the

merged image in the Shift entry field. This value is typically «0». A value of > 0 is useful for
example, if a reduction of one output image is to be shown at a certain position of the other
output image. This function is also useful for lateral image series, such as those found in
biomapping.
& see Example of Moving an Image (page Fehler! Textmarke nicht definiert.)

� In the Image 1 and Image 2 field, enter the size of the dimensions ( x / y / z / t / λ) of the output
image in the merged image in the Size entry field.

� If you select the Append option field, the second data set is placed next to the first data set. The
direction of the placement depends on whether the check box on the x, y or z tab was selected.
Selecting this function on all the different tabs for x, y and z shifts the second output image either
in only one dimension or in several dimensions.

� In the Result field, you can specify the pixel after which the merged image ends.

Definition background: Absolute lengths are used to determine the dimensions of the merged

image. If the two data sets to be merged feature the same linear extension but a different

number of pixels (due to a different scan format), it must be decided whether the number of

pixels or the resulting total length is to be decisive for the merged image.

� If you select the Best Fit option in the Result field, the software uses the following procedure for
calculating the resulting image:
The width of a single pixel is calculated for both images: µm/pixel. If the difference of this size
between the two images is smaller than a factor of 2, this procedure uses the larger image
resolution (i.e., the smaller µm/pixel value) for the resulting image. If the deviation of the image
resolution between the two output images is larger than a factor of 2, the smaller image
resolution (i.e., the larger µm/pixel value) is used for calculating the resulting image. The number
of pixels of the resulting image (Element Number) divided by the total length results in the
resolution of the resulting image.

Definition background: Absolute lengths are used to determine the dimensions of the merged

image. If the two data sets to be merged feature the same linear extension but a different

number of pixels (due to a different scan format), it must be decided whether the number of
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pixels or the resulting total length is to be decisive for the merged image.

& see Selecting a Scan Format (page 142)

ch tab
Definition of the combination of images with different numbers of detection channels
� If two images or data sets with different numbers of detection channels are to be merged, you

define in the Image 1 field the channel number in the merged image at which the channels of the
output image 1 should be inserted.

� If two images or data sets with different numbers of detection channels are to be merged, you
define in the Image 2 field the channel number in the merged image at which the channels of the
output image 2 should be inserted.

� Selecting the option box distributes the two output images to different channels of the merged
image.
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Navigation: Editing\ Separation
Separating single images or image segments from a data set

� In the Experiment Overview display window, select the image data set to be processed by
double-clicking the file.

Dimension Selection field
� The ch entry field displays the detection channels of the image or the image series. Select the

detection channels from which the image segment or the individual images are to be separated.
� The number of pixels in y that is dependent upon the scan format is indicated in the y entry field.

Enter the number of pixels to be separated in the Start y and End y entry fields. Use the R
(Reset) button to undo the entries.

� The number of pixels in x that is dependent upon the scan format is indicated in the x entry field.
Enter the number of pixels to be separated in the Start x and End x entry fields. Use the R
(Reset) button to undo the entries.

� The number of single images of an image series is displayed in the z entry field. Enter the
number of images to be separated in the Start z and End z entry fields. Use the R (Reset) button
to undo the entries.

� An interval within a dimension can be entered in the Step z / y / x entry field. For example, if you
enter 2 in the Step z entry field, only every 2nd image is separated.

Examples
� If you want to separate all images of a detection channel from an image series, click in the ch

entry field on the channel to be separated without changing the values in the entry fields of the
other dimensions.

� If you want to separate complete single images from an image series, enter the corresponding
numbers in the Start z and End z entry fields without changing the values in the entry fields of
the other dimensions.

� If you want to separate a segment in all images of an image series, define the size of the
segment in the Start x, End x and Start y, End y entry fields without changing the values in the
entry fields for z.

Adjusting Brightness, Contrast and Gamma Correction

This chapter contains the following topics
�Setup and operation of the Process operating step
�Navigation: Enhancement\ Contrast and Brightness
�Navigation: Enhancement\ Gamma Correction

Setup and operation of the Process operating step
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After clicking the Process arrow symbol, the usual setup of the user interface is completely changed.
All function buttons of the other button areas/operating steps are hidden. The Experiment Overview
(1) display window is shown on the left with the opened experiments. The navigation window (2) with
the directory tree of all functions available in this operating step is located underneath it. The middle of
the user interface displays 10 large tiles (3), which comprise the 10 function groups. A help field (4) is
located above these tiles, which can display a brief explanation of a function group by holding the
mouse pointer over the corresponding tile.

� Click on the tile with the desired function group. On every navigational level, you can display an
explanation of the function groups in the top help field by holding the mouse pointer over the
corresponding tile.

� Select one tile each on the following navigational levels until you have reached the desired
function with the corresponding dialog on the lowest level.

� You can directly select a function in the navigation window by clicking the corresponding folder.

The menu bar at the top right offers the following buttons (5):

� Click Back to return to the previously displayed navigational level.
� Click Forward to display the level which you selected prior to clicking the Back button.
� Click Up to enter the next higher level in the hierarchy.
� Click Reset to return modified variables to their last setting.
� To exit the Process operating step, click the arrow symbol of another operating step (e.g.

Acquire).

The bottom of every dialog displays the following two buttons:

� Click Preview to execute the selected function and to display the resulting image on the right in
the preview window.

� Click Apply to apply the selected function to the current image data set, to display the resulting
image in the Viewer display window and to create a new file in the current experiment.

Navigation: Enhancement\ Brightness and Contrast
Adjusting brightness and contrast
If you change the brightness of an image, the high, medium and low brightness values of the image
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will change to the same degree. Contrast is used to vary the ratio of bright and dark values in the
image.

� In the Experiment Overview display window, select the image data set to be processed by
double-clicking the file.

� For multichannel images, select the Lock Channels check box to make all changes for all
channels at one time and to the same extent.

� For images that do not use the entire dynamic range, select the Linear Model check box. If the
check box has been clicked, there is a linear relationship between the brightness in the output
image and the resulting image. Whether an image uses the entire dynamic range available can
be seen by creating a histogram of the image. If the histogram does not cover the entire
intensity range (see minimum and maximum values), the dynamic range is not being used in full.
& see Calculating a Histogram (page 227)
If you have images in which you wish to highlight the medium brightness values more strongly,
select the nonlinear model (Linear Model check box is not enabled).

� In the Channel Adjustment field, change the brightness of the resulting image using the
Brightness slider. If the slider is exactly in the center, the output image and resulting image have
exactly the same level of brightness. If the slider is moved from the center to the right, the result
image becomes brighter than the output image. If the slider is moved from the center to the left,
the resulting image becomes darker than the output image.

� In the Channel Adjustment field, change the contrast of the resulting image using the Contrast
slider. If the slider is exactly in the center, the output image and result image have exactly the
same level of contrast. If the slider is moved from the center to the right, the result image has
greater contrast than the output image. If the slider is moved from the center to the left, the
result image has less contrast than the output image.

Navigation: Enhancement\ Gamma Correction
Adjusting the medium brightness values (gamma correction)
The gamma correction can be used to influence the conversion of the output image contrast to the
resulting image contrast in a nonlinear manner. The gamma correction only affects the medium
brightness values of an image, whereas the very bright and very dark image sections remain
unchanged.

� In the Experiment Overview display window, select the image data set to be processed by
double-clicking the file.

� For multichannel images, select the Lock Channels check box to make all changes for all
channels at one time and to the same extent.

� In the Channel Adjustment field, change the medium brightness values of the resulting image
using the slider. If the slider is exactly in the center, the output image and resulting image have
exactly the same level of brightness. If the slider is moved from the center to the right, the
medium brightness values become brighter. If the slider is moved from the center to the left, the
medium brightness values become darker.
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Expanded Focus by Projecting Image Stacks onto a Single Image

This chapter contains the following topics
�Setup and operation of the Process operating step
�Navigation: Extended Focus \ Average Projection, Maximum Projection, Transparent Projection

Setup and operation of the Process operating step

After clicking the Process arrow symbol, the usual setup of the user interface is completely changed.
All function buttons of the other button areas/operating steps are hidden. The Experiment Overview
(1) display window is shown on the left with the opened experiments. The navigation window (2) with
the directory tree of all functions available in this operating step is located underneath it. The middle of
the user interface displays 10 large tiles (3), which comprise the 10 function groups. A help field (4) is
located above these tiles, which can display a brief explanation of a function group by holding the
mouse pointer over the corresponding tile.

� Click on the tile with the desired function group. On every navigational level, you can display an
explanation of the function groups in the top help field by holding the mouse pointer over the
corresponding tile.

� Select one tile each on the following navigational levels until you have reached the desired
function with the corresponding dialog on the lowest level.

� You can directly select a function in the navigation window by clicking the corresponding folder.

The menu bar at the top right offers the following buttons (5):

� Click Back to return to the previously displayed navigational level.
� Click Forward to display the level which you selected prior to clicking the Back button.
� Click Up to enter the next higher level in the hierarchy.
� Click Reset to return modified variables to their last setting.
� To exit the Process operating step, click the arrow symbol of another operating step (e.g.

Acquire).
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The bottom of every dialog displays the following two buttons:

� Click Preview to execute the selected function and to display the resulting image on the right in
the preview window.

� Click Apply to apply the selected function to the current image data set, to display the resulting
image in the Viewer display window and to create a new file in the current experiment.

Navigation: Extended Focus\ Average Projection, Maximum Projection, Transparent Projection
Creating a Projection Image Along the Orthogonal Axis (z-axis with horizontal xy-sections and
y-axis with vertical xz-sections)

& see Principles and Types of Projections (page 193)

� In the Experiment Overview display window, select the image data set to be processed by
double-clicking the file.

� Select one of the three projection types: Average Projection, Maximum Projection, Transparent
Projection.

Options tab
� The Projection Direction field is used to specify the dimension to be used for the projection.

Select [z] for stereoscopic series, [t] for time series or [λ] for lambda series to create the
projection from all images of a detection channel, such as from image 1 to image 10 in detection
channel 1.
Select [ch] to create the projection from a certain image in all detection channels, for example
from image 1 in detection channel 1 and image 1 in detection channel 2.

� Click on Rescale in the Options field to standardize the intensity values of the image to the
maximum possible intensity values when creating the projection image. This ensures that the
calculated gray values of the projection image remain within the value range of, for example, 0 to
255 at 8 bits. This allows for brightening dark images.

� If you click on Invert in the Options field, the projection axis is mirrored. The calculation of the
projection image is thus in the opposite direction. This function makes sense above all in the
case of inverse microscopes to match the calculation of the projection image to the inverse
beam path of laser light.

� Move the slider in the Threshold field to define a threshold value. The intensity values below this
value are not taken into account for the creation of the projection image.

Factor tab (only for transparent projection)

& see Principles and Types of Projections (page 193)

� The Factor tab is only displayed if the transparent projection was selected. Use the slider to vary
the transparent factor α. The higher it is set, the stronger the intensity values flow from the lower
levels in the image stack into the projection image.

The three projection types can also be enabled directly using the corresponding buttons

(fix Max / fix Avg / fix Trans). If you activate the function using the button, the projection

image will just be a temporary display on the monitor.You can undo this using the

Original button.
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& see Maximum Projection of an Image Stack with Invariable Projection Axis (page 196)
& see Average Projection of an Image Stack with Invariable Projection Axis (page 197)
& see Transparent Projection of an Image Stack with Invariable Projection Axis (page 198)

Linear Filters and Morphological Filters
(optional, see the chapter “Optional Software Packages, 3D” on page 271 ff. or “Materials” on page
247 ff.)

Leveling and Filtering of Surface Images
(optional, see the chapter “Optional Software Packages, Materials” on page 247 ff.)

Identifying and Separating Superimposed Fluorescent Signals

This page contains the following topics
� Setup and operation of the Process operating step
� What are the dye finder tools used for?
� The Principle of Adaptive Dye Separation
� Navigation: Dye Finder\ Adaptive Dye Separation (Strong) / (Weak)
� Navigation: Dye Finder\ Manual Dye Separation
� The Principle of Spectral Dye Separation
� Navigation: Dye Finder\ Spectral Dye Separation
� Navigation: Dye Finder\ Dimensionality Reduction

Setup and operation of the Process operating step

After clicking the Process arrow symbol, the usual setup of the user interface is completely changed.
All function buttons of the other button areas/operating steps are hidden. The Experiment Overview
(1) display window is shown on the left with the opened experiments. The navigation window (2) with
the directory tree of all functions available in this operating step is located underneath it. The middle of
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the user interface displays 10 large tiles (3), which comprise the 10 function groups. A help field (4) is
located above these tiles, which can display a brief explanation of a function group by holding the
mouse pointer over the corresponding tile.

� Click on the tile with the desired function group. On every navigational level, you can display an explanation of the
function groups in the top help field by holding the mouse pointer over the corresponding tile.

� Select one tile each on the following navigational levels until you have reached the desired function with the
corresponding dialog on the lowest level.

� You can directly select a function in the navigation window by clicking the corresponding folder.

The menu bar at the top right offers the following buttons (5):

� Click Back to return to the previously displayed navigational level.
� Click Forward to display the level which you selected prior to clicking the Back button.
� Click Up to enter the next higher level in the hierarchy.
� Click Reset to return modified variables to their last setting.
� To exit the Process operating step, click the arrow symbol of another operating step (e.g. Acquire).

The bottom of every dialog displays the following two buttons:

� Click Preview to execute the selected function and to display the resulting image on the right in the preview window.
� Click Apply to apply the selected function to the current image data set, to display the resulting image in the Viewer

display window and to create a new file in the current experiment.

What are the dye finder tools used for?
Many of the fluorescent dyes used in fluorescence microscopy emit fluorescent light in closely
adjacent wavelength ranges so that the emission spectrums of the fluorescent signals are
overlapping. If specimens are marked with such fluorescent dyes and the dyes are detected
simultaneously, it may lead to overlapping of fluorescent signals. This so-called optical crosstalk
causes several fluorescent signals to be detected in only one detection channel. After image
recording, these fluorescent signals can no longer be differentiated from each other in the image data
set.

(1) Two-channel recording of two fluorescent dyes with overlapping
emission spectrums

(2) Schematic correlation
diagram of image data
from detection channel 1

and 2

Figure (1) illustrates the problems of crosstalk. Two fluorescent dyes, whose emission spectrums are
overlapping, are used for an image recording in two detection channels. While the emission light of
the green fluorescent dye is detected exclusively in detection channel 1, the fluorescent signals of the
red and green fluorescent dye overlap in detection channel 2. As a result, the image data acquired in
detection channel 2 can no longer be uniquely traced back to the green or the red fluorescent signal.
The crosstalk of the fluorescent signals is also visible in a correlation diagram. Correlation diagrams
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illustrate the common distribution of two variables. In Figure (2), the variables are the fluorescent
signals in detection channel 1 and detection channel 2. The scatter diagram of the red fluorescent dye
tends toward the plane diagonal of the correlation diagram since a certain share of the green
fluorescent dye was also detected in detection channel 2. Such a correlation diagram is available in
the Leica Confocal Software for an initial interpretation of an image data set using the cytofluorogram.
The cytofluorogram can be used to visualize the common distribution of image data sets with up to
three detection channels (fluorescent dyes).

& see Multicolor / Create 2D cytofluorogram (page 260)

The dye finder functions can be used to separate superimposed fluorescent signals again after image
recording by means of different mathematical methods:

Function Description
Adaptive Dye
Separation

The algorithm of adaptive dye separation uses a cluster analysis for identifying
and separating the fluorescent signals. No reference data of the fluorescent dyes
used for the creation of the image data set are required. This function can be
applied to spatial image series, time image series and lambda series.

Spectral Dye
Separation

The algorithm of the spectral dye separation performs a pixel-based singular
value decomposition. Reference data of the emission spectrums for the
fluorescent dyes used for the creation of the image data set are required. This
function can be applied only to lambda series.

Dimensionality
Reduction

The algorithm of dimensionality reduction is based on a principal component
analysis. This function allows reducing multidimensional lambda series to a few
dimensions, that is single images. This function can be applied only to lambda
series.

Manual Dye
Separation

This function allows the manual input of factors (matrix coefficients) to decrease
or increase the signal information in individual detection channels.

The Principle of Adaptive Dye Separation
The algorithm of adaptive dye separation can be used to identify and separate fluorescent signals in
an image data set without knowledge of the fluorescent dyes being used. This is done by means of a
cluster analysis. A cluster analysis is a mathematical method for classifying objects into homogenous
groups (clusters). The classification into groups is carried out by means of a variable, i.e. a feature
describing all analyzed objects. A group is homogenous if its objects are as similar as possible with
respect to the variable (the feature).

This mathematical classification method is applied to the problem of superimposed fluorescent
signals. The objects to be classified are the intensity values (gray-scale values of the pixels) that are
recorded in different detection channels (wavelength ranges). If all combinations of these intensity
values are mapped in the so-called feature space, it is possible to classify them into groups, i.e.
assign them to a fluorescent dye. The level of the intensity value in the respective detection channels
serves as feature variable.
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(3) Intensity values (gray-scale values)
from the different detection channels are

combined to vectors

(4) Objects in the three-dimensional feature space
Each pixel represents an intensity value triple.

To apply the cluster analysis, the intensity value combinations are mapped as pixels in the feature
space (4). In contrast to the local space with its three spatial axes, the feature space is a geometric
space whose dimensions are formed by variables. In the case of the image data sets analyzed in
fluorescence microscopy, the axes of the feature space are the intensity values measured in different
detection channels (wavelength ranges) (3). Each point in the feature space is characterized by a
vector.

The individual steps of the cluster analysis
The first two steps of the cluster analysis serve to reduce the amount of data, thereby accelerating the
calculation. In the first step, the points closely surrounding the origin of the feature space are removed
(5). These values in the lower value range represent noise that does not contribute any information
about the specimen and can be deleted. The second step consists of projecting the points located in
the feature space onto the unit sphere, a sphere with radius 1 (6).

(5) Removing noise surrounding the origin (6) Projection of points onto the unit sphere
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Afterward, the actual cluster analysis is carried out. The cluster analysis aims at differentiating as
many groups of points in the feature space as there are fluorescent dyes that are used for creating the
image data set. The measure used to determine the similarity or dissimilarity of the points is the
Euclidian distance (the sum of squares of distances) of the points to calculated midpoints. This
measure is used to search groups of points in which the distance of each point to the midpoint of its
group is smaller than to the midpoint of the other groups:

(7) Two random clusters with
midpoints are defined.

(8) Each point is assigned to the
midpoint closest to it.

(9) The position of the midpoints
is recalculated.

(10) New clusters after the
correction of the midpoints.

(11) Each point is assigned to
the midpoint closest to it.

(12) The position of the midpoints
is recalculated.

First, a certain number of clusters with midpoints is specified (7), which is entered on the user
interface before the calculation. Next, each point in the feature space is assigned to the midpoint
closest to it (8). The new midpoint is calculated for each cluster (9). All points are again assigned to
the midpoint closest to them (11), and the midpoints of the new clusters are calculated (12). This
method is repeated again until the groups do no longer change.

Crosstalk correction
After the fluorescent dyes have been isolated as separated groups of points in the feature space by
means of the cluster analysis, the superimposition of the fluorescent signals must be corrected. The
superimposition can be seen in the feature space by the angle of the scatter diagrams to the axes of
the feature space.

(13) Perfect separation of
fluorescent signals

(14) Real characteristic of
fluorescent signals

(15) Crosstalk correction

Because from a mathematical point of view, the scatter diagrams of two completely independent, that
is uncorrelated variables in the feature space are at a right angle (90°) to each other (13). However,
image data sets with superimposed fluorescent signals show scatter diagrams that tilt toward the body
diagonal due to the correlating image data. The more acute the angle between the scatter diagrams,



Leica Microsystems Heidelberg GmbH
LCS software functions:

Description of individual functions

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 224 of 307

the stronger the correlation of the fluorescent signals (14). To separate the superimposed fluorescent
signals, the scatter diagrams must mathematically be calculated back to right angle.

For this purpose, it is necessary to determine a reference point for each cluster, whose spatial
position results in the reference angle.

(16) Adaptive dye separation (strong) (17) Adaptive dye separation (weak)

The calculated angle of the respective straight line is added to or subtracted from each point of the
original scatter diagram. This is accomplished by means of a matrix operation, which corresponds to a
projection onto the planes of the feature space. As a result, the tilted straight lines/scatter diagrams
are «erected» again or, in other words, drawn apart. This can be visualized using the cytofluorogram.

Navigation: Dye Finder\ Adaptive Dye Separation (Strong)
Navigation: Dye Finder\ Adaptive Dye Separation (Weak)

� In the Experiment Overview viewer window, select the image data set to be edited with adaptive dye separation by
double-clicking the file. The image data set can be a spatial image series, a time image series or a lambda series.

� If necessary, correct the number of fluorescent dyes, which were used to create the image data set, in the Fluorescent
Dyes field. The software automatically enters the number of detection channels in this field.

�

Navigation: Dye Finder\ Manual Dye Separation
This function allows you to reduce the unwanted signal information of an image data set with up to
four detection channels by means of a matrix multiplication.



Leica Microsystems Heidelberg GmbH
LCS software functions:

Description of individual functions

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 225 of 307

The dialog window displays the matrix multiplication. The pixel values of the 4 possible channels of
the original image to be processed (1) are calculated with each other using the factors M11 through
M44 (2). The characteristic numbers of the M factors refer to the channels. For example, factor M12
represents the portion of signal information, which channel 2 of the original image (1) should have on
channel 1 of the resulting image (3). Since the factors M11, M22, M33 and M44 refer to the same
channel in the original image and resulting image, the value of these factors is set to 1.

� In the Experiment Overview display window, select the image data set to be processed by double-clicking the file.
� By changing the M factor, you increase or decrease the signal information in the channel of the resulting image. For

example, if the crosstalk of channel 2 in channel 1 is to be removed from the resulting image, enter a negative number
between 0 and 1 in the M12 field. If you enter positive numbers between 0 and 1 in the M12 field, the signal information
in channel 1 of the resulting image is increased.

The Principle of Spectral Dye Separation
The algorithm of spectral dye separation can be used to identify and separate fluorescent signals in
an image data set by means of the reference data of the emission spectrums of the fluorescent dyes
being used. This is done by means of a singular value decomposition.

(18) Acquisition of a lambda series with 12 single images

This method is based on the assumption that every pixel of an image data set is composed of a linear
superimposition of the emission spectrums of the fluorescent dyes used. Figure (18) shows the yellow
fluorescent signal of a lambda series that was created by the superimposed emission spectrums of
the green and the red fluorescent dye. Using the reference data of the emission spectrums of both
fluorescent dyes, it is possible to calculate the coefficients that define the share of the respective
fluorescent dye in each individual detection band. These coefficients are, in turn, used to calculate two
separate image data sets, which contain only the share of one fluorescent dye, from the yellow
fluorescent signal.



Leica Microsystems Heidelberg GmbH
LCS software functions:

Description of individual functions

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 226 of 307

Navigation: Dye Finder\ Spectral Dye Separation

� In the Experiment Overview display window, select the image data set to be processed by double-clicking the file. Only
lambda series can be processed using this function.

� In the Dye Selection field, select the fluorescent dyes that were used for the recording of the image data set to be edited by
selecting a check box and a fluorescent dye from the list field.

If the reference data of the desired fluorescent dye should not be available or if your

own reference data should be used, they can be imported using the dye editor.

The Principle of Dimension Reduction
Lambda series are images of a single optical plane that were recorded across a certain wavelength
range at a certain wavelength. In doing so, information about the specimen are redundantly recorded
in single images. Using the algorithm of dimension reduction, the redundant image information in
lambda series can be removed. In addition, the image data of the lambda series recorded in only one
detection channel are separated depending on the fluorescent dyes and displayed in separate
detection channels.

The method applied here is based on a principal component analysis. The principle of the principal
component analysis consists of transferring correlated image data into uncorrelated image data. A
transformation of the coordinate system is carried out for this purpose. The transformation aims at
finding the main components (main axes) of the scatter diagrams in the multidimensional feature
space by means of shifting the origin and rotation of the coordinate system. When viewing lambda
series in the feature space, each wavelength range, in which an image was recorded, represents a
dimension.

& see The Principle of Adaptive Dye Separation (page 221)

(19) Transformation of the coordinate system (20) Dimension reduction

First, the origin of the coordinate system is placed at the center of mass of the respective scatter
diagram. In the second step, the coordinate system is rotated in such a way that the first coordinate
points toward the largest variance of the scatter diagram. The second coordinate (and every
additional one in the multidimensional feature space), which must be orthogonal to the first
coordinate, is selected so that it describes the largest possible portion of the rest variance (19). In the
new coordinate system, the largest portion of the variance lies toward the x-axis, while a small portion
lies toward the y-axis.

To achieve the dimension reduction, the main components with relatively small variance are
neglected (20). No essential information is lost here since they contain only noise or redundant
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information shares. Finally, the image data of the compressed scatter diagram is displayed in
separated detection channels.

Navigation: Dye Finder\ Dimensionality Reduction
� In the Experiment Overview display window, select the image data set to be processed by double-clicking the file. Only

lambda series can be processed using this function.
� In the Number of Dimensions field, enter the number of fluorescent dyes that were used for creating the image data set.

Segmentation of Image Structures
(optional, see the chapter "Optional Software Packages, 3D" on page 271 ff.)

Measurement and Analysis Functions

Calculating a Histogram

Function
The Histogram function measures the frequency of a measurement variable, displays it in a curve and
in addition, calculates various statistical values. The histogram is measured from the data set selected
in the Viewer window. This data set can be a spatial series, a time series or a lambda series. The
statistical values are calculated dependent on the size of the third dimension—height (z) for spatial
series, time (t) for time series, wavelength (λ) for lambda series.

� Click on the Histogram button.
� A viewer window opens that displays the measurement curve for each detection channel and the

statistical values.

Parameter Meaning Formula
# Pixel The total number of pixels that are included in the calculation of the histogram.

This corresponds to the configured scan format.
Mean Arithmetical mean value

Maximum Maximum value Max ( I)
Minimum Minimum value Min ( I)
Variance Variance

Average
Deviation

Average deviation

Standard
Deviation

Standard deviation

Mean Energy Average image energy

Root Mean
Square (RMS)

Root mean square value
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Skewness Skewness of the distribution

Some of the parameters are specified in scientific exponential notation, e.g. Pixel = 3.28e+005 =
327680 (corresponds to a scan format of 640 x 512).

Using the maximum and minimum values of intensity, the gain values and offset values

can be optimally configured for the detectors.

Measuring a Profile Within a Region of Interest (ROI)

Function
The Profile (z) function measures a measurement variable within a region of interest, displays it in a
curve and calculates various statistical values. The profile is measured from the data record selected
in the Viewer window. This data set can be a spatial series, a time series or a lambda series. The
statistical values are calculated dependent on the size of the third dimension—height (z) for spatial
series, time (t) for time series, wavelength (λ) for lambda series.

� Click on the Profile (z) button and draw a region of interest (ROI) in the image. The buttons used
to define a region of interest are activated together with the Profile (z) button.
& see Defining the Region of Interest (ROI) as an Ellipse (page 233 ff.)
& see Defining the Region of Interest (ROI) as a Polygon
& see Defining the Region of Interest (ROI) as a Rectangle
& see Automatically Defining the Region of Interest (ROI)
& see Selecting and Moving the Region of Interest (ROI)
& see Deleting Regions of Interest (ROI)

� A window opens automatically to display the measurement curve for every detection channel as
well as the statistical values.

Parameter Meaning Formula
# Pixel (ROI) Number of pixels within the selected region of interest
Area Area of the region of interest

Length Height of image stack (spatial
series)
Recording time (time series)
Bandwidth (lambda series)

Mean Amplitude The arithmetical mean

Maximum Amplitude Maximum value Max ( I)
Maximum amplitude
position

Position of maximum value Arg Max Ι (z), (t), (λ)

Minimum Amplitude Minimum value Min ( I)
Minimum amplitude Position of minimum value Arg Min Ι (z), (t), (λ)



Leica Microsystems Heidelberg GmbH
LCS software functions:

Description of individual functions

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 229 of 307

position
Average Deviation Average deviation

Standard Deviation Standard deviation

Variance Variance

The following four measurement values appear only when the Two-Point Measurement
function is selected in the Viewer Options dialog window.

� Select the View menu, the Experiment Overview option, and the Charts icon.
& see Viewer Options Dialog Window, Charts Icon (page 177)

� In the Measurement field you can switch two-point measurement on or off by selecting 2 Point or
Off.

l(µm); I(s);
I(nm)

Intensity measured at measuring point 1 (z, t, λ) I(z1); I(t1); I(λ1)

l(z); I(t); I(λ) Intensity measured at measuring point 2 (z, t, λ) I(z2); I(t2); I(λ2)
dI, dz Difference of values between measuring point 1 and 2 |I(z1) - I(z2)|; |I(t1) - I(t2)|,

|I(λ1) - I(λ2)|
d(z), (t), (λ) Height (z), recording time (t), bandwidth (λ) between the

measuring points 1 and 2
|z1 - z2|; |t1 - t2|, |λ1 - λ2|

Typical Applications
This function can be used to determine the extreme values of the intensity within an image stack.
They in turn allow for the optimized setting of the detectors. In addition, this function can be used to
determine the emission maximum of a lambda series. By adapting the width and the position of the
screens in front of the detectors, more emission light from the specimen can be recorded than with
conventional optical filters. In time series, this function can be used to determine the time of the
highest fluorescence activity.

This quantification function is only available off-line, i.e. for previously recorded data

sets.

Measuring a Profile Along a Line Segment

Function
The Profile function measures a measurement variable along a line segment, displays it in a curve
and calculates various statistical values. The profile is measured from the data record selected in the
Viewer window. This data set can be a spatial series, a time series or a lambda series. The statistical
values are calculated dependent on the size of the third dimension—height (z) for spatial series, time
(t) for time series, wavelength (λ) for lambda series.
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� Click on the Profile button. The measurement section is displayed as a white line in the image in
the Viewer window.
You can change the length and position of the line segment by clicking the line and, while
clicking and holding the grab point with the left mouse button, dragging it to the desired position.

� A window opens automatically to display the measurement curve for every detection channel as
well as the statistical values.

Parameter Meaning Formula
Length Length of the measured section

Mean
Amplitude

Arithmetic mean of measurement variable

Maximum
Amplitude

Maximum value of measurement variable Max ( I)

Minimum
Amplitude

Minimum value of measurement variable Min ( I)

Average
Deviation

Mean standard deviation of the values from
the average value of the measurement
variable

Standard
Deviation

Standard deviation of the values of the
measurement variable

Variance Variance of the measurement variable

The following four measurement values appear only when the Two-Point Measurement
function is selected in the Viewer Options dialog window.

� Select the View menu, the Experiment Overview option, and the Charts icon.
& see Viewer Options Dialog Window, Charts Icon (page 177)

� In the Measurement field you can switch two-point measurement on or off by selecting 2 Point or
Off.

Parameter Meaning Formula
l(µm); I(s);
I(nm)

Value measured at measuring point 1 (z, t, λ) I(z1); I(t1); I(λ1)

l(µm); I(s);
I(nm)

Value measured at measuring point 2 (z, t, λ) I(z2); I(t2); I(λ2)

dI, dz Difference of values between measuring point 1 and 2 |I(z1) - I(z2)|; |I(t1) - I(t2)|,
|I(λ1) - I(λ2)|

d(z), (t), (λ) Height (z), recording time (t), bandwidth (λ) between
the measuring points 1 and 2

|z1 - z2|; |t1 - t2|, |λ1 - λ2|

This quantification function is only available off-line, i.e. for previously recorded data

sets.

Measuring Surfaces and Volumes
(optional, see the chapter “Optional Software Packages, Materials” on page 247 ff.)
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Copying Quantification Graphs to the Annotation Sheet

Function
The Snap Quantification Data function copies the data calculated by the quantification functions to the
annotation sheet. The calculated values for the following quantification functions, which are also
displaying an evaluation graph, can be copied to an annotation sheet:

& see Creating an Annotation Sheet (page 239)

& see Measuring a Profile Along a Line Segment (page 229)

& see Measuring a Profile Within a Region of Interest (ROI) (page 228)

& see Measuring Surfaces and Volumes (page 258)

& see Measuring Roughness Along a Line Segment (page 247)

Printing Quantification Graphs

Function
The Print Quantification Data function sends the data calculated by the quantification functions to the
standard printer. The calculated values for the following quantification functions, which are also
displaying an evaluation graph, can be printed:

& see Measuring a Profile Along a Line Segment (page 229)

& see Measuring a Profile Within a Region of Interest (ROI) (page 228)

& see Measuring Surfaces and Volumes (page 258)

& see Measuring Roughness Along a Line Segment (page 247)

This function is also available in the context menu within the quantification function window:

�
Move the mouse pointer into the view window opened by a quantification function.

�
Click the right mouse button, and select the Print menu item.
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Exporting Quantification Data

Function
Using he Export Quantification Data function, you can export the data calculated by the quantification
functions as ASCII standard data. This enables you to read and edit data in Excel. The calculated
values for the following quantification functions, which are also displaying an evaluation graph, can be
exported:

& see Measuring a Profile Along a Line Segment (page 229)

& see Measuring a Profile Within a Region of Interest (ROI) (page 228)

& see Measuring Surfaces and Volumes (page 258)

& see Measuring Roughness Along a Line Segment (page 247)

This function is also available in the context menu within the quantification function window:

�
Move the mouse pointer into the view window opened by a quantification function.

�
Click the right mouse button, and select the Export menu item.

Defining the Region of Interest (ROI) as an Ellipse

Function
Using the Ellipse button, you can define an elliptic Region of Interest (ROI) within the image:

�
Click on the Ellipse button.

�
Click the left mouse button on the image position where you would like to place a ROI corner.

�
Then, keeping the left mouse button pressed, drag the mouse pointer diametrically to the
opposite corner to define the second corner of the ROI.

& see Selecting and Moving the Region of Interest (page 236)
& see Moving and Rotating a Region of Interest (ROI) (page 236)
& see Deleting Regions of Interest (ROIs) (page 237)

Other Requirements
The definition of a region of interest in the image is required for quantification functions. Therefore, the
Ellipse button is deactivated until you activate a quantification function using one of the following
buttons:
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& see Measuring a Profile Within a Region of Interest (ROI) (page 228)

& see Calculating a Histogram (page 227)

& see Measuring Roughness Within a Region of Interest (ROI) (page 248)

Defining the Region of Interest (ROI) as a Polygon

Function
Using the Polygon button, you can define any polygonal Region of Interest (ROI) within the image:

�
Click on the Polygon button.

�
Click the left mouse button on the image position where you would like to place a ROI corner.

�
In order to define the other polygon corners, release the mouse button, move the cursor to the
next polygon corner, and click the left mouse button again. Repeat this step for each desired
polygon corner.

�
If you want to draw the polygon by hand, keep the left mouse button pressed and draw the ROI
into the image.

�
Close the polygon with a double click.

& see Selecting and Moving the Region of Interest (page 236)
& see Moving and Rotating a Region of Interest (ROI) (page 236)
& see Deleting Regions of Interest (ROIs) (page 237)

Other Requirements
The definition of a region of interest in the image is required for quantification functions. Therefore, the
Polygon button is deactivated until you activate a quantification function using one of the following
buttons:

& see Measuring a Profile Within a Region of Interest (ROI) (page 228)

& see Calculating a Histogram (page 227)

& see Measuring Roughness Within a Region of Interest (ROI) (page 248)

Defining the Region of Interest (ROI) as a Rectangle



Leica Microsystems Heidelberg GmbH
LCS software functions:

Description of individual functions

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 235 of 307

Function
Using the Rectangle button, you can define a rectangular Region of Interest (ROI) within the image:

�
Click on the Rectangle button.

�
Click the left mouse button on the image position where you would like to place a ROI corner.

�
Then, keeping the left mouse button pressed, drag the mouse pointer diametrically to the
opposite corner to define the second corner of the ROI.

& see Selecting and Moving the Region of Interest (page 236)
& see Moving and Rotating a Region of Interest (ROI) (page 236)
& see Deleting Regions of Interest (ROIs) (page 237)

Other Requirements
The definition of a region of interest in the image is required for quantification functions. Therefore, the
Rectangle is deactivated until you activate a quantification function using one of the following buttons:

& see Measuring a Profile Within a Region of Interest (ROI) (page 228)

& see Calculating a Histogram (page 227)

& see Measuring Roughness Within a Region of Interest (ROI) (page 248)

Automatically Defining the Region of Interest (ROI)

Function
You can use the Wizard button to have the computer define any structure in the image as a Region of
Interest (ROI) automatically in the image. Depending on which of the buttons you have clicked, an
elliptical, rectangular or polygonal region of interest is placed around the structure.

�
Click on the Ellipse, Rectangle or Polygon buttons then on the Wizard button.

�
Double-click with the left mouse button on the structure in the image that you want to mark as
region of interest.

�
The structure is automatically marked as an elliptical, rectangular or polygonal region of interest.

& see Defining the Region of Interest (ROI) as an Ellipse (page 233 ff.)
& see Defining the Region of Interest (ROI) as a Polygon
& see Defining the Region of Interest (ROI) as a Rectangle
& see Deleting Regions of Interest (ROIs)

Other Requirements
The definition of a region of interest in the image is required for quantification functions. The Wizard
button is only enabled when you have previously enabled a quantification function using one of the
following buttons:
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& see Measuring a Profile Within a Region of Interest (ROI) (page 228)

& see Calculating a Histogram (page 227)

& see Measuring Roughness Within a Region of Interest (ROI) (page 248)

Selecting and Moving the Region of Interest (ROI)

Function
Using the Select ROI button, you can select and move a Region of Interest (ROI) within the image:

�
Click first the Select ROI button and then the ROI you want to move.

�
Move the mouse pointer into the ROI.

�
As soon as the mouse pointer changes to a crossed double arrow, press and hold the left mouse
button.

�
Keeping the left mouse button pressed, move the ROI.

You can change the size of the region of interest you have drawn:

�
Hold the mouse pointer over one of the ROI's edges until a double arrow appears. Press the left
mouse button to shift the shape of the ROI in one direction.

�
If you place the mouse pointer exactly over a corner of the ROI, you can change its shape in two
directions at once.

& see Moving and Rotating a Region of Interest (ROI) (page 236)
& see Deleting a Region of Interest (ROI) (page 237)

Other Requirements
The definition of a region of interest in the image is required for quantification functions. Therefore, the
Select ROI is deactivated until you activate a quantification function using one of the following buttons:

& see Measuring a Profile Within a Region of Interest (ROI) (page 228)

& see Calculating a Histogram (page 227)

& see Measuring Roughness Within a Region of Interest (ROI) (page 248)

Moving and Rotating the Region of Interest (ROI)
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Function
Using the Rotate ROI button, you can move and rotate a Region of Interest (ROI) within the image:

�
Click first the Rotate ROI button and then the region of interest you want to rotate.

�
Place the mouse pointer exactly on the corner of the selected region of interest.

�
As soon as the mouse pointer changes to a double arrow, press and hold the left mouse button.

�
Keeping the left mouse button pressed, rotate the region of interest. The region of interest will be
rotated around its center point.

You can change the size of the region of interest you have drawn:

� Hold the mouse pointer over one of the ROI's edges until a double arrow appears. Press the left
mouse button to shift the shape of the ROI in one direction.

& see Deleting Regions of Interest (ROIs) (page 237)

Other Requirements
The definition of a region of interest in the image is required for quantification functions. Therefore, the
Rotate ROI is deactivated until you activate a quantification function using one of the following
buttons:

& see Measuring a Profile Within a Region of Interest (ROI) (page 228)

& see Calculating a Histogram (page 227)

& see Measuring Roughness Within a Region of Interest (ROI) (page 248)

Deleting Regions of Interest (ROIs)

Function
The Clear button deletes all defined ROIs at once. To delete an individual ROI, click the Select ROI
button, then the ROI in the image, and press the DELETE key on the keyboard.

Other Requirements
The definition of a region of interest in the image is required for quantification functions. Therefore, the
Clear is deactivated until you activate a quantification function using one of the following buttons:

& see Measuring a Profile Within a Region of Interest (ROI) (page 228)

& see Calculating a Histogram (page 227)
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& see Measuring Roughness Within a Region of Interest (ROI) (page 248)
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Data Documentation

Creating an Annotation Sheet

Function
Use the Annotation button to open a window in which you can prepare recorded images for
presentation purposes. If you have opened the annotation sheet, the Snap, Line, Rectangle and Text
buttons are also enabled. Use these buttons to copy the image loaded in the Viewer window into the
annotation sheet, to highlight specific areas of the copied image with lines and rectangles and to enter
an image comment into a text field.

& see Drawing a Line (page 240)
& see Drawing a Rectangle (page 240)
& see Adding a Text Field (page 241)

If you hold the mouse pointer over the annotation sheet and press the right mouse button, a context
menu containing the following commands appears:

Command Function
Line Use this to insert a line of default size onto the annotation sheet.
Rectangle Use this to insert a rectangle of default size onto the annotation sheet.
Text Use this to insert a text field with a default font onto the annotation sheet.
Zoom Use this to select from four magnifications for viewing the annotation sheet.
Grid This displays a grid on the annotation sheet, which can not be printed.

The Line, Rectangle and Text commands can be activated both from the context menu and by clicking
their corresponding buttons.

Saved annotation sheets are given the *.ano file extension.

Copying an Image into the Annotation Sheet

Function
If you click the Snap button, the image loaded in the Viewer window is copied onto the annotation
sheet. If you mark the copied image and then press the right mouse button, a context menu
containing the following commands appears:

Command Function
Original size This displays the image in its original size.
Fit to page This enlarges the image to the size of the annotation sheet.
Bring to front This brings the image to the foreground.
Send to back This sends the image to the background.
Delete This deletes the image.

You can change the size of the image by dragging one of the image grab points. To move the image
without changing its size, mark the image and move it while pressing the left mouse button.
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The Snap button can be applied only if an annotation sheet has been opened using the

Annotation button first and the Viewer window has been clicked.

Drawing a Line on the Annotation Sheet

Function
Use the Line button to draw a line on the annotation sheet. On the annotation sheet, click the position
where you want the line to begin. Keeping the left mouse button depressed, drag the mouse pointer
across the page to the position where you want the line to end. If you mark the line and then press the
right mouse button, a context menu containing the following commands appears:

Command Function
Style This opens a dialog window where you can configure the style, thickness and length

of the line.
Color This opens a dialog window for selecting a color for the line.
Bring to front This brings the line to the foreground.
Send to
back

This sends the line to the background.

Delete This deletes the line.

You can change the length of the line by dragging one of its grab points. To move the line without
changing its size, click the center grab point and move the line while pressing and holding the left
mouse button.

The Line button can be applied only if the annotation sheet has been opened using the

Annotation button first.

Drawing a Rectangle on the Annotation Sheet

Function
Use the Rectangle button to draw a rectangle on the annotation sheet. On the annotation sheet, click
the position where you want the corner of the rectangle to be. Keeping the left mouse button
depressed, drag the mouse pointer across the page to define the size of the rectangle. If you mark the
rectangle and then press the right mouse button, a context menu containing the following commands
appears:

Command Function
Style This opens a dialog window where you can configure, among other options, the style

and thickness of the line.
Color This opens a dialog window for selecting a color for the rectangle.
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Bring to
front

This brings the rectangle to the foreground.

Send to
back

This sends the rectangle to the background.

Delete This deletes the rectangle.

You can change the size of the rectangle by dragging one of the image grab points of the rectangle.
To move the rectangle without changing its size, click in the middle of the rectangle and move it while
pressing and holding the left mouse button.

The Rectangle button can be applied only if the annotation sheet has been opened

using the Annotation button first.

Adding a Text Field to an Annotation Sheet

Function
Use the Text button to insert a text field onto the annotation sheet. On the annotation sheet, click the
position where you want the text field to be placed. Keeping the left mouse button depressed, drag
the mouse pointer across the page to define the size of the text field. If you mark the text field and
then press the right mouse button, a context menu containing the following commands appears:

Command Function
Font This opens a dialog window used to select from various fonts and other formatting

options.
Transparent This makes the background visible through the text field.
Bring to front This brings the text to the foreground.
Send to
back

This sends the text to the background.

Delete This deletes the text.

You can change the size of the text field by dragging one of the image grab points of the text field. To
move the text field without changing its size, click in the middle of the text field and move it while
pressing and holding the left mouse button.

The Text button can be applied only if the annotation sheet has been opened using the

Annotation button first.

Printing

Function
You can trigger the print command either by clicking the Print button or from the Printer Selection
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dialog window. To open this dialog window, select the Print option in the File menu. The image loaded
in the Viewer window or an annotation sheet can be printed.

When you initiate the Print command, the image currently loaded in the Viewer window or the
currently open annotation sheet is printed using the default printer and default page layout. You can
change these default settings in the Printer Selection dialog window to suit your needs. Use the
following buttons provided in the dialog window to do so:

Button Function
Printer setup This opens the dialog window for selecting a printer and changing the printer

settings.
Print This prints the image or the annotation sheet.
Background
color

Use this to open a dialog window for selecting a background color for the page.

Center on page This centers the image on the page.
Fit to page This option changes the size of the image to fit the size of the printable area.
Aspect ratio The height-to-width ratio remains the same when the size of the image changes.

Use the Image field to change the height (Size Y) and width (Size X) of the image and to define a top
margin (Offset Y) and a left margin (Offset X). The image size and margins can not be modified if the
Fit to page option is enabled. If you have enabled Center on Page, you can change the size but not
the margins.

Check the results of your settings in the Print Preview field. Use the Page field to specify the height
and width of the printable area (which is not identical to the paper size). The two bottom lines of the
dialog window display the currently installed printer and configured paper size.

Close the Printer Selection dialog window by clicking OK to save the new settings for

the active Viewer window. This allows you to store different printer settings and page

layouts for different images. However, these settings are not permanent and are lost

when you exit the Leica Confocal Software.
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Data Handling

Opening a File

Function
With the Leica Confocal Software, you can open various file types using the Open button.

File Type Description
Experiment (*.lei) A Leica-specific, binary data format. When the experiment is loaded, both the

image data and the experiment settings are loaded.
Annotation sheet
(*.ano)

A Leica-specific, binary data format. The elements on the annotation sheet, such
as images, texts and graphic images, are each available as individual objects.

Tiff files (*.tif) These are Leica image files in single and multi Tiff format. External files in RGB-
Tiff format can be loaded as well.

& see Creating an Experiment (page 244)
& see Creating an Annotation Sheet (page 239)

Saving a File

Function
Click on the Save button to save the data of the current experiment (*.lei) or the current annotation
sheet (*.ano).

If you use the Save button to save an experiment or annotation sheet for the first time, the Save As
dialog window opens.

It is easy to inadvertently overwrite your original data using the Save function. To avoid

doing so, use the Save As function to save an experiment that has already been saved

once or more under a new name.

& see Saving a File As... (page 243)

Saving a File as...

Function
Use the Save As button to save an experiment (*.lei) or annotation sheet (*.ano) while giving it a
specific name and file type.
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When saving an experiment, a folder is created at the file level with the name of the experiment. This
folder then contains the description file (*.lei) for the experiment as well as the individual image files.
The format of the description file is Leica-specific and binary. This file contains the parameter settings
and the color information (in the form of color look-up tables) for each image belonging to the
experiment.

The image files of an experiment can be saved in tif or raw format. The standard format, tif, also
contains the experiment settings and the color information for the images. In the raw format, just the
image data is saved.

Typical Applications
The advantage of the raw format is the smaller file size, but this is only significant for image
recordings with relatively small amounts of data. For example, if you record an image series with a
large number of individual images but at a low scan format, you can save and open it faster in raw
format than in tif.

Storing All Data

Function
Use the Save All button to save experiments (*.lei) or annotation sheets (*.ano) while giving them a
specific name and file type.

When saving an experiment, a folder is created at the file level with the name of the experiment. This
folder then contains the description file (*.lei) for the experiment as well as the individual image files.
The format of the description file is Leica-specific and binary. This file contains the parameter settings
and the color information (in the form of color look-up tables) for each image belonging to the
experiment.

The image files of an experiment can be saved in tif or raw format. The standard format, tif, also
contains the experiment settings and the color information for the images. In the raw format, just the
image data is saved.

Typical Applications
The advantage of the raw format is the smaller file size, but this is only significant for image
recordings with relatively small amounts of data. For example, if you record an image series with a
large number of individual images but at a low scan format, you can save and open it faster in raw
format than in tif.

Creating an Experiment

Function
Click on the New Experiment button to open a new Viewer window, which creates a new experiment.
An experiment is a file that consists of one ore more individual images or image series. This allows
you to keep several images, each recorded using different scan parameters, or edited versions of
images in one experiment. The format of the experiment file (*.lei) is Leica-specific.
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User-Specific Adjustments

Controlling Functions Using the Control Panel

Function
At frequent points during an image recording, various parameters have to be reset. For this reason,
the control panel can be used to control functions quickly and directly. You can freely allocate the
radio buttons of the control panel to a selection of functions:

� In the View menu, select the Status Bars option and then Control Panel Status Bar.

The status bar for the control panel is displayed at the bottom of the user interface of the Leica
Confocal Software. Viewed from left to right, the status bar consists of the icon for the control panel,
the seven fields that represent the radio buttons of the control panel, and three buttons.

� Click on one of the fields arranged in the same way as the radio buttons of the control panel.
� A list is opened where you can select the desired function. The name of the allocated function is

shown in the field.

The sensitivity of the radio buttons can be adjusted:

� Click with the right mouse button on a recording parameter in the status bar of the control panel.
� The recording parameters Phase, Pinhole, Scan Field Rotation and Zoom allow selecting one of

three sensitivity stages: Smooth, Moderate and Rough.
� For the recording parameters Gain, Offset, Smart Gain and Smart Offset, the number of volts

can be adjusted by rotating the radio button.
� For the recording parameters Z Position and Z Wide Position, the number of micrometers can

be adjusted by rotating the radio button.

Additional information about this topic can be found in the separate online help:

Tutorials (Exercises for Using Leica Confocal Software)

If you have assigned a function to all the radio buttons, you can save this configuration as a template.

� Click on the left of the three buttons located on the right side of the status bar.
� A dialog window is opened in which you can give the configuration a name and save it.
� Click on the middle button to select and load a configuration.

In addition to these user-defined configurations, you can also access other configurations predefined
at the factory:

� Click on the right of the three buttons located on the right edge of the status bar.
� This opens a dialog window listing all the configurations for the control panel.

The configurations set as default, indicated by a L (Leica), can only be loaded but not modified. The
user-defined configurations are created in the drop-down list under User and marked with a U (User).
Click one of the configurations and then press the right mouse button to open a context menu which
contains the following commands:

Command Function



Leica Microsystems Heidelberg GmbH
LCS software functions:

Description of individual functions

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 246 of 307

Set as default
template

The configuration is loaded as the default configuration when the software is
started.

Remove default
setting

The setting of this configuration as default setting is undone.

Load Loads the configuration.
Rename (only for U) Use this to change the name of the configuration.
Delete (only for U) The configuration is deleted.

Saving the Viewer Window as a Template

Function
Using the Template button, you can save a user-defined design of the Viewer window as a template.
The elements of the Viewer window that can be shown or hidden, are the buttons, the color bars of
the color look-up tables, and the Experiment legend.

& see Viewer Window (page 172)

Clicking the Template button opens a dialog window that you can use to enter a name for the
template. This configuration of the Viewer window is saved and will be loaded each time you open a
file or create a new experiment.

Additional information
In the Tools menu, click on Options and select the Viewer Template tab to access the user-defined
templates. In the Leica Templates list box, you can choose from the following predefined templates:

Viewer
Template

Design

Viewer (Pure) The view window consists only of the image window.
Viewer (LUT) The view window consists of the image window and the color bars of the color

look-up tables.
Viewer
(Standard)

The view window consists of the buttons, the image window, the color bars of the
color look-up table, and the Experiment legend.

In the Personal Templates List box, the user-defined templates are entered. Using the Add Active
Viewer and Remove Template buttons, you can save a new template or delete an existing one.

In the Tools menu, click on Options to indicate in the Workspace tab how many view windows, if any,
Viewer should open when the Leica Confocal Software is started.
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Optional Software Packages

Materials (optional)

This optional software package is not part of the basic program package. However, it

can be obtained from your Leica branch office or an authorized dealer.

Measuring Roughness Along a Line Segment

Function
The Roughness Profile function measures height, distance, and angular values of a surface along a
specific line and displays these values in a curve. The height profile is measured from the data record
selected in the Viewer window. This data set should be a spatial series.

A topographical image is the prerequisite for the generation of a height profile. For this reason, the
Roughness Profile button is active only when a topographic image of the data record has been
created in advance with the Topography button. Only one detection channel can be quantified at a
time.

& see Creating a Topographical Image (page 199)

� Click on the Roughness Profile button. The measurement section is displayed as a white line in
the image in the Viewer window.
You can change the length and position of the line segment by clicking the line and, while
clicking and holding the grab point with the left mouse button, dragging it to the desired position.

� A window opens automatically to display the measurement curve for every detection channel as
well as the statistical values.

Parameter Meaning Formula
Evaluation
length: I(P)

Length of the plotted section, according to DIN
EN ISO 4287

Max. Peak: Pp Height of the highest profile peak (based on the
average height), according to DIN EN ISO 4287

Max (Pp)

Min. Valley: Pν Depth of the greatest profile valley (based on the
average height), according to DIN EN ISO 4287

Min (Pv)

Deviation: Pa Arithmetic average of the profile ordinates within
the measured section (average height) according
to DIN EN ISO 4287

with

RMS: Pq Root mean square value of the profile ordinates
within the measured section, according to DIN
EN ISO 4287

with
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The following four measurement values appear only when the Two-Point Measurement
function is selected in the Viewer Options dialog window.

� Select the View menu, the Experiment Overview option, and the Charts icon.
& see Viewer Options Dialog Window, Charts Icon (page 177)

� In the Measurement field you can switch two-point measurement on or off by selecting 2 Point or
Off.

Parameter Meaning Formula
h (position of the slide's left
measurement point)

Profile height at the position of the slide's left
measurement point

h1 ( l1)

h (position of the slide's right
measurement point)

Profile height at the position of the slide's right
measurement point

h2 ( l2)

Step Height dh The profile's height difference between the slide's left
and right measurement points

dx Distance between the slide's left and right corners

alpha The angle of the left measurement point to the right
measurement point connection line to horizontal

Saving the measurement values
The software can save the values on the positions of both measurement points as well as the height
difference between the measurement points.

� Select the View menu, Experiment Overview option, Surface Measure icon.
& see Viewer Options Dialog Window, Surface Measure Icon (page 182)

� To save the values, click on the Remember button in the field Multipoint Measurement. The
Clear button deletes them again.

This quantification function is only available off-line, i.e. for previously recorded data

sets.

Measuring Roughness Within a Region of Interest (ROI)

Function
The Roughness Area function measures height, distance, and angular values of a surface within a
region of interest. The profile is measured from the data record selected in the Viewer window. This
data set should be a spatial series.

A topographical image is the prerequisite for the generation of a height profile. For this reason, the
Roughness Area button is active only when a topographic image of the data set has been created in
advance with the Topography button.
& see Creating a Topographical Image (page 199)

� Click on the button Roughness Area and draw a region of interest (ROI) into the image. The
buttons with which you define a ROI are activated together with the Roughness Area button.
& see Defining the Region of Interest (ROI) as an Ellipse (page 233 ff.)
& see Defining the Region of Interest (ROI) as a Polygon
& see Defining the Region of Interest (ROI) as a Rectangle
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& see Automatically Defining the Region of Interest (ROI)
& see Selecting and Moving the Region of Interest (ROI)
& see Deleting Regions of Interest (ROI)

� A window opens automatically to display the statistical values.

Parameter Meaning Formula
# Pixel Number of pixels within the selected region of interest
Area Surface area

Avg. Height Average height of the profile ordinates

Pa Arithmetic average of the profile ordinates within the
measured section (average height) according to
DIN EN ISO 4287

with

RMS (Pq) Root mean square value of the profile ordinates
within the measured section, according to DIN EN
ISO 4287

with

Min Valley
(Pν)

Minimal height of the profile ordinates (based on the
average height)

Min (Pv)

Max Peak
(Pp)

Maximal height of the profile ordinates (based on
the average height)

Max (Pp)

This quantification function is only available off-line, i.e. for previously recorded data

sets.

Linear Filters and Morphological Filters (Optional)

This chapter contains the following topics
� Setup and operation of the Process operating step
� What are linear filters?
� Navigation: Image Filters\ Linear Filters
� What are morphological filters?
� Navigation: Image Filters\ Morphological Filters

Setup and operation of the Process operating step
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After clicking the Process arrow symbol, the usual setup of the user interface is completely changed.
All function buttons of the other button areas/operating steps are hidden. The Experiment Overview
(1) display window is shown on the left with the opened experiments. The navigation window (2) with
the directory tree of all functions available in this operating step is located underneath it. The middle of
the user interface displays 10 large tiles (3), which comprise the 10 function groups. A help field (4) is
located above these tiles, which can display a brief explanation of a function group by holding the
mouse pointer over the corresponding tile.

� Click on the tile with the desired function group. On every navigational level, you can display an
explanation of the function groups in the top help field by holding the mouse pointer over the
corresponding tile.

� Select one tile each on the following navigational levels until you have reached the desired
function with the corresponding dialog on the lowest level.

� You can directly select a function in the navigation window by clicking the corresponding folder.

The menu bar at the top right offers the following buttons (5):

� Click Back to return to the previously displayed navigational level.
� Click Forward to display the level which you selected prior to clicking the Back button.
� Click Up to enter the next higher level in the hierarchy.
� Click Reset to return modified variables to their last setting.
� To exit the Process operating step, click the arrow symbol of another operating step (e.g.

Acquire).

The bottom of every dialog displays the following two buttons:

� Click Preview to execute the selected function and to display the resulting image on the right in
the preview window.

� Click Apply to apply the selected function to the current image data set, to display the resulting
image in the Viewer display window and to create a new file in the current experiment.

What are linear filters?
Filters are used to enhance the quality of an image. As a rule, this means removing undesirable pixels
from the image. The filter function available here—a low-pass filter—is used to suppress static noise
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in an image that could be generated by the detector.

The principle of a filter consists of taking the value of each pixel in an image and setting it off against
the values of the adjacent pixels. The filter kernel describes the number and weighting of the adjacent
pixels that come to bear in the calculation of the new pixel. The kernel used here can be described
using Pascal's triangle:

Filter kernel size Pascal triangle Standardization

Kernel Size 3

Kernel Size 5

Kernel Size 7

Kernel Size 9
...

1 1
1 2 1

1 3 3 1
1 4 6 4 1

1 5 10 10 5 1
1 6 15 20 15 6 1

1 7 21 35 35 21 7 1
1 8 28 56 70 56 28 8 1

...

1/2
1/4
1/8
1/16
1/32
1/64
1/128
1/256
...

If, for example, kernel size 5 is selected, 5 pixels of the original image are used in calculating 1 pixel
in the filtered image. It is always the middle pixel in the filter kernel that is the pixel to be calculated. In
this case, the gray values of the 5 pixels corresponding to the weighting scale 1-4-6-4-1, are multiplied
by the factors 1/16, 4/16, 6/16, 4/16, 1/16 and together added to the final value. With respect to the
calculation of the pixel C in the following schematic representation this means that the gray values of
pixels A, B and D, E are included in the calculation of the filtered pixel C'. C' is calculated as follows:
16x1/16 + 4x4/16 + 8x6/16 + 32x4/16 + 8x1/16 = 1 + 1 + 3 + 8 + 0.5 = 13.5

A B C D E
Gray values of pixels A-E in the original image 16 4 8 32 8
Factors of kernel size 5 1/16 4/16 6/16 4/16 1/16
Gray value of C' in the filtered image 13,5

A calculation of this kind is performed for each pixel in the original image. At the edge of the image,
the filter mask protrudes beyond the image. For these pixels, the value 0 is set.

Function of linear filters

Intensity profile of an unfiltered image Intensity profile of the image after application of
the Blur filter

Intensity profile of the image after application of
the Sharpen filter

Intensity profile of the image after application of
the Highpass filter

� If you select the Blur filter, the low-pass filter described above is applied to the image. This filter
type filters the high frequencies out of the image. That is, the very distinctive transitions from low
to high intensity values are reduced. This filter can be used to remove noise from an image.

� If you select the Sharpen filter, the low-pass filter is applied to the image, and the values of the
high-pass-filtered image are added to the values of the original image. This filter type filters the
low frequencies out of the image. That is, the very distinctive transitions from low to high
intensity values are intensified.
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� If you select the Highpass filter, the low-pass filter is applied to the image, and the values of the
original image are subtracted from the values of the low-pass-filtered image. The result
corresponds to an image that was processed with a high-pass filter. This filter type displays only
the very distinctive transitions from low to high intensity values in the image.

Navigation: Image Filters\ Linear Filters
Applying linear filters (low-pass and high-pass filters) to images

� In the Experiment Overview display window, select the image data set to be processed by
double-clicking the file.

� Select one of the three filter types: Blur, Sharpen, Highpass.
� In the Kernel Size field, select a value for the kernel size. The value specified in the Kernel Size

field as Cut-off Wavelength is the size of the filter measured in pixels. This value is calculated on
the basis of the scan parameters (enlargement of the objective, wavelength of the excitation
light, scan format, electronic zoom factor...) used for each image.

� In the Filter Directions field, set the dimensions of the filter. Select the spatial axes to which the
filter is to be applied sequentially. One-dimensional filters are applied, that is, the filter is
calculated only via one axis at any given time. The value specified in the Filter Directions field as
Cut-off Wavelength is the size of the filter measured in nanometer. For example, with a value of
160 nm all wavelengths lesser than or equal to 160 nm are filtered.

Sharp Factor (only with Sharpen filter)
� Use the slider in the Sharp Factor field to vary the effect of the Sharpen filter. If this factor is set

to 0, the filter is not active.

Blur (Gallery), Sharpen (Gallery), Highpass (Gallery) tiles
� Click on the Blur (Gallery), Sharpen (Gallery) or Highpass (Gallery) tile to view a gallery of

preview images of the selected image data set. Each of the preview images was calculated with
a different kernel size (and a different sharpness factor). Click a tile to display a dialog window
with the corresponding settings.

What are morphological filters?
Using mathematical operators, morphological filters are used to change the form of connected
structures in an image and to separate them from the background. Morphological operators are
typically applied to binary images. Binary images feature pixels, which only have the value 1 or 0. The
segmentation functions in the Leica Confocal Software can be applied to create binary images.
However, these operators can also be used to process halftone images, that is images with a value
range of, for example, 256 (8 bits) different gray values/intensity values.

& see Process Operating Step / Segmentation Folder (page 284)

The principle consists of moving a mask—also referred to as structural element—pixel by pixel over
the image. The pixel to be examined is always the central pixel of the mask. The mask in the Leica
Confocal Software can have the shape of a cube, cross or sphere. Shape and size of the mask
determine which and how many adjacent pixels are included in the filtering. A certain criterion is used
to distinguish which pixels are defined as structure and as background in the resulting image. For
binary images, this criterion is the logical combination AND or OR; for halftone images, it is the size of
the gray value/intensity value.

& see Boolean Operations (page 291)

The shape of the mask is used to influence the structures to be highlighted in the resulting image. For
example, if the sphere is selected as mask form, round shapes are accentuated in the resulting
image. However, the morphological operator determines in which proximity relation the corresponding
pixel is coded as structure or as background in the resulting image.

The following two elementary basic types of morphological operators, namely erosion and dilation, as
well as combinations of these operators exist:
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Operator Description
Erosion With binary images, the examined pixel is set to the binary value 1 in the resulting image

if all adjacent pixels (determined by the shape and size of the mask) in the binary original
image are coded with a 1.
With halftone images, the minimum gray value of the adjacent pixels is entered in the
resulting image instead of the value of the examined pixel.

Dilation With binary images, the examined pixel is set to the binary value 1 in the resulting image
if at least one adjacent pixel (determined by the shape and size of the mask) in the
binary threshold image is coded with a 1.
With halftone images, the maximum intensity value of the adjacent pixels is entered in
the resulting image instead of the value of the examined pixel.

Combination of
operators

Description

Open Open is a combination of operators. First, an erosion is executed, followed
by a dilation.

Close Close is a combination of operators. First, a dilation is executed, followed by
an erosion.

Top Hat Top Hat processes the image with the Open operator combination and
subtracts the resulting image from the original image.

Bottom Hat Bottom Hat processes the image with the Close operator combination and
subtracts the original image from the resulting image.

Filters Description
Median The Median filter belongs to the group of nonlinear hierarchical filters. In Median filtering,

the intensity values of the adjacent pixels (determined by the shape and size of the mask)
are sorted based on their size. The intensity value occupying the middle of this hierarchy is
then entered in the resulting image of the median filtering instead of the examined pixel.

Effect of the morphological operators

Original image After applying the Median filter
Structures (with very high intensity values) are
color-coded in gray, the background (intensity
value
0) in dark blue. Between these two extreme
values, the range from higher to lower intensity
values is color-coded from brown, yellow, green
to turquoise.

The Median filter smoothes the overall image,
while simultaneously accentuating and
contouring structures in the image.

After applying the Erosion operator After applying the Dilation operator
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Connected structures shrink and small structures
and connections between structures disappear
(the number of high intensity values decreases,
while the number of low intensity values
increases).

Connected structures grow and spaces within a
structure and between structures are filled (the
number of high intensity values increases, while
the number of low intensity values decreases).

After applying the Open operator (Erosion +
Dilation)

After applying the Close operator (Dilation +
Erosion)

Connected structures shrink and spaces become
larger (the number of high intensity values
decreases, while the number of low intensity
values increases).

Connected structures grow and spaces remain
almost unchanged (the number of high intensity
values increases, while the number of low
intensity remains almost identical).

After applying the Top Hat operator After applying the Bottom Hat operator
The high intensity values are extracted The low intensity values are extracted

Navigation: Image Filters\ Morphological Filters
Applying morphological filters to images

� In the Experiment Overview display window, select the image data set to be processed by
double-clicking the file.

� Select one the seven filter types: Median, Erosion, Dilation, Open, Close as well as Top Hat and
Bottom Hat.

� In the Mask field, select the basic form of the filter mask: Cube, Cross or Sphere. The selection
of the shape of the structure element influences the image structures processed by the filter. For
example, spheres accentuate round structures in the resulting image.

� Enter the size of the mask in pixels in the fields Size X, Size Y and Size Z. The size of the mask
determines how many adjacent pixels are included in the filter mask.

� In the Repetition field, you specify the frequency with which the filter is to be applied.

Tiles with designation (Gallery)
� Click one of the tiles labeled with (Gallery) to view a gallery of preview images of the selected

image data set. Each of the preview images was calculated with a different structure element
and/or mask size. Click a tile to display a dialog window with the corresponding settings.

Leveling and Filtering of Surface Images
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This chapter contains the following topics
� Setup and operation of the Process operating step
��Navigation: Materials\ Leveling
��What are linear filters?
� Navigation: Materials\ Roughness Filter
� Navigation: Materials\ Waviness Filter

Setup and operation of the Process operating step

After clicking the Process arrow symbol, the usual setup of the user interface is completely changed.
All function buttons of the other button areas/operating steps are hidden. The Experiment Overview
(1) display window is shown on the left with the opened experiments. The navigation window (2) with
the directory tree of all functions available in this operating step is located underneath it. The middle of
the user interface displays 10 large tiles (3), which comprise the 10 function groups. A help field (4) is
located above these tiles, which can display a brief explanation of a function group by holding the
mouse pointer over the corresponding tile.

� Click on the tile with the desired function group. On every navigational level, you can display an
explanation of the function groups in the top help field by holding the mouse pointer over the
corresponding tile.

� Select one tile each on the following navigational levels until you have reached the desired
function with the corresponding dialog on the lowest level.

� You can directly select a function in the navigation window by clicking the corresponding folder.

The menu bar at the top right offers the following buttons (5):

� Click Back to return to the previously displayed navigational level.
� Click Forward to display the level which you selected prior to clicking the Back button.
� Click Up to enter the next higher level in the hierarchy.
� Click Reset to return modified variables to their last setting.
� To exit the Process operating step, click the arrow symbol of another operating step (e.g.
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Acquire).

The bottom of every dialog displays the following two buttons:

� Click Preview to execute the selected function and to display the resulting image on the right in
the preview window.

� Click Apply to apply the selected function to the current image data set, to display the resulting
image in the Viewer display window and to create a new file in the current experiment.

Navigation: Materials\ Leveling
Adapting an interpolation function to a data set to correct trend curves (e.g. obliquely
recorded data set)
This procedure aims at bringing an intensity curve that features a trend curve into a horizontal
position. For this purpose, a suitable interpolation function (polynomial) is first adapted to the intensity
curve. Next, the distance of the optimal interpolation function to a horizontal intensity plateau is
calculated. The occurring intensity differences are added pixel by pixel to the original data set. This
compensates the trend curve.

& see Adaptation Function for Correcting Trend Curves (page 289)

The target function to be optimized in determining the coefficients of the adaptation function is:

� Select one of the four types of the adaptation functions: Leveling (Linear), Leveling (Bilinear),
Leveling (Quadratic), Leveling (Cubic).

Fitting Interpolation Function Formula
Linear f(x) = a + bx + cy
Bilinear f(x) = a + bx + cx + dxy
Quadratic f(x) = a + bx + cx + dxy + fx²
Cubic f(x) = a + bx + cx + dxy + fx² + gxy² + hx³ + iy³

� In the Experiment Overview display window, select the image data set to be processed by
double-clicking the file.

� Select the step size in the Sample Step Width field. The step size sets the number of support
positions for the polynomial. The smaller the step size, the more time-consuming and precise the
calculation of the adaptation function.

� If the data set should show noise, it is recommended to hide the low intensity noise signals in the
Threshold field by setting a threshold. All intensity values whose values are below the threshold
are not used in the calculation. This prevents noise signals from being erroneously used as
support positions for the adaptation function.
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What are linear filters?
Filters are used to enhance the quality of an image. As a rule, this means removing undesirable pixels
from the image. The filter function available here—a low-pass filter—is used to suppress static noise
in an image that could be generated by the detector.

The principle of a filter consists of taking the value of each pixel in an image and setting it off against
the values of the adjacent pixels. The filter kernel describes the number and weighting of the adjacent
pixels that come to bear in the calculation of the new pixel. The kernel used here can be described
using Pascal's triangle:

Filter kernel size Pascal triangle Scaling

Kernel Size 3

Kernel Size 5

Kernel Size 7

Kernel Size 9
...

1 1
1 2 1

1 3 3 1
1 4 6 4 1

1 5 10 10 5 1
1 6 15 20 15 6 1

1 7 21 35 35 21 7 1
1 8 28 56 70 56 28 8 1

...

1/2
1/4
1/8
1/16
1/32
1/64
1/128
1/256
...

If, for example, kernel size 5 is selected, 5 pixels of the original image are used in calculating 1 pixel
in the filtered image. It is always the middle pixel in the filter kernel that is the pixel to be calculated. In
this case, the gray values of the 5 pixels corresponding to the weighting scale 1-4-6-4-1, are multiplied
by the factors 1/16, 4/16, 6/16, 4/16, 1/16 and together added to the final value. With respect to the
calculation of the pixel C in the following schematic representation this means that the gray values of
pixels A, B and D, E are included in the calculation of the filtered pixel C'. C' is calculated as follows:
16x1/16 + 4x4/16 + 8x6/16 + 32x4/16 + 8x1/16 = 1 + 1 + 3 + 8 + 0.5 = 13.5

A B C D E
Gray values of pixels A-E in the original image 16 4 8 32 8
Factors of kernel size 5 1/16 4/16 6/16 4/16 1/16
Gray value of C' in the filtered image 13.5

A calculation of this kind is performed for each pixel in the original image. At the edge of the image,
the filter mask protrudes beyond the image. For these pixels, the value 0 is set.

Function of linear filters

Intensity profile of an unfiltered image

Intensity profile of the image after applying the
Waviness filter

Intensity profile of the image after applying the
Roughness filter

� If you select the Waviness filter, the low-pass filter described above is applied to the image. This
filter type filters the high frequencies out of the image. That is, the very distinctive transitions
from low to high intensity values are reduced. This filter can be used to remove noise from an
image.

� If you select the Roughness filter, the low-pass filter is applied to the image, and the values of
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the original image are subtracted from the values of the low-pass-filtered image. The result
corresponds to an image that was processed with a high-pass filter. This filter type displays only
the very distinctive transitions from low to high intensity values in the image.

Navigation: Materials\ Roughness Filter
Applying high-pass filters to images

� In the Experiment Overview display window, select the image data set to be processed by
double-clicking the file.

� In the Kernel Size field, select a value for the kernel size. The value specified in the Kernel Size
field as Cut-off Wavelength is the size of the filter measured in pixels. This value is calculated on
the basis of the scan parameters (enlargement of the objective, wavelength of the excitation
light, scan format, electronic zoom factor...) used for each image.

� In the Filter Directions field, set the dimensions of the filter. Select the spatial axes to which the
filter is to be applied sequentially. One-dimensional filters are applied, that is, the filter is
calculated only via one axis at any given time. The value specified in the Filter Directions field as
Cut-off Wavelength is the size of the filter measured in nanometer. For example, with a value of
160 nm all wavelengths lesser than or equal to 160 nm are filtered.

Navigation: Materials\ Waviness Filter
Applying low-pass filters to images

� In the Experiment Overview display window, select the image data set to be processed by
double-clicking the file.

� In the Kernel Size field, select a value for the kernel size. The value specified in the Kernel Size
field as Cut-off Wavelength is the size of the filter measured in pixels. This value is calculated on
the basis of the scan parameters (enlargement of the objective, wavelength of the excitation
light, scan format, electronic zoom factor...) used for each image.

� In the Filter Directions field, set the dimensions of the filter. Select the spatial axes to which the
filter is to be applied sequentially. One-dimensional filters are applied, that is, the filter is
calculated only via one axis at any given time. The value specified in the Filter Directions field as
Cut-off Wavelength is the size of the filter measured in nanometer. For example, with a value of
160 nm all wavelengths lesser than or equal to 160 nm are filtered.

Measuring Surfaces and Volumes

Function
The Materials function calculates surfaces and volumes of the three-dimensional, spatial data set.
Click on the Materials button to automatically open a window in which a measurement curve and the
size of the accumulated volume are displayed depending on the z position. Accumulated volume
means that for each z position the value of the volume of the data set lying below it is calculated.

A requirement for calculating the surfaces and volumes is a typographical image. Thus, the Materials
button is only active if the Topography button was used before to create a topographical image of the
data set. Only one detection channel can be quantified at a time.

& see Creating a Topographical Image (page 199)

Parameter Meaning
Scanned
Area A

This value represents the horizontal projection of the surface of an xy section.

Surface Area
A'

This value represents the actual surface of an xy section. In relation to the horizontal
projection the actual surface is always at least as large, in general even larger.
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Ratio A'/A This value represents the relation of surface to base area. The larger it is, the more
the two-dimensional surface is embedded in the three-dimensional space.

The following four measurement values appear only when the Two-Point Measurement
function is selected in the Viewer Options dialog window.

� Select the View menu, the Experiment Overview option, and the Charts icon.
& see Viewer Options Dialog Window, Charts Icon (page 177)

� In the Measurement field you can switch two-point measurement on or off by selecting 2 Point or
Off.

V (z<=upper
position value)

This value represents the volume located below the upper position value of
the measurement slider (right corner point of the slider).

V (z<=lower
position value)

This value represents the volume located below the lower position value of the
measurement slider (right corner point of the slider).

dV Volume between the position values of the slider
dz Distance between the position values of the slider

This quantification function is only available off-line, i.e. for previously recorded data

sets.
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Multicolor (optional)

This optional software package is not part of the basic program package. However, it

can be obtained from your Leica branch office or an authorized dealer.

Multicolor / Create 2D cytofluorogram

This page contains the following topics
� Creating the 2D cytofluorogram of an image data set
� Instances and interpretation of the cytofluorogram

Creating the 2D cytofluorogram of an image data set
This function is used to create a two-dimensional cytofluorogram. A 2D cytofluorogram is a dot
diagram that visualizes the joint distribution of intensity values of two detection channels. Every dot of
the scatter plot of the cytofluorogram represents an intensity value pair from the two detection
channels. The image data of up to three detection channels can be visualized in the cytofluorogram.

2D cytofluorogram from two detection channels 2D cytofluorogram from three detection channels

� Click on the CF2D button to create a 2D cytofluorogram of the active image data set in the
Viewer window. If two detection channels are clicked, all available intensity value pairs are
displayed in a two-dimensional scatter plot. With three active detection channels, the intensity
value pairs of 2 detection channels in each case are displayed in three two-dimensional scatter
plots. If only one detection channel is selected, the distribution of intensity values is displayed in
a bar diagram.

� Click on the Gallery button to apply all the images of an image series in the creation of the
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cytofluorogram.

� Click on the Single button to use the single images currently displayed in the Viewer window in
the creation of the cytofluorogram. The Next, Previous or Play buttons can then be used to
navigate through the image series and the corresponding cytofluorograms.

The image data of 3 detection channels can also be displayed as three-dimensional cytofluorogram.

& see Multicolor package / Create 3D cytofluorogram (see page 262)

The Viewer Options dialog window offers various options pertaining to the cytofluorogram. Among
other things, the intensity value range can be limited, the color coding can be varied and display
elements of the cytofluorogram can be displayed or hidden.

& see Viewer Options Dialog Window, Multicolor Icon (see page 267)

Diagrammatic view of possible instances of the cytofluorogram

(a)
Image data in the green and the
red detection channel correlate
positively.

(b)
Image data in the green and the
red detection channel correlate
negatively.

(c)
Positively correlating image data
and noise in the green and red
detection channel.

(d)
Image data and noise in the green
and red detection channel are

(e)
Optical crosstalk from green to red
detection channel

(f)
Independent and correlating image
data and noise in the green and red
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independent of each other. detection channel

� The diagram (a) shows a scatter plot whose points accumulate on a straight line in the plane
diagonal of the cytofluorogram. The correlation of the image data of both detection channels is
very high and positive. A relationship exists between the intensity values in the green and red
channel, because an increase in the red channel corresponds to a comparatively identical
increase in the green channel. This characteristic of the cytofluorogram occurs in the
colocalization of fluorescent dyes.

� The diagram (b) shows a scatter plot whose points accumulate on a straight line in the plane
diagonal of the cytofluorogram. The correlation of the image data of both detection channels is
very high and negative. A relationship exists between the intensity values in the green and red
channel, because a decrease in the red channel corresponds to a comparatively identical
increase in the green channel.

� The diagram (c) shows a scatter plot whose points are scattered over a broad area. Only a
relatively small number of pints, namely those in the center of the scatter plot, are located in the
plane diagonal. A direct relationship between the intensity values in both channels can only be
assumed for this subset. The broad scattering of the scatter plot points to noise in the image
data set.

� The diagram (d) shows two separate scatter plots whose points are each scattered over a broad
area. A correlation of the image data of both detection channels cannot be determined because
the increase in one channel corresponds only to a very minor increase in the other channel.
Each detection channel images independent information about the object.

� The diagram (e) shows two separate scatter plots whose points are each scattered over a broad
area. The scatter plot of the green channel is tipped in the direction of the spatial diagonal. This
instance of the cytofluorogram points to optical crosstalk from the green channel to the red
channel.

� The diagram (f) shows not only two separate scatter plots but also a scatter plot whose points
are concentrated in the plane diagonal of the cytofluorogram. The two detection channels
feature correlating image data as well as information independent from each other about the
object.

Using a binary mask, a portion of the intensity value pairs can be selected in the cytofluorogram and
localized in the original images. Please refer to the description of the Mask button.

& see Multicolor / Visualize colocalization in the original image (see page 264)

In addition, different geometric and densitometric data can be calculated for the original image and the
image data selected in the cytofluorogram and displayed.

& see Multicolor / View statistics (see page 266)

Multicolor / Create 3D cytofluorogram

This function is used to create a three-dimensional cytofluorogram. A 3D cytofluorogram is a dot
diagram that visualizes the joint distribution of intensity values of three detection channels. Every dot
of the scatter plot of the cytofluorogram represents an intensity value triplet from the three channels.
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� Click on the CF3D button to create a 3D cytofluorogram of the active image data set. The
visualization of image data with the 3D cytofluorogram is only useful if the image data set was
recorded in three detection channels.

� Use the Rotate, Move and Zoom buttons to rotate and move the 3D cytofluorogram as well as
reduce or enlarge it.

& see Rotating the 3D View (see page 201)
& see Moving the 3D View (see page 201)
& see Zooming the 3D View (see page 202)

Additional information on possible instances and the interpretation of the cytofluorogram can be found
in the description of the 2D cytofluorogram.

& see Multicolor / Create 2D cytofluorogram (see page 260)

The Viewer Options dialog window offers various options pertaining to the cytofluorogram. Among
other things, the intensity value range can be limited, the color coding can be varied and display
elements of the cytofluorogram can be displayed or hidden.

& see Viewer Options Dialog Window, Multicolor Icon (see page 267)

Multicolor / View overlay image

Function
Pressing this button creates an overlay image from all active detection channels. Compared to the
conventional overlay image, this function offers the option of using color look-up tables developed
specifically for the cytofluorogram which highlight or diminish the points in the spatial diagonal of the
cytofluorogram with a special color. Using the overlay image, it is possible to visualize the sections in
the original image where colocalizations of fluorescent dyes occur.
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Cytofluorogram coded with the rg-blue color look-
up table

Overlay image coded with the rg-blue color
look-up table

The color look-up tables can be found in the Viewer Options dialog window under the Multicolor icon,
Color tab, Binary with custom colors selection item.

& see Viewer Options Dialog Window, Multicolor Icon (see page 267)

Multicolor / Localize value pairs of the cytofluorogram in the original image

Pressing the Mask button creates a binary mask of the image data of the cytofluorogram. This
function allows to select certain intensity value pairs of the cytofluorogram and to localize them in the
original image.

Selecting intensity value pairs in the cytofluorogram and localizing them in the original image

� Click on the CF2D button to create a 2D cytofluorogram of the image data set.

� Click on the Mask button to create a binary mask of the cytofluorogram. At the same time, the
buttons are activated with which a region of interest (ROI) can be drawn.

� Click on the Quantify arrow symbol and on one of the ROI buttons, e.g. on the Ellipse or Polygon
button, and draw a region of interest on the cytofluorogram.

Selecting data in the cytofluorogram can only be performed with two active detection channels. If
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three detection channels are active, the ROI buttons cannot be used.

� The intensity value combinations that are within the region of interest in the cytofluorogram are
highlighted in color in the original images.

Examples
The masked image data can be coded in different colors in the original image, as well as represented
either isolated or overlapping with the original images. The corresponding settings are made in the
Viewer Options dialog window, Multicolor icon, Mask tab.

& see Viewer Options Dialog Window, Multicolor Icon (see page 267)

(1a)
Image data in the green channel

(1)
2D cytofluorogram of both
channels

(1b)
Image data in the red channel

(2a)
Image data selected in the
cytofluorogram are highlighted in
white in the original image
(selection item: Image covered by
mask)

(2)
2D cytofluorogram with selected
intensity value pairs

(2b)
Image data selected in the
cytofluorogram are highlighted in
white in the original image
(selection item: Image covered
by mask)
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(3a)
Only the image data selected in
the cytofluorogram are displayed
in the color coding of the channel
(selection item: Masked image
only)

(3)
2D cytofluorogram with selected
intensity value pairs

(3b)
Image data selected in the
cytofluorogram are highlighted in
blue in the original image
(selection item: Image covered
by blue mask)

Multicolor / View statistics

Function
Pressing this button calculates statistical data about the geometry and densitometry of the image data
selected in the cytofluorogram and the original images and displayed in a window. If the ROI buttons
are used to define regions of interest in the original image, the statistics is also calculated for these
regions.

A binary mask of the cytofluorogram must have been created using the Mask button

before the statistics can be calculated and displayed.

& see Multicolor / Localize value pairs of the cytofluorogram in the original image (see page 264)

Geometric
Analysis

Meaning Formula for
image

Formula for ROI

# of pixels Number of pixels in the image or within the region
of interest (ROI)

# of pixels, mask Number of pixels in the masked regions

Area [µm2] Area of scan field

Area, mask [µm2] Area of masked regions

Mask area rate Percentage share of masked regions of the overall
area
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Densitometric
Analysis

Meaning Formula for image Formula for ROI

Intensity sum Sum of the
intensities

with with

Intensity sum,
mask

Sum of
intensities in the
masked regions

Mean intensity Arithmetic mean
of intensities

Mean intensity,
mask

Arithmetic mean
of the intensities
in the masked
regions

Mask intensity
rate

Percentage
share of
intensities in the
masked regions
of the sum of
intensities

Viewer Options Dialog Window, Multicolor Icon

This chapter contains the following topics
� Structure of the Experiment Overview window
� Options for the value range of the cytofluorogram
� Options for the color look-up tables of the cytofluorogram
� Options for the binary mask of the cytofluorogram
� Options for the display of the cytofluorogram

Structure of the Experiment Overview window
To open the Viewer Options dialog window, select the Experiment Overview option in the View menu.
The Experiment Overview display window appears on the left side of the user interface. The top part
of this window displays the recorded images in a directory tree. The bottom part displays the Viewer
Options dialog window. This dialog window is used to perform basic settings for different software
functions. The left side shows the icons corresponding to the functions and the right side shows the
related tabs. When you open the dialog window, it contains the icons of the functions that you are
currently using. Click Show all to view all icons.

The tabs of the Multicolor icon can be used to perform optional settings for the following functions:

& see Multicolor / Create 2D cytofluorogram (see page 260)

& see Multicolor / Create 3D cytofluorogram (see page 262)

& see Multicolor / Localize value pairs of the cytofluorogram in the original image (see
page 264)

& see Multicolor / View overlay image (see page 263)
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& see Multicolor / View statistics (see page 266)

Options for the value range of the cytofluorogram

Input tab

� Adjust the sliders in the Intensity Ranges field to vary the intensity value range that is displayed
in the cytofluorogram, separately for each detection channel.

� Select the Lock sliders check box to lock the sliders of the detection channels to each other. This
allows you to adjust the value range of the cytofluorogram simultaneously for all detection
channels.

� Adjust the sliders in the Visible Frequencies field to vary the intensity value pairs displayed in the
cytofluorogram depending on their frequency.

Options for the color look-up tables of the cytofluorogram
Two main categories of color look-up tables are available for the color coding of the cytofluorogram.
The binary color look-up tables (Binary with...) visualize the presence of an intensity value
combination. As soon as the value combination is present only once, a dot is displayed in the
cytofluorogram. Each dot is displayed with the same brightness. The frequency-coded color look-up
tables (Frequency coded...) visualize the frequency of the intensity value pairs. The brightness of the
dot in the cytofluorogram represents the frequency. The brighter the dot in the cytofluorogram, the
more frequent is the intensity value combination that it represents.
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Color tab

� If you select Binary with fixed color, all points of the cytofluorogram are displayed in white.
� If you select Binary with image colors, the scatter plot is coded with the color look-up tables of

the detection channels. The points that are located in the plane or spatial diagonal, are
represented in a shading of the color look-up tables.

� If you select Binary with custom colors, you can select a series of special color look-up tables in
Custom color list box which will code the points in the plane and spatial diagonal with a
projecting or diminishing color.

With a cytofluorogram consisting of three detection channels, the color look-up table 2x2x2 gray-

red is automatically selected. In this case, the other color look-up tables in the Custom color list

box are no longer available.

� If you select Frequency coded, linear, you can select one of the color look-up tables in the
Frequency color LUT list box, which is also available for color coding the image data in the
detection channels. The frequency color coding is linear.

� If you select Frequency coded, logarithmic, you can select one of the color look-up tables in the
Frequency color LUT list box, which is also available for color coding the image data in the
detection channels. The frequency color coding is logarithmic.

� If you select Frequency and Intensity weighted, then frequency and intensity are simultaneously
visualized with a special color look-up table.

� If you deselect the Auto scale check box, you can specify a value for the maximum frequency
which is visualized with a frequency-coded color look-up table in the cytofluorogram.

Options for the binary mask of the cytofluorogram
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Mask tab

� Click on the Activate multicolor mask check box to create a binary mask of the cytofluorogram.
This corresponds to pressing the Mask button.

� If you select Mask only, the original images will show only the image data that were masked in
the cytofluorogram (with a region of interest). The masked image data are displayed in white.

� If you select Masked image only, the original images will show only the image data that were
masked in the cytofluorogram (with a region of interest). The color coding depends on the color
look-up table of the respective detection channel.

� If you select Image covered by mask, the original images are shown together with the image
data that were masked in the cytofluorogram. The masked image data are displayed in white.

� If you select Image covered by blue mask, the original images are shown together with the
image data that were masked in the cytofluorogram. The masked image data are displayed in
blue.

� If you select Invert mask, the color coding of masked image data and original image is inverted.
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Options for the display of the cytofluorogram

View tab

� If you click on the Show Axes check box, the two or three spatial axes of the cytofluorogram are
shown.

� If you click on the Show Color LUTs check box, the color look-up tables of the detection
channels are displayed on the axes of the cytofluorogram.

� If you click on the Show Histograms check box, a histogram curve is displayed on each axis of
the 2D cytofluorogram.

� If you click on the Show Bounding Box check box, the cube of the cytofluorogram is displayed.
� Select Fast in the Rendering field to accelerate the calculation of the cytofluorogram with large

amounts of data. This is recommended, for example, if you click on the Gallery button so that all
single images of an image series are included in the cytofluorogram.

3D (optional)

This optional software package is not part of the basic program package. However, it

can be obtained from your Leica branch office or an authorized dealer.

3D Projections and Animations of Image Series

This chapter contains the following topics
� Setup and operation of the Process operating step
� Navigation: 3D Visualization and Animation\ Projections
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� Navigation: 3D Visualization and Animation\ Projections with
Animation

�Navigation: 3D Visualization and Animation\ Stereo
�Navigation: 3D Visualization and Animation\ Stereo with Animation

Setup and operation of the Process operating step

After clicking the Process arrow symbol, the usual setup of the user interface is completely changed.
All function buttons of the other button areas/operating steps are hidden. The Experiment Overview
(1) display window is shown on the left with the opened experiments. The navigation window (2) with
the directory tree of all functions available in this operating step is located underneath it. The middle of
the user interface displays 10 large tiles (3), which comprise the 10 function groups. A help field (4) is
located above these tiles, which can display a brief explanation of a function group by holding the
mouse pointer over the corresponding tile.

� Click on the tile with the desired function group. On every navigational level, you can display an
explanation of the function groups in the top help field by holding the mouse pointer over the
corresponding tile.

� Select one tile each on the following navigational levels until you have reached the desired
function with the corresponding dialog on the lowest level.

� You can directly select a function in the navigation window by clicking the corresponding folder.

The menu bar at the top right offers the following buttons (5):

� Click Back to return to the previously displayed navigational level.
� Click Forward to display the level which you selected prior to clicking the Back button.
� Click Up to enter the next higher level in the hierarchy.
� Click Reset to return modified variables to their last setting.
� To exit the Process operating step, click the arrow symbol of another operating step (e.g.

Acquire).

The bottom of every dialog displays the following two buttons:
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� Click Preview to execute the selected function and to display the resulting image on the right in
the preview window.

� Click Apply to apply the selected function to the current image data set, to display the resulting
image in the Viewer display window and to create a new file in the current experiment.

Navigation: 3D Visualization and Animation\ Projections
Creating Projection Images Along a Definable Projection Axis

& see Principles and Types of Projections (page 193)

� In the Experiment Overview display window, select the image data set to be processed by
double-clicking the file.

� Select one of the four projection types: Average Projection, Maximum Projection, Transparent
Projection, SFP Projection (SFP Shadow Projection).

Options tab
� Click on Rescale in the Options field to standardize the intensity values of the image to the

maximum possible intensity values when creating the projection image. This ensures that the
calculated gray values of the projection image remain within the value range of, for example, 0 to
255 at 8 bits. This allows for brightening dark images.

� If you click on Invert in the Options tab, the projection axis is mirrored. The calculation of the
projection image is thus in the opposite direction. This function makes sense above all in the
case of inverse microscopes to match the calculation of the projection image to the inverse
beam path of laser light.

� Move the slider in the Threshold field to define a threshold value. The intensity values below this
value are not taken into account for the creation of the projection image.

Rotation tab
� In the Viewing Direction field, set the desired projection axis by entering a value for Z, Y and X.

With these three values, you rotate the image stack into a certain position and thus define the
angle at which the image stack is projected.
The projection axis here is the viewing angle of the person viewing the rotated image stack. The
scheme below illustrates the rotation direction of each image level; in the case of positive values
for Z, Y and X. In the case of negative values, the rotation direction is exactly the other way
around:

� In the Depth Factor field, enter a value to scale the z-axis of the projection images.

Factor tab (only for transparent projection)

& see Principles and Types of Projections (page 193)

� The Factor tab is only displayed if the transparent projection was selected. Use the slider to vary
the transparent factor α. The higher it is set, the stronger the intensity values flow from the lower
levels in the image stack into the projection image.

� Click on the Transparency Gallery tile to view a gallery of preview images of the selected image
data set. Each of these preview images was calculated using a different transparency factor.
Click a tile to display a dialog window with the corresponding settings.
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Light tab (only for SFP projection)

& see Principles and Types of Projections (page 193)

� The Light tab is only displayed if the SFP projection was selected. In the Light Direction field,
you define the projection angle for the first computing step of the SFP projection. This angle
symbolizes the angle of incidence of the laser beam onto the specimen. Enter one coordinate
each for x and y.

� Move the slider in the Absorption field to vary the absorption coefficient α. The higher it is set,
the smaller are the values calculated in the projection image. If the coefficient is set low, many of
the pixels in the projection image reach the maximum value, making it increasingly difficult to
distinguish between the structures.

� If you click on Calc. Shadow in the Options field on the Options tab, a cast shadow is calculated
for the SFP projection image and displayed.

� Click on the SFP Light Gallery tile to view a gallery of preview images of the selected image data
set. Each of these preview images was calculated using a different projection angle. Click a tile
to display a dialog window with the corresponding settings.

� Click on the SFP Absorption Gallery tile to view a gallery of preview images of the selected
image data set. Each of these preview images was calculated using a different absorption
coefficient. Click a tile to display a dialog window with the corresponding settings.

Navigation: 3D Visualization and Animation\ Projections and Animation
Running projection images as three-dimensional rotation animation

& see Principles and Types of Projections (page 193)

Animation tab
� To make settings for the rotation animation, click on the Animation check box. The

corresponding fields are enabled.
� In the Rotation field, select the animation type: Full turn or 360°, half turn or 180°, quarter turn or

90°, or any other angle.
� In the Frames field, enter the number of projection images to be created for the animation. The

number of projection images and the animation type specify the intervals at which the projection
images are created. With a half turn (angle of 180°) and a number of images of, for example, 10,
an image is created in steps of 20° (not 18°), as there are only 9 steps for 10 recorded images.

There is another calculation in the case of the full turn (angle of 360°). To prevent the first and

last projection image from being recorded under the same angle (360° = 0°), the function

calculates one recorded image more, but without creating the corresponding projection image. In

the case of 10 images, for example, the interval between the projection images is 36° (not 40°),

as 11 recorded images (i.e. 10 steps) are used in the calculation. However, only 10 projection

images are created.

� In the Rotation Axis field, vary the inclination of the rotation axis.
� To start the rotation animation, click on the Movie button.

& see Starting and Ending a Film (page 191)

The three projection types can also be enabled directly using the corresponding buttons
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(3D Proj / 3D Max / 3D Avg / 3D Trans). If you activate the function using the button, the

projection image will just be a temporary display on the monitor. You can undo this

using the Original button.

& see Maximum Projection of an Image Stack with Variable Projection Axis (page 197)
& see Average Projection of an Image Stack with Variable Projection Axis (page 282)
& see Transparent Projection of an Image Stack with Variable Projection Axis (page 199)

Navigation: 3D Visualization and Animation\ Stereo
Navigation: 3D Visualization and Animation\ Stereo with Animation
Creating Red-Green Stereo images (Anaglyphic Images)

Stereo View Options Field
� In the Eye Angle list box determine the angle under which the two stereo images are recorded.

For example, if you enter the value 30, a stereo image is recorded at an angle of 15° each left
and right from the projection axis that was set on the Rotation tab.

� Stereo images can only be created from one detection channel. If you have an image series that
was recorded in several detection channels, select the desired image data set in the Detection
Channel list box.

� To display both stereo images in one image in the Viewer window, the buttons Channel 1,
Channel 2, Single and Overlay must be pressed.
& see Viewing Detection Channel 1 (page 184)
& see Viewing Detection Channel 2 (page Fehler! Textmarke nicht definiert.)
& see a Viewing a Single Image (page 186)
& see Viewing an Overlay Image (page 188)

Additional information
Anaglyphic images create a stereoscopic sense of depth if they are viewed with corresponding 3D
glasses (red-green stereo glasses). The stereoscopic effect of the anaglyphic image is possible since
human beings use both eyes for viewing. Since the eyes are approximately 6.5 cm (2.56 inch) apart,
the brain receives two images from different perspectives. Objects located at different distances are
observed at different angles. This angular difference is a measure of distance for the human brain.
The difference between the similar images generated by the two eyes is processed by the brain into
one image with spatial depth impression. These image differences can also be simulated by holding a
slightly different image in front of each eye.

In anaglyphic images, the complete stereoscopic image information is located on one image. The
information of the left and right image is coded through colors. For this reason, glasses with a different
color filter for each eye are needed in viewing these images. This filter separates the image
information again for each eye. The red filter only passes red light, while completely absorbing the
green light. On the other hand, the green filter absorbs the red light. Each eye perceives one image;
both are merged in the brain into an overall spatial image.

Linear Filters and Morphological Filters

This chapter contains the following topics
� Setup and operation of the Process operating step
� What are linear filters?
� Navigation: Image Filters\ Linear Filters
� What are morphological filters?
� Navigation: Image Filters\ Morphological Filters
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Setup and operation of the Process operating step

After clicking the Process arrow symbol, the usual setup of the user interface is completely changed.
All function buttons of the other button areas/operating steps are hidden. The Experiment Overview
(1) display window is shown on the left with the opened experiments. The navigation window (2) with
the directory tree of all functions available in this operating step is located underneath it. The middle of
the user interface displays 10 large tiles (3), which comprise the 10 function groups. A help field (4) is
located above these tiles, which can display a brief explanation of a function group by holding the
mouse pointer over the corresponding tile.

� Click on the tile with the desired function group. On every navigational level, you can display an
explanation of the function groups in the top help field by holding the mouse pointer over the
corresponding tile.

� Select one tile each on the following navigational levels until you have reached the desired
function with the corresponding dialog on the lowest level.

� You can directly select a function in the navigation window by clicking the corresponding folder.

The menu bar at the top right offers the following buttons (5):

� Click Back to return to the previously displayed navigational level.
� Click Forward to display the level which you selected prior to clicking the Back button.
� Click Up to enter the next higher level in the hierarchy.
� Click Reset to return modified variables to their last setting.
� To exit the Process operating step, click the arrow symbol of another operating step (e.g.

Acquire).

The bottom of every dialog displays the following two buttons:

� Click Preview to execute the selected function and to display the resulting image on the right in
the preview window.

� Click Apply to apply the selected function to the current image data set, to display the resulting
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image in the Viewer display window and to create a new file in the current experiment.

What are linear filters?
Filters are used to enhance the quality of an image. As a rule, this means removing undesirable pixels
from the image. The filter function available here—a low-pass filter—is used to suppress static noise
in an image that could be generated by the detector.

The principle of a filter consists of taking the value of each pixel in an image and setting it off against
the values of the adjacent pixels. The filter kernel describes the number and weighting of the adjacent
pixels that come to bear in the calculation of the new pixel. The kernel used here can be described
using Pascal's triangle:

Filter kernel size Pascal triangle Standardization

Kernel Size 3

Kernel Size 5

Kernel Size 7

Kernel Size 9
...

1 1
1 2 1

1 3 3 1
1 4 6 4 1

1 5 10 10 5 1
1 6 15 20 15 6 1

1 7 21 35 35 21 7 1
1 8 28 56 70 56 28 8 1

...

1/2
1/4
1/8
1/16
1/32
1/64
1/128
1/256
...

If, for example, kernel size 5 is selected, 5 pixels of the original image are used in calculating 1 pixel
in the filtered image. It is always the middle pixel in the filter kernel that is the pixel to be calculated. In
this case, the gray values of the 5 pixels corresponding to the weighting scale 1-4-6-4-1, are multiplied
by the factors 1/16, 4/16, 6/16, 4/16, 1/16 and together added to the final value. With respect to the
calculation of the pixel C in the following schematic representation this means that the gray values of
pixels A, B and D, E are included in the calculation of the filtered pixel C'. C' is calculated as follows:
16x1/16 + 4x4/16 + 8x6/16 + 32x4/16 + 8x1/16 = 1 + 1 + 3 + 8 + 0.5 = 13.5

A B C D E
Gray values of pixels A-E in the original image 16 4 8 32 8
Factors of kernel size 5 1/16 4/16 6/16 4/16 1/16
Gray value of C' in the filtered image 13.5

A calculation of this kind is performed for each pixel in the original image. At the edge of the image,
the filter mask protrudes beyond the image. For these pixels, the value 0 is set.

Function of linear filters

Intensity profile of an unfiltered image Intensity profile of the image after application of
the Blur filter

Intensity profile of the image after application of
the Sharpen filter

Intensity profile of the image after application of
the Highpass filter

� If you select the Blur filter, the low-pass filter described above is applied to the image. This filter
type filters the high frequencies out of the image. That is, the very distinctive transitions from low
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to high intensity values are reduced. This filter can be used to remove noise from an image.
� If you select the Sharpen filter, the low-pass filter is applied to the image, and the values of the

high-pass-filtered image are added to the values of the original image. This filter type filters the
low frequencies out of the image. That is, the very distinctive transitions from low to high
intensity values are intensified.

� If you select the Highpass filter, the low-pass filter is applied to the image, and the values of the
original image are subtracted from the values of the low-pass-filtered image. The result
corresponds to an image that was processed with a high-pass filter. This filter type displays only
the very distinctive transitions from low to high intensity values in the image.

Navigation: Image Filters\ Linear Filters
Applying linear filters (low-pass and high-pass filters) to images

� In the Experiment Overview display window, select the image data set to be processed by
double-clicking the file.

� Select one of the three filter types: Blur, Sharpen, Highpass.
� In the Kernel Size field, select a value for the kernel size. The value specified in the Kernel Size

field as Cut-off Wavelength is the size of the filter measured in pixels. This value is calculated on
the basis of the scan parameters (enlargement of the objective, wavelength of the excitation
light, scan format, electronic zoom factor...) used for each image.

� In the Filter Directions field, set the dimensions of the filter. Select the spatial axes to which the
filter is to be applied sequentially. One-dimensional filters are applied, that is, the filter is
calculated only via one axis at any given time. The value specified in the Filter Directions field as
Cut-off Wavelength is the size of the filter measured in nanometer. For example, with a value of
160 nm all wavelengths lesser than or equal to 160 nm are filtered.

Sharp Factor (only with Sharpen filter)
� Use the slider in the Sharp Factor field to vary the effect of the Sharpen filter. If this factor is set

to 0, the filter is not active.

Blur (Gallery), Sharpen (Gallery), Highpass (Gallery) tiles
� Click on the Blur (Gallery), Sharpen (Gallery) or Highpass (Gallery) tile to view a gallery of

preview images of the selected image data set. Each of the preview images was calculated with
a different kernel size (and a different sharpness factor). Click a tile to display a dialog window
with the corresponding settings.

What are morphological filters?
Using mathematical operators, morphological filters are used to change the form of connected
structures in an image and to separate them from the background. Morphological operators are
typically applied to binary images. Binary images feature pixels, which only have the value 1 or 0. The
segmentation functions in the Leica Confocal Software can be applied to create binary images.
However, these operators can also be used to process halftone images, that is images with a value
range of, for example, 256 (8 bits) different gray values/intensity values.

& see Process Operating Step / Segmentation Folder (page 284)

The principle consists of moving a mask—also referred to as structural element—pixel by pixel over
the image. The pixel to be examined is always the central pixel of the mask. The mask in the Leica
Confocal Software can have the shape of a cube, cross or sphere. Shape and size of the mask
determine which and how many adjacent pixels are included in the filtering. A certain criterion is used
to distinguish which pixels are defined as structure and as background in the resulting image. For
binary images, this criterion is the logical combination AND or OR; for halftone images, it is the size of
the gray value/intensity value.

& see Boolean Operations (page 291)

The shape of the mask is used to influence the structures to be highlighted in the resulting image. For
example, if the sphere is selected as mask form, round shapes are accentuated in the resulting
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image. However, the morphological operator determines in which proximity relation the corresponding
pixel is coded as structure or as background in the resulting image.

The following two elementary basic types of morphological operators, namely erosion and dilation, as
well as combinations of these operators exist:

Operator Description
Erosion With binary images, the examined pixel is set to the binary value 1 in the resulting image

if all adjacent pixels (determined by the shape and size of the mask) in the binary original
image are coded with a 1.
With halftone images, the minimum gray value of the adjacent pixels is entered in the
resulting image instead of the value of the examined pixel.

Dilation With binary images, the examined pixel is set to the binary value 1 in the resulting image
if at least one adjacent pixel (determined by the shape and size of the mask) in the
binary threshold image is coded with a 1.
With halftone images, the maximum intensity value of the adjacent pixels is entered in
the resulting image instead of the value of the examined pixel.

Combination of
operators

Description

Open Open is a combination of operators. First, an erosion is executed, followed
by a dilation.

Close Close is a combination of operators. First, a dilation is executed, followed by
an erosion.

Top Hat Top Hat processes the image with the Open operator combination and
subtracts the resulting image from the original image.

Bottom Hat Bottom Hat processes the image with the Close operator combination and
subtracts the original image from the resulting image.

Filters Description
Median The Median filter belongs to the group of nonlinear hierarchical filters. In Median filtering,

the intensity values of the adjacent pixels (determined by the shape and size of the mask)
are sorted based on their size. The intensity value occupying the middle of this hierarchy is
then entered in the resulting image of the median filtering instead of the examined pixel.

Effect of the morphological operators

Original image After applying the Median filter
Structures (with very high intensity values) are color-
coded in gray, the background (intensity value 0) in
dark blue. Between these two extreme values, the
range from higher to lower intensity values is color-
coded from brown, yellow, green to turquoise.

The Median filter smoothes the overall
image, while simultaneously accentuating
and contouring structures in the image.
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After applying the Erosion operator After applying the Dilation operator
Connected structures shrink and small structures
and connections between structures disappear (the
number of high intensity values decreases, while the
number of low intensity values increases).

Connected structures grow and spaces
within a structure and between structures are
filled (the number of high intensity values
increases, while the number of low intensity
values decreases).

After applying the Open operator (Erosion +
Dilation)

After applying the Close operator
(Dilation + Erosion)

Connected structures shrink and spaces become
larger (the number of high intensity values
decreases, while the number of low intensity values
increases).

Connected structures grow and spaces
remain almost unchanged (the number of
high intensity values increases, while the
number of low intensity remains almost
identical).

After applying the Top Hat operator After applying the Bottom Hat operator
The high intensity values are extracted The low intensity values are extracted

Navigation: Image Filters\ Morphological Filters
Applying morphological filters to images

� In the Experiment Overview display window, select the image data set to be processed by
double-clicking the file.

� Select one the seven filter types: Median, Erosion, Dilation, Open, Close as well as Top Hat and
Bottom Hat.

� In the Mask field, select the basic form of the filter mask: Cube, Cross or Sphere. The selection
of the shape of the structure element influences the image structures processed by the filter. For
example, spheres accentuate round structures in the resulting image.

� Enter the size of the mask in pixels in the fields Size X, Size Y and Size Z. The size of the mask
determines how many adjacent pixels are included in the filter mask.

� In the Repetition field, you specify the frequency with which the filter is to be applied.

Tiles with designation (Gallery)
� Click one of the tiles labeled with (Gallery) to view a gallery of preview images of the selected
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image data set. Each of the preview images was calculated with a different structure element
and/or mask size. Click a tile to display a dialog window with the corresponding settings.

Maximum Projection of an Image Stack with Variable Projection Axis

Function
The 3D Max. button starts a maximum projection. The projection axis is freely variable.
The basis for a projection is an image stack, i.e. a series of horizontal xy-sections or vertical xz-
sections. When a projection is generated, the sampling points of the individual images—
superimposed along the projection axis—are examined throughout all optical sections. From each of
these columns of sampling points, the maximum intensity value is displayed in the two-dimensional
projection image as the representative of all intensity values within the column.

& see Principles and Types of Projections (page 193)

� Click on the 3D Max. button. A maximum projection of the current image stack is created and
displayed in the Viewer window.

� You can now change the projection axis by clicking in the image in the Viewer window and
holding the left mouse button pressed.

� Broken support lines are displayed that enclose the symbolically displayed image stack. Turn the
image stack to the desired new position by moving the mouse pointer while holding down the left
mouse button.

� If you release the left mouse button, a new maximum projection is calculated and displayed. The
projection axis is the viewing direction of the user to the newly positioned image stack.

� Use the Zoom button to enlarge or reduce the projection.
& see Zooming the 3D View (page 202)

� You can return to the original image anytime by clicking on the Original button.

In the Viewer Options dialog window, you can also adjust a threshold and scale the intensity value
range present in the image.

& see Viewer Options Dialog Window, Projections Icon (page 178)

A maximum projection can be activated using either the 3D Max. button or the Process

operating step / 3D Visualization and Animation folder. If you activate the function using

the button, the projection image will just be a temporary display on the monitor.

& see Process Operating Step / 3D Visualization and Animation Folder (page 271)
& see Creating an Experiment (page 244)

Note the difference between a maximum projection and a topographical image, which is

generated from intensity maximums. In a maximum projection, the intensity maximums
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are assigned color values directly. In a topographical image based on intensity

maximums, the intensity maximums are assigned real z-positions of the individual

sampling points first and then are color-coded.

& see Creating a Topographical Image (page 199)

Average Projection of an Image Stack with Variable Projection Axis

Function
Use the 3D Avg. button to start an average projection. The projection axis is freely variable.
The basis for a projection is an image stack, i.e. a series of horizontal xy-sections or vertical xz-
sections. When a projection is generated, the sampling points of the individual images—
superimposed along the projection axis—are examined throughout all optical sections. From each of
these columns of sampling points, the arithmetic average is calculated from all intensity values and
displayed in the two-dimensional projection image as the representative of the complete column.

& see Principles and Types of Projections (page 193)

� Click on the 3D Avg. button to create an average projection of the current stack of images. The
projection is displayed in the Viewer window.

� You can now change the projection axis by clicking in the image in the Viewer window and
holding the left mouse button pressed.

� Broken support lines are displayed that enclose the symbolically displayed image stack. Turn the
image stack to the desired new position by moving the mouse pointer while holding down the left
mouse button.

� After you release the left mouse button, the computer calculates and displays the new average
projection. The projection axis is the viewing direction of the user to the newly positioned image
stack.

� Use the Zoom button to enlarge or reduce the projection.
& see Zooming the 3D View (page 202)

� You can return to the original image anytime by clicking on the Original button.

In the Viewer Options dialog window, you can also adjust a threshold and scale the intensity value
range present in the image.

& see Viewer Options Dialog Window, Projections Icon (page 178)

An average projection can be activated using either the 3D Avg. button or the Process

operating step / 3D Visualization and Animation folder. If you activate the function using

the button, the projection image will just be a temporary display on the monitor.

& see Process Operating Step / 3D Visualization and Animation Folder (page 271)
& see Creating an Experiment (page 244)
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Transparent Projection of an Image Stack with Variable Projection Axis

Function
You can activate a transparent projection using the 3D Trans. button. The projection axis is freely
variable.
The basis for a projection is an image stack, i.e. a series of horizontal xy-sections or vertical xz-
sections. When a projection is generated, the sampling points of the individual images—
superimposed along the projection axis—are examined throughout all optical sections. From each of
these sampling point columns, a weighted average is calculated from all intensity values, which is
then displayed in the two-dimensional projection image as a representative of the entire column.

& see Principles and Types of Projections (page 193)

The user can vary the weighting of the sampling points to calculate the averages by setting the
corresponding factors (transparent factor) in the Viewer Options dialog window. Furthermore, you can
indicate a threshold and scale the intensity value range for the image.

& see Viewer Options Dialog Window, Projections Icon (page 178)

� Click the 3D Trans. button. A transparent projection of the current image stack is created and
displayed in the Viewer window.

� You can now change the projection axis by clicking in the image in the Viewer window and
holding the left mouse button pressed.

� Broken support lines are displayed that enclose the symbolically displayed image stack. Turn the
image stack to the desired new position by moving the mouse pointer while holding down the left
mouse button.

� Upon releasing the left mouse button, the new transparent projection will be calculated and
displayed. The projection axis is the viewing direction of the user to the newly positioned image
stack.

� Use the Zoom button to enlarge or reduce the projection.
& see Zooming the 3D View (page 202)

� You can return to the original image anytime by clicking on the Original button.

You can activate a transparent projection using the 3D Trans. button or the Process

operating step / 3D Visualization and Animation folder. If you activate the function using

the button, the projection image will just be a temporary display on the monitor.

& see Process Operating Step / 3D Visualization and Animation button (page 271)
& see Creating an Experiment (page 244)

Creating an SFP Projection of an Image Stack

Function
The SFP button starts an SFP projection, the mathematical simulation of a fluorescence process. The
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basis for a projection is an image stack, i.e. a series of horizontal xy-sections or vertical xz-sections.
When a projection is generated, the sampling points of the individual images—superimposed along
the projection axis—are examined throughout all optical sections. In the first step, the laser beam is
simulated penetrating the sample and diminishing. In the second step, using the determined light
density, the simulated fluorescence for each Voxel is calculated.

& see Principles and Types of Projections (page 193)

� Click on the SFP button. A SFP projection of the current image stack is created and displayed in
the Viewer window.

� You can now change the projection axis by clicking in the image in the Viewer window and
holding the left mouse button pressed.

� Broken support lines are displayed that enclose the symbolically displayed image stack. Turn the
image stack to the desired new position by moving the mouse pointer while holding down the left
mouse button.

� Upon releasing the left mouse button, the new SFP projection will be calculated and displayed.
The projection axis is the viewing direction of the user to the newly positioned image stack.

� You can return to the original image anytime by clicking on the Original button.

The SFP projection can be activated using the SFP button and the Process operating

step / 3D Visualization and Animation folder. If you activate the function using the

button, the projection image will just be a temporary display on the monitor.

& see Process Operating Step / 3D Visualization and Animation Folder (page 271)
& see Creating an Experiment (page 244)

Segmentation of Image Structures

This chapter contains the following topics
� Setup and operation of the Process operating step
� What is segmentation in image processing?
� Navigation: Segmentation\ Thresholding
� Navigation: Segmentation\ Seeding (Threshold)
� Navigation: Segmentation\ Seeding (Single Channel)
� Navigation: Segmentation\ Seeding (Cross-Channel)

Setup and operation of the Process operating step



Leica Microsystems Heidelberg GmbH
LCS software functions:

Description of individual functions

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 285 of 307

After clicking the Process arrow symbol, the usual setup of the user interface is completely changed.
All function buttons of the other button areas/operating steps are hidden. The Experiment Overview
(1) display window is shown on the left with the opened experiments. The navigation window (2) with
the directory tree of all functions available in this operating step is located underneath it. The middle of
the user interface displays 10 large tiles (3), which comprise the 10 function groups. A help field (4) is
located above these tiles, which can display a brief explanation of a function group by holding the
mouse pointer over the corresponding tile.

� Click on the tile with the desired function group. On every navigational level, you can display an
explanation of the function groups in the top help field by holding the mouse pointer over the
corresponding tile.

� Select one tile each on the following navigational levels until you have reached the desired
function with the corresponding dialog on the lowest level.

� You can directly select a function in the navigation window by clicking the corresponding folder.

The menu bar at the top right offers the following buttons (5):

� Click Back to return to the previously displayed navigational level.
� Click Forward to display the level which you selected prior to clicking the Back button.
� Click Up to enter the next higher level in the hierarchy.
� Click Reset to return modified variables to their last setting.
� To exit the Process operating step, click the arrow symbol of another operating step (e.g.

Acquire).

The bottom of every dialog displays the following two buttons:

� Click Preview to execute the selected function and to display the resulting image on the right in
the preview window.

� Click Apply to apply the selected function to the current image data set, to display the resulting
image in the Viewer display window and to create a new file in the current experiment.

What is segmentation in image processing?
Many applications of confocal microscopy require extracting structures in an image and, for example,
make them accessible as a whole for quantitative analyses. The segmentation process is applied to
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separate relevant from irrelevant image information. In image processing, segmentation is not only the
separation of background and structure, but also the graduation of an image into coherent structures.
There are pixel-oriented and region-oriented segmentation processes.

Pixel-oriented processes examine the intensity value of an isolated pixel. This process acquires the
intensity value distribution of an image in a histogram and attempts to locate a threshold in it. This
process is implemented in the Leica Confocal Software by means of the «Thresholding» function. It is
possible to set an upper and a lower threshold. All pixels whose intensity values lies within the range
defined by the threshold values receive the binary value 1 in the resulting image and all other pixels
receive the binary value 0. The result is a binary image with the structure versus background
information. The pixels coded as structure are all represented with the maximum gray value 255 (at 8-
bit depth), those coded as background with gray value 0.

Compared to the pixel-oriented process, the region-oriented process of the segmentation takes into
account that structures are coherent formations. For image processing, this means that every pixel
must always be examined together with its adjacent pixels. In this case, the isolated examination of
the intensity value of one pixel is no longer decisive for the identification of a pixel as structure or
background, but the intensity value of a pixel within the context of the intensity values of its adjacent
pixels. This process is implemented in the Leica Confocal Software by means of the «Seeding»
functions (range growth functions). Starting with a start pixel (also referred to as «seed pixel»), the
relation of the intensity values of start pixel and adjacent pixel is examined. A criterion is then used to
decide which pixels in the binary resulting image are counted towards the structure (binary value 1)
and which ones are counted towards the background (binary value 0). This criterion, for example, can
be defined such that the intensity value of an adjacent pixel may not deviate more than 75% from the
value of a seed pixel.

Original image Binary image
Pixel-oriented process,
Thresholding

Binary image
Region-oriented process,
Seeding

Navigation: Segmentation\ Thresholding
Pixel-oriented segmenting by means of a threshold
It is possible to define an upper and a lower threshold. The intensity value of each pixel in the image
is then examined whether it falls inside or outside this threshold range. This method of segmentation
is especially useful if the structures in the image do not touch and stand out clearly from the
background.

� In the Experiment Overview display window, select the image data set to be processed by
double-clicking the file.

� Specify the lower threshold separately for each detection channel in the Channels field on the
Lower tab by entering a value between 0 and 255 (at 8-bit depth) or positioning the slider
accordingly. Intensity values that fall below this threshold are set to 0 in the binary resulting
image.

� Specify the upper threshold separately for each detection channel in the Channels field on the
Upper tab by entering a value between 0 and 255 (at 8-bit depth) or positioning the slider
accordingly. Intensity values that fall above this threshold are set to 0 in the binary resulting
image.

� Click Lock Channels in the Options field if you want to specify the same threshold for all
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detection channels.
� Click on the Suggest button if the software is to calculate a suitable lower threshold. The

calculation of the threshold utilizes the algorithm that was selected on the Estimation tab (see
below).

Estimation tab
Entropy Maximization: Calculating the maximum entropy
The foundation of this algorithm is the premise that a connection exists between the probability of an
event and its information content. Therefore, more frequent events (often the background) have a
lower information content and less frequent events (often the structure) have a higher one. The
intensity values present in the image are divided into two sets and examined based on the intensity
value at which the entropy—the probability of its occurrence—is the highest. The optimum threshold is
the value at which the sum of the entropies of both sets is the highest or, in other words, at which the
information content is the lowest.

Within Group Variance Minimization: Calculating the minimum value of group variance
The foundation of this algorithm is the premise that two normal distributions of low as well as high
intensity values can be found in an image, which correspond to the structure and the background. The
intensity values present in the image are examined for each possible threshold and two normal
distribution curves are calculated. The threshold is then placed between these two curves.

Navigation: Segmentation\ Seeding (Threshold)
Region-oriented segmenting by means of a threshold
The user can define a lower and an upper threshold. Based on a selectable start pixel, the intensity
values of all adjacent pixels are examined whether they fall inside or outside this threshold range. If
no more adjacent pixels are found that fall inside the value range, the operation is finished.

� In the Experiment Overview display window, select the image data set to be processed by
double-clicking the file.

� Specify the lower threshold in the Lower Threshold field and the upper threshold in the Upper
Threshold field by entering a value between 0 and 255 (at 8-bit depth) or positioning the slider
accordingly. Intensity values that fall below or above this threshold range are set to 0 in the
binary resulting image.

� In the Position field of the Channels list field, select the detection channel whose image data is
to be segmented. If the All option is selected, the segmentation is carried out separately for each
detection channel.

� If the image data set is a time series or a lambda series, select the fourth dimension in the list
field on the right, i.e. a certain time or a certain wavelength.

� Position the graticule in the image for the definition of the start pixel by entering one value each
for the x-, y- and z-coordinate in the Position field. Or move the graticule in the image to the
desired position by pressing and holding the left mouse button.

Navigation: Segmentation\ Seeding (Single Channel)
Region-oriented segmenting in one channel
The user can define a permissible deviation (in per cent) from the intensity value of a selectable start
pixel. Based on this start pixel, the intensity values of all adjacent pixels are examined, for example,
whether they deviate by more than 75% from the value of the start pixel. If no more adjacent pixels
are found that fall inside the permissible value range, the operation is finished. This operation is
carried out separately for each selected detection channel.

� In the Experiment Overview display window, select the image data set to be processed by
double-clicking the file.

� Specify the permissible deviation in per cent in the Threshold field by entering a value or
positioning the slider accordingly. Intensity values that deviate more than the specified
percentage range, are set to 0 in the binary resulting image.

� In the Position field of the Channels list field, select the detection channel whose image data is
to be segmented. If the All option is selected, the segmentation is carried out separately for each
detection channel.
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� If the image data set is a time series or a lambda series, select the fourth dimension in the list
field on the right, i.e. a certain time or a certain wavelength.

� Position the graticule in the image for the definition of the start pixel by entering one value each
for the x-, y- and z-coordinate in the Position field. Or move the graticule in the image to the
desired position by pressing and holding the left mouse button.

Navigation: Segmentation\ Seeding (Cross-Channel)
Region-oriented segmenting across all channels
The user can define a permissible deviation (in per cent) from the intensity value of a selectable start
pixel. Based on this start pixel, the intensity values of all adjacent pixels are examined, for example,
whether they deviate by more than 75% from the value of the start pixel. If no more adjacent pixels
are found that fall inside the permissible value range, the operation is finished. In contrast to the
previous «Seeding (Single Channel)» function, this operation is carried out simultaneously across all
detection channels.

� In the Experiment Overview display window, select the image data set to be processed by
double-clicking the file.

� Specify the permissible deviation in per cent in the Threshold field by entering a value or
positioning the slider accordingly. Intensity values that deviate more than the specified
percentage range, are set to 0 in the binary resulting image.

� The All option is fixed in the Position field of the Channels list field. If the image data set is a time
series or a lambda series, select the fourth dimension in the list field on the right, i.e. a certain
time or a certain wavelength.

� Position the graticule in the image for the definition of the start pixel by entering one value each
for the x-, y- and z-coordinate in the Position field. Or move the graticule in the image to the
desired position by pressing and holding the left mouse button.
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Appendix

Adaptation Function for Correcting Trend Curves

& see Process Operating Step / Materials Folder (page 255)

1. Selecting the step width, that is, the distance of the support positions

2. Selecting the character of the interpolation function to be adapted

3. Calculating the interpolation function f(x) = a + bx + cy

4. Adding the intensity differences to the leveling of the trend curve
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before leveling

after leveling

Example for Merging Images of Different Channel Numbers (Merging)

a.) First output image (setting: Start=2)
b.) Second output image (setting: Start=1)
c.) Merged image
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Operating Principle of Boolean Operations

AND Write a 1 if there is a 1 in
pixel 1 AND in pixel 2;
otherwise write 0

a.) Binary representation
of pixel 1
b.) Binary representation
of pixel 2
c.) Binary representation
of result pixel

AND represents the intersection of
two images

OR Write a 1 if there is a 1 in
pixel 1 OR in pixel 2;
otherwise write 0

a.) Binary representation
of pixel 1
b.) Binary representation
of pixel 2
c.) Binary representation
of result pixel

OR represents the union of sets of
two images

XOR Write a 1 if the values in
pixel 1 and in pixel 2
differ; otherwise write 0

a.) Binary representation
of pixel 1
b.) Binary representation
of pixel 2
c.) Binary representation
of result pixel

XOR represents the union of sets
without the intersection of two
images.
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Optional Trigger Control Panel

Description of Function
The optional trigger control panel is used for controlling incoming and outgoing trigger signals. In
addition, trigger signals can be actuated manually to control recording sequences.
The control panel can be ordered from the appropriate Leica branch office using part number 15-
30911-001.

Front side of the trigger control panel

Element Function
T1 Signal lamp; indicates when a trigger signal was manually actuated on trigger channel 1 or an external trigger

signal arrives via T1 connection (rear side of the trigger control panel)
T2 Signal lamp; indicates when a trigger signal was manually actuated on trigger channel 2 or an external trigger

signal arrives via T2 connection (rear side of the trigger control panel)
T3 Signal lamp; indicates when a trigger signal was manually actuated on trigger channel 3 or an external trigger

signal arrives via T3 connection (rear side of the trigger control panel)
T4 Signal lamp; indicates when a trigger signal was manually actuated on trigger channel 4 or an external trigger

signal arrives via T4 connection (rear side of the trigger control panel)
Out4 Signal lamp; illuminates if an outgoing trigger signal is emitted via trigger channel 4 (standard TTL signal)
L Signal lamp; indicates the line signal. This lamp illuminates during the time in which data is recorded during the

line scan.
F Signal lamp; indicates the frame signal. This lamp illuminates during the time in which a single frame is recorded.
L/F The logical AND operation between the line signal L and the frame signal F
TM1 Push button; activating this push button creates a trigger signal on trigger channel 1. This signal can be recorded

and processed by the confocal system.
TM2 Push button; activating this push button creates a trigger signal on trigger channel 2. This signal can be recorded

and processed by the confocal system.
TM3 Push button; activating this push button creates a trigger signal on trigger channel 3. This signal can be recorded

and processed by the confocal system.
TM4 Push button; activating this push button creates a trigger signal on trigger channel 4. This signal can be recorded

and processed by the confocal system.

Rear side of the trigger control panel

Element Function
Trigger out Connection socket for connecting the trigger-out socket on the rear side of the supply unit
9V DC / 100
mA

Voltage supply of the trigger control panel

T1 Connection for incoming trigger signals (5 V, 100 ms, 2.2 kOhm)
T2 Connection for incoming trigger signals (5 V, 100 ms, 2.2 kOhm)
T3 Connection for incoming trigger signals (5 V, 100 ms, 2.2 kOhm)
T4 Connection for incoming trigger signals (5 V, 100 ms, 2.2 kOhm)
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Out4 Connection which is used to emit a trigger signal generated by the confocal system (standard TTL)
L Line signal. This signal is on logical "1" during the time in which data is recorded during a line scan.
F Frame signal. This signal is on logical "1" during the time in which data is recorded during a single image

(frame).
L/F The logical AND operation between the line signal L and the frame signal F

Installation
The trigger control panel is connected to the confocal system as follows:

1. The supplied ribbon cable is connected to the "Trigger out" connection socket at the rear side of the
operator panel and to the connection of the same name at the rear side of the supply unit.

2. The trigger control panel must be connected to the supplied power supply, and the power pack
must be connected to 230 V AC.

Application
External trigger signals (connection sockets "T1"-"T4") can be transmitted to the confocal system via
trigger control panel using a BNC cable.
Outgoing trigger signals can be transmitted to external devices via "Out4" connection socket.
The "TM1" - "TM4" push button can be used for testing purposes.
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Glossary

Aberration,
chromatic

An optical image distortion conditional on the varying refraction of light rays of
different wavelengths on a lens. Thus light rays of shorter wavelengths have
longer focal distances than light rays of longer wavelengths.

Aberration,
spherical

An optical image distortion conditional on the varying distance of paraxial light
rays of the same wavelength from the optic axis. Light rays that travel through
outer lens zones have shorter focal distances than rays that travel through the
lens center (optic axis).

Achromatic Describes a correction class for objectives. The chromatic aberration for two
wavelengths is corrected for objectives of this type. Usually an objective of this
type is corrected to a wavelength below 500 nm and above 600 nm.
Furthermore, the sine condition for one wavelength is met. The image curvature
aberration is not corrected.

Airy disc The Airy disc refers to the inner, light circle (surrounded by alternating dark and
light diffraction rings) of the diffraction pattern of a point light source. The
diffraction discs of two adjacent object points overlap some or completely, thus
limiting the spatial resolution capacity.

Aliasing An image distortion caused by a sampling frequency that is too low in relation to
the signal frequency.

AOTF
Acousto-Optical
Tunable Filter

The acousto-optical tunable filter is an optic transparent crystal that can be used
to infinitely vary the intensity and wavelength of radiated light. The crystal
generates an internal ultrasonic wave field, the wavelength of which can be
configured to any value. Radiated light is diffracted vertically to the ultrasonic
wave field like through a grid.

Aperture,
numerical

Aperture is the sine of the opening angle under which light enters into the front
lens of a microscope objective; its symbol is NA. The aperture influences both
the light intensity and the resolution capacity of an objective optical system.
Since various media can be present between specimen and objective lens
(such as the embedding medium for the specimen), the numerical aperture (NA
= n * sinα) is usually applied as the unit of measurement for the light intensity
and the resolution capacity.

Apochromatic Describes a correction class for objectives. The chromatic aberration for three
wavelengths is corrected for objectives of this type (usually 450 nm, 550 nm
and 650 nm) and the sine condition for at least two colors is met. The image
curvature aberration is not corrected.

Bleaching,
optical

The destruction of fluorochromes, by intense lighting. In fluorescence
microscopy, fluorochromes are excited with laser light to a high state of energy,
the singlet state. When the excited molecules return to their normal energy
state, a fluorescent signal is emitted. If the intensity of the excitation is too high
however, the color molecules can change via intercrossing from a singlet state
to a triplet state. Due to the significantly longer life of triplet states
(phosphorescence), these excited molecules can react with triplet-oxide and be
lost for further fluorescence excitation.

Confocality While the optical design of conventional microscopes allows the uniform
detection of focussed and unfocussed image components, the confocal
principle suppresses the structures found outside of the focal plane of the
microscope objective. Screens are implemented in optically conjugated
locations to achieve this. They function as point light source (excitation screen)
and point detector (detection screen). The diameter of the detection screen,
along with the wavelength and numerical aperture of the objective being used,
determines the axial extension of an optical section (optical resolution).

Dichroic Dichroic filters are interference filters at an angle of incidence of light of 45°.
The transmissivity or reflectivity of dichroites depends on a specific wavelength
of light. For an RSP 510 filter (reflection short pass) for example, the excitation
light below 510 nm is reflected and the excitation light above this value is
transmitted. The transmission values are generally between 80% and 90% and
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the reflection values between 90% and 95%.
Double dichroite Double dichroic filters are interference filters at an angle of incidence of light of

45°. The transmissivity or reflectivity of double dichroites depends on two
specific wavelengths of light. For a doubledichroite DD 488/568, for example,
the excitation light at 488 nm and 568 nm is reflected and the excitation light
above these values is transmitted. The transmission values are generally at
80% and the reflection values are between 90% and 95%.

Dry objective A microscopic objective used without immersion media. Between the objective
lens and the specimen is air.

Empty
magnification

A magnification without additional gain of information. Empty magnification is
used as soon as distances are displayed that are smaller than the optical
resolution. Magnifications with a larger scale than that of the empty
magnification do not provide any additional information about the object but,
instead, only diminish the focus and the contrast.

Filter, digital,
phase-true

A digital filter consists of a computing rule used to modify image data. Filters are
always applied to remove disturbing image components. A phase-true filter
ensures that quantifiable image values do not change through filtering and
remain a requirement for standardized measuring methods (e.g.,
characterization of surfaces in accordance with ISO).

Fluorescence
microscopy

A light-optical contrast process for displaying fluorescent structures. Auto-
fluorescent samples have a so-called primary fluorescence. They do not need
to be enriched with additional, fluorescent substances. Secondary fluorescent
substances, on the other hand, have to be treated with appropriate dyes or
stains called fluorochromes. Specific dyeing methods additionally allow the
precise localization of the stained structure elements of an object. Fluorescence
microscopy allows both potential morphological examinations and the ability to
carry out dynamic examinations on a molecular level.

Fluorite
objectives

Describes a correction class for objectives. Fluorite objectives are semi-
apochromatic, meaning their degree of correction lies between the achromatic
and apochromatic.

Frame A frame corresponds to the acquisition of a single optical section. For example,
if a single optical section is acquired 4 times (to average the data and to
eliminate noise), then 4 frames are created for this optical section.

Image curvature
aberration

The curved surface to which a microscopic image is to be clearly and distinctly
mapped is described as image curvature aberration. It is conditional on the
convex shape of the lens and makes itself apparent as an error due to the short
focal distances of microscope objectives. Here the object image is not in focus
both in the center and at the periphery at the same time. Objectives that are
corrected for image curvature aberration are called plane objectives (plane =
flat image field).

Immersion
objective

A microscopic objective, developed with the requirements for applying
immersion media. The use of incorrect or no immersion medium with an
immersion objective can lead to resolution loss and impairment of the
correction.

Neutral filter Neutral filters are semi-reflective glass plates. They are used to distribute the
light path independent of wavelength. The incident light is partially reflected and
partially transmitted. Neutral filters are usually placed at a 45° angle in the path
of the beam. The ratings of a neutral filter are based on its reflectivity-to-
transmissivity ratio. A neutral filter RT 30/70, for example, reflects 30% of the
excitation light and transmits 70%.

Phase
visualization

The principle of phase visualization as used by Leica is an optimized alternative
method to ratiometric displaying. The main area of application lies in measuring
ion concentrations in physiology. In contrast with ratiometric procedures, phase
visualization obtains more information on the specimen. In addition, this method
allows for adapting the display of physiological data to the dynamics of the
human eye. Detailed information on the principle of phase visualization can be
obtained directly from Leica Microsystems Heidelberg GmbH.

Pixel An acronym based on the words, picture and element. A pixel represents the
smallest, indivisible image element in a two-dimensional system. In this
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documentation, both the sampling points of the specimen as well as the image
points are referred to as pixels.

Plane objectives Describes a correction class for objectives. The image curvature aberration is
corrected for objectives of this type. Correcting this error requires lenses with
stronger concave surfaces and thicker middles. Three types of plane objectives,
plane achromate, plane apochromate and plane fluorite, are based on the type
of additional correction for chromatic aberration.

Reflection long
pass filter

Reflection long pass filters are interference filters that reflect short-wave light
but are transparent for long-wave light. An optical reflection long pass filter is
characterized by the reading of the wavelength edge at which the filter changes
from reflection to transmission (50% threshold).

Reflection short
pass filter

Reflection short pass filters are interference filters that transmit short-wave light
while reflecting long-wave light. An optical reflection short pass filter is
characterized by the reading of the wavelength edge at which the filter changes
from transmission to reflection (50% threshold).

Refraction index The factor by which the light velocity in an optical medium is less than in a
vacuum.

ROI Abbreviation for "Region of Interest". ROI encloses an area for which a
measurement analysis is to be performed. On top of that, an ROI can also
designate the area of a specimen to be scanned (ROI scan).

Signal-to-noise
ratio

The ratio of signals detected in the specimen to the unwanted signals that are
caused randomly by various optic and electronic components, which are also
recorded by the detector.

Stokes shift The Stokes shift is a central term in fluorescence microscopy. If fluorescent
molecules are excited with light of a specific wavelength, they radiate light of
another, larger wavelength. This difference between excitation light and
fluorescent light is referred to as Stokes shift. Without Stokes shift, separating
the high-intensity excitation light from the low-intensity fluorescence signals in a
fluorescence microscope would not be possible.

Triple dichroic Triple dichroic filters are interference filters at an angle of incidence of light of
45°. The transmissivity or reflectivity of triple dichroites depends on three
specific wavelengths of light. For a tripledichroite TD 488/568/647, for example,
the excitation light at 488 nm, 568 nm and 633 nm is reflected and the excitation
light above these values is transmitted. The transmission values are generally
at 80% and the reflection values are between 90% and 95%.

Voxel An acronym based on the words, volume and pixel. A voxel represents the
smallest, indivisible volume element in a three-dimensional system. In this
documentation, both the volume elements of the specimen as well as the 3D
image points are referred to as voxels.

Working
distance

The distance from the front lens of an objective to the focal point. For a variable
working distance, the gap between the front lens of the objective and the cover
slip or uncovered sample is specified. Usually objectives with large working
distances have low numerical apertures, while high-aperture objectives have
small working distances. If a high-aperture objective with a large working
distance is desired, the diameter of the objective lens has to be made
correspondingly large. These, however, are usually low-correction optic
systems, because maintaining extreme process accuracy through a large lens
diameter can only be achieved with great effort.
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Specifications

Dimensions of the Leica TCS SP2
Inverse stand:

Dimensions of the Leica TCS SP2 confocal system (all measurements in mm)
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Declaration of Conformity
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Index
*.ano, 189, 243, 244

*.lei, 243, 244

*.tif, 243, 244

12 bit, 165, 204, 209

2D, 260

2-point, 177

3D, 174, 262

3D View button, 200

3D visualization, 271

8 bit, 165, 204, 209

Aberration, 294

Absorption coefficient, 193, 271, 283

Accumulation, 165

Accumulation method, 165

Achromatic, 134, 294

Acousto-optical beam splitter, 131

Acousto-optical tunable filter, 294

Adding a text field, 241

Adding a text field to an annotation sheet, 241

Adding images, 204

Addition, 204

Adjusting the phase, 160

Adjusting the photomultiplier, 138

Airy disc, 141, 294

Aliasing, 142, 294

Amplitude, 210

AND, 204, 291

Animation, 271

Annotation button, 239, 240

Annotation sheet, 232, 239, 240, 241

AOBS, 131

AOTF, 130, 294

Aperture, 294

Apochromatic, 134, 294

Apply button, 163

Applying the parameter setting of an
experiment, 163

Area, 248

Arithmetic, 204

Arithmetic with constant, 204

Arithmetical mean value, 227, 247, 248

ASCII data, 233

Automatically defining the Region of Interest,
235

Average, 164

Average brightness values, 214

Average deviation, 227, 229

Average image energy, 227

Average projection, 179, 193, 197, 217, 271,
282

Averaging procedure, 164

Back button, 204, 209, 210, 214, 217, 249,
255, 271, 275, 284

Background, 166, 249, 275, 284

Basic settings, 174

Batch processing of data, 164

Beam Path Setting dialog window, 130, 147,
149

Beam splitter, 131

Begin, 146, 147

Begin button, 147

Begin point, 146

Begin point for a lambda series, 147
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Begin point for a spatial series, 146, 147

Bidirectional, 160

Bidirectional scan, 160

Binarization, 284

Binary images, 249, 275, 284

Binary template, 264, 266

Bit depth, 209

Bit resolution, 209

Bleaching, 145, 294

Blur, 249, 275

Boolean, 204

Boolean operations, 204, 249, 275, 291

Boolean operators, 204, 249, 275, 291

Bottom hat, 249, 275

Brightness values, 214

Browse, 174

Burst mode, 164

Button, 6

Calculations, 204, 227

Center of mass, 199

Center of mass of intensities, 199

Channel, 184

Clear, 237

Close, 249, 275

Cluster analysis, 219

Colocalization, 260, 263, 264

Color Look-Up tables, 172, 184, 185

Color mixing, 188, 189

Combining images, 210

Configuration, 167

Configuring a time series, 170

Confocal imaging, 8

Confocality, 294

Context menu, 6

Continuous Scan, 145

Contrast transfer function, 214

Control panel, 245

Conversion, 209

Coordinate axes, 174

Copying an image into the annotation sheet,
239

Copying quantification graphs, 232

Correcting trend curves, 255

Correlation, 260

Creating a topographical image, 183, 199

Creating an experiment, 243, 244

Creating the 3D view, 181

Creating the 3D View, 200

Cross channel, 284

Crosstalk, 219, 260

Crosstalk correction, 219

Curve display, 181

Cytofluorogram, 260, 262, 263, 264, 266

Data format, 243

Deleting the region of interest, 237

Densitometric analysis, 266

Detection channel, 184

Detection pinhole, 141

Detectors, 130

Dialog window, 6

Dichroic, 294

Dichroic filters, 130

Diffraction image, 141

Digitization, 165, 209

Dilation, 249, 275
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Display, 174

Display zoom, 176

Displaying an image from a series, 191

Displaying the previous image in a series, 190

Dividing images, 204

Division, 204

Documentation conventions, 6

Double dichroite, 294

Double-dichroic filters, 130

Drawing a line, 240

Drawing a line on the annotation sheet, 240

Drawing a rectangle, 240

Drawing a rectangle on the annotation sheet,
240

Dry objective, 134, 294

Dye, 151

Dye finder, 219

Dynamic average, 164

Edit legend dialog window, 172

Edit legend entries, 172

Electronic zoom, 139

Ellipse, 233

Emission spectrum, 151

Empty magnification, 294

End point, 146

End point for a lambda series, 149

End point for a spatial series, 146, 148

Enhancement, 214

Enlarged recordings, 141

Erosion, 249, 275

Excitation wavelength, 131, 166, 167

Experiment, 163, 244

Experiment browser, 174

Experiment legend, 172

Experiment Overview Viewer window, 244

Export, 233

Exporting quantification data, 233

Extended focus, 217

Extraction, 249, 275, 284

File type, 243

Film, 190

Film sequence, 190, 191

Filters, 249, 275

Fine focussing stage, 170

First button, 190

First image of a series, 190

Fluorescence microscopy, 294

Fluorescent dye, 151

Fluorite objectives, 134, 294

Focal plane, 141

Focus, 141, 249, 275

Format, 142

Format button, 142

Forward button, 204, 209, 210, 214, 217, 249,
255, 271, 275, 284

Full screen, 172

Gain value, 138

Gallery, 188, 192

Gallery button, 188, 192

Gamma correction, 214

Gamma curve, 214

Geometric analysis, 266

Glossary, 294

Graphic zoom, 176, 185

Gray-value images, 204, 249, 275, 284

Hardware legend, 172
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Hardware settings, 163, 172

Height, 247, 248

Help button, 129

Help via the Internet, 10

Highpass filter, 249, 255, 275

Histogram, 227

How to use this manual, 5

Image brightness, 138, 214

Image contrast, 138, 214

Image curvature aberration, 294

Image filters, 249, 275

Image frame, 141, 210

Image information, 284

Image processing, 204, 209, 210, 214, 217,
249, 271, 275

Image raster, 142

Image recording, 165

Image resolution, 165, 209

Image series, 146, 147, 149, 154, 188, 190,
191, 192

Image stack, 149, 154, 193, 199, 217

Immersion objective, 134, 294

Import, 151

Invariable projection axis, 193, 196, 197, 198,
217

Isolines, 200

Köhler illumination, 41

Lambda scan button, 147

Lambda series, 147, 149, 150, 154

Lambda steps button, 150

Last button, 191

Last image of a series, 191

LCS file formats, 52

Legal notes, 11

Legend, 6, 172

Leica confocal software, 45

Length of the measured section, 229

Leveling, 183, 255

Line, 240

Line averaging, 163

Line button, 240

Linear filters, 249, 255, 275

Loading and saving parameter settings, 130

Look-Up table, 172, 185

Look-up Table button, 185

Low-pass filter, 249, 255, 275

LUT, 172, 185

Magnification, 139

Maintaining the ICM 1000, 43

Marking the region of interest, 236

Mask, 264

Materials, 255

Materials button, 258

Matrix, 219

Maximum intensity, 199

Maximum projection, 179, 193, 196, 199, 217,
271, 281

Maximum value, 227, 228, 229

Maximum value position, 228

Measurement bar display, 176

Measurement slider, 177

Measuring, 229

Measuring a profile along a line segment, 229,
247

Measuring the area, 258

Measuring volumes, 258
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Median, 249, 275

Median filter, 249, 275

Menu, 6

Merging, 210

Minimum value, 227, 228, 229

Minimum value position, 228

Mode, 143

Mode button, 143

Morphological filters, 249, 275

Morphological operators, 249, 275

Morphology, 249, 275

Move, 174, 201, 210

Move button, 201

Moving an image in the result image, 210

Moving the 3D View, 201

Moving the region of interest, 236, 237

Multicolor, 219

Multicolor reconstruction, 219

Multidimensional image data set, 154, 271

Multiplication, 204

Multiplying images, 204

Navigation, 174

Neutral filter, 130, 294

New Experiment button, 244

New window, 172

Next button, 190

Next image of a series, 190

Noise cancellation, 164

Number of spatial sections, 146, 149

Numerical aperture, 134

Nyquist theorem, 142

Objective, 134

Objective button, 134

Objective dialog window, 134

Objective nosepiece, 134

Offset, 160

Offset value, 138

Open button, 243

Opening a file, 243

Opening the context-sensitive help, 129

Optical crosstalk, 219

Optimal zoom factors, 139

Option, 6

Option new window, 244

Options dialog window, 246

OR, 204, 291

Original image, 199

Orthogonal projections, 196, 197, 198, 217

Out of focus, 141

Overlay, 180, 188, 189, 263

Overlay button, 188

Overlay rgb button, 189

Oversampling, 142

Phase button, 160

Phase shift, 160

Phase visualization, 294

Ping-pong mode, 176

Pinhole, 141

Pinhole button, 141

Pixel, 294

Pixel diagram, 260, 262

Pixel values, 204, 210

Plane objectives, 134, 294

Play/Stop button, 191
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Polygon, 234

Presentation, 239, 240, 241

Previous button, 190

Previous image of a series, 190

Principal component analysis, 219

Print, 232

Printer selection dialog window, 241

Printing, 232, 241

Printing quantification data, 232

Process, 204, 209, 210, 214, 217, 249, 255,
271, 275, 284

Process arrow symbol, 204, 209, 210, 214,
249, 255, 271, 275, 284

Process operating step, 204, 209, 210, 214,
217, 249, 255, 271, 275, 284

Processing large amounts of data, 164

Profile, 229

Profile (z) button, 228

Profile button, 229

Profile depth, 247, 248

Profile height, 247, 248

Projection, 193, 217, 271, 283

Projection of an image stack, 193, 217, 271,
283

Quantification, 177, 229, 232, 233, 247, 248

Range growth, 284

Raster, 176

Raw data, 243, 244

Recording a line using the averaging method,
163

Recording an image using the averaging
method, 164

Rectangle, 235, 240

Rectangle button, 240

Reflection long pass filter, 294

Reflection recordings, 131

Reflection short pass filter, 294

Refraction index, 294

Region of Interest, 228, 233, 234, 235, 248,
294

Region of Interest as a polygon, 234

Region of Interest as a rectangle, 235

Region of Interest as an ellipse, 233

Regions of Interest, 166, 167

Reset button, 204, 209, 210, 214, 217, 249,
255, 271, 275, 284

Resolution, 134, 142, 209

ROI, 141, 166, 167, 228, 233, 234, 235, 236,
237

ROI Scan, 166, 167

Root mean square value, 227, 247, 248

Rotate, 201, 237

Rotate button, 201

Rotating angle, 161

Rotating the 3D View, 201

Rotating the region of interest, 237

Rotating the scanning field, 161

Rotation, 161, 174, 201, 271

Rotational animation, 271

Roughness, 255

Roughness measurement, 247, 248

Safety notes, 13

Sampling theorem, 142

Save All button, 244

Save As button, 243

Save button, 243

Saving, 243, 244

Saving a file, 243
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Saving a file as..., 243

Saving measurement points, 247

Saving the viewer window as a template, 246

Scaling of the measurement curve, 177

Scan field, 161

Scan field rotation button, 161

Scan format, 142

Scan mode, 143, 181

Scan speed, 144

Scatter diagram, 260, 262

Sections, 149

Sections button, 149

Seed pixel, 284

Seeding, 284

Segmentation, 284

Select, 236

Select LUT dialog window, 185

Selecting a scan format, 142

Selecting a scan mode, 143

Selecting a scan speed, 144

Selecting a unidirectional or bidirectional scan,
160

Selecting an image, 191

Selecting an objective, 134

Selecting color maps (LUT), 185

Selecting the excitation beam splitter, 130

Selecting the excitation wavelength, 130

Selection, 172, 191

Selection button, 191

Separating images, 210

Separation, 210

Series, 146, 147, 149, 154, 188, 190, 191,
192, 199

Series button, 146

Series image, 188, 192

Series scan button, 154

Series scan overview dialog window, 146

Setting the number of wavelength steps, 150

Setting the scan parameters, 145

Setting up users, 32

SFP projection image, 179, 193, 271, 283

Sharpen, 249, 275

Shift, 160, 210

Signal-to-noise ratio, 294

Simulated Fluorescence Process (SFP), 271,
283

Simultaneous or sequential image recording,
130

Single channel, 284

Single image, 187

Single scan, 145

Singular value decomposition, 219

Skewness of the distribution, 227

Slot, 134

Snap button, 239

Software reference: all software functions, 49

Spatial image series, 149, 154, 217

Spatial view, 200

Specimen stage, 167

Spectral scan, 147, 150

Spectral series, 147, 150

Spectrum, 151

Speed button, 144

Stain, 151

Standard deviation, 227, 228, 229

Starting, 33



Leica Microsystems Heidelberg GmbH
Index

Leica TCS SP2 User Manual English
Part no.: 159330053 / Vers.: 31102002

Page 306 of 307

Starting a series scan, 154

Starting and ending a film, 191

Starting the operating system, 28

Statistical calculations, 227, 266

Statistics, 266

Step size, 149

Step width, 149

Stereo, 271

Stereo image, 271

Stokes shift, 294

Storing, 244

Structure, 249, 275, 284

Subtracting images, 204

Subtraction, 204

Sum of intensities, 165

Surface, 200

Surface center of mass, 199

Surface structure, 199

Tab, 6

Template button, 246

Text button, 241

Text field, 241

The arithmetical mean, 228, 229

Thickness of optical sections, 141

Three-dimensional image data set, 154, 217,
271

Three-dimensional view, 200

Threshold image, 284

Thresholding, 284

Thumbnail of an image, 174

Tiled button, 187

Time button, 170

Time configuration dialog window, 170

Time series, 154, 170

Top hat, 249, 275

Topographical image, 183, 199

Topography button, 183, 199

Translation, 174

Transparent factor, 179, 193, 198, 271, 283

Transparent projection, 179, 193, 198, 217,
271, 283

Triple dichroic, 294

Triple-dichroic filters, 130

Two-dimensional, 260

Two-point measurement, 177, 228, 247, 258

Undersampling, 142

Undo, 199

Unidirectional, 160

Unidirectional/ bidirectional scan button, 160

Up button, 204, 209, 210, 214, 217, 249, 255,
271, 275, 284

Variable projection axis, 193, 271, 281, 282,
283

Variance, 227, 228, 229

Viewer, 172

Viewer options, 174

Viewer options dialog window, 174, 176, 177,
179, 180, 181, 183

Viewer options dialog window, 3D icon, 174

Viewer options dialog window, charts icon, 177

Viewer options dialog window, display icon,
176

Viewer options dialog window, overlay icon,
180

Viewer options dialog window, projections
icon, 179

Viewer options dialog window, scan progress
icon, 181

Viewer options dialog window, surface
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calculation icon, 183

Viewer options dialog window, surface view
icon, 181

Viewer window, 6, 172, 185

Viewing a multiple image, 187

Viewing an overlay image in RGB, 180, 188,
189, 263

Viewing the last image of a series, 191

Viewing the original image, 199

Viewing the series image, 188, 192

Voxel, 193, 294

Wavelength range, 150

Waviness, 255

Wireframe, 200

Wizard, 235

Working distance, 134, 294

World coordinates, 204, 210

X/Y specimen stage, 167

XOR, 204, 291

xy section, 149

xy sections, 143, 217

xz section, 149

xz sections, 143, 217

Y-positioning, 161

Y-selection, 161

Z configuration dialog window, 149

z/y position, 146, 147, 148

z-actuator, 170

Z-Galvo, 170

Z-movement, 170

Z-objective stage, 170

Zoom button, 139, 202

Zoom in, 174, 185, 202

Zoom In button, 141

Zoom out, 174, 185, 202

Zooming the 3D View, 202

Z-position display, 176

Z-wide, 170


